USER'S GUIDE
# CONTENTS

## ONE WELCOME TO REFLEX

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>DATABASE CONCEPT</td>
<td></td>
</tr>
<tr>
<td></td>
<td>What Is a Database?</td>
<td>2</td>
</tr>
<tr>
<td>B</td>
<td>FIVE VIEWS OF YOUR INFORMATION</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The Form View&quot;™&quot;</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>The List View&quot;™&quot;</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>The Graph View&quot;™&quot;</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>The Crosstab View&quot;™&quot;</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>The Report View&quot;™&quot;</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Five Views of the Information</td>
<td>8</td>
</tr>
<tr>
<td>C</td>
<td>REFLEX FEATURES</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Calculated Fields</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Sorting</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Search/Filter</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Vary</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Translate</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Other Features</td>
<td>10</td>
</tr>
<tr>
<td>D</td>
<td>LEARNING TO USE REFLEX</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Starting Out</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>The Tutorials</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>The Reference Chapters</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>Appendices</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>Index</td>
<td>11</td>
</tr>
<tr>
<td>E</td>
<td>USING YOUR COMPUTER</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The Keyboard</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>The Mouse</td>
<td>15</td>
</tr>
</tbody>
</table>

## TWO STARTING OUT

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>THE REFLEX DISKETTES</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Care and Handling of Your Diskettes</td>
<td>2</td>
</tr>
<tr>
<td>B</td>
<td>FORMATTING DISKETTES</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For Two Diskette Drives</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>For a Hard Disk</td>
<td>5</td>
</tr>
</tbody>
</table>
# REFLEX THE ANALYTIC DATABASE SYSTEM

**C** MAKING BACKUP COPIES OF THE REFLEX DISKETTES  
For Two Diskette Drives  
6

**D** INSTALLATION  
For Two Diskette Drives  
For a Hard Disk  
7

**E** STARTING REFLEX  
Two Diskette Drives  
Hard Disk  
9

**F** USING THE REPORT & UTILITIES DISKETTE  
11

**G** OPTIONAL HARDWARE SETUP  
11

**H** IF THE REFLEX SYSTEM DISK IS DAMAGED OR LOST  
15

## THREE BASIC TUTORIAL

<table>
<thead>
<tr>
<th>PART 1</th>
<th>SCREENHANDLING</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>REFLEX CONCEPT</td>
<td>THE FORM VIEW</td>
<td>16</td>
</tr>
<tr>
<td>PART 2</td>
<td>DESIGNING A FORM</td>
<td>18</td>
</tr>
<tr>
<td>PART 3</td>
<td>ENTERING INFORMATION IN THE FORM VIEW</td>
<td>22</td>
</tr>
<tr>
<td>PART 4</td>
<td>SAVING A DATABASE</td>
<td>27</td>
</tr>
<tr>
<td>REFLEX CONCEPT</td>
<td>THE LIST VIEW</td>
<td>30</td>
</tr>
<tr>
<td>PART 5</td>
<td>ENTERING INFORMATION IN THE LIST VIEW</td>
<td>31</td>
</tr>
<tr>
<td>REFLEX CONCEPT</td>
<td>SORTING</td>
<td>36</td>
</tr>
<tr>
<td>PART 6</td>
<td>SORTING YOUR RECORDS</td>
<td>38</td>
</tr>
<tr>
<td>REFLEX CONCEPT</td>
<td>SEARCHING</td>
<td>43</td>
</tr>
<tr>
<td>PART 7</td>
<td>SETTING SEARCH CONDITIONS: FINDING AND FILTERING</td>
<td>44</td>
</tr>
<tr>
<td>PART 8</td>
<td>CHANGING THE LIST VIEW AND PRINTING</td>
<td>51</td>
</tr>
<tr>
<td>PART 9</td>
<td>EDITING THE RECORDS</td>
<td>59</td>
</tr>
</tbody>
</table>
## Four
### Advanced Tutorial

<table>
<thead>
<tr>
<th>Reflex Concept</th>
<th>Part</th>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reflex Concept</td>
<td>Part 1</td>
<td>Calculated Fields</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Calculated Fields</td>
<td>5</td>
</tr>
<tr>
<td>Reflex Concept</td>
<td>Part 2</td>
<td>The Graph View</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Making A Graph</td>
<td>16</td>
</tr>
<tr>
<td>Reflex Concept</td>
<td>Part 3</td>
<td>The Crosstab View</td>
<td>27</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Using Crosstabs For Analysis</td>
<td>29</td>
</tr>
<tr>
<td>Reflex Concept</td>
<td>Part 4</td>
<td>Vary</td>
<td>44</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Planning Break-Even Analysis</td>
<td>46</td>
</tr>
<tr>
<td>Reflex Concept</td>
<td>Part 5</td>
<td>The Report View</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Designing And Printing A Report</td>
<td>53</td>
</tr>
</tbody>
</table>

## Five
### Reference A

<table>
<thead>
<tr>
<th>Part 1</th>
<th>Reflex Basics</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>The Reflex Screen</td>
<td>4</td>
</tr>
<tr>
<td>B</td>
<td>Windows: Views And Tools</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Views</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Tools</td>
<td>6</td>
</tr>
<tr>
<td>C</td>
<td>Select And Choose</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>Cursor Movement</td>
<td>7</td>
</tr>
<tr>
<td>D</td>
<td>Important Keys And Their Uses</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>The Function Keys</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>Other Important Keys</td>
<td>12</td>
</tr>
<tr>
<td>E</td>
<td>Reflex Menus</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td>Choosing A Menu Command</td>
<td>13</td>
</tr>
<tr>
<td>PART</td>
<td>SECTION</td>
<td>PAGE</td>
</tr>
<tr>
<td>-------</td>
<td>--------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>2</td>
<td>SCREEnHANDLInG</td>
<td>15</td>
</tr>
<tr>
<td>A</td>
<td>MANAGING THE VIEWS</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>Opening a View</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>Opening Multiple Views</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>Closing a View</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>Changing the Active View</td>
<td>18</td>
</tr>
<tr>
<td></td>
<td>Resizing a View</td>
<td>18</td>
</tr>
<tr>
<td></td>
<td>Expanding and Shrinking a View</td>
<td>18</td>
</tr>
<tr>
<td>B</td>
<td>TOOLS</td>
<td>19</td>
</tr>
<tr>
<td></td>
<td>Moving Around in Tools</td>
<td>19</td>
</tr>
<tr>
<td>3</td>
<td>ENTERING AND EDITING DATA</td>
<td>21</td>
</tr>
<tr>
<td>A</td>
<td>THE DATABASE—RECORDS AND FIELDS</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>Creating the Database</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>Entering Data</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>The Current Record</td>
<td>24</td>
</tr>
<tr>
<td>B</td>
<td>FIELD SPECIFICATIONS</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>Field Names</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>Field Types</td>
<td>26</td>
</tr>
<tr>
<td>C</td>
<td>CHOICES</td>
<td>28</td>
</tr>
<tr>
<td></td>
<td>Selecting from a Choice List</td>
<td>29</td>
</tr>
<tr>
<td>D</td>
<td>EDITING</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>The Edit Mode</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>The Edit Menu</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>Insert</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td>Set Column Width</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td>Row Select</td>
<td>33</td>
</tr>
<tr>
<td></td>
<td>Column Select</td>
<td>33</td>
</tr>
<tr>
<td></td>
<td>Window Clear</td>
<td>33</td>
</tr>
<tr>
<td>4</td>
<td>THE VIEWS</td>
<td>34</td>
</tr>
<tr>
<td>A</td>
<td>FORM DESIGN</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td>Opening Form Design</td>
<td>36</td>
</tr>
<tr>
<td></td>
<td>Closing Form Design</td>
<td>37</td>
</tr>
<tr>
<td></td>
<td>Positioning the Cursor</td>
<td>37</td>
</tr>
<tr>
<td></td>
<td>Entering Field Names</td>
<td>38</td>
</tr>
</tbody>
</table>
## CONTENTS

Moving Field Names 38  
Adding Field Names 38  
Deleting Field Names 39  
Renaming Fields 39  
Entering Labels 40  

B **THE FORM VIEW**  40  
Opening and Closing the Form View 41  
Moving Around the Form View 42  
Scanning the Records 42  
Entering Data in Form View 43  

C **THE LIST VIEW**  44  
Opening and Closing the List View 45  
Working in the List View 45  
Rearranging the Columns 46  
Entering and Editing Data in the List View 48  

D **THE GRAPH VIEW**  49  
The Graph View Screen 49  
Opening and Closing the Graph View 51  
Setting Up a Graph: Plotting Data 51  
Working with Records in the Graph 54  
Graph Types 56  
Graphing Summaries and for Each 60  
Scaling, Titles, and Grids 63  

E **THE CROSSTAB VIEW**  66  
Opening and Closing the Crosstab View 67  
Moving Around the Crosstab View 68  
Row and Column Manipulation 69  
Creating a Crosstab 70  
Additional Formulas 77  
Saving, Retrieving, and Deleting Crosstabs 80  

### PART 5 **THE PRINT/FILE MENU**  81  

A **DOS DIRECTORIES**  82  
Using Directories 82  
The Current Directory 83  
DOS File Extension 83  

B **GLOBAL SETTINGS**  84
## REFLEX: THE ANALYTIC DATABASE SYSTEM

### C RETRIEVING A DATABASE
- Retrieving Part of a File

### D SAVING A DATABASE
- Updating a File
- Saving a Filtered Database

### E ERASING A DATABASE

### F PRINTING
- Graph Printing
- Margin and Page Length Limits and Defaults
- Setup Strings
- Saving the Print Settings
- Printer Setup

### PART 6 RECORDS

#### A FIELD & SORT SETTINGS
- Using the Field & Sort Settings Tool
- Fields
- Field Types
- Formulas
- The Sort Order
- Display Formats
- Precision

#### B VARY
- The Vary Tool
- Conditions and Effects

#### C RECORDS COMMANDS
- Add Record
- Delete Record
- Perform Sort
- Recalc
- Clear Database

### PART 7 SEARCH

#### A SEARCH CONDITIONS
- Operators
- Text Search Conditions
- Numeric Search Conditions
CONTENTS

Date Search Conditions 124
Special Search Conditions 124
How Are Search Conditions Evaluated? 125

B SET SEARCH CONDITIONS 126
Using the Search Conditions Table 127
Use Conditions as Entered or Opposite 130

C FILTER, FIND, AND KEEP 131
Apply Filter 131
Remove Filter 132
Find Record 132
Keep Records 133

PART 8 CALCULATED FIELDS 134

A FORMULAS 135
Values: The Basic Elements 135
Formulas 136

B FORMATS FOR FORMULAS 138
Arithmetic Operators 138
The General Format 138
Precedence of Operators in Calculations 139
Using Parentheses to Change the Order of Calculations 139

C ENTERING FORMULAS 140
Local Values and Formulas 141
Entering Numbers, Dates, and Text In Formulas 142
Entering Constants 143

D FUNCTIONS 143
Format of Functions 144
Function Type 144
Function List 145

E WORKING WITH DATES 147
Date Consolidation 147
Date Arithmetic 153

F RECALCULATION: AUTOMATIC AND MANUAL 154

G EDITING AND DELETING FORMULAS 155

H CONVERTING A FORMULA TO ITS RESULTS 155
## SIX REFERENCE B

### PART 1 THE REPORT VIEW

**A THE REPORT VIEW SCREEN**

**B OVERVIEW OF REPORTING**

- Preliminary Steps
- Designing the Report
- Save and Print the Report

**C MOVING AROUND REPORT VIEW**

**D THE DESIGN AREA**

- Design Elements

**E THE WHEN PRINTED COLUMN**

- The Row Flags

**F REPORT MENU**

- Preview on Screen
- Change Sort Settings
- Display Values ON/OFF
- Save Report Design
- Retrieve Report Design
- Erase Report Design
- Quit

**G THE EDIT MENU**

- Delete
- Insert
- Set Column Width
- Row Select
- Move
- Copy
- Window Clear

**H THE PRINT/FILE MENU**

- Retrieve File
- Print
- Change Printer Settings
- Global Settings

**I SEARCH**

**J ATTRIBUTES**

- Using Attributes
- Display Attributes
- Arithmetic Attributes
<table>
<thead>
<tr>
<th>CONTENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>K EXAMPLE REPORTS</strong></td>
</tr>
<tr>
<td>Basic Columnar Report</td>
</tr>
<tr>
<td>Columnar Report with Subtotals</td>
</tr>
<tr>
<td>Summary Report Using Subtotals</td>
</tr>
<tr>
<td>Columnar Report Using Special Report Functions and Cumulative</td>
</tr>
<tr>
<td>Mailing Labels</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PART 2 TRANSLATE</th>
<th>62</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>A TRANSLATE</strong></td>
<td>63</td>
</tr>
<tr>
<td>Overview of Translating</td>
<td>63</td>
</tr>
<tr>
<td><strong>B TRANSLATING PFS AND DBASE FILES</strong></td>
<td>67</td>
</tr>
<tr>
<td><strong>C TRANSLATING 1-2-3, SYMPHONY, AND DIF FILES</strong></td>
<td>69</td>
</tr>
<tr>
<td>Changing the “From...To” Coordinates</td>
<td>72</td>
</tr>
<tr>
<td>Using Named Ranges</td>
<td>73</td>
</tr>
<tr>
<td>Using the “Show Data from Row” Cell</td>
<td>74</td>
</tr>
<tr>
<td>The Fields Menu Command</td>
<td>74</td>
</tr>
<tr>
<td>The Types Menu Command</td>
<td>75</td>
</tr>
<tr>
<td><strong>D TRANSLATING ASCII TEXT FILES</strong></td>
<td>76</td>
</tr>
<tr>
<td>Text File Formats</td>
<td>77</td>
</tr>
<tr>
<td>How to See Your File Format</td>
<td>78</td>
</tr>
<tr>
<td>What Reflex Needs to Know</td>
<td>79</td>
</tr>
<tr>
<td>Using the Text File Translate Table</td>
<td>80</td>
</tr>
<tr>
<td>The Go From and Stop On Choices</td>
<td>81</td>
</tr>
<tr>
<td>Text Translation Examples</td>
<td>83</td>
</tr>
<tr>
<td>If You Have a Problem</td>
<td>90</td>
</tr>
</tbody>
</table>

| PART 3 MERGE | 92 |
| Merging Databases | 93 |

| PART 4 GRAPH PRINT | 95 |
| Printing Graphs | 96 |
| Color Settings | 98 |
| The Graph Print Menus | 100 |
| Printers and Plotters | 100 |
SEVEN APPENDICES

A SYSTEM PARAMETERS 2
B FUNCTIONS AND OPERATIONS 2
C PRINTER SETUP STRINGS 19
D HARDWARE NOTES 20
E ERROR MESSAGES 22
F HANDY HINTS 30

EIGHT INDEX
NOTICES FOR ADVANCED USERS

If you will be using the Reflex Merge facility with files containing Repeating Text fields, please note:

If files containing fields of the type Repeating Text are merged, any null values in those fields will be overwritten with other values in the merged database. (A field in a particular record has a null value when no value has been entered into it.) A workaround for this is to replace the null values with a temporary value prior to merging. The dummy values can then be replaced with null in the merged file. To replace all null values with "temp" in a field, enter a formula such as ="temp" in the field. To then replace "temp" with the null values in the merged database, remove the formula by entering =. 

If you will be creating very large Report designs, please note:

The Report View does not support report definitions with more than 1200 items. An item is a field name, special field, text, or formula that you type in the Design Area. This does not refer to the number of records reported on. If you are producing a report approaching this size, it is recommended that as a precaution you save the report specification using the Save Report Design command in the Report menu.
ONE

WELCOME TO REFLEX
# A DATABASE CONCEPT

**WHAT IS A DATABASE?**

What is a database? Entering information into the records.

---

# B FIVE VIEWS

**FIVE VIEWS OF YOUR INFORMATION**

The FORM View™; The LIST View™; The GRAPH View™; The CROSSTAB View™; The REPORT View™;
Five views of the information.

---

# C REFLEX FEATURES

**REFLEX FEATURES**

Calculated fields; Sorting; Search/filter; Vary; Translate; Other features.

---

# D LEARNING TO USE REFLEX

**LEARNING TO USE REFLEX**

Starting out; The tutorials; The reference chapters; Appendices; Index.

---

# E USING YOUR COMPUTER

**USING YOUR COMPUTER**

The keyboard; The mouse.
Welcome to Reflex, The Analytic Database. Reflex provides powerful ways to analyze the records you keep so that you can quickly understand the meaning behind the information. It is designed to be the easiest program to use for filing and keeping track of information.

This chapter is an orientation to Reflex. It provides a quick introduction to the main parts of the program and the User's Guide.

WHAT IS A DATABASE?

A database is any organized collection of information—a telephone book or a monthly sales report, for instance. Computer database programs allow you to handle such information in electronic form so that you can rearrange the order of items or search for a single piece of information.

Reflex keeps track of records, in which the information is entered. Each record consists of a series of fields. A field is the area that contains a particular item of information. A field name identifies the kind of information that goes in each field.
DESIGNING THE FORM OF YOUR RECORDS

You use the Reflex Form Design screen to enter your field names. You can arrange them however you want, move them to any location, and edit them at any time. In addition, you can add and delete fields instantly, as your business needs change.

<table>
<thead>
<tr>
<th>Views</th>
<th>Edit</th>
<th>Print/File</th>
<th>Records</th>
<th>Search</th>
<th>Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>FORM</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tyler Canoe Company</td>
<td>Monthly Sales Report</td>
<td>Date:</td>
<td>Fields rearranged</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rep:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Product:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quantity:</td>
<td>Sales $:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unit Cost:</td>
<td>$ Margin:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total Cost:</td>
<td>% Margin:</td>
<td>Fields added</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avg Price:</td>
<td>Commission:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

ENTERING INFORMATION INTO THE RECORDS

You enter information as you would fill out any form. Each time you complete a form, Reflex creates another blank one. You can enter new information and edit old information at any time, instantly.

In addition, Reflex features let you translate files you have created with 1-2-3®, Symphony™, dBase II®, dBase III™, PFS®, and also DIF and ASCII (text) files.
FIVE VIEWS OF YOUR INFORMATION

Reflex provides five views of your database—that is, five different ways of working with the information.

THE FORM VIEW™

The Form View displays information in detail, one complete record at a time. The screen appears exactly as you have designed it.

<table>
<thead>
<tr>
<th>Views</th>
<th>Edit</th>
<th>Print/File</th>
<th>Records</th>
<th>Search</th>
<th>Form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FORM</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tyler Canoe Company</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Monthly Sales Report</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date: May-85</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rep: Alan</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Product: Silent</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quantity: 32</td>
<td></td>
<td>Sales $: $38,976</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unit Cost: $570</td>
<td></td>
<td>$ Margin: $28,736</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total Cost: $18,248</td>
<td></td>
<td>% Margin: 53.2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avg Price: $1,218</td>
<td></td>
<td>Commission: $6,228.88</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Form View makes specific information available instantly.
THE LIST VIEW™

The *List View* enables you to see several records at once. It displays all the records in order, in a row and column format.

Sales records for each of your Sales Reps, arranged by month so you can compare their results over time.

<table>
<thead>
<tr>
<th>Date</th>
<th>Rep</th>
<th>Sales $</th>
<th>$ Margin</th>
<th>Quantity</th>
<th>Avg Price</th>
<th>Total C</th>
<th>Unit C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apr-85</td>
<td>Alan</td>
<td>$16,987</td>
<td>$8,437</td>
<td>15</td>
<td>$1,132</td>
<td>$8,558</td>
<td>$578</td>
</tr>
<tr>
<td>Apr-85</td>
<td>Bob</td>
<td>$2,175</td>
<td>$1,035</td>
<td>2</td>
<td>$1,088</td>
<td>$1,148</td>
<td>$578</td>
</tr>
<tr>
<td>Apr-85</td>
<td>Cathy</td>
<td>$4,891</td>
<td>$2,041</td>
<td>5</td>
<td>$978</td>
<td>$2,859</td>
<td>$578</td>
</tr>
<tr>
<td>Apr-85</td>
<td>Dave</td>
<td>$7,544</td>
<td>$2,444</td>
<td>9</td>
<td>$938</td>
<td>$5,130</td>
<td>$578</td>
</tr>
<tr>
<td>May-85</td>
<td>Alan</td>
<td>$38,976</td>
<td>$20,736</td>
<td>32</td>
<td>$1,218</td>
<td>$18,248</td>
<td>$578</td>
</tr>
<tr>
<td>May-85</td>
<td>Bob</td>
<td>$6,992</td>
<td>$3,082</td>
<td>7</td>
<td>$999</td>
<td>$3,999</td>
<td>$578</td>
</tr>
<tr>
<td>May-85</td>
<td>Cathy</td>
<td>$3,813</td>
<td>$1,533</td>
<td>4</td>
<td>$953</td>
<td>$2,288</td>
<td>$578</td>
</tr>
<tr>
<td>May-85</td>
<td>Dave</td>
<td>$22,578</td>
<td>$8,898</td>
<td>24</td>
<td>$941</td>
<td>$13,688</td>
<td>$578</td>
</tr>
<tr>
<td>Jun-85</td>
<td>Alan</td>
<td>$29,876</td>
<td>$15,626</td>
<td>25</td>
<td>$1,195</td>
<td>$14,258</td>
<td>$578</td>
</tr>
<tr>
<td>Jun-85</td>
<td>Bob</td>
<td>$2,169</td>
<td>$1,029</td>
<td>2</td>
<td>$1,085</td>
<td>$1,148</td>
<td>$578</td>
</tr>
<tr>
<td>Jun-85</td>
<td>Cathy</td>
<td>$6,499</td>
<td>$3,879</td>
<td>6</td>
<td>$1,883</td>
<td>$3,428</td>
<td>$578</td>
</tr>
<tr>
<td>Jun-85</td>
<td>Dave</td>
<td>$24,351</td>
<td>$8,961</td>
<td>27</td>
<td>$982</td>
<td>$15,398</td>
<td>$578</td>
</tr>
</tbody>
</table>

To make comparisons easier, you can rearrange the columns instantly to bring important details into focus. You can even temporarily set aside whole columns of information, leaving visible only the exact details you want.
One of your sales is generally rising. In May, Cathy’s sales took off, but what is happening to Bob?

The **Graph View** automatically presents a graphic representation of your information. Often a *visual summary* reveals important trends or exceptions that would otherwise take you hours to discover from raw data.

The Graph View automatically presents a graphic representation of your information. Often a *visual summary* reveals important trends or exceptions that would otherwise take you hours to discover from raw data.

Your graph is created instantly; you simply enter field names for the information you want to display, and Reflex draws the graph. Then, by selecting any point on the graph, you bring up the corresponding detailed record in the Form or List Views.

This unique *summary-to-detail capability* puts graphic analysis at your fingertips. You can change the type of graph instantly. The scale is set automatically, or you can change it to suit your needs. You can ask for totals, counts, averages, or other summaries, and Reflex automatically shows them on the graph.
THE CROSSTAB VIEW™

The Crosstab View divides your information into categories and displays them in a numeric summary table. Use it to pinpoint trends and relationships among the data. Or quickly change the crosstab for a second analysis, and Reflex shows you a different aspect of your information.

<table>
<thead>
<tr>
<th>Views</th>
<th>Edit</th>
<th>Print/File</th>
<th>Records</th>
<th>Search</th>
<th>Crosstab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summarize:</td>
<td>@SUM</td>
<td>Field:</td>
<td>Sales $</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rep</td>
<td>&quot;Paddles&quot;</td>
<td>$34,287</td>
<td>$33,635</td>
<td>$34,897</td>
<td>$46,925</td>
</tr>
<tr>
<td></td>
<td>&quot;Silent&quot;</td>
<td>$147,588</td>
<td>$22,228</td>
<td>$81,795</td>
<td>$76,356</td>
</tr>
<tr>
<td></td>
<td>&quot;Sport&quot;</td>
<td>$43,578</td>
<td>$23,533</td>
<td>$39,142</td>
<td>$39,843</td>
</tr>
<tr>
<td></td>
<td>&quot;Swiftwater&quot;</td>
<td>$84,148</td>
<td>$56,925</td>
<td>$74,888</td>
<td>$92,567</td>
</tr>
<tr>
<td>ALL</td>
<td>$389,497</td>
<td>$135,713</td>
<td>$236,552</td>
<td>$255,781</td>
<td>$931,463</td>
</tr>
</tbody>
</table>

Bob's average percent Margin is highest. Is he pushing too hard on price at the expense of volume?

These kinds of analyses are so quick that you can ask question after question about your information. Your understanding becomes deeper and more complete.
THE REPORT VIEW™

The Report View enables you to design custom printouts of your information.

<table>
<thead>
<tr>
<th>Report</th>
<th>Edit</th>
<th>Options</th>
<th>Search</th>
<th>Attributes</th>
</tr>
</thead>
</table>

**FIRST QUARTER SALES BY REP**

<table>
<thead>
<tr>
<th></th>
<th>Silent</th>
<th>Sport</th>
<th>Swiftwater</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Quarter Sales For Alan</td>
<td>$131,500.00</td>
<td>$38,871.00</td>
<td>$74,148.00</td>
</tr>
<tr>
<td>First Quarter Sales For Bob</td>
<td>$22,222.00</td>
<td>$22,533.00</td>
<td>$56,925.00</td>
</tr>
<tr>
<td>First Quarter Sales For Cathy</td>
<td>$34,705.00</td>
<td>$32,142.00</td>
<td>$75,886.00</td>
</tr>
</tbody>
</table>

You can format the printout of your data almost any way you want it, directly on the Reflex screen. Setting up your report is easy, and you can save the format for use later on. The Report View lets you instantly preview what will appear in print.

**FIVE VIEWS OF THE INFORMATION**

Reflex Views give you five different ways of seeing and analyzing your information. Each view contributes to your understanding in a different way.

Each view is directly connected to the same underlying database; work you do in one view instantly affects all the others. You can shift immediately from one view to another. And you can use up to three windows simultaneously to display the Form, List, and Graph Views.
REFLEX FEATURES

CALCULATED FIELDS

You can enter formulas into any field for automatic calculation of values. Use built-in mathematical, statistical, financial, and date functions for building sophisticated models.

SORTING

You can arrange your records in exactly the order you want them. For instance, you may want your employee records in alphabetical order to print a directory, and then change to date-of-hire order for benefit analysis.

SEARCH/FILTER

You can search for individual records that meet conditions you specify. Or you can use the same conditions to divide the database instantly into a subset of the records for quick analysis. For example, if you want to look at only high-margin sales, you apply a Reflex Filter and instantly create a temporary “working database” of only those records.

VARY

You can automatically enter a sequence of data and create many records at once to set up a skeleton database or to build hypothetical scenarios.

TRANSLATE

You can use information from other computer programs without having to reenter the data. Reflex can use 1-2-3, Symphony, dBase II, dBase III, PFS, DIF, and ASCII (text) files you already have. Reflex can also work with the data from many of the popular micro-to-mainframe programs.
OTHER FEATURES

Reflex combines the five views and analysis features with easy-to-use menus that work directly from the screen. Pop-down menus provide quick access to 50 commands.

Reflex also makes full use of the special function keys on the IBM keyboard. For instance, you can press [F10] to see a choice list of current field names, functions, or other options, then select the entry you want. When you need help, press [F1] to display a Help screen.

Complete directions for operating Reflex can be found in the first tutorial and at the beginning of Reference A.

LEARNING TO USE REFLEX

STARTING OUT

You need to do a few things to prepare Reflex to run on your computer. Turn to the “Starting Out” chapter for step-by-step directions.

THE TUTORIALS

This package includes an electronic tutorial which you will find on your help diskette.

If you prefer a written tutorial, you will find two sections of the User's Guide particularly useful. The Basic Tutorial takes you step by step through setting up, creating, and using a database. The tutorials are arranged so that you can begin working with Reflex quickly. The Advanced Tutorial uses step-by-step examples to show you how to do analyses with Reflex.

Included in the tutorial chapters are short introductions to the features of Reflex, called “Reflex Concepts.” Read these for an overview of the program.
WELCOME TO REFLEX

Both the electronic and written tutorials use sample databases, constructed so that you can practice using Reflex at your own convenience.

THE REFERENCE CHAPTERS

The Reference chapters provide complete descriptions of all of the parts of Reflex. If you want to plunge right in with your own work, read the appropriate parts of the Reference chapters as you need to.

APPENDICES

Different appendices provide helpful hints for using Reflex, a troubleshooting guide with a list of error messages, and several technical charts.

INDEX

Use the Index to find references to any topic in this User's Guide.

USING YOUR COMPUTER

Throughout this User's Guide, we are assuming you have an IBM PC with two diskette drives, or an IBM XT with one diskette drive and a hard disk. If you have an IBM PC-compatible computer, or an IBM AT, you will have no trouble using Reflex on it. If your keyboard is different, you will need to consult your computer manual to find the keys equivalent to the IBM keys.
THE KEYBOARD

The computer keyboard looks like an expanded version of a standard typewriter keyboard. There are groups of keys to the right and left of the regular typewriter keys, and several special-purpose keys.

THE TYPEWRITER KEYS

The typewriter keys act just like the keys on a typewriter. The characters you type in appear on the screen.

NOTE You cannot use the letters 0 and 1 for the numbers zero (0) and one (1). Your computer takes these things literally.

Use the shift key to get capital letters just as you would with a typewriter. When two symbols are pictured on a key, the key gives you the upper one.

The key makes all the letter keys uppercase, but it doesn’t affect the number keys or the punctuation keys. You will still have to use the key to get the upper symbols. The key toggles: Press it once and it’s on; press it again and it’s off. Using the key with on gives you a lowercase letter.

The tab key normally moves you to the right. Using and together moves you to the left (backtab).
When you are typing an entry, the (Backspace) key moves you one space to the left, wiping out the character it passes over. Do not confuse the backspace key with the other keys with arrows on them.

**THE CURSOR MOVEMENT KEYS**

You use the **cursor movement keys** to move the **cursor**, a highlighted rectangle on your screen, to the location you want Reflex to pay attention to. The cursor can be one character wide or as wide as the whole screen. The arrow keys move the cursor one space in the direction of the arrow. Depending on the context, the \[Home\], \[End\], \[Pg Up\], and \[Pg Dn\] keys move the cursor in larger jumps.

Pressing the \[Num Lock\] key turns the cursor movement keys into a numeric keypad. This key also toggles: Press it again to return these keys to cursor movement keys. In most cases, you will find it convenient to enter numbers from the top row of the typewriter keys.

**FUNCTION KEYS**

The function keys with template.

The **function keys** \[F1\] through \[F10\] perform specific Reflex commands. These keys are described in several places in this User's Guide; a complete chart is found at the beginning.
of Reference A. Your Reflex manual includes a paper template that you can cut out and place over the function keys to remind you of which key does what.

**SPECIAL KEYS**

The \[ Ctrl \] key is used to double the capability of some other key. For example, when \[ Ctrl \] is used with \[ ← \] and \[ → \], these keys act like “Page Left” and “Page Right” to move the screen in large jumps over the information.

The \[ Ins \] key inserts a row or a column in a display so you can add information to what is already there.

The \[ Del \] key deletes the contents of a field, or an entire row or column in a display. If you use this key while you are in Edit mode, this key deletes one character at a time.

The enter key \[ ~ \] is sometimes called the carriage return key, because it is in the same location as the carriage return on a typewriter keyboard. This key causes Reflex to “enter” what you have typed into a cell or to carry out a menu command. It means, “Go ahead, do it!”

The \[ Esc \] key is the opposite of the \[ ~ \] key: It cancels what you have been doing. It means, “I’ve changed my mind.” If you press it while typing an entry, it returns the cell to its condition before you started.
THE MOUSE

As an option, Reflex can be used with a mouse, a hand-operated pointing device attached to your computer. If you use a mouse, an arrow known as the pointer will appear on your screen. You control the pointer by rolling the mouse across your desktop.

Using a mouse is explained fully in the first tutorial.
Notes:
TWO

STARTING OUT
A  REFLEX DISKETTES  
THE REFLEX DISKETTES
Care and handling of your diskettes.

B  FORMATTING  
FORMATTING DISKETTES
For two diskette drives; For a hard disk.

C  BACK UP COPIES  
MAKING BACKUP COPIES OF THE REFLEX DISKETTES
For two diskette drives.

D  INSTALLATION  
INSTALLATION
For two diskette drives; For a hard disk.

E  STARTING REFLEX  
STARTING REFLEX
Two diskette drives; Hard disk.

F  REPORT & UTILITIES  
USING THE REPORT & UTILITIES DISKETTE

G  OPTIONAL HARDWARE  
OPTIONAL HARDWARE SETUP
In this section we describe the things you need to do before using Reflex.

Although Reflex is ready to run on your IBM Personal Computer right away, there is a little preparation to be done first. In particular, you need to:

1. Prepare a formatted diskette to store databases.
2. Make backup copies of the Reflex diskettes.
3. Install the Reflex program, so it may be used to start ("boot") the system.

In addition to these preparatory procedures, this chapter discusses the hardware you need for running Reflex, how to start running Reflex, and finally, what to do if your Reflex System Disk is damaged.

**EQUIPMENT**

Reflex will work on the IBM PC, IBM XT, IBM AT, and fully IBM PC-compatible computers.

Your computer must have at least 384K of main memory (RAM) and be equipped to use double-sided diskettes with 360K bytes of storage.

Your computer must also have an IBM Color/Graphics Adapter and a display capable of high resolution graphics (although a color monitor is unnecessary), or a Hercules (Monochrome) Graphics Card for the IBM Monochrome Display.

Your Operating System (DOS) must be version 2.0 or later.

**THE REFLEX DISKETTES**

Your Reflex package includes three diskettes, two of which you'll use for running Reflex, and one disk containing the Help files.

**Reflex System Disk**  The main Reflex program.


By following the instructions in this chapter, you will make both the Reflex System Disk and the Report & Utilities Disk "bootable", i.e. you can put either into Drive A: and start the computer. Which disk you actually use at any given time will depend on which Reflex facility you wish to use.

If you have a hard disk, you can copy both diskettes to the hard disk and have all the Reflex facilities available at once.

In addition to the Reflex diskettes, you will need a few blank diskettes. These must be formatted before you work with Reflex. You will use these diskettes to save the work you do with Reflex.

CARE AND HANDLING OF YOUR DISKETTES

Diskettes are sensitive. If they aren't handled properly, they can be damaged, losing the information stored on them. In general, if you treat them carefully and keep backup copies, you can count on overcoming any mishaps that may occur.

Always handle a diskette by the edge. Never touch any part of the recording surfaces. Store diskettes in the envelopes they come in. This will keep dust, smoke, and anything else off of the recording surface.
Keep your diskettes away from magnets and machines that emit magnetic fields (telephones, for instance). Magnets are found in many unlikely places around the office, such as paper clip containers, so be cautious.

Don’t let diskettes get too hot or too cold. They are designed to be safe between 50 and 125 degrees Fahrenheit. Even on a cool day, however, direct sunlight can heat a diskette and damage it.

Don’t write on them (except carefully with a felt-tip pen)—instead, write on a new label first, then stick the label on the diskette cover.

We recommend that you store your original Reflex diskettes and your backup copies in their paper envelopes in a vertical position. Use a hard-covered box to keep them safe from dust and damage.

And always make backup copies of any diskette containing important information. If something is very important, make two backup copies and store them in different places.

---

FORMATTING DISKETTES

Before you can use a diskette to store the work you do on Reflex, it must be formatted. Here is the procedure to format a blank diskette.

FOR TWO DISKETTE DRIVES

1. Be sure your DOS diskette is in Drive A and the computer is on. Your screen displays A> If it doesn’t, type A: and press

2. Type Format B: and press

3. Place a new diskette in Drive B and press The screen displays Formatting while it works.
Formatting takes a little while. When it is finished, your computer displays a message asking whether to format another diskette. Type N (for “no”). The A> prompt appears.

### FOR A HARD DISK

1. Be sure that the hard disk is the default Drive.  
   *Assuming the hard disk is Drive C (it generally is), your screen displays C>. If it doesn’t, type C: and press]*

2. Type **CD \** and press [Enter]
   *This makes the root directory of your hard disk the current directory. If your DOS files are on a different directory, then you must change the current directory to it.*

3. Type **Format A:** and press [Enter]
   *Your screen prompts you to insert a diskette in Drive A.*

4. Place a new diskette in Drive A and press [Enter]
   *The screen displays Formatting while it works.*

Formatting takes a little while. When it is finished, your computer displays a message asking if you want to format another diskette. Type N (for “no”). The C> prompt appears.

### WARNING

Always have an extra, formatted diskette available. If you reach the end of a Reflex session and want to save the work you have been doing, you will then be able to do so. If you turn off the computer or exit Reflex without saving your work, it will be lost.
MAKING BACKUP COPIES OF THE REFLEX DISKETTES

Your Reflex disks are not copy-protected. Before using Reflex, you should make a backup copy of the Reflex System Disk and Report & Utilities Disk. Should anything happen to your original Reflex disks you can use your backup disks. If you are using a hard disk system, your original Reflex disks can serve as your backup copies.

FOR TWO DISKETTE DRIVES

To make a backup copy of your Report & Utilities Disk, follow the procedure described above and use your Reflex Report & Utilities disk instead of your Reflex System Disk.

1. Be sure your DOS diskette is in Drive A and your computer is on. The screen displays A> If it doesn't, type A: and press \[← \]

2. Type format b:/s and press \[← \] Your screen prompts you to insert a diskette in Drive B.

3. Place a new diskette in Drive B and press \[← \] The screen displays Formatting during the formatting process.

Formatting takes a little while. When it is finished, your computer displays a message asking whether to format another diskette. Type N (for “no”). The A> prompt appears.

4. Remove your DOS disk from Drive A and Replace it with your Reflex System Disk.

5. Type copy *.* B: and press \[← \] DOS will display a listing of the files as they are copied to your backup disk in Drive B. You now have a fully-functional backup copy of your Reflex System Disk.*
STARTING OUT

When all the Reflex diskettes have been copied and labeled, enter N. The A> prompt appears.

INSTALLATION

The final step is to “install” Reflex. This simply means copying it to your hard disk, if you have one, or copying DOS to the Reflex System Disk and Report & Utilities Disk so you can use them to start (boot) your computer.

FOR TWO DISKETTE DRIVES

1. Be sure your DOS diskette is in Drive A, and the computer is on.
   The screen displays A>
   If it doesn’t, type A: and press [Enter]

2. Insert your Reflex System Disk into Drive B.

3. Type B:Install and press [Enter]  Don’t space after the colon.

This command executes the Install program on your Reflex disk. Reflex copies several important files from the DOS diskette onto your System Disk. A message appears when the process is complete.

4. Remove your Reflex System disk from Drive B.

Your Reflex System Disk is ready for use. You have made the disk “self-booting” which means that you do not have to load DOS first. You can start the computer with the Reflex System Disk in Drive A.

Repeat steps 2 through 4 for the Reflex Report & Utilities disk.
FOR A HARD DISK

Reflex will be installed in a sub-directory of your hard disk named \Reflex. This installation process creates the sub-directory and copies the necessary files from the diskettes to the hard disk.

NOTE

The Reflex System Disk and the Report & Utilities Disk will take about 300K of disk space each. The Help Disk will take about 200K.

1. Be sure that the hard disk is the default drive.
   Assuming the hard disk is Drive C (it generally is), the screen displays C>. If it doesn’t, type C: (or whatever letter designates your hard disk) and press Enter.

WARNING

The hard disk must be the current drive. If it is not, the installation will not be performed properly. Check to be sure the screen displays C> (or whichever letter designates your hard disk), not A>.

2. Place your Reflex System disk into Drive A.

3. Type A:HDNSTAL1 and press Enter
   Don’t space after the colon, and the final character is the number one (1). A message on the screen will tell you that the files were installed on the hard disk.

If your screen has the message, “Bad command or file name”, you may have the wrong diskette in Drive A or you did not include the “A:” when you typed in “A:HDNSTAL1”. Start again with step 2.

A new sub-directory named “Reflex” has been created on the hard disk and the files from your Reflex System disk have been copied to into the new sub-directory.
4. Remove your Reflex System disk from Drive A.

5. Place your Reflex Report & Utilities Disk in Drive A.

6. Type `A:HDNSTAL2` and press `Enter` Reflex copies the files on this disk to the same Reflex subdirectory.

7. Remove the Report & Utilities Disk from Drive A.

8. Place the Help Disk in Drive A.


Reflex has been successfully transferred to a new sub-directory named “Reflex” on your hard disk.

---

**STARTING REFLEX**

**TWO DISKETTE DRIVES**

1. Place your Reflex System disk in Drive A.

2. Turn on the power switch to your computer. The screen prompts: Enter new date:

3. Type in the date using the MM/DD/YY format. (e.g., 7/18/84)

4. Press `Enter` The screen prompts: Enter new time:

5. Enter the time using the HH:MM format. (e.g., 15:53)

6. Press `Enter` The screen shows the A> prompt.
7. Type **Reflex** and press \[\rightarrow\].
   Your computer will load Reflex and display the Reflex title screen.

8. Remove your Reflex System disk from Drive A, and replace it with your backup Help disk.
   This disk contains the Help files. Reflex will read from this disk whenever you press the Help key \[F1\].

9. Place a formatted diskette in Drive B to save your Reflex data files.

   You and Reflex are ready for action!

---

**The Reflex title screen.**
Press \[/\] to start working with Reflex.

---

**HARD DISK**

1. With the door to Drive A open, turn on the power switch to your computer.
   The screen prompts:
   Enter new date:

2. Type in the date using the MM/DD/YY format.
   (e.g., 1/16/84)
3. Press ↓ The screen prompts: Enter new time:

4. Enter the time using the HH:MM format. (e.g., 15:53)

5. Press ↓ The screen shows the C> prompt.

6. Type `CD \Reflux` and press ↓ Note the space after CD. This command takes you to the Reflex subdirectory.

7. Type `Reflux` and press ↓ Your computer will load Reflex and display the Reflex title screen.

You and Reflex are now ready for action!

---

**USING THE REPORT & UTILITIES DISKETTE**

The facilities on the Report & Utilities diskette may be used with the same procedure as running Reflex from the Reflex System Diskette.

If you have a hard disk, follow the procedures for starting Reflex, but type `Reflux2` rather than `Reflux` in step 7.

If you are using a floppy-based system, follow the procedures above, but place the Report & Utilities Disk in Drive A, rather than the Reflex System Disk, and type `Reflux2` rather than `Reflux` in step 7.
OPTIONAL HARDWARE SETUP

USING A HERCULES GRAPHICS CARD

Reflex will run with either an IBM Graphics card or a Hercules Graphics card (monochrome version).

To use Reflex with a Hercules graphics card, use the following procedure each time you start your system.

Prior to running Reflex enter the following command:

Set Reflex = HERC

Alternatively, you may run a “batch file” which is included with Reflex and will both enter the required command and then start Reflex. To use this, enter

Reflexh

in place of entering Reflex to start the program. This will enter the Hercules command and then start Reflex. This command should be given at the same time the Reflex command would have been given (see Starting Reflex, above). Similarly, you can enter Reflex2h for the Report & Utilities Disk.

If you are using a floppy-based system, and you would like to give the Hercules command and then start Reflex automatically when you start your system, rename the Reflexh.Bat file to Autoexec.Bat. If you are already using an Autoexec.Bat file, you may want to incorporate the “Set Reflex = HERC” command into your Autoexec file.

ACTIVATING THE PRINT-SCREEN (PrtSc) KEY

Since Reflex runs in graphics mode, rather than text mode, the PrtSc key is not automatically enabled for sending a copy of the screen to a printer. There is a program included on the DOS disk, though, which will enable the PrtSc key. To use this program copy it from the DOS disk to the Reflex disk and then run it prior to running Reflex.

Follow this procedure for a two diskette drive system:
1. Be sure your DOS diskette is in Drive A, and the computer is on.

   The screen displays A>
   If it doesn’t type A: and press

2. Type dir graphics and press ←

   This will check to see if the required program is on your DOS disk.

3. If you see a message “File not found”, then the program isn’t on your DOS disk. See your dealer to get a copy of it. If the file name is shown (Graphics.com), proceed.

4. Insert the Reflex System Disk in Drive B.

5. Type copy graphics.com b: and press ←

   This transfers the program to your Reflex disk.

6. Repeat steps 4 and 5 with your Report & Utilities disk.

Use this procedure with a hard-disk system:

1. Be sure that the hard disk is the default drive

   Assuming the hard disk is Drive C (it generally is), the screen displays C>. If it doesn’t, type C: and press

2. Insert your DOS diskette in Drive A.

3. Type dir A:graphics and press ←

   This will check to see if the required program is on your DOS disk.

4. If you see a message “File not found”, then the program isn’t on your DOS disk. See your dealer to get a copy of it. If the file name is shown (Graphics.com), proceed.

5. Enter cd \reflex and press ←

   This will change your current directory to the same one containing your Reflex program.

6. Type copy a:graphics.com and press ←

   This transfers the program to your hard disk.

You are now set up to use the graphics program. To actually make use of it, use the following procedure each time you start your system.
Prior to running Reflex enter the following command:

**Graphics**

If you have a hard disk, enter this command after you’ve changed the directory to the one containing Reflex (with the “cd” command.)

Alternatively, you may run a “batch file” which is included with Reflex and will both enter the required command and then start Reflex. To use this, enter

**Reflexg**

in place of entering **Reflex** to start the program. This will enter the graphics command and then start Reflex. This command should be given at the same time the **Reflex** command would have been given (see Starting Reflex, above).

If you are using a floppy-based system, and you would like to give the graphics command and then start Reflex automatically when you start your system, rename the Reflexg.Bat file to **Autoexec.Bat**. If you are already using an Autoexec.Bat file, you may want to incorporate the “Graphics” command into your Autoexec file.

**NOTES**

1. The graphics program which comes with DOS is designed to work with IBM or Epson dot-matrix printers with graphics capability and the IBM graphics card. It will not work with other printers or other graphics cards, including the Hercules card.

2. If the PrtSc key is pressed without a printer attached, your computer will appear to freeze. This is independent of whether the graphics program is used (or whether Reflex is used.)

**USING A SERIAL PRINTER**

If you plan to use a serial printer with Reflex, there is some setup necessary. In particular, the “baud rate” must be set so the computer can communicate properly with the printer. Please see Appendix D for details.
USING A MOUSE

If you are using Reflex with a mouse, it is generally necessary to run the mouse "driver" program prior to running Reflex. This program in effect "activates" the mouse. Refer to the documentation accompanying your mouse for instructions.
THREE

BASIC TUTORIAL
<table>
<thead>
<tr>
<th>PART 1</th>
<th>PART 1: SCREENHANDLING</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>PART 2</td>
<td>REFLEX CONCEPT: THE FORM VIEW</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>PART 2: DESIGNING A FORM</td>
<td>18</td>
</tr>
<tr>
<td>PART 3</td>
<td>PART 3: ENTERING INFORMATION IN THE FORM VIEW</td>
<td>22</td>
</tr>
<tr>
<td>PART 4</td>
<td>PART 4: SAVING A DATABASE</td>
<td>27</td>
</tr>
<tr>
<td>PART 5</td>
<td>REFLEX CONCEPT: THE LIST VIEW</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>PART 5: ENTERING INFORMATION IN THE LIST VIEW</td>
<td>31</td>
</tr>
<tr>
<td>PART 6</td>
<td>REFLEX CONCEPT: SORTING</td>
<td>36</td>
</tr>
<tr>
<td></td>
<td>PART 6: SORTING YOUR RECORDS</td>
<td>38</td>
</tr>
<tr>
<td>PART 7</td>
<td>REFLEX CONCEPT: SEARCHING</td>
<td>43</td>
</tr>
<tr>
<td></td>
<td>PART 7: SETTING SEARCH CONDITIONS: FINDING AND FILTERING</td>
<td>44</td>
</tr>
<tr>
<td>PART 8</td>
<td>PART 8: CHANGING THE LIST VIEW AND PRINTING</td>
<td>51</td>
</tr>
<tr>
<td>PART 9</td>
<td>PART 9: EDITING THE RECORDS</td>
<td>59</td>
</tr>
</tbody>
</table>
THREE

This chapter is designed to give you a good idea of how to use Reflex. You will find that Reflex is both easy to understand and easy to use. Reflex can be used quickly. You will be able to work productively with the program after the first three short parts.

The first three parts are fundamental. The first explains how to operate the program and the next two explain how to set up and enter information into a database—in this case, how to create a mailing list. The remaining basic parts give step-by-step instructions for doing different things with the mailing list you create; for example, how to sort your list, search for a specific record, and print out a copy. The Advanced Tutorial in Chapter Four shows how to use Reflex's powerful analysis capabilities. The nine parts cover these topics:

Part 1, Screenhandling
Introduces skills you will need to work with the Reflex Views and windows.

Part 2, Designing a Form
Starts from scratch with setting up the form.

Part 3, Entering Information in the Form View
Introduces the Form View, and explains how to enter information into the form you design.

Part 4, Saving a Database
Explains how to save your database in a file (on a data disk).

Part 5, Entering Information in the List View
Introduces the List View and explains how to enter information using this view.

Part 6, Sorting Your Records
Explains how to rearrange the order of your records.

Part 7, Setting Search Conditions: Finding and Filtering
Explains how Reflex finds a particular record or group of records from conditions you set and introduces the idea of filtering the records so that you can work with a smaller portion of them.

Part 8, Changing the List View and Printing
Explains how to rearrange the columns in the List View and how to print out the list of names and addresses.

Part 9, Editing
Explains the different ways to change the format of your records and how to change the data already entered in your records.
ABOUT THE TUTORIALS

These tutorials take the point of view that you are just beginning to use a computer. In the beginning, everything is explained thoroughly. In later parts, we assume that you don't need to have everything explained again. Nevertheless, we never abandon the step-by-step approach to doing specific tasks.

The clearly marked "Reflex Concepts" sections give you a quick overview of the program. You will find the tutorials useful even if you don't follow every lesson step by step. Each section begins with a description of what it contains, and each part stands alone, so you can learn what you need when you need it. Even if you are experienced, we recommend that you begin with Part 1 because most of the basic screenhandling skills are covered in that part.

WHAT TO LOOK FOR

The tutorials contain both general explanatory information and specific instructions for you to follow. The instructions assume you are using a two-diskette drive system. If you have a hard-disk system, note that you may use Drive C for Drive A.

The instructions are printed in the left-hand column. What you actually type in is printed in boldface. Explanations or comments for each step are in the right-hand column.

THIS IS NOT THE REFERENCE SECTION

Everything about Reflex is explained in the Reference sections. The tutorials simply present one approach to using the program that we tested and found effective for learning. If you want to set out on your own, feel free to do so, using the Reference sections as your guide.

A CONTINUING EXAMPLE

The tutorials use the example of the (fictional) Tyler Canoe Company. The company is fairly small, employing several craftspeople to build high-quality canoes and several sales representatives to sell them.

Assume you are the Sales Manager for Tyler. The tutorials present tasks for you to accomplish and problems for you to solve—all fairly straightforward and all common to business.
Using these examples, you will quickly learn the skills of using Reflex. The sample files included on the Reflex Help Disk contain the Tyler Canoe Company’s business records.

PART 1

SCREENHANDLING

In this part, you will learn how to work with Reflex. We have provided a sample database, which you will retrieve. Then, without paying much attention to the information, you will practice selecting an object, choosing a menu command, splitting the screen to display two views at once, and changing the active view.

WHAT YOU’LL DO

☐ Retrieve a sample database
☐ Look at the information in the Form View, one of the five Reflex Views
☐ Replace the Form View with the List View
☐ Split the screen to use two views at once
☐ Change the size of a view

RETRIEVE A FILE

Load Reflex into your computer. (See the “Starting Out” chapter for directions.) Reflex displays the Reflex title screen. Let’s look at what you’ll see on the screen.
The Reflex screen when it first appears. The instructions will disappear when you take any action.

The Reflex screen diagram shows:
- **Edit line**: Displays the contents of whatever is selected on your screen.
- **Main menu line**: Shows the main menu titles. Hidden beneath each title is a pop-down menu, which we will use in the next step.
- **Windows area**: Where the different Reflex Views are displayed.
- **Message line**: Displays useful information at different times, depending on what Reflex is doing.

Before you can retrieve a file, you have to insert the disk with the file on it into the diskette drive. Do so now.

1. Remove the Reflex System Disk from Drive A.
2. Insert the Help disk into Drive A and shut the door. You are now ready to retrieve a file.

**CHOOSING A MENU COMMAND**

In order to choose the Retrieve File menu command, you first pop down the menu under the Print/File title, then move the cursor to Retrieve File on that menu.
The Print/File menu provides the Retrieve command.

There are two ways to **choose** a menu command from the keyboard:

1. Press [/] to activate the menu line. Use the [→] or [←] keys to move the highlight to the Print/File title. When the menu pops down, use the [↓] or [↑] keys to move the highlight to the Retrieve File command. Press [←]. Or,
2. Press [/] and type PR—the P is the first letter of the Print/File menu title. The R is the first letter of the Retrieve File menu command. This method is quicker once you become more familiar with what is under each menu title.

If you have a mouse, you can choose the menu option by using the pointer. Put the tip of the pointer on the Print/File menu title. Press-and-hold the left button. (If you click the left button, the menu will pop down and then pop back up right away.) As long as you continue to hold down the left button, the menu will stay popped down. Move the pointer down to the Retrieve File command and release the button.

Using the mouse this way can be a little tricky at first. Once you have done it a few times, you will get used to it. Remember that the tip of the pointer is what you need to position.

1. Choose Retrieve File from the Print/File menu. Type: /PR The introduction screen is replaced by the Retrieve File tool.
Tools allow you to specify what you want done. The Retrieve File tool is similar to other tools you will see in Reflex. In this case, you will specify which file to retrieve.

The Name cell is highlighted, ready for you to enter the file name to retrieve. The Directory cell tells Reflex where to look for the file. In this case, your file is in Drive A, so if the cell shows something else (e.g., C:\, if you are using a hard disk) you need to change it:

2. Press \(\uparrow\) once. The selection moves to the directory cell.

3. Type: A: and press \(\leftarrow\). Reflex automatically enters a backslash.

SELECTING FROM A CHOICE LIST

Now we’ll introduce a very important feature of Reflex—Choices. At any time, you can press [F10] and Reflex will display a list of entries appropriate for that particular place. Rather than typing one in, you can simply select the one you want.

4. Press Choices [F10]. Reflex displays a choice list of files in Drive A.

The files choice list gives you the names of all the Reflex files on your data disk. If you use the keyboard, there are two ways to select from a choice list.

- Use the \(\downarrow\) and \(\uparrow\) keys to highlight the name you want, and press \(\leftarrow\). Or,
- Type the first letter of the name you want. (If more than one name begins with the same letter, Reflex will highlight the first one. Type the same letter again and the next name will be highlighted) When the name you want is highlighted, press \(\leftarrow\).

[m] If you have a mouse, put the pointer on the name you want and click the left button.

NOTE Often a choice list contains more items than can be displayed on the screen at once. The list automatically scrolls as you move the cursor with the cursor movement keys.

The file you want is named “Salesrep”.
5. Use the \( \downarrow \) key to highlight Sales rep, and press \( \leftarrow \).

**PROCEEDING FROM A TOOL**

After you fill out a tool, you **Proceed** (or **Cancel** if you change your mind), and Reflex carries out the command you have specified.

Once you have moved the cursor to Proceed, you can use the \( \leftarrow \) and \( \rightarrow \) keys to move between Proceed and Cancel.

6. Now that Proceed is highlighted, press \( \leftarrow \). The tool disappears, and Reflex retrieves the file you have specified.

The file you have retrieved is the Tyler Canoe Company's monthly sales records. You will first see this file in the Form View. Each screenful of information in the Form View is the record of sales for one product sold by a particular sales rep for a given month. We will explain the Form View fully in the next section. Notice particularly the added main menu title: FORM. This menu presents commands for use with this view. Each of Reflex's Views has added menu commands available when the view is active.
If You Don't See The Form View
If someone else has accidentally saved this file with another view displayed, you need to make a quick adjustment:

1. If the Form View is not on the screen, open it by choosing Form from the Views menu (/VF), then press $\rightarrow$. If two or three Views remain on the screen, go to the next step.

2. If the Form View is on the screen, you need to close the other View(s). Press $\rightarrow F6$ until the List or Graph view label is highlighted, then choose Close from the Views menu (/VC).

SELECT AN OBJECT ON THE SCREEN

To select an object on the screen means to move the cursor to it so that it is highlighted. You select something to tell Reflex what it should pay attention to. Then you either enter information at that location or command Reflex to carry out an operation on that object. Now try selecting objects in the Form View.

Use the cursor movement keys to move the selection from place to place. Practice until you get the hang of it.

The fields in the Form View have a specific order. The $\rightarrow$ and $\uparrow$ keys take you to the next field (to the right and down). The $\leftarrow$ and $\downarrow$ keys take you to the previous field (left and up). $\rightarrow S$ and $\rightarrow \downarrow S$ also take you to the next and previous fields. $\rightarrow Home$ and $\rightarrow End$ select the first and last fields. $\rightarrow Pg Up$ and $\rightarrow Pg Dn$ don't work in this case, because the entire form fits on the screen. Otherwise, they would move other fields into view.

If you have a mouse, put the pointer on one of the field names on the screen and click the left button.

That's all there is to selecting. The cursor movement keys will work a little differently in other places, depending on which view is displayed. In general, they move in the direction of the arrow. In Form View, the cursor skips from field to field; you can't select any other part of the screen. We'll come back to the Form View in the next tutorial. Now let's open the List View.
REPLACE ONE VIEW WITH ANOTHER

Since the Form View is active, when you open a second view, Reflex will need an extra instruction. Do you want to replace the first view, or do you want to split the screen? In this demonstration, we will replace the Form View with the List View.

1. Choose List from the Views menu. Type: /VL
   The screen remains the same, except that the message line at the bottom asks you to give a further command.

Which Way?   Replace       Vertical       Horizontal

Right now, we want to replace the Form View with the List View. Replace is automatically selected, so:

2. Press ←. The List View replaces the Form View.

If you are using a mouse, put the pointer on the word Replace and click the left button. (If you click the left button with the pointer inside the windows area, the screen displays two views at once. See “Split the Screen,” on the next page.)
The List View, the second of Reflex's views, displays the same information as Form View, but in a different way. Each individual record is shown in a row going across the screen. Each field name appears at the top of each column. We will talk more about the List View later on. For now, practice moving the cursor around to different places on this grid.

**SCROLL THE VIEW**

As you move the cursor to the edge of the screen, the display scrolls to reveal rows and columns of information that were not visible before. In Reflex, a view can be larger than the area available on the screen. You scroll the view to see the parts of the view that extend beyond the screen, either horizontally or vertically.

When you use the cursor movement keys to scroll, you select successive cells. If you hold a key down rather than giving it a single tap, you will move very quickly in the direction of the arrow.

After you have used the arrow keys, try the \[Home\], \[End\], \[Pg Up\], and \[Pg Dn\] keys to see how they work.

- Home takes you to the first cell in the first record.
- End takes you to the first cell in the last record.
- Page Up moves the screen up the List View, one screen at a time.
- Page Down moves the screen down the List View, one screen at a time.

Using the \[Ctrl\] key together with the \[→\] and \[←\] keys gives you “Page Right” and “Page Left.” These move the screen across the List View, one screen at a time. When you use \[Ctrl\] with another key, press \[Ctrl\] first. While holding it down, tap the other key.

**SPLIT THE SCREEN**

You can display more than one view at a time by splitting the screen. First you open a second view, then tell Reflex to split the screen, either vertically or horizontally. You have already replaced the Form View with the List View. Now open the Form View again and split the screen.
The Form View and List View share the screen.

1. Choose Form from the Views menu. /VF

The message line asks what to do next: Replace, Vertical, or Horizontal.

2. Press V, for Vertical. (You can also move the cursor to Vertical and press [Left].)

The screen splits vertically in the middle, and Form View is displayed on the right side of the screen.

[m] If you have a mouse, you can use the pointer to determine where the split should occur. After you choose Form from the Views menu, put the pointer near the top edge of the windows area (be careful to stay within the windows area). Click the left button, and the screen will split vertically. To make a horizontal split, put the pointer near the left side of the windows area and click the left button. The screen will split horizontally.

The Form View and List View share the screen.

<table>
<thead>
<tr>
<th>Date</th>
<th>Rep</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan-85</td>
<td>Alan</td>
<td>Paddles</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Alan</td>
<td>Silent</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Alan</td>
<td>Sport</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Alan</td>
<td>Swiftwater</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Bob</td>
<td>Paddles</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Bob</td>
<td>Silent</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Bob</td>
<td>Sport</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Bob</td>
<td>Swiftwater</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Cathy</td>
<td>Paddles</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Cathy</td>
<td>Silent</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Cathy</td>
<td>Sport</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Cathy</td>
<td>Swiftwater</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Dave</td>
<td>Paddles</td>
</tr>
</tbody>
</table>

CHANGE THE ACTIVE VIEW

Since you have just opened it, the Form View is active. The active view is indicated by a highlighted view label. Notice also the added main menu title for the active view. Only one view can be active at any time. To work with the other view, you first have to make it active.

To change the active view, press the View key [F6] or choose Next View from the Views menu (/VN).
[m] If you are using a mouse, simply put the pointer in the view you want to be active and click the left button.

Practice changing the active view several times, ending with List as the active view.

CHANGE THE SIZE OF A VIEW

There are two ways to change the size of a view: You can expand and shrink the active view. Or you can resize the windows to change the way the views are displayed. We'll take them one at a time.

EXPANDING AND SHRINKING THE ACTIVE VIEW

To expand the active view, press the Expand key ~ F6. The active view will fill the whole screen.

List View takes over the whole screen.

2. Press ~ F6 again. 
The screen returns to the way it was before you expanded the active view.

Practice expanding and shrinking the List View a few times. Remember, you can only change the size of the active view.

RESIZING THE WINDOWS

Occasionally, you may want to change the size of the windows so you can see more or less of a particular view. To resize, follow these steps:

1. First make the left-hand view active. 
If your screen were split horizontally, you would start by making the top view active.

2. Choose Resize from the Views menu. /VR 
The lines around the view become dotted "shadow" lines.

3. Use the cursor movement keys or [ ] to move the shadow line to a new location. 
The shadow lines show where the new boundaries will be.
The "shadow line" shows where the new dividing line will be.

![Screen layout with a table and a menu]

**4. Press **←**. The screen adjusts.**

**CHANGE YOUR MIND? THE ESCAPE KEY**

If you start something in Reflex and change your mind, the **Esc** key will restore the situation to what it was before, as long as you press **Esc** before you press **←**. For example, in resizing the screen, the change is not final until you press **←**. Press **Esc** instead and the Resize command is cancelled. The screen returns to the previous display.

Similarly, if you press **/** to activate the menu line, but you decide not to choose a menu command, press **Esc**. The menus are put away, and control returns to the active View.

The general rule is *any sequence which ends with **←** can be interrupted by pressing **Esc**.*

**Esc** cancels a Reflex tool or choice list. If you are editing, **Esc** cancels the Edit mode. If you are typing over an entry, **Esc** returns the entry to what it was before you started to change it.
NOW YOU’RE READY TO GO ON

This part has concentrated on the basic skills for handling the screen. In the following parts, each of these directions will be repeated in the context of real work on Reflex.

When you go on, you will be starting from scratch, setting up a form and creating a database.

At this point, either you can go directly to Part 2, or you can exit the program. In either case, you don’t need to save this database.

If you are going straight on to Part 2:

1. Choose Clear Database from the Records menu. /RC

   The message line asks you to confirm that you really want to clear the database.

   WARNING
   Do not choose Erase File from the Print/File menu. You want to erase the database from the memory of your computer, not from the file on your disk, which is what Erase File would do.

2. Type Y to confirm.

3. Choose Form from the Views menu. /VF

   The Form Design screen appears. Go on to Part 2.

QUITTING REFLEX

If you wish to pause before going on, you should quit the program. Part 2 begins again from the title screen.

1. Choose Quit from the Views menu. /VQ

   The message line asks you to confirm that you really want to quit. This gives you a chance to be sure you have saved your data.

2. Type Y to confirm.

   The whole screen clears, and the A> prompt appears. You have left Reflex and returned to the operating system.
THE FORM VIEW

The Form View is one of the five Reflex Views. (The others are List View, Graph View, Crosstab View, and Report View.) The Form View has two parts. First, you'll use the Form Design screen to create the form for your records. You'll then use the Form View to enter information and to see complete records, one at a time.

Form View is where you begin. Setting up the form is the first step in using Reflex.

WHAT IS A FORM?

A Reflex form is like any other form—a tax form, an insurance form, a personnel form, and so forth. Like these forms, a Reflex form is simply a collection of blanks where you enter information. Each space has a name that tells you what information to enter.

In database programs, including Reflex, the blanks are called fields, and the names of the fields are called field names. You put together a collection of field names and fields to make a form.

ANY FORM YOU WANT

A conventional form, printed on paper, isn’t easy to change. But with Reflex, you design the form yourself and you make any form you want, with any kind and any number of fields you need (up to 128). You can arrange the fields any way you like. Later, you can alter your form, adding, deleting, renaming, and rearranging the fields to match your changing needs.
Your Reflex Form can look exactly like the paper forms you have been using.

The space available for your form is very large. It extends beyond what you can see on the screen. In fact, there is enough room to make a huge form with over 45 pages worth of field names and fields. You move around the form by scrolling.
A RECORD IS A FILLED-OUT FORM

Once you have designed your form, you then fill it out, putting information next to the appropriate field name. A filled-out form constitutes a record. After you've filled out one form, Reflex displays another blank one. Each time you fill out the form, you create another record. The database consists of all the records.

Reflex keeps track of all the records and stores them so you can view and analyze them. Using the Form View, you can scan through all the records in sequence.

PART 2

DESIGNING A FORM

In this part, you will learn how to design the form for the records you will be keeping.

WHAT YOU'LL DO

- Select different locations on the Form Design screen
- Type in the field names for your records

USE FORM DESIGN TO ENTER FIELD NAMES

If you are coming straight from Part 1, your screen already displays the Form Design screen. Skip the next paragraph and go on.

If you are beginning this part from scratch, start Reflex. When the title screen is displayed, choose Form from the Views menu (/VF). The Form Design screen will appear.
The Form Design screen. The cursor sits in the upper left corner of the screen. Note that Form has been added to the menu line.

The Form Design screen is like a blank piece of paper on which you will type the field names for your mailing list. Use the cursor to position the field names where you want them.

As you move the cursor around the screen, you’ll notice the numbers at the lower left corner changing. These are the position numbers, which act as coordinates to locate your field names. The Form View has room for 500 characters across and 500 lines down. The cursor always starts at the 001,001 position, the first line and the first column. You can always return the cursor to this position by pressing the [Home] key.

**ENTERING FIELD NAMES**

The general rule for entering field names is: Position the cursor where you want the field name and type it in. Position the cursor where you want the field name to start, type it in, and end with [←], [↓], or cursor movement key (but not a space—Reflex accepts spaces as part of a field name). When you position the cursor again, the field is added to the database. You can use the cursor movement keys, the [←] key, or the mouse pointer to position the cursor. Now use the following procedure to set up your form:

The field names you want for your mailing list are Name, Address, City, State, and Zip Code.
1. Press the **Home** key. This returns the cursor to the upper left corner.

2. Press **↓** twice and type in: **Name**  The letters appear just where the cursor sits on the screen. If you type an incorrect character, press backspace as many times as you need to, then retype.

**NOTE** Don't type in a colon (:). Reflex will add colons after each field name when you leave Form Design.

3. Press **←** twice. This enters the first field name and skips a line. Skipping lines makes the form easy to read. The cursor sits on the left side of the screen, ready for the next field name.

4. Type in: **Address**
   Press **←** twice. This enters the second field name, skips a line, and positions the cursor for the next field name.

5. Type in: **City**
   Press **←** twice. You get the idea.

Watch out! In the next step we do something a little bit different. Instead of using the **←** key, we use the tab key **→** to position the cursor for the next field name.

6. Type in: **State**
   Press **→** twice. Using the **→** key positions the cursor to the right of the previous field name. You could also use the **→** key to reach the same position.

7. Type in: **Zip Code**
   Press **←** once. You only need to press **←** once, as you have finished typing in all the field names you will be using.
You have finished entering field names. The field names establish fields for your information, which will appear in Form View.

Don't worry about any spelling errors or having the field names in exactly the right position. At this point, you don't need to make your form perfect. However, if you wish to make corrections before going on, select the field name, retype it, and press [→]. Later, in Part 9, you will learn more about how to edit field names.

To finish setting up your form, there's one more thing to do.

THE LAST STEP
The last step is most important: Exit Form Design.

As long as you are in Form Design, Reflex thinks you are entering field names (or titles). Anything you type in will be interpreted as part of the design. You enter information in the Form View, not in the Form Design screen.

To leave Form Design, you choose Exit Design from the Form menu, which has been added to the far right of main menu line. /FE

Chose Exit Design from the Form menu. /FE Reflex will display the Form View.
The Form ready for data entry.

Your field names are placed exactly where you typed them, each followed by a colon. You are ready to fill in your form with information.

Congratulations! You have set up a form for all the records in your database. Later on you will move the field names and add others to this form. You can be sure that whatever changes you want to make to your basic form will be quick and easy.

Go on to the next part.

**RECAP**

Setting up the form for your records is the first step in creating a database. To do so:

1. Use the Form Design screen.
2. Enter your field names where you want them.
3. Most important: Exit Form Design.

**PART 3**

**ENTERING INFORMATION IN THE FORM VIEW**

You are about to enter part of the Tyler Canoe Company's customer list into your first Reflex database.

In this part, you will enter information into the form you have
designed. This will create records, one per form. The collection of records is your database.

**WHAT YOU’LL DO**

- Type in the first three records on the Tyler Canoe Company customer list
- Use the Record keys, [F7] and [F8], to scan the records

**ENTER INFORMATION**

In the Form View you enter information into each **field**. The field is the area to the right of the field name.

The general rule for entering information is very similar to the rule for entering field names: *Select the field, type in the information, and select the next field.*

**CREATING A RECORD**

Now it’s time to begin creating records. We’ll enter the first three names on the Tyler Canoe Company Mailing List.

Be sure your cursor sits next to the Name field name. If it isn’t there, press **Home**.

1. Type in: **Adirondacks Expeditions**  
   Note that the name appears in the edit line as well as in the field.

2. Press the [←] key once.  
   The cursor sits next to the next field name, ready for the address.

3. Continue with the rest of the information:  
   Address: **111 A Street**  
   City: **Albany**  
   State: **NY** Zip Code: **90001**  
   Be sure to press [←] after each entry and when you finish.

When you finish typing in all the information, your screen should look like the illustration on the next page.
Congratulations again! You have successfully entered one complete record into your database. It may not seem like a whole lot, but it's a good beginning. If you notice any typing errors, select the field with the error and retype the entry.

**ADDING RECORDS**

The moment you entered information in the first field of your first record, Reflex prepared a new blank record (an empty form). There is always a blank record waiting to be filled out. It is always at the end of the database, after the last record.

Since the Adirondacks Expeditions record is now the only record in your database, it is also the last record. The blank record is the next record. Press the Next Record key, \[F8\]. The first record disappears, replaced by a blank form, ready for you to fill out.

Where did that first record go? Your first record is tucked away in your database. It exists in the computer's memory. You can see it again by pressing the Previous Record key, \[F7\].

You have created the database, but it has only one record in it. Type in the next two records, and then we'll move on to the List View.
THREE

BASIC TUTORIAL

1. Press the Next Record key \[ F8 \] to bring up a blank record. If the cursor is not in the first field, press the \[ Home \] key.

2. Type in the second record:
   Name: Baltic Boating
   Address: 222 B Street
   City: Boston
   State: MA Zip Code: 90002

3. Bring up another blank record and type in the third record:
   Name: Crenshaw's Canoeing
   Address: 333 C Street
   City: Carmel
   State: CA Zip Code: 90003

You now have a database with three records in it. You can page through your records with the \[ F7 \] and \[ F8 \] keys; we call this **scanning** the database. You can also press the same keys with \[ ~ \] to go instantly to the first record or the last record.

4. Press the First Record key—\[ ~ F7 \].

5. Press the Last Record key—\[ ~ F8 \].

The “last” record is the last record with information in it. To bring up a blank record, you go to the last record and then press \[ F8 \] for the next record.

Go on to the next tutorial, which explains how to save your database. Don’t turn off your computer until you have saved your database on a data disk.

**NOTES ON ENTERING DATA**

**LONG ENTRIES**
You can enter up to 254 characters in any field. If another field name is in the way as you type, only the information that fits in the blank field is displayed in that field. However, the
complete information appears in the edit line at the top of the screen.

To see a long entry in the edit line, press the Edit key \( \text{F2} \) and then \( \text{[Home]} \). The cursor will sit at the first character. Now use the \( \text{[S]} \) key to scroll across the edit line to read the entire entry.

**NOTES ON FIELD TYPES**

There are three *field types*: text, date, and numeric. *Reflex sets these types automatically from the first entry you make in any field*. In this tutorial, you entered text in all the fields except the last one, which is a numeric field. From now on, Reflex will allow you to enter only these types of information in these fields.

**Text Fields**

You can enter anything in a text field, and Reflex will treat it as text. For example, a number will be accepted in a text field, but Reflex will not use it for calculations. Text fields show an apostrophe at the beginning of the entry in the edit line.

**Date Fields**

To establish a date field, your first entry must be in the form \( \text{MM/DD/YY} \) (e.g., 1/16/85, 11/4/86). This is the *date entry format*, and Reflex will accept only this format for a date field. You can, however, *display* dates in several ways. Use the Field & Sort Settings tool from the Records Menu to set the display format.

**Numeric Fields**

When you enter a number, Reflex makes that field a numeric field, and it will then accept only numbers. Always enter numbers without dollar signs or commas. You can instruct Reflex to *display* numbers in several ways in the Field & Sort Settings tool.

**CHANGING THE FIELD TYPE**

Occasionally you will need to change the field type. For example, a numeric field will not display zeros at the beginning of an entry. Consequently, in a real mailing list, you would want to change the Zip Code field to text. Also, if you acciden-
tally type in a wrong entry the first time you use a field, you will have to change the field type. To change a field type, see “Field & Sort Settings” in Reference A for exact instructions.

RECAP

To enter information in the Form View:
1. Select the proper field.
2. Type the appropriate information.
3. Select another field or press [→].

To scan the database, use the [F7], [F8], [↑] F7, and [↓] F8 keys.

A blank record always follows the last record.

PART 4

SAVING A DATABASE

In this part, you learn how to save your database on a data disk.

When you create a database, the information you type in exists in electronic form in your computer's memory. However, it stays there only while the computer is running and only as long as Reflex is loaded in the memory as well. Saving the database on a disk is the vital step to make a permanent database.

Normally, your data is secure in your computer's memory while you are working. But power failures do occur, and mistakes do happen. It is a good idea to save your work about every 15 minutes. This limits any possible loss of data.

WHAT YOU'LL DO

☐ Save your mailing list database in a disk file

SAVE THE DATABASE IN A DISK FILE

In order to save your database, you need to insert a formatted disk in Drive A. You can use the Help disk you used in Part 1;
there is room on it to store this database. Hard disk users should insert a formatted disk in Drive A or use the hard disk.

We call the disk you use for storing your database a *data disk*, to distinguish it from your *system disk*.

1. Choose Save File from the Print/File menu. *IPS*

   The Save File tool appears. It asks for the name of the file you want to use for this database.

   ![The Save File tool](image)

   The cell where you will type in the file name is already highlighted, ready to accept the name you give your database.

   **NOTE**

   In Tutorial 1, you set the Directory instruction in the Retrieve File tool to tell Reflex where to find a file. Now you may need to change the Directory to instruct Reflex where to save the file.

2. Press ↑ once.

   The selection moves to the directory cell.

3. Type A: and press ←.

   Reflex automatically enters a backslash, and the Name cell is selected.
4. Type: Maillist

Don’t leave a space between Mail and list. If there is a file name already in the cell it will disappear as you begin typing.

5. Press ⌘ to select

The Save File tool disappears. Proceed and press ⌘ again. Type Y to confirm.

The red light on Drive A will go on. Reflex is making a copy of your database on the data disk.

You have now completed all the steps to create and save a database with Reflex. The form you set up, and the information you typed into it, is now preserved on a data disk, ready to be retrieved at any time.

NOTES ON SAVING

There are certain restrictions on file names: They can’t be any longer than eight characters. The characters must be letters or numbers. Spaces, punctuation marks, and special characters can’t be used. These restrictions are imposed by the operating system of your computer.

When you save a file using the same file name as a file already on your data disk, Reflex asks you to confirm. Saving a file with the same name erases the old file and replaces it with the new file. Of course, if you have updated the file, you will want to do this. If you don’t want to erase the old file, choose a different name for your new file.

RECAP

1. Save a database in a disk file by choosing Save File from the Print/File menu. IPS

2. Enter the directory instruction if necessary, and enter a valid file name in the Name cell.

3. Proceed. Reflex saves the current database on your data disk.

You can save a database in a disk file at any time.
THE LIST VIEW

All Reflex Views show you the same information. But each View lets you see, manipulate, and understand the information in a different way. The List View lets you see all your records arranged in rows. Because you can display many records simultaneously, you can examine a lot of information quickly.

THE POWER OF FLEXIBLE LISTS

Reflex allows you to create lists that can reveal facts and relationships in your data that you might otherwise struggle to discover. You can instantly sort your records—that is, arrange them in order—in different ways. Arranged by date of purchase, a list lets you see who your most current customers are; arranged by sales rep, the list lets you assess each salesperson’s performance.

By establishing search conditions, you can find an individual record or filter the database to see a list of only those records that meet your criteria—for instance, all sales larger than $1500 or all customers who live in Boston and made a purchase in 1984. In other words, you can define the kind of records you want to see, and Reflex will find them.

You can reposition columns in the List View for quick side-by-side comparison of significant information. In fact, you can display only the columns of data that interest you. In this way, one list is many lists. And since you can enter data into the List View it can even help you enter data more quickly.

The next four parts cover the various aspects of working with the List View. In Part 5, you learn how to enter records in the List View. Sorting and searching are explained in Parts 6 and 7, and the “Reflex Concepts” sections that precede them. In Part 8, you rearrange columns and then print the list.
PART 5

ENTERING INFORMATION IN THE LIST VIEW

In this part, you will continue entering customer information into your database, this time using the List View.

WHAT YOU’LL DO

☐ Enter information in the List View
☐ Change the column width
☐ Split the screen to display two views at once

ENTER INFORMATION IN THE LIST VIEW

You have already used the Form View to enter information into your database. Now you will use the List View to do the same thing. If you are coming directly from Part 4, the Form View is already on your screen. Otherwise, retrieve the maillist database you saved when you stopped work and display the Form View.

OPENING THE LIST VIEW

Your first step now is to replace the Form View with the List View.

1. Choose List from the Views menu. /VL

   Reflex displays the screen handling choices: Replace, Vertical, Horizontal.

2. Press [ホールド] to replace the Form View.

   The List View appears, showing the current record.

3. Press [Home].

   Now you see all three records.
The List View displays the entire set of records you have entered in the Form View.

As you can see, the database is displayed in rows and columns. Each record is a row, and each field is a column. The field names have become column headings.

In the Form View, whatever record is displayed is the current record, the one Reflex is paying attention to. In the List View, the current record is indicated by an arrowhead to the left of the left-most column.

You can select any cell in the List View by positioning the cursor. The cell that is highlighted is the selected cell, and the cell contents are displayed in the edit line.

There is always a blank column on the right side of the List. It is used to change the order of the columns, and is described in Part 8.

Before you enter more records into the List View, we'll change the column width so you can see all of that first name.

### CHANGE THE COLUMN WIDTH

As you can see, Adirondacks Expeditions doesn't fit into the present Name column (although the complete name appears in the edit line). Any time Reflex displays information in a table format (such as the List View), you can change the width of the columns to suit your needs.

To change the column width, follow these steps:

<table>
<thead>
<tr>
<th>Name</th>
<th>Address</th>
<th>City</th>
<th>State</th>
<th>Zip Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adirondack</td>
<td>111 A Str.</td>
<td>Albany</td>
<td>NY</td>
<td>98801</td>
</tr>
<tr>
<td>Baltic Boa</td>
<td>222 B Str.</td>
<td>Boston</td>
<td>MA</td>
<td>98802</td>
</tr>
<tr>
<td>Crenshaw's</td>
<td>333 C Str.</td>
<td>Carmel</td>
<td>CA</td>
<td>98883</td>
</tr>
</tbody>
</table>

Fields as cells
1. Select the Adirondacks Expeditions cell.

2. Choose Set Column Width from the Edit menu. /ES
   The message line tells you to use the cursor movement keys to set the column boundary.

3. Use the [←] and the [→] keys to change the column width.
   The column boundary moves to the new location.

4. Press [←].
   The column adjusts.

[m] If you have a mouse, you can change the column width with the pointer. Without choosing the Set Column Width command, put the tip of the mouse pointer on the right-hand dividing line of the column you want to change. Press-and-hold the left button. Move the pointer and the shadow line to the new location. When it is where you want it, release the button.

**ENTER A RECORD IN THE LIST**

The general rule for entering data in the List View is the same as the general rule in the Form View: Select a cell, type the information, and select another cell. Selecting a new cell enters the information into the record and prepares the new location to receive information.

To see how this works, we'll enter the last two names on your customer list. The first field we want is in the blank record at the end of the database.

1. Use the cursor keys to select the Name cell in the empty record (the last line of the List).
   The current record indicator will move to this record.

2. Type in:
   **Denny's Deepsea**

3. Press [→] once to select the Address cell.
   A new blank record appears below the current record.
4. Continue with the rest of the record:
Address:  
City:  
State:  
Zip Code:  
444 D Street  Dallas  TX  90004

Remember to press ← after your last entry.

You have now entered a fourth record into your database. Before entering the fifth record, split the screen.

**SPLIT THE SCREEN**

Splitting the screen allows you to see two views simultaneously, so you can look at your information from two different perspectives at once. In this case, we'll display both the Form View and the List View.

Choose Form from the Views menu, (/VF), and type V to split the screen vertically.

The record you entered in the List View is now displayed in the Form View as well. Because it has just been opened, the Form View is active.
Scan through the records in the Form View, using the Previous Record [F7] and Next Record [F8] keys. Note that as the record in the Form View changes, the current record indicator in the List View changes.

CHANGING THE ACTIVE VIEW
You are going to enter one more record in the List View. To do that, you must first make it the active view.

Press the View key [F6]. This makes the List View active.

[m] If you have a mouse, move the pointer to anywhere in the List View and click the left button.

Because the screen is split down the middle, some of the columns in the List View are not visible. They will scroll into view as you move across the row with the cursor.

ENTERING A RECORD ON THE SPLIT SCREEN
As you enter the last record in the List View, watch what happens in the Form View.

1. Select the Name cell in the empty record. The empty record is at the end of the List. Notice that the Form View also displays the empty record.

2. Type in: Early Bird Fishing and press →. The name appears in the Form View as well. Another blank record is created.

3. Continue with the rest of this record:
Address: City: State: Zip Code:
RFD Rt. 2 Englebert MN 90005

Press ← after your last entry.

Now you have not only set up a form and entered records, you have also seen how Reflex displays information in two ways. The same information entered in the List View is displayed in the Form View, and vice versa.

The following tutorials use sample databases already prepared, so you won't have to enter lots of practice information.
RECAP

To enter information in the List View:
1. Select the proper cell.
2. Type the appropriate information.
3. Select another cell, or press ←.

REFLEX CONCEPT

SORTING

Each Reflex View lets you see your information in a specific way. Reflex also provides tools to manipulate the information itself. Sorting is what you do to arrange your records in a particular order.

Sorting arranges the records in the order you determine.

Sorting uses alphabetical, chronological, and numerical order to put your records in the order you determine. When you sort the records, you establish the order of the whole database. You can change the sort order at any time, no matter which view is active. In other words, sorting affects the database itself, not individual views.
SORT FIELDS

You can use any field in your records as the primary sort field. This means that Reflex orders the records based on the information in that field. For example, if you have a Date field, you can order your records by date, making the first record the one with the earliest date and the last record the one with the latest date. The records will be in chronological order.

If two records have the same date, you need to specify a secondary sort field. Reflex will then look at the secondary sort field to determine the order of the records on that date. For instance, if your secondary sort field is Name, Reflex will arrange all the records for the same date in alphabetical order by Name. Reflex can use up to five sort fields, so your records will be arranged exactly as you require.

ASCENDING AND DESCENDING ORDER

No matter how many different sort fields you use, you can make each one either ascending or descending. Alphabetical order is ascending from the first letter, A, to the last letter, Z. If you want a series of words sorted in descending order, it would be from Z to A.

The same principle applies to date and numeric fields. Dates are ascending when they go from earliest date to latest date and descending when they go from latest date to earliest date. Numbers are ascending when they go up from smallest number to largest number and descending when they go from largest number to smallest number.

CHANGING THE SORT ORDER

You can sort your database one way for one purpose and then change the sort order for a different purpose. For example, you can sort your mailing list by name to be able to find customers quickly. Then, you can sort the same list by zip code for efficient printing of mailing labels.
SORTING YOUR RECORDS

In this part, you will learn a basic technique for handling the records in your database: how to establish and change the sort order.

We have provided a sample database to save you the task of entering all the records. It is the Tyler Canoe Company's customer list, and it can be found on the Help disk included with the program. The file name is Custlist.

WHAT YOU’LL DO

☐ Retrieve the Tyler Canoe Company customer list from the Help disk and look through the records by scrolling the List View.
☐ Sort the records in different ways

RETRIEVE THE SAMPLE FILE

After you have started Reflex and inserted the Help disk into Drive A, you are ready to retrieve the prepared customer list. As you know from Part 1, you choose Retrieve File from the Print/File menu: /PR then press choices [F10] for a list of files to choose from.

Retrieve Custlist If you need more complete directions, refer to Part 1.

NOTE When you retrieve a database, it is displayed the same way you saved it. You should see the Custlist database with the first record showing in Form View. If it has been changed, press the First Record key [F7] to make the first record current.

LOOKING AT THE RECORDS
Replace the Form View with the List View:

Choose List from the Views menu and select Replace.
/VL then R
The Tyler Canoe Company

customer list.

<table>
<thead>
<tr>
<th>Date</th>
<th>Rep</th>
<th>Name</th>
<th>Address</th>
<th>City</th>
<th>St</th>
</tr>
</thead>
<tbody>
<tr>
<td>6-Apr-85</td>
<td>Dave</td>
<td>Serenity Campsites</td>
<td>95 Commerce Blvd</td>
<td>Memphis</td>
<td>TN</td>
</tr>
<tr>
<td>23-Apr-85</td>
<td>Alan</td>
<td>Lake Merrit Rowing C</td>
<td>326 Harrison St.</td>
<td>Oakland</td>
<td>CA</td>
</tr>
<tr>
<td>23-Apr-85</td>
<td>Alan</td>
<td>Lakeside Boat Rentals</td>
<td>2567 Lakeside Ro</td>
<td>Portland</td>
<td>OR</td>
</tr>
<tr>
<td>3-Jun-85</td>
<td>Bob</td>
<td>Franklin Hughes, Expl Hightop Mountain</td>
<td>Charles Co</td>
<td>CA</td>
<td></td>
</tr>
<tr>
<td>16-Jan-85</td>
<td>Dave</td>
<td>Hiawatha Harry</td>
<td>8879 Downtown St.</td>
<td>Cambridge</td>
<td>MA</td>
</tr>
<tr>
<td>5-Mar-85</td>
<td>Dave</td>
<td>Whitewater Adventures</td>
<td>1423 Center Ave.</td>
<td>Hodgessville</td>
<td>CA</td>
</tr>
<tr>
<td>18-Mar-85</td>
<td>Bob</td>
<td>Midwest Boat Supply</td>
<td>1422 Lincoln Dr.</td>
<td>Chicago</td>
<td>IL</td>
</tr>
<tr>
<td>22-Feb-85</td>
<td>Alan</td>
<td>Morton's Outdoor</td>
<td>16243 Lakeland D</td>
<td>Lakeland</td>
<td>FL</td>
</tr>
<tr>
<td>21-May-85</td>
<td>Dave</td>
<td>Questors, Inc.</td>
<td>1528 Broadway</td>
<td>Boston</td>
<td>MA</td>
</tr>
<tr>
<td>15-Mar-85</td>
<td>Alan</td>
<td>Giant Sporting Goods</td>
<td>1533 24 St</td>
<td>New York</td>
<td>NY</td>
</tr>
<tr>
<td>9-Jun-85</td>
<td>Dave</td>
<td>Rapid Rivers, Inc.</td>
<td>22 Forest Street</td>
<td>Anchorage</td>
<td>AL</td>
</tr>
<tr>
<td>7-Jun-85</td>
<td>Bob</td>
<td>Wind 'n Water</td>
<td>832 Horseshoe Co.</td>
<td>San Franci</td>
<td>CA</td>
</tr>
<tr>
<td>13-Jun-85</td>
<td>Alan</td>
<td>Jenny's River Trips</td>
<td>29786 14th St.</td>
<td>Boston</td>
<td>MA</td>
</tr>
</tbody>
</table>

Use the cursor movement keys to scroll your list.

Your customer list contains 35 records in all—a small database, but large enough for you to practice manipulating it.

Notice that we have added three fields to the mailing list: Date, showing the last date of purchase; Rep, showing the sales representative; and Total Sales, showing the amount sold in the past year. These are important pieces of information for a current customer list and for knowing who is in contact with each of your customers. Of course, this information will not appear on mailing labels, since the Report View enables you to select the fields to use in printing.

**SORT THE RECORDS**

The records are displayed in the order they were entered. In this case, after the first five records there doesn't seem to be any particular order at all. This is easily remedied by establishing the sort order with the Field & Sort Settings tool.

Choose Field & Sort Settings from the Records menu. /RF
The Field & Sort Settings Tool. The sort order is established in the Sort # column.

The Field & Sort Settings tool presents a list of all the field names on your current database and a series of columns with cells for you to fill in. As you might guess from the looks of it, it is used for several things. Field & Sort Settings provides you with control over and information about your records, including the display formats for the different fields, formulas for calculating field values, and the sort order of the records. Right now we are going to use it to establish the sort order. (For a complete description of all the functions of this tool, see “Field and Sort Settings” in Reference A.)

**MAKING THE LIST ALPHABETICAL**

For easy reference, it would be useful to sort the records alphabetically by customer name. Start by making the Name field the primary sort field. The primary sort field is the first field Reflex will look at when it sorts the records. (Later you will establish a secondary sort field, a third, and so on.) To indicate the primary sort field, follow these steps:

1. Select the Name cell in the Sort # column.  
   It’s the third cell down.
2. Type in the number 1 (one).  
   Remember, the lowercase L won’t work.
3. Press \[→\].  
   Reflex automatically puts an A in the A/D column. This stands for ascending.
THREE

A/D stands for *ascending* or *descending*. Sometimes, you will want your records sorted in ascending order: A to Z, smallest to largest number, or earliest to latest date. Other times when you want to sort in descending order, you type in a D for descending.

4. Press the \[^{\leftarrow}\] key to select Proceed. You can also get to the Proceed box with the cursor keys.

5. Press \[^{\leftarrow}\]. The tool disappears.

Your customer list is now sorted in alphabetical order by customer name.

You can make any field the primary sort field. This means you can sort by Date, by Zip (good for mass mailings), by Rep, or by any other field you choose.

**CHOOSING A SECONDARY SORT FIELD**

You have decided that you want to see the customer list sorted by Rep. Further, you think that the most recent customers should be at the top of the list in each rep’s group, so you will use Date as your secondary sort field.

1. Choose Field & Sort Settings from the Records menu. /RF Again you see the tool, with the old settings intact.

2. Select the Rep cell in the Sort # column.

3. Type: 1 and press \[^{\leftarrow}\]. The previous primary sort field number changes instantly to 2.

The previous primary sort field now becomes the secondary sort field. Whenever you change the sort order, Reflex assumes that the current sort order has been modified, not thrown away.

4. Select the Date cell in the Sort # column. Type: 2 and press \[^{\leftarrow}\]. The Name field is now the third sort field.

5. Press \[^{\leftarrow}\] to select Proceed and press \[^{\leftarrow}\]. The tool disappears.
Your customer list sorted by Rep and by Date within each Rep.

Your List View is now sorted in the order you determined.

6/12/85

<table>
<thead>
<tr>
<th>Date</th>
<th>Rep</th>
<th>Name</th>
<th>Address</th>
<th>City</th>
<th>St</th>
</tr>
</thead>
<tbody>
<tr>
<td>12-Jun-85</td>
<td>Cathy</td>
<td>Canoe Club of America</td>
<td>7954 Antique Ave</td>
<td>Boston</td>
<td>MA</td>
</tr>
<tr>
<td>14-Jan-85</td>
<td>Dave</td>
<td>Land 'o Lakes Sportin</td>
<td>879 First Street</td>
<td>St. Paul</td>
<td>MA</td>
</tr>
<tr>
<td>18-Jan-85</td>
<td>Dave</td>
<td>Hiawatha Harry</td>
<td>8879 Downtown St</td>
<td>Cambridge</td>
<td>MA</td>
</tr>
<tr>
<td>14-Feb-85</td>
<td>Dave</td>
<td>Wilson Sporting Goods</td>
<td>74 Walters Lane</td>
<td>New York</td>
<td>NY</td>
</tr>
<tr>
<td>5-Mar-85</td>
<td>Dave</td>
<td>Whitewater Adventures</td>
<td>1423 Center Ave</td>
<td>Hodgesvill</td>
<td>CA</td>
</tr>
<tr>
<td>6-Apr-85</td>
<td>Dave</td>
<td>Serenity Campsites</td>
<td>55 Commerce Blvd</td>
<td>Memphis</td>
<td>TN</td>
</tr>
<tr>
<td>7-Apr-85</td>
<td>Dave</td>
<td>Private Fishing, Inc.</td>
<td>37654 Andrews Co</td>
<td>Chicago</td>
<td>IL</td>
</tr>
<tr>
<td>21-May-85</td>
<td>Dave</td>
<td>Questors, Inc.</td>
<td>1528 Broadway</td>
<td>Boston</td>
<td>MA</td>
</tr>
<tr>
<td>9-Jun-85</td>
<td>Dave</td>
<td>Rapid Rivers, Inc.</td>
<td>22 Forest Street</td>
<td>Anchorage</td>
<td>AL</td>
</tr>
</tbody>
</table>

This list is quite different from the previous list, and it is useful for a different purpose. Because your customer list is arranged in groups—first all of Alan's customers, then all of Bob's, and so on—you can quickly see how each of your sales representatives is doing.

RECAP

You use the Field & Sort Settings tool to sort records.

You create the primary sort field by entering the number 1 in the Sort # column for the field you want to use.

You create secondary and subsequent sort fields also by entering numbers in the sort column. You can have as many as five sort fields.

Typing an A or D in the A/D column tells Reflex whether you want the sort to be in ascending or descending order.
SEARCHING

Often, you will want to find just one record without having to scroll through all of them. ("What was the July result?") Or you want to see just a few records that provide the information you want. ("How have my top salespeople been doing this year?") Or you want to use a smaller subset of your records temporarily. ("Let's look at our Boston customers before deciding on a strategy.") With Reflex, you can look at just the records you need at any moment.

SEARCH CONDITIONS

You can command Reflex to search for any record or group of records in your database. You do this by entering conditions that Reflex uses to identify the records you want to see.

Search conditions identify specific records among all of the records in the database.

FINDING

Find is used to zero-in on a particular record or set of records while still seeing the whole database in the Views.
FILTERING

Using the same conditions, you can create a temporary working database consisting of only those records that meet the conditions. This is called filtering the database.

The Filter creates a working database, setting aside the other records temporarily.

Filtering has no effect on the underlying database; it only determines which records are displayed and used in the Views.

PART 7

SETTING SEARCH CONDITIONS: FINDING AND FILTERING

In this part, you'll learn how to set search conditions. You'll use them to find records that match. Then you'll use the same conditions to filter the records to create a smaller working database. In this way, you'll isolate different parts of your total database for closer scrutiny.

You will be using the sample database of the Tyler Canoe Company's customer list. It is the Custlist file on your Help disk.
THREE BASIC TUTORIAL

WHAT YOU’LL DO

☐ Specify search conditions
☐ Find records that meet the criteria
☐ Filter the database to see only those records

SPECIFY SEARCH CONDITIONS

You start with the customer list on the Help disk. If you are continuing directly from Part 6, skip the first two steps.

1. Retrieve Custlist from your data disk. (/PR)

2. Open the List View (/VL), Type R to replace the Form View

3. Sort the records alphabetically by Name. Use the Field & Sort Settings tool (/RF).

Now you’re ready to enter search conditions.

Your customer list provides quite a bit of information. At this point, you want to find records for customers in Boston who have purchased more than $20,000 worth of canoes in the past year.

1. Choose Set conditions from the Search menu. /SS The Search Conditions tool appears, displaying a table with the database field names.
The Search Conditions tool.

The tool first asks you to indicate how you want to enter the conditions: Cell or Table. The Table checkbox is already highlighted, as Reflex assumes that you will usually want that choice.

2. Press \[\leftarrow\]. The cursor moves to the first condition cell in the table.

To establish the search conditions, you enter information in the cells next to the field names. As usual in Reflex, you select the cell first, then type in the condition.

3. Select the condition cell next to City.

You want to see the records for Boston customers. So you tell Reflex, in effect, “City equals Boston.” Reflex then looks through the database and makes note of all the records that meet this condition.

4. Type in: “Boston” Type it exactly like this. Reflex needs the quotation marks to identify text field entries.

5. Press \[\leftarrow\]. Note that Reflex adds another condition column to the table (you will use this later).
THREE

Because both search conditions are in the same column, a record must meet both conditions to pass.

6. Use the \[ \downarrow \] key to scroll the table. Select the condition cell next to Total Sales and type: \[ > 20000 \]

This establishes the condition "Total Sales greater than $20,000."

When you enter two or more conditions in the same column in the table, Reflex understands you to mean "Show me only the records that meet all these conditions—in this case, those that have Boston in the City field AND a number greater than 20,000 in the Total Sales field." A condition entered into a different column causes Reflex to use OR.

<table>
<thead>
<tr>
<th>Field</th>
<th>Condition</th>
<th>OR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Address</td>
<td></td>
<td></td>
</tr>
<tr>
<td>City</td>
<td>&quot;Boston&quot;</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zip</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total Sales</td>
<td>[ &gt; 20000 ]</td>
<td></td>
</tr>
</tbody>
</table>

Use: \( \square \) Conditions as Entered \( \square \) Opposite of Conditions

7. Press \( \downarrow \).

Notice that \( \leftarrow \) takes you out of the table to the next pair of checkboxes, skipping the cells between.

Reflex gives you a choice between using the conditions you have established, or their opposite. This provides you a way to see all the records that don't meet the conditions. At present, we want to use these conditions, so we will select the specified checkbox.

8. Press \( \leftarrow \).

The cursor moves to Proceed.

9. Press \( \leftarrow \) to proceed.

The Search Conditions tool disappears.
You have established your search conditions. As yet, the List View is just as you have left it. You now have two choices: you may either find these records or filter the database to make only these records visible. Let's do both, one at a time.

**FIND SPECIFIC RECORDS**

Now that you have established your search conditions, you can find records that meet them. To do this, you choose Find Record from the Search menu (/SF), or use the Find key [F5].

1. Press [Home].  
   *This selects the first record in your database.*

2. Press [F5].  
   *Reflex highlights the first record that meets the conditions you have established.*

3. Press [F5] several more times.  
   *Each record for Boston customers with total sales greater than $20,000 is highlighted in succession.*

**FILTER TO MAKE A WORKING DATABASE**

To see a list consisting of only the records you want, you need to apply the filter. You can either choose Apply Filter from the Search menu (/SA), or press the Filter key [F5].

1. Press [Home].  
   *Instantly, Reflex changes the list to include only the records that meet your filter conditions. Notice the “Filt” indicator on the message line.*

2. Press [Home].  
   *This brings you to the top of the list.*
THREE

The Filtered List.

You have created a smaller working database—a subset of the whole. As long as the filter is applied, Reflex treats the working database as the current database. Only these records show in the views. Note that your full database is still in the computer's memory; it just isn't showing. Reflex has temporarily set aside the records that do not meet the search conditions.

REMOVING THE FILTER

To remove the filter, choose Remove Filter from the Search menu (/SR) or press the Filter key again.

THE OR COLUMN

Let's go back and examine an additional way of using the Conditions tool.

1. Choose Set Conditions again from the Search menu. /SS

2. Select the Condition cell in the third column (headed OR) on the Rep field row.
The modified search conditions. You have added an OR to the conditions.

3. Type in "Bob" and press  
   Be sure to use quotation marks.

Your new conditions allow more records to pass the filter. Now Reflex will search for records that meet the conditions either in the first column or in the second column (or both)—in this case, those that are in Boston AND have more than $20,000 total sales, OR that show Bob as sales rep (no matter what city or how much total sales).

Note that when you entered a condition in the OR column, Reflex automatically added another OR column. Reflex always provides up to 10 columns for conditions.

4. Press  twice to select
   Proceed, then press  .

5. Choose Apply Filter from the Search menu (/SA) to see your new working database.
NOTES ON SEARCHING

Here is a list of logical operators you can use to enter conditions. A complete list appears in Reference A.

- equals
- greater than
- greater than or equal to
- less than
- less than or equal to
- not equal to

RECAP

Use the Search Conditions tool to establish search conditions.

Find successive records that meet the conditions by choosing the Find command (/SF) or by pressing the Find key [F5].

Filter the records by choosing Apply Filter (/SA) or by pressing the Filter key [F5]. Remove the Filter by choosing Remove Filter (/SR) or by pressing [F5] again.

PART 8

CHANGING THE LIST AND PRINTING

You often need a quick printout of the information you’re working with. In this part, you arrange columns in the List View of your customer list to show exactly the information you want. And then you get a quick printout of this data.

WHAT YOU’LL DO

- Insert and delete columns of information in the List View
- Print out a list of your customers

CHANGE THE LIST VIEW DISPLAY

You can display all the columns, some of the columns, or none of the columns in the List View. And you can arrange the columns in any order you like. Changing the List View display makes it possible to get many different lists from one set of records.
In this part, you still use the Tyler Canoe Company customer list (Custlist). If you are continuing directly from the previous part, skip the first two steps.

1. Retrieve Custlist from your data disk.

2. Open the List View, replacing the Form View, if necessary.

3. Remove any Filters.

Now you’re ready to change the display. You want your list of customers to display the sales rep next to the customer name and to show the last date of purchase and the amount.

**DELETING COLUMNS**
The first thing to do is delete the columns you don’t want. (Don’t worry, the information remains in the database. Reflex only removes it from the List View temporarily.)

1. Select any cell in the Address column.

2. Choose Column Select from the Edit menu (**EC**) or press the Column key **F4**.

3. Press **Del**. The entire Address column is highlighted.

4. Press **Del** again. The Address column disappears, and the display adjusts. The City column is now highlighted.

5. Press **Del** again. The City column disappears and the State column is highlighted.

6. Press **Del** again. The State column disappears, and the Zip column is highlighted.

Now the Zip column disappears. Your List View looks like the illustration below.
The modified List View.

```
<table>
<thead>
<tr>
<th>Date</th>
<th>Rep</th>
<th>Name</th>
<th>Total Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>25-Jan-85</td>
<td>Bob</td>
<td>Baltic Boating</td>
<td>$21,358.00</td>
</tr>
<tr>
<td>4-May-85</td>
<td>Bob</td>
<td>Boy Scouts of America</td>
<td>$14,500.00</td>
</tr>
<tr>
<td>12-Jun-85</td>
<td>Cathy</td>
<td>Canoe Club of America</td>
<td>$36,795.00</td>
</tr>
<tr>
<td>16-May-85</td>
<td>Bob</td>
<td>Crenshaw's Canoeing</td>
<td>$13,563.00</td>
</tr>
<tr>
<td>4-May-85</td>
<td>Alan</td>
<td>Denny's Deepsea</td>
<td>$34,216.00</td>
</tr>
<tr>
<td>5-May-85</td>
<td>Cathy</td>
<td>Early Bird Expedition</td>
<td>$17,430.00</td>
</tr>
<tr>
<td>28-Apr-85</td>
<td>Bob</td>
<td>Explorer Scouts of America</td>
<td>$12,987.00</td>
</tr>
<tr>
<td>16-Mar-85</td>
<td>Bob</td>
<td>Fairhaven Park</td>
<td>$14,500.00</td>
</tr>
<tr>
<td>3-Jun-85</td>
<td>Bob</td>
<td>Franklin Hughes, Expl</td>
<td>$9,450.00</td>
</tr>
<tr>
<td>21-Jun-85</td>
<td>Alan</td>
<td>Friendly Canoe Supply</td>
<td>$16,589.00</td>
</tr>
<tr>
<td>15-Mar-85</td>
<td>Alan</td>
<td>Giant Sporting Goods</td>
<td>$16,545.00</td>
</tr>
<tr>
<td>30-May-85</td>
<td>Alan</td>
<td>Girl Scouts of America</td>
<td>$19,675.00</td>
</tr>
<tr>
<td>16-Jan-85</td>
<td>Dave</td>
<td>Hiawatha Harry</td>
<td>$1,525.00</td>
</tr>
</tbody>
</table>
```

To un-select a column, press [↑] or [↓] and the cursor returns to the heading cell, or press [Esc] and the cursor returns to the row it was on before the column selection.

**MOVING A COLUMN**

Now that you have removed the columns you don't need, you are ready to rearrange the remaining columns. First you insert a blank column to the left of the Rep column, and then you enter the column name you want to put there.

2. Press [Ins].
3. Press [↑].
4. Type: Name and press [←].
5. Make the new Name column wider. /ES
The List View, ready to be printed.

<table>
<thead>
<tr>
<th>Date</th>
<th>Name</th>
<th>Rep</th>
<th>Total Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>25-Jan-85</td>
<td>Baltic Boating</td>
<td>Bob</td>
<td>$21,358.80</td>
</tr>
<tr>
<td>4-May-85</td>
<td>Boy Scouts of America</td>
<td>Bob</td>
<td>$14,589.00</td>
</tr>
<tr>
<td>12-Jun-85</td>
<td>Canoe Club of America</td>
<td>Cathy</td>
<td>$36,785.80</td>
</tr>
<tr>
<td>16-May-85</td>
<td>Crenshaw’s Canoeing</td>
<td>Bob</td>
<td>$13,563.00</td>
</tr>
<tr>
<td>4-May-85</td>
<td>Denny’s Deepsea</td>
<td>Alan</td>
<td>$34,216.80</td>
</tr>
<tr>
<td>5-May-85</td>
<td>Early Bird Expeditions</td>
<td>Cathy</td>
<td>$17,438.00</td>
</tr>
<tr>
<td>28-Apr-85</td>
<td>Explorer Scouts of America</td>
<td>Bob</td>
<td>$12,987.80</td>
</tr>
<tr>
<td>16-Mar-85</td>
<td>Fairhaven Park</td>
<td>Bob</td>
<td>$14,508.80</td>
</tr>
<tr>
<td>3-Jun-85</td>
<td>Franklin Hughes, Explorer</td>
<td>Bob</td>
<td>$9,458.00</td>
</tr>
<tr>
<td>21-Jun-85</td>
<td>Friendly Canoe Supply</td>
<td>Alan</td>
<td>$16,589.00</td>
</tr>
<tr>
<td>15-Mar-85</td>
<td>Giant Sporting Goods Company</td>
<td>Alan</td>
<td>$16,545.00</td>
</tr>
<tr>
<td>30-May-85</td>
<td>Girl Scouts of America</td>
<td>Alan</td>
<td>$19,675.00</td>
</tr>
<tr>
<td>16-Jan-85</td>
<td>Hiawatha Harry</td>
<td>Dave</td>
<td>$1,525.00</td>
</tr>
</tbody>
</table>

You now have a complete list of your customers, sales reps, last date of purchase, and total amount of sales. This is the list you will print out.

**NOTES ON ARRANGING THE LIST VIEW**

To *restore* any column you have deleted, enter the field name in a blank column heading.

To restore *all* the deleted columns, choose Show All Fields from the List menu (LS). You may need to readjust your column widths to show all the data.

To *replace* one column with another, enter the new field name in the column heading. The old column is deleted and replaced with the new column.

To delete *all* the columns at once (leaving one blank column remaining), choose Window Clear from the Edit menu (EW).

**WARNING** If you press the Row key [F3], you will select an entire row. If you then press [Del], you will delete the record on that row. Unlike a column, you can’t get a row back; it has been permanently deleted from the database.
PRINT THE CONTENTS OF THE LIST VIEW

Make sure your printer is attached to your computer, plugged in, turned on, and supplied with paper. Consult the manual supplied by the manufacturer for directions.

The Global Settings tool contains checkboxes for automatic line-feed, serial or parallel printers, and which port you have attached the printer to. When you set up your printer, choose Global Settings from the Print/File menu (/PG), and enter the correct settings. Then choose Save Settings from the Global Settings menu to make these settings permanent.

The following procedure is for obtaining a quick print-out of information from the List View. (The steps are the same for the Form and Crosstab Views.) The Report View provides many additional features for customized reports. The Graph View uses the special Graph Print program.

When you are finished arranging the List View to your satisfaction (including changing the column widths to display the information), you are ready to print it out. Reflex prints only the columns that are currently part of the List. It prints all the records in the working database, not just those shown on the screen at one time.

USING THE PRINT SETTINGS TOOL

You use the Print Settings tool to add a title to the information and to tell Reflex how you want it printed.

Choose Print from the Print/File menu. /PP

The Print Settings tool is displayed.
The Print Settings tool.

As you can see, the Print Settings tool provides cells for quite a bit of information. The entries displayed are default values—a standard set of instructions that will fit most cases. If your printer or page size requirements are different, you can change them as we go along.

The cursor highlights Title Line 1. You can enter up to 50 characters in each of the title lines.

1. Type: Tyler Company Customers
   Press  prints.

2. If you want to, add a second title line, perhaps
   From the Sales Department
   Press  moves the cursor to the next set of cells.

   This title will appear on the first page of your print-out, centered at the top.

   This line will appear, centered, directly under the first line.

The Output: To Printer . . . To Disk File line allows you to use the printer or to “print” the output to a file on a disk. You want to use the printer now, so you don’t need to change the default value.

3. Press  moves the cursor to the next set of cells.

   This enters the printer instruction and moves the cursor to the next set of cells.

The left and right margins are measured in character widths, or spaces. The numbers entered in the cells answer the question, “How many spaces from the left edge of the paper do
you want the margin?” The default values are for standard 8½ by 11 inch paper. If you want to change them, do so now; otherwise, continue.

4. Press \[ \leftarrow \] twice. \hspace{1cm} This takes you past the right margin cell and selects the top margin cell.

The top and bottom margins are measured in rows. (One row equals one line of printing.) The number for the top margin tells the printer how many lines to leave blank at the top of the paper. The number for the bottom margin tells the printer how many lines to leave blank at the bottom. Again, change the default values if you want to, or go on.

5. Press \[ \leftarrow \] twice. \hspace{1cm} This takes you past the bottom margin cell and selects the page length cell.

The standard page length is 66 lines. If you have odd-sized paper, change this setting (6 lines to the inch).

6. Press \[ \leftarrow \]. \hspace{1cm} This selects the setup string cell.

The setup string cell enables you to send a string of instructions to your printer for special types of print—boldface, compressed print, etc. Right now, we are not going to do anything special, so leave this cell blank.

7. Press \[ \leftarrow \]. \hspace{1cm} This selects the checkbox for continuous feed paper.

Your printer paper is either continuous or single sheet. You need to tell Reflex what kind of paper is being fed into your printer.

8. Select the proper Paper Feed checkbox for your printer setup and press \[ \leftarrow \]. \hspace{1cm} This selects the Print From Page checkbox.

Print From Page . . . To . . . tells the printer the range of pages to print. Right now, you want to print all the records, leave the default selection.
9. Press twice. This selects the Print cell.


When your printer is finished printing, put away the Print tool.

11. Select Put Away and press . The Print tool disappears. Your previous display is on the screen.

Arranging columns of information for printing is a basic feature of Reflex. The Report View provides an even greater array of display and calculation options for custom reports.

NOTES ON PRINTING

When the Print Settings tool is open, use the Save Settings command from the Options menu to make permanent the instructions you enter in this tool (does not apply to the title lines). This makes the current instructions the default instructions.

The key combination takes you directly to Print in the Print Settings tool. It is exactly like selecting the Print cell and then pressing . Use it when you are certain that the remaining instructions are correct.

Printing the Form View prints one record at a time.

RECAP

Select a column by choosing Column Select from the Edit menu (/ES) or press the Column key [F4].

Insert a column to the left of the selected column by choosing Insert from the Edit menu (/EI) or press [Ins].

Delete the selected column by choosing Delete from the Edit menu (/ED) or press [Del].

Enter a field name in a column heading to cause Reflex to display that column.

To Print the contents of a View, choose Print from the Print/File menu (/PP), fill out the instructions, and Proceed.
EDITING THE RECORDS

In this part, you will learn the different ways of editing the database you have created. You will make changes to the records on your customer list.

WHAT YOU'LL DO

- Edit the contents of a field
- Add and delete a record
- Add field names to change the form and the database

EDIT FIELD CONTENTS

Retrieve the Tyler2 file from the Help disk.

1. Choose Retrieve File from the Print/File menu. /PR

   The Retrieve File tool appears.

2. If necessary, enter: A: in the Directory box.

3. Press [F10], select Tyler2 and then proceed.

   The first record of your mailing list appears in Form View.

4. Open the List View and split the screen vertically. /VL

   You are ready to begin editing your records.

Adirondacks Expeditions has changed its name to Adirondacks Adventures. To change the name in your records, you select the field with the information in it, edit the field contents, and then enter the changed field contents.

1. Press [Home].

   This selects the first field in your first record. Adirondacks Expeditions is displayed in the edit line on your screen.
The first field in the first record has been selected. Note that the field contents are displayed in the edit line.

2. Press F2. This puts Reflex in the **Edit mode**. You will be able to make changes to the contents of the selected field.

Notice that Reflex has inserted an apostrophe before *Adirondacks*. This indicates that the entry is a text field, not a date or numeric field.

In the Edit mode, a small cursor sits just to the right of the field contents in the edit line. (It also appears in the same position in the cell.) By using ← and → keys, you highlight individual characters in *Adirondacks Expeditions*.

3. Use the ← key to move the cursor until it is on the E in *Expeditions*. The cursor movement has no effect on the contents. (The (Backspace) key erases them.)

4. Type in: **Adventures** The word appears before Expeditions.

In the Edit mode, everything you type is inserted where the cursor sits. You can't type over what is there. You use the Del key to remove unwanted characters.

5. Press Del three times. Watch the edit line at the top of the screen. The characters disappear one at a time.
THREE

BASIC TUTORIAL

6. Press and hold down the \( \text{Del} \) key to erase the rest of Expeditions.

That's quicker.

7. Press \( \leftarrow \).

Your editing changes are now final. Once you press \( \leftarrow \), you are no longer in Edit mode. To edit another cell, select it and press \( \text{F2} \) again.

SPECIAL KEYS IN EDIT MODE

If you change your mind while editing, press the \( \text{Escape} \) key, \( \text{Esc} \). Editing changes made before pressing \( \leftarrow \) are ignored, and the field contents remain what they were before you started. \( \text{Esc} \) also takes you out of Edit mode.

You can use the \( \text{Backspace} \) key, \( \text{(Backspace)} \), to erase characters.

The \( \text{Tab} \) key, \( \text{[\text{]}\text{]}\text{]}\text{]} \), moves you through the edit line five spaces at a time. \( \text{[\text{]}\text{]}\text{]}\text{]} \) moves to the left, \( \text{[\text{]}\text{]}\text{]} \) unshifted moves to the right.

The \( \text{Insert} \) key, \( \text{Ins} \), inserts a space.

The \( \text{Delete} \) key, \( \text{Del} \), deletes the selected character.

EDITING IS THE SAME IN FORM VIEW

The Edit mode works exactly the same way in Form View and everywhere else in Reflex. You select the cell you want to modify and press \( \text{F2} \).

DELETE A RECORD

Crenshaw's Canoeing has gone out of business, so you need to delete that record from your mailing list. Deleting a whole record is done with a menu option. As with all the editing procedures, you can delete a record in the List View or the Form View. In the List View:

1. Select any field in the record for Crenshaw's Canoeing.

2. Choose Delete Record from the Records menu. /RD

The entire record disappears.
WARNING

Once you delete the record, it's gone. Of course, it still exists on your data disk and the whole file can be retrieved again. But then you would have to begin again from the start of your editing.

To delete the current record in Form View, choose Delete Record from the Records menu, and the record disappears.

ADD A NEW RECORD

You can *add* a record between other records in your database. This inserts a blank record after the current record.

A new customer, Canoes Unlimited, has been added to your list. It needs to be added after Baltic Boating. To add this record in the List View:

1. Select any cell in the Baltic Boating record.

2. Choose Add Record from the Records menu. /RA

   *A blank record is added to the database following Baltic Boating.*

3. Press **Esc** to unselect the blank row, then type the information in the proper fields:

   Name: Canoes Unlimited
   Address: 666 Sixth St.
   City: Seattle
   State: WA
   Zip Code: 90006

To add a record following the current record in the Form View, choose Add Record from the Records menu. A blank record is displayed. Fill it out in the usual way.

INSERT AND DELETE ON THE EDIT MENU

The Insert command on the Edit menu can be used to add a blank row *above* the current record in the List View. To insert a blank row, select the entire row by choosing Row Select from the Edit menu (/ER), then choose Insert from the Edit menu (/EI) or press **Ins**.
This sequence inserts a blank row in the List, Crosstab, and Report Views.

Choosing Delete from the Edit menu (/ED) or pressing [Del], deletes the currently selected object, whether row, column, or field contents.

CHANGE THE FORM DESIGN

To add more information to the records you are keeping or to change the arrangement of the field names, you will need to change the design of your form. To reach Form Design, you must first make the Form View active.

1. If necessary, make the Form View active with F6. Notice that the Form menu is added to the menu line.

2. Choose Design Form from the Form menu. /FD Form Design will appear on the screen, displaying your original field names.

REARRANGING THE FIELD NAMES

You can use Form Design at any time to modify the form. Changing the form is exactly like setting it up initially. In this example we first explain the steps for moving a field name from one location to another.
1. Select the Zip Code field name. Use the arrow keys to move the cursor to the field name. Notice that in Form Design, the arrow keys move you only one space or one line at a time, not from field to field. The cell contents appear on the edit line.

2. Choose Move Field from the Form menu. /FM The message line tells you to move the cursor to the new position.

3. Use the arrow keys to move the Zip Code field down below State. A "shadow" of the selected cell moves to the new location.

The "shadow" shows the new location of the cell.

<table>
<thead>
<tr>
<th>Zip Code</th>
<th>Views</th>
<th>Edit</th>
<th>Print/Save</th>
<th>Records</th>
<th>Search</th>
<th>Form</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

[FONT DESIGN]

Name
Address
City
State  Zip Code

Line: 011 Col: 061

Use arrow keys to position, then ENTER

4. Press [←]. The field name is moved to its new location.

[m] If you have a mouse, you can move the field name with it. In Form Design, put the pointer on the field name you want to move and press-and-hold the left button. While still holding down the button, move the pointer to the new location. A "shadow" cell accompanies the pointer. When it is where you want it, release the button. The field name is entered in its new location.
**ADDITION TO THE FORM**
The title will be added as a label, which means that it will appear on every form, but it won't be a field name. To make something on the form a label, you type an apostrophe before the characters in Form Design.

Begin in Form Design.

1. Press [Home].  
   The cursor moves to the upper left corner.

2. Press [→] three times to center your title.

3. Type: ‘*Tyler Customers*’  
   The apostrophe tells Reflex that this is not a field name.

4. Press [←].  
   This enters the words onto the form.

**EDITING FIELD NAMES**
While you're at it, why not erase Code from Zip Code? It's not really necessary. Changing a field name does not affect the records in any way.

**WARNING**
If you want to change a field name, edit it, don’t delete it. If you delete a field name, all the data in that field is lost.

1. Select Zip Code and press [F2].  
   You are now in Edit mode.

2. Press (Backspace) to remove the word Code and the space after Zip.  
   Your change is not final until you press [←].

**NOTE**
Reflex will not accept a “trailing” space after a field name, or a “leading” space before a field name. Spaces in field names must be surrounded with valid characters.
### ADDING A FIELD NAME
You've decided to add Date, Total Sales, and Rep to each record.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Select Name. This is the first field name.</td>
</tr>
<tr>
<td>2.</td>
<td>Choose Insert from the Edit menu (Ins) or press Ins. This inserts a blank line in the form above the selected field name.</td>
</tr>
<tr>
<td>3.</td>
<td>Position the cursor at the left edge of the form, above Name. This is where you will type your new field name.</td>
</tr>
<tr>
<td>4.</td>
<td>Type: Date. Press ↓. As usual, there is no need to add a colon (:). Reflex automatically adds it for you in Form View.</td>
</tr>
<tr>
<td>5.</td>
<td>Press Ins to insert another blank row above Name.</td>
</tr>
<tr>
<td>6.</td>
<td>Position the cursor several spaces to the right of Date and type: Rep. Be sure to leave enough room for the date between the two new field names.</td>
</tr>
<tr>
<td>7.</td>
<td>Press End and then ↓ twice to position the cursor at the bottom left of the Form Design screen, and type: Total Sales. Press ↓. The screen displays the current record in Form View, with the title and the three (empty) fields. The current record has not changed while you worked in Form Design.</td>
</tr>
<tr>
<td>8.</td>
<td>Choose Exit Design from the Form menu and take a look. (FE)</td>
</tr>
<tr>
<td>9.</td>
<td>Make the List View active F6, and scroll it to see the added columns. The new columns are added on the far right side of the List View.</td>
</tr>
</tbody>
</table>

You may wonder why you have added these new fields to your mailing list. You certainly wouldn't print the date of purchase or the sales rep on a mailing label.

As you have seen in the Sort and Search parts, it is very useful to have these extra fields. You are able, for example, to send
a mailing to customers who have purchased canoes recently, or
to all customers for a particular sales representative.

When you print out the mailing labels using the Report View,
you will be able to choose which fields to print and to leave out the unnecesary information.

NOTES ON EDITING

In Form Design: Choosing Insert from the Edit menu or pressing [Ins] inserts a blank line above the selected location. Choosing Delete from the Edit menu or pressing [Del] deletes the selected object or, if no object is selected, deletes an entire blank line. Reflex will not allow you to delete a line with a field name on it.

RECAP

To edit cell contents, select the cell and press [F2]. Change the contents in the edit line and press [Esc].

To insert or delete a record, select any cell in the record you want. Choose Add Record or Delete Record from the Records menu.

You can add or change field names at any time without affecting the information in the database.
LOOKING AHEAD

The Advanced Tutorial introduces the remaining Reflex Views and explains methods of analysis. The skills you have developed in the Basic Tutorial will be put to use in the following chapter.
FOUR

ADVANCED TUTORIAL
# ADVANCED TUTORIAL

<table>
<thead>
<tr>
<th>PART 1</th>
<th>REFLEX CONCEPT: CALCULATED FIELDS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PART 1: CALCULATED FIELDS</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>PART 2</td>
<td>REFLEX CONCEPT: THE GRAPH VIEW</td>
</tr>
<tr>
<td></td>
<td>PART 2: MAKING A GRAPH</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>PART 3</td>
<td>REFLEX CONCEPT: THE CROSSTAB VIEW</td>
</tr>
<tr>
<td></td>
<td>PART 3: USING CROSSTABS FOR ANALYSIS</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>PART 4</td>
<td>REFLEX CONCEPT: VARY</td>
</tr>
<tr>
<td></td>
<td>PART 4: PLANNING BREAK-EVEN ANALYSIS</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>PART 5</td>
<td>REFLEX CONCEPT: THE REPORT VIEW</td>
</tr>
<tr>
<td></td>
<td>PART 5: USING THE REPORT VIEW</td>
</tr>
</tbody>
</table>
The Advanced Tutorial is devoted to introducing many of the features that make Reflex The Analytic Database System. It will also help you improve the skills you learned in the Basic Tutorial.

Part 1, Calculated Fields
Shows you how to calculate information in some fields based on information in others.

Part 2, Making a Graph
Explains how to graph information in the database.

Part 3, Using Crosstabs for Analysis
Explains how to use crosstabs for numeric summaries of your data.

Part 4, Planning
Shows you how to set up a hypothetical database using the Vary tool and how to do what-if? analyses.

Part 5, Using the Report View
Explains how to set up a mailing list and a sales report.

**CALCULATED FIELDS**

By entering a formula, you can use information you already have to calculate new information. Reflex can calculate the value of any field based on values in other fields on the same record. To create such a calculated field, you simply select the field and enter the formula. Reflex does the calculation and displays the result. You can use formulas to cut down both the number of manual calculations and the number of entries you have to make in your records.

**CALCULATED FIELDS**

Calculated fields. Reflex uses a formula to calculate field values from values in other fields.

```
Revenue: $690
Cost: $500
Profit: $190
Commission: $19

0.10 * Profit
```
A calculated field. Reflex calculates the value for the Commission field as 10 percent of the value in the Profit field.

FORMULAS

Normally, formulas contain numbers, field names, built-in functions, and operators. An operator tells Reflex to multiply, divide, add, or subtract. For example, the formula for Commission equals 10 percent of Profit would be written:

Commission = .10 * Profit

The illustration shows how it would look typed into the Commission field. Note that you don’t have to type in the Commission part of the formula. When you type the formula into the Commission field, Reflex displays the result in that field.

Here is what happens: Reflex looks at the Profit field contents, in this case a numeric value, multiplies it by .10, and displays the result in the Commission field.

A formula entered on one record is used on every record in the database. The same calculation is performed for every record, automatically.

MODELS

Any field can be a calculated field, depending for its value on values in other fields. Typically, of course, calculations are performed on numeric fields. When several fields are linked together by formulas, the result is often called a model. Models
are representations of relationships between pieces of information. In the following example of a model, all fields are linked directly or indirectly to the Cost field:

<table>
<thead>
<tr>
<th>FIELD</th>
<th>FORMULA</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost</td>
<td>You enter data.</td>
<td></td>
</tr>
<tr>
<td>Price</td>
<td>= Cost * 1.60</td>
<td>Price is 60 percent more than cost.</td>
</tr>
<tr>
<td>Commission</td>
<td>= Price * .10</td>
<td>Commission is 10 percent of price.</td>
</tr>
<tr>
<td>% Margin</td>
<td>= (1 – Cost/Price) * 100</td>
<td>Percent margin is a percentage of price.</td>
</tr>
<tr>
<td>Profit</td>
<td>= Price – Cost</td>
<td>Profit is price minus cost.</td>
</tr>
<tr>
<td>Net Profit</td>
<td>= Profit – Commission</td>
<td>The Company's net profit is profit minus commission.</td>
</tr>
</tbody>
</table>

When you enter information in the Cost field, Reflex calculates the values for all the other fields immediately. Whenever you change the value of the Cost field, the values in the other fields are recalculated.

**WHAT-IF?**

You can use models to answer important what-if questions about your business. What if inflation goes up? How will that rise affect costs, profits, schedules? What if profits grow? How will that growth affect taxes and staffing? Any time you can model the relationship between values, you can turn out results based on hypothetical futures.

For example, look back to the model above based on the Cost field. When you supply a variety of possible cost figures, the model instantly shows how those different costs affect all the other figures. Finally, you can make a few simple changes in the formulas themselves to see the results of changing price or commission policies.
MORE COMPLEX FORMULAS

In addition to numbers, field names, and the +, -, *, and / operators, a formula can contain **built-in functions** and **logical operators**: greater than, less than, greater than or equal to, and the like. A formula such as

@IF (Cost > 100, 250, Cost * 2.5)

tells Reflex to choose between two values, returning 250 if the value in the Cost field is greater than 100, or Cost times 2.5 if the value in the Cost field is equal to or less than 100.

CALCULATED FIELDS

In this part, you enter formulas to calculate values in one field based on values in other fields.

**WHAT YOU'LL DO**

- Enter simple formulas to calculate field values using field names and numbers.
- Enter a more complex formula using @IF.

ENTER SIMPLE FORMULAS

So far you have been using a customer list database. Now we turn to the kinds of records often used to keep track of the current state of business. For this lesson, we have prepared a sample monthly sales record for the Tyler Canoe Company.

Begin by retrieving the Salesrep file from the Help disk.
The Form View displays the first record, which contains the fields Date, Rep, Product, Quantity, Sales $, Average Price, Unit Cost, and Total Cost. You are going to add two new fields: $ Margin (dollar margin), and % Margin (percent margin). After the fields are added, you will enter formulas to calculate the values for the new fields.

**ADDING FIELD NAMES IN FORM DESIGN**

As you remember, you need to return to Form Design to add field names:

1. Choose Design Form from the Form menu. /FD

2. Select a convenient location on the screen, then type in: $ Margin ←.

3. Select another location and type in: % Margin ←. *The two new fields have been added to your records.*

4. Choose Exit Design from the Form menu. /FE

You have added two new fields to the records, but there is no information in them yet. When you enter formulas, Reflex will calculate the information.
WHAT DOES A FORMULA LOOK LIKE?
To see what a formula looks like on the Reflex screen, select the Avg Price field and look at the edit line.

=Sales $ / Quantity

As you can see, the field value displayed in the window area is a number, while the value displayed in the edit line is a formula: =Sales $ / Quantity. When we set up the sample database, we used a formula to calculate the values in this field. The average price is always the total sales divided by the quantity.

ENTER YOUR OWN FORMULA

The first formula you will enter is the formula for the $ Margin. The dollar margin is the difference between the total cost and the total sales dollars.

The general rule for entering formulas is: Select the field, type in the formula, and press ~ or select another field. This rule is just like entering a value, except you enter a formula.

1. In Form View, select the $ Margin field and type: =Sales $ - Total Cost

2. Press ~. The calculation is performed.

Now all the records have calculated values in the $ Margin field.
If Reflex beeps at you when you try to enter a formula, there's something wrong. Reflex automatically puts you in Edit mode so you can make any necessary changes.

- Check the spelling of the field names. Reflex doesn't care about capital letters, but spelling the field names correctly is critical. Spelling includes spaces between words. If you made a spelling error, edit what you typed in. Press \[ \rightarrow \]. Now it should work.

- Because Reflex automatically determines the field type based on the first entry in a field, it is possible to mis-type a field as a text field if you forget to enter the equals sign in front of a formula. You want this field to be a numeric field. To change the field type:

  1. Choose Field & Sort from the Records menu. /RF
  2. Select the cell in the Type column on the line for the field.
  3. Press \[ F10 \] and then select the numeric field type.

**USING CHOICES**

Experienced users have found that the Choices key \[ F10 \] is helpful in entering formulas. After you type =, press the Choices key to display a list of current field names. Use the \[ \downarrow \] and \[ \uparrow \] to scroll the list. When the field name you want to use in your formula is highlighted, press \[ \rightarrow \]. The field name is entered in the formula just as if you had typed it. You can use the Choices key as often as necessary while entering a formula.

**ENTER THE SECOND FORMULA**

For your second formula, use the List View. You will see how quickly Reflex calculates values.

Open the List View (/VL). Press \[ \rightarrow \] to replace the Form View.

Your second formula is the percent margin. The dollar margin is the amount the Tyler Canoe Company makes on each sale. The percent margin is the relationship between the dollar
margin and the price. For example, if you sell for $10 something that cost you $7, your margin is $3, which represents 30 percent of the total sales dollars.

So the formula you want to write is:

\[ \% \text{ Margin} = \frac{\$ \text{ Margin}}{\text{Sales} \, \$} \times 100 \]

Why times 100? To see the result as a percent, rather than a decimal (e.g., 30 rather than .3).

Now enter the formula, this time using Choices.

1. Select any cell in the % Margin column and type in: \( = \)
   This alerts Reflex that you are entering a formula.

2. Press \( \text{F10} \), the Choices key.
   A list of field names is displayed. $ Margin is already selected.

3. Press \( \leftarrow \).
   $ Margin is displayed in your formula.

4. Type \( \text{Space} \), \( \text{Space} / \).
   The spaces are optional. They make the formula easier to read.

5. Press \( \text{F10} \), move cursor down to select Sales $, press \( \leftarrow \).
   The choice list scrolls as you move the cursor down.

6. Type in the rest of the formula: \( \ast 100 \)
   Put spaces on either side of the \( \ast \) if you like.

7. Press \( \leftarrow \).
   Reflex calculates values for the % Margin field on every record.

We have gone carefully through using the choice list in formulas because you will often find it useful. It is faster than typing for most field names, and it prevents typing errors.

**SETTING DISPLAY FORMATS**

Both the $ Margin and % Margin fields display their values as a series of numbers, without commas; and the % Margin values are more precise than we need. To set the display formats for these fields, we will use the Field and Sort Settings tool.
1. Choose Field & Sort Settings from the Records menu.

2. Move the cursor down and across to select the Format cell for the $ Margin field. The table will scroll as you move the cursor down.

3. Press Choices [F10] to display a choice list of numeric display formats.

4. Select Currency and press \[ \]. Currency is entered in the format cell, and the precision is automatically set to 2.

5. Press \[ \] to select the Precision cell, and type 0. This database uses only whole dollars, so we don’t need the digits following the decimal. Press \[ \].

6. Select the Format cell for % Margin.

7. Use Choices [F10] to set the format to Fixed, and change the Precision to 0. The List View returns to the screen.

8. Press \[ \] to select the Proceed cell and press \[ \]. You have changed the display formats for the two new fields, making them easier to read on the screen.

NOTE The display format has no influence on any calculations performed. Reflex always calculates based on 15 digits of significance.

**ENTER A MORE COMPLEX FORMULA**

So far you have seen fairly straightforward examples of formulas calculating field values in your records:

Avg Price = Sales $ / Quantity
Total Cost = Unit Cost * Quantity
$ Margin = Sales $ - Total Cost
% Margin = $ Margin / Sales $ * 100
Now you will enter a more complex formula that uses a built-in function.

A *built-in function* is an internal calculator, used by Reflex to perform in place of or as part of formulas. Built-in functions begin with the @ symbol. The *function name* identifies the kind of calculation to perform. With only a few exceptions, all functions are followed by an *argument* (enclosed in parentheses). The argument acts as a direction to the function, giving it specific values to operate on. If a function has more than one argument, each argument is separated from the next by a comma. The function you use in this tutorial is of this type.

**USING @IF**

@IF uses a search condition to determine which of two values will be the result. In the following steps, you use @IF to calculate two different commission rates for your sales records, depending on how much the % Margin is.

Here is the format:

@IF(search condition, result 1, result 2).

This is sometimes called *if-then-else*: If a record meets the search condition, *then* result 1 is used, or *else* (if the record does not meet the condition) result 2 is used.

We will now go through it step by step.

To encourage your salespeople to sell higher-margin products, you pay commissions on a sliding scale. Their standard commission is 10 percent of the Sales $. But if the % Margin is above 35 percent, their commission goes up to 15 percent of the Sales $.

The formula for calculating the commission is:

\[
\text{Commission} = \@\text{IF}(% \text{ Margin} \geq 35, \text{Sales } \times \, .15, \text{Sales } \times \, .1)
\]

This formula can be read as follows: “The commission equals one of two values: If the % Margin is greater than or equal to 35 percent, *then* the commission is .15 times the Sales $; *else* (otherwise) the commission is .1 times the Sales $.”

First, of course, you need to add a field for Commission.
The commission formula returns a value in the Commission field.

1. Go to the Form Design screen and type in: Commission

2. In the Form View or List View, select the Commission field and enter:

   \[ =\text{IF} (\%\ Margin \geq 35, \text{Sales} \times .15, \text{Sales} \times .1) \]

3. Press \( \leftarrow \).

Reflex now calculates the value in the Commission field automatically.

If you make a mistake, Reflex will beep and place you in the Edit mode. The cursor will move to a position near the error. Read the formula carefully, comparing it to the version printed here. One common error is to put a space between > and =. This disrupts Reflex's understanding; change it to \( > = \). Spaces are important within field names also.

ADDITIONAL ANALYSIS POSSIBILITIES

Your additional information reflects the company’s actual business even more closely than the original “raw” data. You have not only the sales records for the month, but also the
dollar and percent margin figures, and a record of the commissions earned by each of the salesreps on the month's sales.

You are now in position to analyze your information for better understanding.

The next two lessons use the Graph View and the Crosstab View to analyze the information in this database.

NOTES ON CALCULATED FIELDS

Reflex knows you are entering a formula when you begin your entry with =, +, or @. You can edit any formula by selecting the cell and pressing F2.

- Global constants: Enter the same value in a field on every record with a formula. = 145, for example, will enter 145 in every record.
- Delete a formula: You can delete a formula with delete the formula from the Field & Sort Settings tool.
- Override a formula: Entering a value without an = sign will override the formula for that record only and it is called a local value. If you then delete a local value, the formula will again calculate a value for the field.

RECAP

You enter a formula in a field, just as if you were entering a number or a word.

The formula uses numbers, field names, operators, and built-in functions.

Reflex calculates the field value based on the formula you have entered.
THE GRAPH VIEW

The Reflex **Graph View** gives you another way of looking at the information in your database.

The Reflex graph is designed to enable you to do graphic analysis. To make a graph, you simply specify the x-axis field and the y-axis fields. Menu options offer display and calculation choices. Reflex provides five types of graph: scatter graph, line graph, bar graph, cumulative (stacked) bar graph, or pie chart.

![Graph Example]

**INSTANT SUMMARY-TO-DETAIL**

Unlike conventional graphs, the Reflex Graph View isn't simply a static display. They are analytic graphs. You can use the graph to select points of interest. For instance, suppose you see a high point, such as a portfolio with particularly good returns. Select that point on the graph, and Reflex shows the detailed record behind it in the Form or List View.
Graphic Record Selection. Instantly see the record behind each point on the graph.

**GRAPH SUMMARIES**

When you graph individual records, Reflex displays each value. You may also graph summaries: totals, averages, counts, minimums, maximums, variances and standard deviations.

Graph with sum. Reflex adds up all the values for the x-axis entries.
GRAPH FOR EACH: THE Y-AXIS

Field values displayed on the y-axis can be instantly divided into categories based on unique entries in a field. For example, if you graph sales over time, you can divide the sales results into categories for each sales rep. The graph automatically puts up a separate line or set of bars for each.

MAKING A GRAPH

In this part, you learn how to make several graphs from the records in your database.

WHAT YOU’LL DO

- Make a graph of each sales rep’s sales and choose the most effective display
- See detailed records of significant points
- Change the graph to display totals
- Change the graph by adding another y-axis value

SET UP A GRAPH

To set up a graph in the Graph View, you follow these basic steps:

1. Enter the field name you want displayed on the x-axis.
2. Enter the field name(s) you want displayed on the y-axis.
3. Choose the type of graph: scatter, line, cumulative bar, parallel bar, or pie chart.

For this graph, we’ll use the monthly sales records of the Tyler Canoe Company. We have included a database for this tutorial on the Help disk, under the file name Sales. Retrieve the Sales file and open the Form View.
A Monthly Sales Record for
the Tyler Canoe Company.

The Tyler Canoe Company keeps track of sales by date, by
sales representative, and by product. You can see what
the sales records look like by scanning through them with the
[F7] and [F8] keys. Now you will graph this information.

1. Choose Graph from the
   Views menu, [VGR], Press
   ← to replace.

   Note that two menu titles
   have been added to the menu
   line—Graph and Type.

The Graph View.
When the Graph View is first opened, the X-axis Field name cell is highlighted. You start by entering a field name. Whatever field name you put here will determine what appears on the X-axis of your graph. Because the Choices key [F10] is so useful, we will use it exclusively in the following steps. However, you can type in the field names instead if you want to.

2. Press Choices [F10], scroll down to select Rep, and press ←. The x-axis cell becomes Rep.

3. Press ↓ once to select the first y-axis label cell. The y-axis label cell sits at the lower left of the screen.

You fill in the y-axis label cells with field names to determine what fields appear on the y-axis. There is only one label cell at present; as soon as you type in a field name, another cell will appear. You can have as many as eight fields on the y-axis.

4. Press Choices [F10] and select Sales $, then press ←. Reflex draws a graph of sales for each record in your database.

5. Press → once to select the empty y-axis label box. Use Choices to enter Total Cost. Reflex adds a second line to your graph.

<table>
<thead>
<tr>
<th>Total Cost</th>
<th>Views</th>
<th>Edit</th>
<th>Print/File</th>
<th>Records</th>
<th>Search</th>
<th>Graph</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Reflex has put each entry in the Rep field on the x-axis and graphed the corresponding Sales $ and Total Cost value in the form of a line graph.

**SEE DETAILED RECORDS FOR SIGNIFICANT POINTS**

There are several things you might want to do next: Scroll the graph to see more of it; select one of the points on the graph and see the individual record it represents; split the screen to see the graph and individual records at the same time; change the type of graph; change the graph to represent totals for each Rep; or add another value in the next legend box. These things can be done at any time. But for now, let's take them in order.

**SCROLLING THE GRAPH**

Scrolling in Graph View works as Page Right and Page Left do in List View.

Use the `Ctrl ←` and `Ctrl →` keys to scroll the graph.  

The current record is highlighted on the graph. (You can use the Previous Record `F7` and Next Record `F8` keys or the `←` and `→` keys to change the current record.)

As you scroll across the graph, notice that Alan's Sales $ line periodically drops very near or below the Total Cost line. We'll select one of those points to see what's happening.

**SELECTING RECORDS ON THE GRAPH**

Each point on the graph represents a value in a particular record. By selecting any point, you automatically make that record the current record. Scroll until one of Alan's below-cost sales is on the screen. We'll select the record on the graph, then see the record in the Form View.

1. Press the `↑` key 3 times to highlight the current record in the graph.  

   The rectangle around the current record is now highlighted.
2. Use the [←] and the [→] keys to move the highlight from point to point until one of Alan's sales-below-cost records is selected.

3. Open the Form View, /VF. Press [←] to replace the Graph View. One of Alan's records appears. He has sold paddles below cost.

[m] If you have a mouse, you can select a record by putting the pointer on the record in the graph and clicking the left button.

**SPLITTING AND RESIZING THE SCREEN**

Seeing individual records by selecting a point on the graph can be very useful. To make it even easier, let's split the screen to display both Graph and Form Views.

1. Open the Graph View, /VG. Type V to split the screen vertically. The Graph View is on the right.

2. Press [F6] to make the Form View active.

3. Choose Resize from the Views menu. /VR

4. Press [←] several times, until the shadow line is very close to the left column of fields in Form View.

5. Press [←]. Your previous graph will be shown on the right. Just enough of Form View will be displayed to show the sales figures on the graph.

Now you can use both views at once, selecting individual records in the Graph View and seeing all the details in the Form View. Of course, you can expand the active view at any time so that it fills the entire screen.

**SELECTING ANOTHER RECORD**

We'll continue selecting records to see if there is a pattern to Alan's sales/cost results.
The record corresponding to a point on the graph is displayed in Form View.

The Type menu displays the available graph types.

CHANGING THE GRAPH TYPE
When you choose Graph View, Reflex automatically uses a line graph. However, you can change the type of graph instantly to suit your needs. The types of graph available appear in the Type menu.

The Type menu displays the available graph types.
First, close the Form View

1. Press [F6], then choose Close from the Views menu. /VC

2. Choose Bar from the Type menu. The graph changes to a bar graph.

We'll leave the question of Alan's particular sales records for a moment, to take a look at some totals. How are sales going overall?

CHANGING THE GRAPH TO DISPLAY TOTALS

So far, you have seen individual records displayed on your graph, one for each record in your database. Reflex can automatically total the values displayed and graph them for each sales rep. In fact, the Reflex Graph View can calculate and display sums, counts, averages, minimums, maximums, standard deviations and variances.

To graph Totals, use the Graph Options tool:

1. Choose Options from the Graph menu. The options tool is displayed. /GO

2. Select the Summary cell.
The graph after Totals has been chosen.

<table>
<thead>
<tr>
<th>Views</th>
<th>Edit</th>
<th>Print/File</th>
<th>Records</th>
<th>Search</th>
<th>Graph</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SUM</td>
<td></td>
</tr>
</tbody>
</table>

3. Press **F10** to display the list of Summary Choices.

Notice that the summaries Reflex will Graph are: sum, count, average, minimum, maximum, variance, and standard deviation.

4. Select **@SUM** and press **←**. Proceed.

Reflex will total the values graphed for each x-axis entry.

5. Select the empty label cell.

6. Press Choices **F10** and select **$ Margin** from the choice list.

Your graph adds a **$ Margin bar**.

Clearly, Alan is doing well. He and Dave are your top sales reps. When you add another y-axis value, **$ Margin**, you will be able to compare how much each rep makes for the company.
As you might have expected, the dollar margin figures follow the sales dollars figures closely. Alan is certainly contributing his share. Let's look at sales per month.

**ENTER SEVERAL Y-AXIS VALUES AT ONCE WITH FOR EACH**

Often you will want to see separate lines or sets of bars, based on different categories in a field—a separate sales line for each sales rep, or a separate yield line for each product. Using the For Each command accomplishes this. It creates a separate y-axis graph for each value in another field.

Simply enter a new x-axis field to change the graph:

1. Select the x-axis cell and enter: **Date**
Total Sales, Total $ Margin, and Total Cost by month.

Your sales are generally rising. Normally, the canoe business is cyclical, with strong spring and fall seasons. This graph shows nothing you wouldn't expect. However, you can now break up the total Sales $ figures into a graph that represents how each sales rep is performing.

2. Choose For Each from the Graph menu. /GF

Reflex adds a cell for you to enter which field you want to use for your categories.
3. Enter: Rep  

The graph breaks up the total sales figures into four different bars, one for each sales rep.

This graph presents a somewhat different story. Alan's sales have taken off, and Cathy's are moving up. Dave is strong and steady as usual. But what is happening to Bob? In a time of rising sales, his are low.

Notice that we display values from the Sales $ field on the y-axis, but that we use the Rep field for the For Each.

FURTHER GRAPHIC ANALYSIS

This part has barely scratched the surface of the Graph View. You will want to experiment with changing the type to find the most effective display, entering a new x-axis field and new y-axis fields and trying different summaries. The Graph View works like the other views: You select a cell, enter what you want it to work on, and press \[→\].

We also recommend applying various filters to the database with the Search Conditions tool and seeing the effects on the graph. Graphing values from a working database provides visual representations of subsets of the records.

NOTES ON GRAPH VIEW

You can add a title to the graph with a Graph menu option. It will appear centered over the graph.

The Graph Scaling option enables you to override the automatic scales for the x- and y-axes and establish your own.

Use the Graph Print program on the Report & Utilities disk to print a Reflex graph.

RECAP

To make a graph, you enter a field name in the X-axis field cell and in as many y-axis label cells as you need (up to eight).
Four

Reflex Concept

Total sales for each product.

You can select a point on the graph and see the record displayed in the Form View.

You use **Summaries** to summarize the values graphed.

You use **For Each** to create a separate graph line or set of bars for each unique value in another field.

The Crosstab View gives you another way of looking at your information. It *summarizes the data* in categories, which you define. The Crosstab View provides quick and effective numerical analysis of your records.

**What is a Crosstab?**

The easiest way to explain a crosstab is with an example. Let's say you're sitting at your desk with today's sales receipts in front of you. Each receipt has a product name, a price, and a sales rep name. What you want is a *summary* of this information; actually, you want several different summaries.

First, you want total sales. So you go through each receipt and add up all the prices to get the total. You write it down on some paper.

Second, you want total sales *for each product*. So you divide your receipts into piles, one for each product. Then you go through each pile, adding up the sales from each receipt. You write the results in a little chart.

<table>
<thead>
<tr>
<th>Total Sales</th>
<th>Product A</th>
<th>Product B</th>
<th>Product C</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$2,700</td>
<td>$2,760</td>
<td>$3,330</td>
<td>$8,790</td>
</tr>
</tbody>
</table>

Third, you want total sales *for each sales rep*. So again you divide your receipts into piles, this time one pile for each sales rep. Then you go through each pile, adding up the prices. Again you write the results in a chart.
Total sales for each sales rep.

A simple cross-tabulation chart.

Fourth, you make a big chart with intersecting categories so you can quickly record the total sales for each product for each sales rep.

One last time you divide your receipts into even smaller piles. Each of the sales rep piles you divide into a pile for each product. Then you go through each pile, adding up the prices. You write the results in the squares on your chart. This way you can see at a glance how your people and your products are doing.

Very happy with the result, you think to yourself, "I wish I had a chart just like this with the average prices." So you go through each pile again . . .

That's the basic idea of a crosstab.

You define what kind of summary you want (total sales), and then divide the information into smaller categories (total sales for each product, total sales for each sales rep), and then cross the categories in the form of a chart so you can tabulate even more specific information (total sales for each product for each sales rep).

Reflex does it for you automatically.

**MANY DIFFERENT SUMMARIES**

A Reflex crosstab can show more than just total sales. It uses seven summary functions: @SUM, @AVG (average),
@COUNT, @STD (standard deviation), @VAR (variance), @MAX (maximum), and @MIN (minimum).

Sometimes you get information drawn straight from the database: maximum or minimum values, for example. Often, though, the summary produces a figure found on no individual record: sum, average, count, standard deviation, variance.

CROSSTAB ANALYSIS: DISPLAY OPTIONS
The crosstab results can use any of Reflex's numeric display options—fixed, general, scientific, financial, and currency. You can set the decimal precision to include as many as 15 digits. Or the crosstab can display the results as percentages, or indexes as well.

Because the Crosstab View is so flexible and quick, you can perform several different analyses in just a few minutes.

USING CROSSTABS FOR ANALYSIS
In this part, you use a series of crosstabs to analyze the Tyler Canoe Company's monthly sales records.

WHAT YOU'LL DO
- Set up a simple crosstab to become familiar with the basic concept
- Expand the crosstab into a full two-dimensional table that lets you see the relationships among the parts of your information
- Use the crosstab to perform several different analyses by changing the kind of summary function you want to perform

SET UP A CROSSTAB
Setting up a crosstab has two parts:
1. Entering a crosstab Summary function and a field name to determine the kind of summary you want the crosstab to calculate.
2. Dividing the data into categories. This is like dividing a stack of paper records into convenient piles for scrutiny.
We will cross-tabulate sales by sales rep for each product.

1. Retrieve the Sales file from the Help disk, if necessary. *This is the same database as used in the previous tutorial.*

Before we get started, let's change some of the display formats from Currency to Financial. You may notice at times that numbers are occasionally displayed as a string of asterisks. This means there's not enough room to display it. You may then either widen the column (IES) or change the display format to one which takes less room.

2. Open the Field & Sort Settings tool /RF and choose the format cell for Sales $ and use [F10] to change it to Financial. *The format cell displays financial.*

Now we'll introduce a very useful feature—the Ditto feature. It is used to copy the value from a cell to the one below it. (It is particularly useful for data entry in the List View.)

3. Press [↓] to select the format cell for the Avg Price field. Enter "" (ditto—double quote) and press [←]. *The Financial format is copied from the cell above.*

4. Repeat step 3 for the next 3 rows (Unit Cost, Total Cost, and $ Margin). *They are all set to Financial.*

5. Open the Crosstab View, called Xtab on the Views menu. /VX
The Crosstab View when it first appears.

The first cell, the **Summary** cell, is highlighted, ready for you to enter the kind of summary you want. The **Field** cell is where you will enter the field name you want to use. More columns and rows will be added as you need them. As the screen stands when you first see it, you have a small crosstab with one column heading and one row heading. “All” means that all the records are considered for that row and that column. The crosstab begins as a summary of all the records.

6. Press Choices [F10] and select @SUM Press [→]. The first summary you want to see is the total sales dollars. The @SUM function will add all the values in the field you enter next.

7. With the Field cell selected, press Choices [F10], scroll the list of fields, and select **Sales $** from the choice list. Press [←]. @SUM will add all the values in the Sales $ field across all the records.

Immediately, your crosstab presents its first result: the total sales dollars for all records in your database.
Your first crosstab. The results reflect what you have entered in the Summary and Field cells.

Although this is a simple crosstab, the general principle is clear. The crosstab shows the answer to the question, “What were the total sales for all products and all sales reps?”

**MAKING SMALLER CATEGORIES**

Most often you will want to divide a field into categories, one for each unique entry. To do this, use For Each on the Crosstab menu.

We will divide the Rep field, creating one column for each.

1. Choose For Each from the Crosstab menu. The Crosstab For Each tool appears.
The Crosstab For Each tool.

Your first choice is whether you want the sales reps’ names displayed along the top (as column headings) or along the side (as row headings). Let’s put them in column headings across the top.

2. Press ↑ and then ← to select the Column checkbox and press ←.

3. Enter: Rep

4. Proceed.

The cursor moves to the Field Name cell.

Use Choices or type it in.

Your crosstab automatically expands to show Sales $ for each sales rep.

Reflex has looked through the entries in the Rep field and has created one column for each. The results cells display the total sales for each sales rep.
Your second crosstab. Now you have summarized the sales of each of your sales reps.

<table>
<thead>
<tr>
<th>Views</th>
<th>Edit</th>
<th>Print/File</th>
<th>Records</th>
<th>Search</th>
<th>Crosstab</th>
</tr>
</thead>
</table>

**CROSSTAB**

- **Summary:** SUM
- **Field:** Sales $

<table>
<thead>
<tr>
<th>Rep</th>
<th>ALL</th>
<th>&quot;Alan&quot;</th>
<th>&quot;Bob&quot;</th>
<th>&quot;Cathy&quot;</th>
<th>&quot;Dave&quot;</th>
<th>ALL</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>389,497</td>
<td>135,713</td>
<td>238,552</td>
<td>255,781</td>
<td>931,463</td>
<td></td>
</tr>
</tbody>
</table>

**MAKE THE CROSSTAB TWO-DIMENSIONAL**

Why is Bob lagging behind? Breaking down the sales for each product for each rep might give you a clue. Just as you used For Each to create categories for each sales rep, you can use it to create categories for each product.

1. Choose For Each from the Crosstab menu. **/CF**

2. Select the Row checkbox, if necessary, and press ←.

**NOTE** Be certain to select the Row checkbox, so you don't erase the columns for Rep with columns for Product.

3. Enter **Product** in the Field **Name** cell. Then proceed.
Your two-dimensional crosstab.
Now you have a cross-tabulation of the total sales for each sales rep by each product.

It's now pretty clear that the reason Alan is doing so well is that he's concentrating on the top-of-the-line Tyler Silent canoes. Bob, by contrast, has done very poorly with the Silent. Bob also has the lowest sales in all product categories.

**CHANGE THE CROSSTAB FOR ANALYSIS**

You can change this crosstab in several ways to continue examining the relationship between your sales reps and your products.

- You can change the *summary* function or the *field* simply by selecting it and entering new ones.
- You can change the display by choosing Options from the Crosstab menu.

**CHANGING THE SUMMARY FUNCTION AND FIELD**

First, let's see how much each product and each sales rep contributes to the dollar margin:

1. Select the Field cell, and enter $ Margin. Use Choices [F10] or type it in.
Crosstab: $ Margin by Rep for each Product.

This crosstab confirms some of what you already knew: Alan's performance is very good on all products except paddles. Bob, on the other hand, has a poor showing with everything but paddles. Some questions come to mind: Is Bob pushing for too high a price on paddles (his sales were lowest but his $ Margin is highest)? Should he be concentrating on selling the more profitable canoes? Conversely, is Alan selling paddles below cost to generate sales on the other products? Looking at the average of Avg $ Margin will give you the perspective you need.

This time you will change both the Field cell and the Summary cell. But before you do, you will learn a step that will save recalculation time on large databases.

2. Select the Field cell and press Del. The results area goes blank.

If you had changed the Field cell the new crosstab would have been recalculated. Deleting the Field cell just turned the crosstab off temporarily.

3. Select the Summary cell, and enter @AVG. Use Choices F10 or type it in.

4. Select the Field cell, and enter Avg $ Margin. Use Choices F10 or type it in.
Crosstab: Average $ Margin by Rep for each Product.

Sure enough, Bob's Avg $ Margin is higher than all the other salesreps on every product except Silents, and is especially high on paddles. And although Alan is selling paddles below cost, the high Avg $ Margin that he's getting on Silents is enough to give him the highest total $ Margin among the four sales reps.

**CHANGING THE DISPLAY**

The Crosstab display options are useful to clarify the information within the crosstab. Instead of displaying the summary figures as numbers, you can display them as percentages. It is often easier to see how the categories compare this way.

1. Change the Summary cell back to @SUM. Use Choices F10 or type it in.

2. Change the Field cell back to $ Margin. Use Choices F10 or type it in.

3. Choose Options from the Crosstabs menu. The Options tool appears.
The top row is a series of checkboxes for the way data is displayed in the results cells. We will choose % Column so that we can see the results in percentages, showing what percent of each rep's sales came from each product.

The % Column choice changes the numbers into percentages in each column. Each number is the percentage for that cell over all records for that column.

4. Move the cursor to the % Column checkbox and press $\rightarrow$.

We'd also like to set the display format so no digits to the right of the decimal are shown.

5. Select the Display Format cell.


7. Select Fixed and press $\rightarrow$.

8. Enter 0 in the Precision cell.

The following step is a new instruction for proceeding from a tool immediately, without having to move the cursor from
Total of dollar margin, %
Column display.

Two important pieces of information are quickly revealed by this crosstab. The first is that reps with a lower percentage of their $ Margin in Paddles have a higher percentage in Silents. The second is that Silents are very important to total company $ Margin and Paddles are not. And from the previous crosstab of Avg $ Margin, you know that Silents are the highest $ Margin per unit item you have to sell. It looks like Bob might benefit from a selling strategy of deeper discounts on Paddles to improve his $ Margin on Silents and thus improve his $ Margin overall.

MAKE RANGES

The Make Ranges command enables you to break a numeric field into a set of ranges for use as categories. It is similar to the way For Each divides a text or date field into unique entries. Make Ranges does not use unique entries, but a set of numeric ranges.
Your commission policy is specifically designed to encourage your sales reps to concentrate on high-percentage margin sales. You are going to use a crosstab to evaluate sales activities for different percentage margins. Because you want a general idea of sales activity, you will summarize for total quantity sold within each range.

1. Choose Options from the Crosstab menu and return the type of data to Number.

2. Select the Field cell and enter Quantity. The results area changes to display total quantity.

3. Choose Make Ranges from the Crosstab menu. The Crosstab Ranges tool appears.

4. Select Row and press . You want to substitute the ranges of % Margin for the products, leaving the reps.

5. Enter % Margin in the Field cell. You will divide the records into ranges based on values in this field.

The range you will enter is from zero to 60 by 10. This makes a series row headings, thus creating categories for the crosstab. (This will become clear as you do it.)
FOUR

ADVANCED TUTORIAL

6. Enter these values: After a few moments of calculating, Reflex displays the new crosstab.

From: 0
To: 60
By: 10

and proceed.

Before looking at this crosstab closely, change the column width of the row headings so you can see the categories. Select any row heading cell; then use the Set Column Width command on the Edit menu to make the column wider.

As you can see, Bob's sales activity is skewed toward the higher percentage margins. The large number at % Margin 20–30 is undoubtedly paddles. The others show more large-number activity in lower margin ranges.

INSERTING AN ADDITIONAL CATEGORY

For Each and Make Ranges are not the only way to create column or row headings. You can enter search conditions into headings one at a time, as many as you like.

As you remember, Alan had several sales in which the % Margin was below zero. You will insert another row heading above the current top row and enter a condition to capture these records.
1. Select the top row heading. It currently has % Margin UPTO(0,10).

The expression UPTO(0,10) is a range operator used in Reflex to set search conditions. It is the same as >= 0 and < 10; that is, the range includes the lower number, but stops short of the upper number.

2. Press Ins. A blank row is inserted above the top row.

3. In the empty row heading cell, enter: % Margin < 0. This establishes a row for all the records in which the % Margin field is less than zero.

The crosstab displays the total quantity of sales where the margin was less than zero in the new top row. In fact, the new heading displays results for Cathy as well as Alan. Has she picked up the practice from him?

THE PRACTICAL RESULTS OF CROSSTABS

If these were your own business records, you would certainly have several topics of conversation the next time you talked with your sales staff.

Alan may have found an effective technique that the rest of your sales reps could profit from. You may want to encourage Bob to take less profit on paddles and concentrate on selling larger quantities of canoes. You have spotted an area of great potential if you can help Bob increase sales of the Tyler Silent.

In short, your understanding of what is going on is increased. One of the goals of Reflex is to help determine which questions ought to be asked, as well as to help answer them.

NOTES ON THE CROSSTAB VIEW

The Crosstab menu presents several options for Named Crosstabs. You can save, retrieve, and erase crosstab specifications in a file on your data disk. This allows you to set up a useful crosstab, save it, and invoke it again when your data has been updated.
You can enter any valid search condition in a heading cell for use in a crosstab. This allows you to make a crosstab like this:

```
<table>
<thead>
<tr>
<th>Rep</th>
<th>Field: Sales $</th>
<th>% Margin (25% Margin) = 25%</th>
<th>% Row</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alan</td>
<td>17</td>
<td>83</td>
<td>100%</td>
</tr>
<tr>
<td>Bob</td>
<td>6</td>
<td>92</td>
<td>100%</td>
</tr>
<tr>
<td>Cathy</td>
<td>13</td>
<td>87</td>
<td>100%</td>
</tr>
<tr>
<td>Dave</td>
<td>38</td>
<td>78</td>
<td>100%</td>
</tr>
<tr>
<td>All</td>
<td>18</td>
<td>82</td>
<td>100%</td>
</tr>
</tbody>
</table>
```

For complete directions, see the “Crosstabs” section of Reference A.

**RECAP**

Enter a summary function and a field name to determine the kind of summary information you want Reflex to produce in your crosstab.

Divide the information in your fields into smaller categories in the column and row headings.

Change the crosstab to explore the meaning of your information.
REFLEX CONCEPT

VARY

Vary is a Reflex tool that creates records automatically. You can use Vary to create extensive sets of new records for filling out a standard form. And you can create sets of hypothetical records for planning and forecasting.

AUTOMATIC STANDARDIZED DATA ENTRY

Records in a database often require repetitive entries: product names, dates, division names, and so on. In such cases, you will find it useful to set up a series of records with these values already established and blank fields left to be filled in later—in effect, creating a skeleton for the database. Using the Vary tool, you can automatically create such records.

For example, suppose that your company has three regional divisions, each selling the same group of products, and that you are setting up a database to keep track of the results. You can use Vary to create three divisional records.

Vary creates three records at once.

Division
Product
Sales

Then, typing a list of products common to all divisions, you create further records for each product for each divisional record.
Vary creates one record for each product for each division.

Your database is established. Empty fields (such as Sales) on each record wait to be filled in with specific numbers, but all the records with common entries have been created automatically. You not only reduce the time it takes to enter this information, but you also establish a record for each necessary entry. You can see at a glance what information is missing.

**AUTOMATIC HYPOTHETICAL DATA**

The Vary tool is a shortcut for putting numbers in records. This is a powerful way to make the most of business models, since you can create many what-if scenarios at the same time. Vary automatically enters a range of numbers, creating records for each successive entry.

Consider a familiar what-if question: "What would be the effect of a price change on profits?" You have entered formulas that return profits based on price and quantity and formulas that return quantity based on price. You could enter each possible price into a record, one at a time, and see what results the model produces. But that's slow. Also, you'd have a record of only the last possibility you tried.

What you really need is a set of records returning profits for various prices—say, all prices between $3000 and $4000, at $100 intervals. Use Vary to enter the range of prices, and instantly you have a complete set of records, showing profit for each entry.
Vary enters a range of numbers, and the models calculate values for each new record.

You can now analyze your hypothetical data with Graph View and Crosstab View, just as if you were analyzing historical records.

PART 4

PLANNING BREAK-EVEN ANALYSIS

In this lesson, we will set up a hypothetical database and use it to plan part of the introduction of a new product. We will use Vary to create many records instantly and the other Reflex features to understand the model.

WHAT YOU'LL DO

☐ Set up a new database
☐ Enter data with Vary
☐ Create several models
☐ Graph the results to find the exact break-even point

CREATE A BREAK-EVEN MODEL

Your basic task is to predict how many new canoes need to be sold at various prices before the company starts to make a profit on them. The database you set up needs fields for projected price, units, different costs (fixed, variable, and total), and expected revenue and profit.
If you still have a database in memory, choose Clear Database from the Records menu (/RC). Confirm by typing Y when the prompt message appears. The screen clears, and you are ready to start.

Begin in Form Design.

1. Type these field names in a column down the left edge of the screen:

   - Price
   - Units
   - Revenue
   - Fixed Cost
   - Variable Cost
   - Total Cost
   - Profit

2. Choose Exit Design from the Form menu. /FE

   This returns you to Form View.

You establish the overall model of your break-even analysis in Form View. Assume a price of $1000. Fixed costs are estimated at $400,000, and each canoe will have additional variable costs of $150.

3. Enter the following formulas and values in the appropriate field:

   - Price:  = 1000
   - Units:  = 200
   - Revenue:  = Price * Units
   - Fixed Cost:  = 400000
   - Variable Cost:  = 150 * Units
   - Total Cost:  = Fixed Cost + Variable Cost
   - Profit:  = Revenue - Total Cost

NOTE Remember that Reflex sets the field type based on your first entry. If you accidentally enter a formula without the =, these fields will become text fields, and they will not accept the revised formula. You can change the field type in Field & Sort Settings.
USE VARY TO CREATE RECORDS

You have set up a model for your break-even analysis. Now you will use the Vary tool to enter a series of values automatically.

Choose Vary from the Records menu. The Vary tool appears.

When you fill out the Vary tool and proceed, Reflex creates a set of records. For now, you will put values from 250 to 1000 with intervals of 50 in the Units field. The values in the calculated fields which depend on the Units value will be calculated for each record.

Fill out the tool according to the following steps:

1. In the Field to vary cell, type: Units
2. In the From cell, type: 250
3. In the To cell, type: 1000
4. In the By cell, type: 50
5. Select the Vary Only the Current Record cell, then proceed.
Graph the Calculated Values

Your database now has 17 records in it, each with a different Units value. The Reflex Graph View will quickly show the relationship between revenue and total cost.

1. Open the Graph View. Split the screen and resize it so that a portion of the Form View is visible.

2. Select the x-axis Field cell and enter: Units

3. Select the first y-axis label box and enter: Total Cost

4. Select the second y-axis label box and enter: Revenue

5. Press [→] three times to select the graph area.

6. Use the [→] key to select the break-even point on the graph.

The break-even point is where the lines cross—that is, where revenue overtakes total costs and begins to produce profit.

The current record indicator becomes a solid highlight.

The current record, displayed in Form View, shows the records on either side of break even.
You immediately see the break-even is approximately 450 units. To refine this further, you may want to do a more detailed Vary, say from 450 to 500 by 5.

**NOTES ON VARY**

If the Field to Vary is a text field, the From..To..By line is replaced with a Text entry box. You can enter a series of words into the field by typing them into this box. Separate the words with commas. For example, enter: North, South, East, West and Reflex will create four records, one for each word.

If the Field to Vary is a date field, Reflex enters a series of dates. Enter the beginning date, the ending date, and the number of days interval.

**RECAP**

Set up a hypothetical database just as you would any database.

Enter formulas to calculate a model of the information you want to look at.

Use Vary to create records with a series of values in a field.

Analyze the result with filters, graphs, and crosstabs.

**THE REPORT VIEW**

The Report View gives you a way of printing customized reports of the information in your database.

The Report View enables you to select information from your database, lay it out in a clear way, and print it.

**FLEXIBLE REPORT FORMATS**

You can create a report format which suits your needs exactly. You can print detailed lists of information, mailing labels, or
Your Reflex report may be long and detailed. Use headers, footers, titles, and conclusions.

You may want a long, detailed report with subtotals, averages, and cumulative totals along the way:

<table>
<thead>
<tr>
<th>REP PRODUCT</th>
<th>SALES</th>
<th>PERCENT TOTAL</th>
<th>CUMULATIVE SALES NET MARGIN FOR EACH MONTH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alan Paddles</td>
<td>$6,550</td>
<td>0.70 %</td>
<td>$6,550</td>
</tr>
<tr>
<td>Alan Silent</td>
<td>$16,835</td>
<td>1.81 %</td>
<td>$23,385</td>
</tr>
<tr>
<td>Alan Sport</td>
<td>$4,976</td>
<td>0.53 %</td>
<td>$28,861</td>
</tr>
<tr>
<td>Alan Swiftwater</td>
<td>$6,672</td>
<td>0.72 %</td>
<td>$35,533</td>
</tr>
<tr>
<td><strong>Total For Alan</strong></td>
<td><strong>$35,033</strong></td>
<td><strong>3.76 %</strong></td>
<td><strong>$7,164.35</strong></td>
</tr>
<tr>
<td>Bob Paddles</td>
<td>$5,235</td>
<td>0.56 %</td>
<td>$40,268</td>
</tr>
<tr>
<td>Bob Silent</td>
<td>$6,450</td>
<td>0.69 %</td>
<td>$60,718</td>
</tr>
<tr>
<td>Bob Sport</td>
<td>$3,794</td>
<td>0.41 %</td>
<td>$50,512</td>
</tr>
<tr>
<td>Bob Swiftwater</td>
<td>$7,433</td>
<td>0.80 %</td>
<td>$57,955</td>
</tr>
<tr>
<td><strong>Total For Bob</strong></td>
<td><strong>$22,912</strong></td>
<td><strong>2.46 %</strong></td>
<td><strong>$5,916.65</strong></td>
</tr>
<tr>
<td>Cathy Paddles</td>
<td>$4,613</td>
<td>0.50 %</td>
<td>$62,558</td>
</tr>
<tr>
<td>Cathy Silent</td>
<td>$6,709</td>
<td>0.72 %</td>
<td>$69,267</td>
</tr>
<tr>
<td>Cathy Sport</td>
<td>$2,667</td>
<td>0.29 %</td>
<td>$71,934</td>
</tr>
<tr>
<td>Cathy Swiftwater</td>
<td>$5,728</td>
<td>0.61 %</td>
<td>$77,662</td>
</tr>
<tr>
<td><strong>Total For Cathy</strong></td>
<td><strong>$15,777</strong></td>
<td><strong>2.12 %</strong></td>
<td><strong>$4,059.45</strong></td>
</tr>
<tr>
<td>Dave Paddles</td>
<td>$6,325</td>
<td>0.68 %</td>
<td>$83,987</td>
</tr>
<tr>
<td>Dave Silent</td>
<td>$11,760</td>
<td>1.26 %</td>
<td>$95,747</td>
</tr>
<tr>
<td>Dave Sport</td>
<td>$5,831</td>
<td>0.63 %</td>
<td>$101,578</td>
</tr>
<tr>
<td>Dave Swiftwater</td>
<td>$11,836</td>
<td>1.27 %</td>
<td>$113,414</td>
</tr>
<tr>
<td><strong>Total For Dave</strong></td>
<td><strong>$35,752</strong></td>
<td><strong>3.84 %</strong></td>
<td><strong>$8,127.45</strong></td>
</tr>
<tr>
<td><strong>Total For Jan-85</strong></td>
<td><strong>$113,414</strong></td>
<td><strong>12.18 %</strong></td>
<td><strong>$25,867.90</strong></td>
</tr>
<tr>
<td>Alan Paddles</td>
<td>$6,635</td>
<td>0.71 %</td>
<td>$6,635</td>
</tr>
<tr>
<td>Alan Silent</td>
<td>$16,317</td>
<td>1.76 %</td>
<td>$22,952</td>
</tr>
<tr>
<td>Alan Sport</td>
<td>$5,677</td>
<td>0.65 %</td>
<td>$28,629</td>
</tr>
<tr>
<td><strong>Total For Alan</strong></td>
<td><strong>$35,033</strong></td>
<td><strong>3.76 %</strong></td>
<td><strong>$7,164.35</strong></td>
</tr>
<tr>
<td><strong>Year-To-Date :</strong></td>
<td><strong>$931,463</strong></td>
<td><strong>12.18 %</strong></td>
<td><strong>$211,891.85</strong></td>
</tr>
</tbody>
</table>

Page: 4
Or you may need only a short summary of the information:

A short summary report.

<table>
<thead>
<tr>
<th>PRODUCT</th>
<th>SALES</th>
<th>NET MARGIN</th>
<th>PERCENT MARGIN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paddles</td>
<td>$22,723</td>
<td>$3,858</td>
<td>17.97%</td>
</tr>
<tr>
<td>Silent</td>
<td>$41,754</td>
<td>$18,384</td>
<td>43.79%</td>
</tr>
<tr>
<td>Sport</td>
<td>$17,268</td>
<td>$5,178</td>
<td>29.92%</td>
</tr>
<tr>
<td>Swiftwater</td>
<td>$31,669</td>
<td>$13,752</td>
<td>43.92%</td>
</tr>
<tr>
<td>Jan-85 Total</td>
<td>$113,414</td>
<td>$41,172</td>
<td>36.69%</td>
</tr>
<tr>
<td>Paddles</td>
<td>$21,375</td>
<td>$3,665</td>
<td>17.93%</td>
</tr>
<tr>
<td>Silent</td>
<td>$35,917</td>
<td>$14,257</td>
<td>40.01%</td>
</tr>
<tr>
<td>Sport</td>
<td>$15,416</td>
<td>$4,107</td>
<td>26.79%</td>
</tr>
<tr>
<td>Swiftwater</td>
<td>$40,877</td>
<td>$3,858</td>
<td>9.48%</td>
</tr>
<tr>
<td>Feb-85 Total</td>
<td>$113,414</td>
<td>($121)</td>
<td>(1.05)%</td>
</tr>
<tr>
<td>Paddles</td>
<td>$75,903</td>
<td>$14,073</td>
<td>18.67%</td>
</tr>
<tr>
<td>Silent</td>
<td>$31,329</td>
<td>$4,107</td>
<td>13.33%</td>
</tr>
<tr>
<td>Sport</td>
<td>$4,087</td>
<td>$1,166</td>
<td>28.82%</td>
</tr>
<tr>
<td>Swiftwater</td>
<td>$241,029</td>
<td>$92,166</td>
<td>39.00%</td>
</tr>
<tr>
<td>Jun-85 Total</td>
<td>$338,286</td>
<td>$134,163</td>
<td>40.00%</td>
</tr>
</tbody>
</table>

===================== YEAR-TO-DATE =====================

| Total   | $338,286 | $134,163 |
| Average | $9,703   | $3,496   |
| Minimum | $1,167   | ($1,812) |
| Maximum | $43,876  | $22,786  |

SET UP AND PREVIEW YOUR REPORT

To set up your report, you “draw a picture” of the way you want it to look, and what information you want it to print. Reflex takes what you create on the screen and uses that information to create the report.

The Preview on Screen feature allows you to preview your report before you print it. Typically, you will gradually build up a report, previewing it on the screen at each step of the way to see what it looks like.

SUMMARY AND DETAIL

Reflex’s Report View allows you to see both detail and summary. Summary calculations include totals, averages, counts, minimums, maximums, variances, and standard deviations. Percentages and running totals may be printed. In addition to totals at the end of the report or at the end of each page, subtotals may be printed on a break in any sort field.
You can sort and filter the database to obtain specific reports based on subsets of the whole.

---

**DESIGNING AND PRINTING A REPORT**

In this lesson we will set up and print out a sales report.

**WHAT YOU’LL DO**

- Retrieve a database.
- Sort the records.
- Design the report.
- Preview the report on the screen and make modifications.
- Print the report.
- Save the report specifications for later use with other data.

**START THE REPORT AND UTILITIES PROGRAM**

The Reflex Report View is on the Report & Utilities disk. You need to start with the Report & Utilities title screen, which comes up when you run Reflex2 from this disk.

1. Assuming that you are already running Reflex, return to DOS by choosing Quit from the Views menu. IVQ

2. Confirm by typing Y for “yes”.

3. Remove the Reflex system disk from Drive A and insert the Report & Utilities disk.

4. At the A> prompt, type in Reflex2 and press [Enter].

The message line will ask for confirmation.

The DOS A> prompt appears.

DESIGNING AND PRINTING A REPORT

The Report & Utilities title screen. The Report check box has been highlighted.

BRINGING UP THE REPORT VIEW
You can bring up any of the programs on this disk by selecting the appropriate option.


The Report View.

When printed column

Row: 1 From Col: 1 through Col: 1 Design area Summary
The Report Design screen is similar to the main program screen, but the main menu titles are different, and the windows area is permanently divided into the When Printed column and the Design area.

**THE BASIC APPROACH**

The basic approach to creating a report is to provide two types of information:

1. What you want printed, e.g., data, titles, totals and subtotals, etc.
2. When you want each row in your report description printed, e.g., at the top of each page, once for every record, every time a sort key changes (as in subtotals), etc.

The screen layout for Report View is designed specifically to make it easy to provide these two sets of information. The main area—the **Design area**—is where you specify what you want printed. On the left is the **When Printed Column** where you say when to print each row.

The other key aspect of Reflex's approach to reporting is that it is designed to enable you to take a *step-by-step approach*. There is a preview on screen feature which shows you what the report will look like on paper. So while you are building up the report description, you can often check to see what it will actually look like, and progress from there.

**A PEEK AT THE FINAL REPORT**

Especially for a fairly complex report, it is a good idea to have the final product in mind. In this case we want to end up with a report that looks like the print-out on the next page.
The final report.

### TYLER CANOE COMPANY SALES
January -- June, 1985

<table>
<thead>
<tr>
<th>Date</th>
<th>Rep</th>
<th>Product</th>
<th>Total Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan-85</td>
<td>Alan</td>
<td>Paddles</td>
<td>$6,550</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Silent</td>
<td>$16,835</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sport</td>
<td>$4,976</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Swiftwater</td>
<td>$6,672</td>
</tr>
<tr>
<td></td>
<td>Bob</td>
<td>Paddles</td>
<td>$5,235</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Silent</td>
<td>$6,450</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sport</td>
<td>$3,794</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Swiftwater</td>
<td>$7,433</td>
</tr>
<tr>
<td></td>
<td>Cathy</td>
<td>Paddles</td>
<td>$4,613</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Silent</td>
<td>$6,709</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sport</td>
<td>$2,667</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Swiftwater</td>
<td>$5,728</td>
</tr>
<tr>
<td></td>
<td>Dave</td>
<td>Paddles</td>
<td>$6,325</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Silent</td>
<td>$11,760</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sport</td>
<td>$5,831</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Swiftwater</td>
<td>$11,836</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Total Sales for Jan-85:</strong> $113,414</td>
</tr>
</tbody>
</table>

| Feb-85| Alan  | Paddles  | $6,635      |
|       |       | Silent   | $16,317     |
|       |       | Sport    | $2,477      |
|       |       | Swiftwater | $9,294     |
|       | Bob   | Paddles  | $4,583      |
|       |       | Silent   | $3,267      |
|       |       | Sport    | $3,926      |
|       |       | Swiftwater | $8,892    |
|       | Cathy | Paddles  | $4,432      |
|       |       | Silent   | $6,878      |
|       |       | Sport    | $2,043      |
|       |       | Swiftwater | $6,102    |
|       | Dave  | Paddles  | $5,725      |
|       |       | Silent   | $9,455      |
|       |       | Sport    | $3,370      |
|       |       | Swiftwater | $16,639   |
|       |       |          | **Total Sales for Feb-85:** $113,585 |

| Mar-85| Alan  | Paddles  | $6,487      |
|       |       | Silent   | $12,509     |
|       |       | Sport    | $7,324      |
|       | Bob   |          |             |
|       |       | Silent   | $8,795      |
|       |       | Sport    | $24,351     |
|       |       | Swiftwater | $8,701     |
|       |       |          |             |
|       |       |          | **Total Sales for Jun-85:** $241,029 |
|       |       |          | **Total Sales for January -- June:** $931,463 |

To produce this report, our Report design screen will look like this:
The Report definition which creates the sales report.

<table>
<thead>
<tr>
<th>Report</th>
<th>Edit</th>
<th>Print/File</th>
<th>Search</th>
<th>Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intr</td>
<td>Intr</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Head</td>
<td>Date</td>
<td>Rep</td>
<td>Product</td>
<td>Total Sales</td>
</tr>
<tr>
<td>Head</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Body</td>
<td>Date</td>
<td>Rep</td>
<td>Product</td>
<td>Sales $</td>
</tr>
<tr>
<td>1-Da</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1-Da</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conc</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Row flags

Row: 1 From Col: 1 through Col: 1  Summary

The entries in the Design area describe what to print in the report. The row flags in the When Printed column say when to print each row: **Header** means at the top of each page; **Body** means once for each record; and **1-Date** means that Date is the first sort field and the row should be printed whenever the Date field changes (this is used to print subtotals by date).

We will now build this report up from scratch.

**DESIGNING A REPORT**

There are four steps to designing a report:

- Retrieve the database you want to use.
- Sort the records.
- Design the report.
- Print the report.

**RETRIEVE THE DATA YOU WANT TO USE**

The first thing to do is to retrieve the database from your data disk. The Retrieve File command is on the Print/File menu.

1. Insert the Help disk in Drive A.  
   *This disk has the sample files on it.*

2. Choose Retrieve File from the Print/File menu, /PR.  
   *The Retrieve File tool appears.*
3. If necessary, change the Directory designation to A:\

4. Press Choices [F10] to display a choice list of file names, and select Sales.

5. Proceed. The Sales database is retrieved from the data disk.

6. Press [F10] to see a choice list of the field names in this database.

The field names in your Sales database.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>@Today</td>
<td>Date</td>
</tr>
<tr>
<td>@Now</td>
<td>Product</td>
</tr>
<tr>
<td>@Page-No</td>
<td>Quantity</td>
</tr>
<tr>
<td>@New Page</td>
<td>Rep</td>
</tr>
<tr>
<td>$ Margin</td>
<td>Sales $</td>
</tr>
</tbody>
</table>

The first four choices are special fields available for any Reflex report. They are used for the current date and time, and pagination. The remaining field names are drawn from the file you have retrieved. We won't need to use all the field names; in fact all the information for our report will be in the Date, Rep, Product, and Sales $ fields.

7. Use the ↓ key to scroll through the other fields.

8. Press Esc to put the choice list away.

**SORT THE DATABASE**

The Report View prints your records in the order they are sorted in the database. To get meaningful subtotals, records must be sorted by the fields you want to subtotal by. For example, to get total sales by month, you need to sort by month.

The Report View Sort tool is a small version of the Field and Sort Settings tool, presenting only the Field, Sort #, and A/D columns. You establish the sort order in the same way as you do it in the main program.
The primary sort field will determine the large categories of the report. Our report is going to present the records for each month, and within each month, broken down by sales rep. Thus we need to make Date the primary sort field, and Rep the secondary sort field.

2. Enter a 1 by the Date field, and a 2 by the Rep field.

The A/D column is used to specify ascending or descending order. We'll leave both sort fields in ascending order.

3. Proceed.

Now we get to actually design the report.

**ENTER FIELD NAMES**

Reflex will print the data from a field when you enter a field name in the design area. Let's start by entering field names on the first row.

We strongly recommend using Choices [F10] to enter field names, for speed and accuracy. You can, if you prefer, type in field names. The general rule for entering field names is select the location, press [F10] to bring up Choices, select the field name you want, and press [←].

1. Press [F10], select Date, and press [←]. Then press [←] twice (to position the cursor for the next field name).

2. Your cursor should be on row 1, column 16. Use Choices [F10] to Enter Rep at this spot. Then press [←] once.
3. Your cursor should be on row 1, column 36. Use Choices to Enter Product at this spot. Then press [ ] once.

4. Your cursor should be on row 1, column 56. Use Choices to Enter Sales $ at this spot.

Each row in the Report design has a row flag in the When Printed Column; it tells Reflex when to print that row. The Body row flag means, “print this row once for each record in the database.” It is the body of the report. In the row you have just finished, Reflex will print data from each of the four fields for each record. Take a look:

5. Choose Preview on Screen from the Report menu, /RP. The Report design screen disappears and is replaced with the preview screen.
Here you see the result of entering field names: *data gets printed where you placed the field names in the design area.* The message line asks you whether to continue previewing your report, or to return to the design screen.

6. Press ← a few times to see subsequent pages of the report.

You can return to the design screen at any time by typing Q, or by selecting Quit and pressing ←.

As you page through your report you will notice that the records reflect the sort order. It would be useful to have a subtotal for each month.

**SUBTOTALS FOR SORT FIELDS**

We anticipated the need for a monthly subtotal when we sorted the database with Date as the primary sort field. The sort fields have their own row flags which tell Reflex to “print this row when the entry in this sort field changes.”

*To get a subtotal, you need to do three things:*

- Enter a field name.
- Specify a summary function, e.g., @SUM, for that field name.
- Enter a row flag to tell Reflex when to print the subtotal.

1. Return to the design screen.

2. Position the cursor on row 2, column 56, directly beneath the Sales $ entry on row 1.

3. Enter Sales $ After you have entered Sales $, don’t move the cursor. You need to select the field name you have just entered in order to enter a summary for it.
The Sales $ field formula.

4. Press Choices \([F10]\) to display a choice list of summaries.

5. Select \(@SUM\) on the choice list and press \([\leftarrow]\). The Sales $ field name changes to \(@SUM(Sales $)\).

When you enter this summary function, Reflex creates a formula which calculates the sum of the values in that field.

Note also that when the Sales $ field name was selected, Choices didn't show a list of field names, it showed a list of available attributes. It always works this way — if you select something already there, Choices shows you available attributes for that selection. In this case it was summary functions for the Sales $ field. In fact, there are many other types of attributes as well. We'll get to those later.

As it stands now, Reflex will print this new row once for every record in the database, so the sum of Sales $ means only the sum of Sales $ for that record, which is the same as the simple Sales $ figure.

To resolve this, we'll go to the When Printed column to say to print this row only when the Date changes. This will give us totals by date.

6. Press \([F3]\) to select the When Printed column. The special highlight extending across the design area is to remind you that row flags apply to the entire row.

7. Press Choices \([F10]\) to see a choice list of row flags.

The Row Flags.
Here is what each row flag means when it is entered in the When Printed column:

- **Intro** prints the row once at the beginning of the report.
- **Header** prints the row once at the top of each page of the report.
- **Body** prints the row once for each record in the working database.
- **Footer** prints the row once at the bottom of each page of the report.
- **Conclusion** prints the row once at the end of the report.
- **Sort fields (1-Date, 2-Rep, etc)** prints the row each time a value changes in the sort field.

Now you will use the 1-Date row flag, to tell Reflex to print the results of `@SUM(Sales $)` each time the date changes. That is, just after the last January record, just after the last February record, etc.

<table>
<thead>
<tr>
<th>Report</th>
<th>Edit</th>
<th>Print/Save</th>
<th>Search</th>
<th>Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan-85</td>
<td>Alan</td>
<td>Paddles</td>
<td>$6,558</td>
<td></td>
</tr>
<tr>
<td>Jan-85</td>
<td>Alan</td>
<td>Silent</td>
<td>$16,835</td>
<td></td>
</tr>
<tr>
<td>Jan-85</td>
<td>Alan</td>
<td>Sport</td>
<td>$4,976</td>
<td></td>
</tr>
<tr>
<td>Jan-85</td>
<td>Bob</td>
<td>Swiftwater</td>
<td>$5,235</td>
<td></td>
</tr>
<tr>
<td>Jan-85</td>
<td>Bob</td>
<td>Paddles</td>
<td>$5,450</td>
<td></td>
</tr>
<tr>
<td>Jan-85</td>
<td>Bob</td>
<td>Sport</td>
<td>$3,794</td>
<td></td>
</tr>
<tr>
<td>Jan-85</td>
<td>Bob</td>
<td>Swiftwater</td>
<td>$7,433</td>
<td></td>
</tr>
<tr>
<td>Jan-85</td>
<td>Cathy</td>
<td>Paddles</td>
<td>$4,613</td>
<td></td>
</tr>
<tr>
<td>Jan-85</td>
<td>Cathy</td>
<td>Silent</td>
<td>$6,789</td>
<td></td>
</tr>
<tr>
<td>Jan-85</td>
<td>Cathy</td>
<td>Sport</td>
<td>$2,667</td>
<td></td>
</tr>
<tr>
<td>Jan-85</td>
<td>Cathy</td>
<td>Swiftwater</td>
<td>$5,728</td>
<td></td>
</tr>
<tr>
<td>Jan-85</td>
<td>Dave</td>
<td>Paddles</td>
<td>$6,325</td>
<td></td>
</tr>
<tr>
<td>Jan-85</td>
<td>Dave</td>
<td>Silent</td>
<td>$11,760</td>
<td></td>
</tr>
<tr>
<td>Jan-85</td>
<td>Dave</td>
<td>Sport</td>
<td>$5,831</td>
<td></td>
</tr>
<tr>
<td>Jan-85</td>
<td>Dave</td>
<td>Swiftwater</td>
<td>$113,414</td>
<td></td>
</tr>
<tr>
<td>Feb-85</td>
<td>Alan</td>
<td>Paddles</td>
<td>$6,635</td>
<td></td>
</tr>
</tbody>
</table>

8. Select the 1-Date row flag and press `<-->`. 1-Date is entered in the When column.

9. Choose Preview on Screen from the Report menu to see the result. /RP

The preview of the result.
$113,414 is the sum of sales for January. If you page through the report, you will see total sales for subsequent months, printed immediately after the set of records for that month.

**DESIGN THE PRESENTATION**

Now that we have set the values we want to present, we need to arrange the report so that it is an effective presentation. To do this we need to add some rows, type in some explanatory text, and change the attributes on some fields.

**ENTER BLANK ROWS**

At the top of the report we will enter five new rows, to make room for three rows of introduction and two rows of header.

1. Return to the design screen: Type Q
2. Select the “Body” row flag in row one by pressing F3.
3. Press ins five times. Five rows are inserted at the top of the design.

Your additional rows are all “Body” rows, so you will need to change the row flags. For the rest of this tutorial, we will use the first letter shorthand for entering row flags.

4. Press home to select the row flag in the first row.
5. Type I and press ←. The row flag changes to “Intro.”
6. Repeat step five for the second and third row flags. You now have three “Intro” rows.
7. Change the row flags on rows four and five to “Header” by selecting them and entering H.

**ENTERING TEXT**

Previously you entered field names in the design area, telling Reflex to draw information from the database. However,
FOUR ADVANCED TUTORIAL

you can also enter text, telling Reflex to print literally whatever you type into the report. This is useful for titles, column headings, labels for subtotals, and so forth.

We will enter a two-line title, to appear once at the beginning of the report, and a column heading line identifying the data in the fields. The heading line will appear at the top of each page.

1. Select row one, column 21 in the design area.

2. Type in
   **TYLER CANOE COMPANY SALES**
   and press [→].

3. Select row two, column 23.

4. Type in
   **January-June, 1985**
   and press [→].

Leave the third row blank. A blank row in the design area is interpreted as a signal to skip a line. The report title will be followed by one blank line.

Since what you just typed isn't recognized as a field name, it is treated as simply text, to be printed in the indicated place in the report.

Now continue with the header row:

5. Select row 4, column 1.

6. Type in *Date* and press [→].
   The apostrophe (single quote) tells Reflex that this is not a field name.

Since Date would be recognized as a field name, you precede it with a single quote to have the word, rather than the date values, appear in the report. This says, “Print the word, not the values”. The quote isn't printed.

7. Select row 4, column 16.
   Type in *Rep* and press [→].
   Again, the apostrophe tells Reflex that this is not a field name.
8. Select row 4, column 36. Type in 'Product' and press ←.

9. Select row 4, column 56. Type in 'Total Sales' and press ←.

We will leave the next header row blank, leaving a blank line between the header and the data when the report is printed.

Each column of data you use in your report now has a heading, to identify it. This use of explanatory text is very useful to clarify your presentation.

10. Choose Preview on Screen from the Report menu (/RP) to see what the report looks like now.

11. Press Q to return to the Design screen.
The report with an introduction and heading.

## TYLER CANOE COMPANY SALES
January -- June, 1985

<table>
<thead>
<tr>
<th>Date</th>
<th>Rep</th>
<th>Product</th>
<th>Total Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan-85</td>
<td>Alan</td>
<td>Paddles</td>
<td>$6,559</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Alan</td>
<td>Silent</td>
<td>$6,935</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Alan</td>
<td>Sport</td>
<td>$4,234</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Alan</td>
<td>Swiftwater</td>
<td>$6,672</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Bob</td>
<td>Paddles</td>
<td>$5,935</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Bob</td>
<td>Silent</td>
<td>$6,458</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Bob</td>
<td>Sport</td>
<td>$3,794</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Bob</td>
<td>Swiftwater</td>
<td>$7,433</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Cathy</td>
<td>Paddles</td>
<td>$4,613</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Cathy</td>
<td>Silent</td>
<td>$6,789</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Cathy</td>
<td>Sport</td>
<td>$2,667</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Cathy</td>
<td>Swiftwater</td>
<td>$5,728</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Dave</td>
<td>Paddles</td>
<td>$6,325</td>
</tr>
</tbody>
</table>

### CHANGING ATTRIBUTES

You have already used the Summary attribute to add @SUM to the Sales $ field. This changed the field name into a formula to calculate a value for your report. Several of the other attributes are display attributes, and we will use one of them, the On Change/All attribute.

This attribute enables you to prevent unnecessary field entries from being printed. In this case, we will instruct Reflex to print the date only once for each month, and the rep only once for each rep. This will clean up the report and make it easier to read.

1. Select the Date field on row 6.

2. Choose On Change/All from the Attributes menu. The Attribute indicator at the bottom right of the screen changes to “On Change/All.”

3. You have already selected the field you want to change, so press Choices [F10] to display a choice list of On Change/All attributes available.
The result of the “Only on Change” attribute applied to the Date and Rep fields.

4. Select “Only on Change” and press \[→\].  
   This instructs Reflex to print the data from this field only when a new value appears.

5. Select the Rep field. Press [F10], select “Only on Change,” and press \[←\].  
   This applies the same attribute to the Rep field.

6. Preview the result by choosing Preview on Screen from the Report menu. /RP  
   The long string of months and reps has been replaced with a single entry for each group.

<table>
<thead>
<tr>
<th>Report</th>
<th>Edit</th>
<th>Print/File</th>
<th>Search</th>
<th>Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYLER CANOE COMPANY SALES</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>January -- June, 1985</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Date</th>
<th>Rep</th>
<th>Product</th>
<th>Total Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan-85</td>
<td>Alan</td>
<td>Paddles</td>
<td>$6,558</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Silent</td>
<td>$16,835</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sport</td>
<td>$4,976</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Swiftwater</td>
<td>$6,672</td>
</tr>
<tr>
<td></td>
<td>Bob</td>
<td>Paddles</td>
<td>$5,235</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Silent</td>
<td>$6,458</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sport</td>
<td>$3,794</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Swiftwater</td>
<td>$7,433</td>
</tr>
<tr>
<td></td>
<td>Cathy</td>
<td>Paddles</td>
<td>$4,613</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Silent</td>
<td>$6,789</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sport</td>
<td>$2,667</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Swiftwater</td>
<td>$5,728</td>
</tr>
<tr>
<td></td>
<td>Dave</td>
<td>Paddles</td>
<td>$6,325</td>
</tr>
</tbody>
</table>

Continuing Previewing Page 1? Continue Quit

ADDING AN UNDERLINE
Traditionally, a column of figures has an underline after the last one to indicate that the next one is a total.

We will insert a row above the totals line and enter a series of hyphens as an underline.

1. Select row 7 by positioning the cursor on that row and pressing [F3].

2. Insert a new line by pressing the \[Ins\] key.  
   A blank line is added above what was row 7.
So the underlines print above the totals (and not for each record), we'll enter the 1-Date row flag:

3. Press \[F10\], select **1-Date** and press \[←\].
   
   1-Date appears in the When Printed column.

While we're at it, let's add a blank line after each total and a conclusion line at the bottom of the design.

4. Press \[↓\] to select the blank line below the totals line. Select **1-Date** from Choices.
   
   1-Date appears in the When Printed column.

5. Select the next line. Select **Conclusion** from Choices.
   
   Conclusion appears in the When Printed column.

Now, getting to the underlines:

6. Select row 7, column 56, and enter a series of hyphens.

A series of hyphens between the "Body" row and the "1-Date" row will serve as a column underline.

<table>
<thead>
<tr>
<th>Report</th>
<th>Edit</th>
<th>Print/File</th>
<th>Search</th>
<th>Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Design</td>
<td>TYLER CANOE COMPANY SALES</td>
<td>January -- June, 1985</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date</td>
<td>Rep</td>
<td>Product</td>
<td>Total Sales</td>
<td></td>
</tr>
<tr>
<td>1-Date</td>
<td>Sales $</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Row: 7 From Col: 56 through Col: 65

7. Choose Preview on Screen from the Report menu, \[RP\], to see the result.
**SETTING VARIABLE WIDTH**

When you enter a field name in the design area, Reflex establishes a standard width to display the data. You will often want to change this width, depending on the actual values contained in your database and the way you are using the field entries in your report.

In the example that follows, you will use a field name within an explanatory note. Then you will change the width of the field, making it “as wide as necessary.” This attribute makes the size of the data determine the area used for it.

1. Select row 8, column 21, and enter **Total Sales for**

2. Press → twice, and enter **Date**

3. Press → once, and enter :

The field name will draw entries from your database. Because it is entered on a “1-Date” row, it will print the entry each time the Date changes. As you have guessed, this text explains the total sales figure that appears after each month’s sales figures in your report.

However, the date is right-justified, the date format you are using is only eight characters wide, and the space allowed by Reflex is 9 characters. If you preview your report at this point, you will notice that there are extra spaces in your sentence.

Reflex provides several ways of handling such design subtleties, including setting the column width, and changing the justification. However, for this particular case, you will apply the **Variable Width** attribute.

4. Select the Date field you have just entered on row 8.

5. Choose Variable Width from the Attributes menu. The current attribute indicator changes to Variable Width.

The “Wide as Needed” attribute not only makes the area available for each entry flexible, depending on the length of the entry, but it also causes everything to the right of that field to “slide left” to maintain the spacing established in your Report Design. In this case, the colon (:) will move to the left close to the date in your report.

7. Choose Preview on Screen to see the result of your change.

However, you need to prevent the @SUM(Sales $) entry on this row from sliding left to keep it in the Total Sales column.

8. Select the @SUM(Sales $) entry on row 8, press [F10], and select “Position as Shown”. Press ←.

The total sales figure will remain in its column.

---

The total sales row in the report preview.
ENTRinging a conclusion

At the conclusion of your report, you often want a total figure for the entire report. A summary entered on a "Conclusion" row will reflect all the entries in your report.

1. Select row 10, column 21.
   Enter
   Total sales for January - June:

2. Select row 10, column 56.
   Use Choices to enter Sales $.

Now you want to add an attribute to this field name, SUM. Because it appears on a "Conclusion" row, it will total the Sales $ entries for all the records included in the report.

3. Choose Summary from the Attributes menu, /AS.

4. The Sales $ field is already selected, so press Choices [F10] and select @Sum from the choice list. Press the entry changes to @Sum(Sales $).

The Attributes indicator at the bottom of the screen changes to Summary.

Your report design is complete. Choose Preview on Screen from the Report menu to preview the result.
## TYLER CANOE COMPANY SALES
### January -- June, 1985

<table>
<thead>
<tr>
<th>Date</th>
<th>Rep</th>
<th>Product</th>
<th>Total Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan-85</td>
<td>Alan</td>
<td>Paddles</td>
<td>$6,550</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Silent</td>
<td>$16,835</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sport</td>
<td>$4,976</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Swiftwater</td>
<td>$6,672</td>
</tr>
<tr>
<td></td>
<td>Bob</td>
<td>Paddles</td>
<td>$5,235</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Silent</td>
<td>$6,450</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sport</td>
<td>$3,794</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Swiftwater</td>
<td>$7,433</td>
</tr>
<tr>
<td></td>
<td>Cathy</td>
<td>Paddles</td>
<td>$4,613</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Silent</td>
<td>$6,709</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sport</td>
<td>$2,667</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Swiftwater</td>
<td>$5,728</td>
</tr>
<tr>
<td></td>
<td>Dave</td>
<td>Paddles</td>
<td>$6,325</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Silent</td>
<td>$11,760</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sport</td>
<td>$5,831</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Swiftwater</td>
<td>$11,836</td>
</tr>
</tbody>
</table>

**Total Sales for Jan-85:** $113,414

| Feb-85 | Alan | Paddles | $6,635 |
|        |      | Silent  | $16,317 |
|        |      | Sport   | $5,477 |
|        |      | Swiftwater | $2,944 |
|        | Bob  | Paddles | $4,583 |
|        |      | Silent  | $3,267 |
|        |      | Sport   | $3,925 |
|        |      | Swiftwater | $8,892 |
|        | Cathy| Paddles | $4,432 |
|        |      | Silent  | $6,878 |
|        |      | Sport   | $2,843 |
|        |      | Swiftwater | $6,102 |
|        | Dave | Paddles | $5,725 |
|        |      | Silent  | $9,455 |
|        |      | Sport   | $3,370 |
|        |      | Swiftwater | $10,639 |

**Total Sales for Feb-85:** $113,585

| Mar-85 | Alan | Paddles | $6,487 |
|        |      | Silent  | $12,509 |
|        |      | Sport   | $7,324 |
|        | Bob  |         |       |
|        |      | Silent  | $8,795 |
|        |      | Sport   | $24,351 |
|        |      | Swiftwater | $8,701 |
|        |      |         |       |
|        |      |         |       |

**Total Sales for Jun-85:** $241,029

**Total Sales for January -- June:** $931,463

## PRINTING THE REPORT

To print your report, choose Change Printer Setting from the Print/File menu. The Reflex print tool is displayed for you to enter margins and other printer information.

*To print your report, select Print at the bottom of the print tool and press [↵].*
SAVING THE REPORT DESIGN

Reflex enables you to save any report design in a file on your data disk. It works like saving a database, but only the design is saved, not the data. Everything in the design is saved, including the sort order, the attributes you have applied to the entries, and the printer settings.

A common practice is to set up a standard report, save the specification, and then each week, month, or quarter, retrieve the report specification and print the report with that period's data.

We'll save this report specification under the name “Sample”:


2. With the name cell selected, type Sample. The report specification is saved.

3. Press \[\downarrow\] to select Proceed and press \[\leftarrow\]

FURTHER REPORTING

That’s it! We’ve just gone through a fairly substantial report. Hopefully, one point in particular came out in this exercise:

Using Reflex’s Report View is an ad-hoc, evolutionary process where you try something and then view it on the screen to see what the result is. So you can experiment, quickly see the results, and make changes as necessary.

To learn more about what Reflex’s Report View can do, we suggest you refer to the Reference section. In particular, look at the other attributes. They provide different capabilities for formatting, justification, different summary functions (such as averages, counts, variances, and others), percentage display, and printing to a disk file in a format to be used with mailing list and other programs.
FIVE

REFERENCE A: REFLEX SYSTEM
FIVE REFLEX BASICS

PART 1 REFLEX BASICS
A/The Reflex Screen  B/Windows; Views and Tools
C/Select and Choose
D/Important Keys and Their Uses  E/Reflex Menus

SCREENHANDLING

PART 2 SCREENHANDLING
A/Managing the Views  B/Tools

ENTERING AND EDITING DATA

PART 3 ENTERING AND EDITING DATA
A/The Database—Records and Fields  B/Field Specifications
C/Choices  D/Editing

THE VIEWS

PART 4 THE VIEWS
A/Form Design  B/The Form View  C/The List View
D/The Graph View  E/The Crosstab View

PRINT/FILE

PART 5 PRINT/FILE
A/DOS Directories  B/Global Settings
C/Retrieving a Database  D/Saving a File  E/Erasing a File
F/Printing

RECORDS

PART 6 RECORDS
A/Field & Sort Settings  B/Vary  C/Records Commands

SEARCH

PART 7 SEARCH
A/Search Conditions  B/Set Search Conditions
C/Filter, Find and Keep

CALCULATED FIELDS

PART 8 CALCULATED FIELDS
A/Form  B/Formats for Formulas  C/Entering Formulas
D/Functions  E/Working with Dates
F/Recalculation  G/Editing Formulas  H/Converting a Formula
PART 1
RE Reflex Basics

A  THE REFLEX SCREEN  4

B  WINDOWS: VIEWS AND TOOLS  6
   Views  6
   Tools  6

C  SELECT AND CHOOSE  7
   Cursor movement  7

D  IMPORTANT KEYS AND THEIR USES  10
   The function keys  10
   Other important keys  12

E  REFLEX MENUS  12
   Choosing a menu command  13
Reference A describes the use of the main Reflex program. As much as possible, this chapter follows the order of the main menus on the Reflex screen.

Neither Reference A nor Reference B, which describes use of the Reflex Report & Utilities disk, is a substitute for the first half of the User's Guide. "Welcome to Reflex" provides an overview of the program, and "Starting Out" describes the procedure for loading Reflex into your computer. The tutorials and the Reflex Concepts give you a thorough basic understanding of Reflex.

The reference chapters do describe how to use all the features and capabilities of the program. As you become more familiar with what it can do, we believe you will want to use it in depth. These chapters provide a map to help you explore Reflex, The Analytic Database.

THE REFLEX SCREEN

When you proceed from the Reflex Title screen, the main program screen is displayed. Most of your work will be with this screen.

Reflex is a visual product. You work with it by interacting with it on the screen. You enter, see, and modify both data and instructions on the screen.
The main menu line contains the currently available menu titles.

The edit line displays the contents of a selected cell. It is used for editing information. As you edit cell contents, the editing changes appear in the edit line.

The windows area displays the views of your database and the information you are working with. Up to three views can be displayed at once in separate windows. Information in any view may extend beyond the window through which it is seen. You can bring information from beyond the boundaries of the window into view by scrolling with the cursor movement keys, both vertically and horizontally.

The message line displays brief directions, error messages, warnings, and status information useful in running Reflex.


WINDBOXS: VIEWS AND TOOLS

VIEWS

Data is entered and presented in views. Reflex has 5 views, each providing a different perspective on your information: the Form View, the List View, the Graph View, the Crosstab View and the Report View.

The Form and List Views.

<table>
<thead>
<tr>
<th>FORM</th>
<th>LIST</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tyler Canoe Co Monthly Sales</td>
<td>Date</td>
</tr>
<tr>
<td>Date: Jan-85</td>
<td>Jan-85</td>
</tr>
<tr>
<td>Rep: Alan</td>
<td>Jan-85</td>
</tr>
<tr>
<td>Product: Paddles</td>
<td>Jan-85</td>
</tr>
<tr>
<td>Quantity: 81</td>
<td>Jan-85</td>
</tr>
<tr>
<td>Sales $: 6,550</td>
<td>Jan-85</td>
</tr>
<tr>
<td>Avg Price: 81</td>
<td>Jan-85</td>
</tr>
<tr>
<td>Unit Cost: 77</td>
<td>Jan-85</td>
</tr>
<tr>
<td>Total Cost: 6,237</td>
<td>Jan-85</td>
</tr>
<tr>
<td></td>
<td>Jan-85</td>
</tr>
</tbody>
</table>

THE ACTIVE VIEW

Although the screen can display up to three views, only one is active at any time. It is the view which will receive any commands that you give.

TOOLS

Aside from views, the other kind of windows are tools. You use tools to give instructions to Reflex or to see and change various settings. A typical tool will contain a variety of related command and settings options.
The Print tool.

![Print Settings Screen]

**SELECT AND CHOOSE**

You **select** a location on the screen (and the object at that location) by moving the cursor to it. The **cursor** is a rectangle of light on the screen that indicates your current work area. It can be one character wide or as wide as a row on the screen. The action you take after selecting something affects what you've selected.

You also **choose** a menu command with the cursor on the screen, but this time it is a two-step operation. You pop down a menu, and then you choose from the commands presented.

You select and choose by moving the cursor. You control the cursor with the cursor movement keys or with a mouse.

**CURSOR MOVEMENT**

Most actions and commands in Reflex operate on the current selection. You change the selection by moving the cursor.

Cursor movement performs another important function as well. Since any of the views may be larger than the amount of window area available to them, you need to be able to move them to look at different parts of the views. This is called **scrolling**. The way you scroll is by moving the cursor to some-
Scrolling to see different parts of the view.

**CURSOR MOVEMENT KEYS**

The cursor movement keys are located on the right side of the keyboard.
The arrow keys move the cursor generally in the direction the arrow points. Press the key to move the cursor one space; hold it down to make the cursor move rapidly in the direction indicated.

The **Home** key moves the cursor generally to the top left corner of any display, or to the first in a series of objects you can work on. The **End** key moves it to the bottom or to the last object in a series.

**Pg Up** and **Pg Dn** move the cursor in large jumps, one screenful at a time. **Ctrl →** and **Ctrl ←** act as Page Right and Page Left, moving the cursor about one screenful. When using these, press the **Ctrl** key down and hold it while pressing the **→** or **←** key; then release both.

**~** is the tab key, moving the cursor from object to object in a series. It moves five spaces to the right in Form Design or editing, and one space to the right in a table display. Used with **↓**, it becomes a backtab key, reversing its direction.

**NOTE** Pressing the **NumLock** key above the bank of cursor movement keys changes them into number keys so you can't move the cursor with them. We recommend that you avoid using this key. If you press **NumLock**, press it again to switch it off.

**MOUSE CURSOR MOVEMENT**

You can also move the cursor with a **mouse**. As you move the mouse, an arrow-shaped **pointer** on the screen tracks its movement.

The mouse.

The mouse has buttons that, when pressed, send signals to the computer. Reflex uses only one button on a mouse. If you are using a mouse with more than 1 button, the left one will be used with Reflex.

You can use the mouse in two ways:
Selection  To select something, point at it, press the button, and release it. This selects whatever you were pointing at.

Press-and-hold  Point at something, press the button, hold it down, move the pointer to another location on the screen while holding the button, and then release the button. Press-and-hold is used to choose a menu option and to move objects from one location to another on the screen.

THE FUNCTION KEYS

The function keys are grouped on the left side of the keyboard. Each of them performs a specific action. Several function keys duplicate menu commands, providing you with a shortcut for commands you use most frequently. Some function keys have a shifted action as well: You press \[\triangle\] and the function key together to invoke the alternate command.
<table>
<thead>
<tr>
<th>KEY</th>
<th>FUNCTION</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Help</td>
<td>Provides information about the active view or tool and access to further information.</td>
</tr>
<tr>
<td>F2</td>
<td>Edit</td>
<td>Puts Reflex into Edit mode.</td>
</tr>
<tr>
<td>F3</td>
<td>Select Row</td>
<td>Selects the entire row.</td>
</tr>
<tr>
<td>F4</td>
<td>Select Column</td>
<td>Selects the entire column.</td>
</tr>
<tr>
<td>F5</td>
<td>Find</td>
<td>Finds and makes current the next record that meets current search conditions.</td>
</tr>
<tr>
<td>F6</td>
<td>Next View</td>
<td>Makes the next view active when more than one view is displayed.</td>
</tr>
<tr>
<td>F7</td>
<td>Previous Record</td>
<td>Makes the previous record in the database the current record.</td>
</tr>
<tr>
<td>F8</td>
<td>Next Record</td>
<td>Makes the next record in the database the current record.</td>
</tr>
<tr>
<td>F9</td>
<td>Recalc</td>
<td>Recalculates formulas.</td>
</tr>
<tr>
<td>F10</td>
<td>Choices</td>
<td>Provides a list of current field names or other valid choices for the current selection.</td>
</tr>
<tr>
<td>F3</td>
<td>Row Heading</td>
<td>Selects a row heading.</td>
</tr>
<tr>
<td>F4</td>
<td>Column Heading</td>
<td>Selects a column heading.</td>
</tr>
<tr>
<td>F5</td>
<td>Filter</td>
<td>This key toggles: Press once to apply filter conditions to the database. Press again to remove the filter.</td>
</tr>
<tr>
<td>F6</td>
<td>Expand</td>
<td>This key toggles: Press once to expand the active view to full screen. Press again to return to the previous display.</td>
</tr>
<tr>
<td>F7</td>
<td>First Record</td>
<td>Makes the first record in the database the current record.</td>
</tr>
<tr>
<td>F8</td>
<td>Last Record</td>
<td>Makes the last record in the database the current record.</td>
</tr>
<tr>
<td>F9</td>
<td>Sort</td>
<td>Applies the current sort order to the database.</td>
</tr>
</tbody>
</table>
OTHER IMPORTANT KEYS

<table>
<thead>
<tr>
<th>KEY</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>←</td>
<td>The key that signals you are giving a command or entering information in a field. Tells the computer, “do this” or “remember this.” This is called the “Enter” key.</td>
</tr>
<tr>
<td>Esc</td>
<td>Used to return to a previous situation. Puts away menus and tools. Removes the Help screens when you are finished. Cancels the Edit mode and removes any changes you made.</td>
</tr>
<tr>
<td>◯</td>
<td>Like the Shift key on a typewriter. Use it to access the top symbol on number and punctuation keys or to type capital letters. Also used with function keys for additional functions.</td>
</tr>
<tr>
<td>Del</td>
<td>Deletes the selected object. An alternative to the Delete command on the Edit menu.</td>
</tr>
<tr>
<td>Ins</td>
<td>Inserts a row, column, or space. An alternative to the Insert command on the Edit menu.</td>
</tr>
<tr>
<td>(Backspace)</td>
<td>A backspace key that erases the previous keystroke when typing.</td>
</tr>
<tr>
<td>Caps Lock</td>
<td>This key toggles between capitals and lowercase letters. It has no effect on number keys or punctuation keys.</td>
</tr>
<tr>
<td>Ctrl</td>
<td>Used with other keys in special cases. [Ctrl] → [←] proceeds from a tool. [Ctrl] and the [→] and [←] keys are used for moving by whole pages. [Ctrl] Home and [Ctrl] End move to the top and bottom of the current screen.</td>
</tr>
<tr>
<td>Num Lock</td>
<td>An on/off switch for the numeric keypad. When it is off, the keys are cursor movement keys. When it is on, they are number keys.</td>
</tr>
<tr>
<td>/</td>
<td>Activates the menus.</td>
</tr>
</tbody>
</table>

**NOTE** The \[Ctrl\] is like \[◇\]—you press the other key while \[Ctrl\] is pressed.

REFLEX MENUS

Reflex offers “menus of commands” which you can choose from to give it instructions. These menus are grouped under menu titles. The main menu line contains the menu titles.
Reflex has five menu titles which are always displayed—Views, Edit, Print/File, Records, and Search. Others are put on the menu line as appropriate for different parts of the program.

Beneath each menu title is a set of menu choices which can be chosen to give a command. Upon request, these menu choices "pop down" beneath the menu title. You choose the one you want, and the indicated operation is then carried out.

When a menu choice is not appropriate at a particular point in the program, it will appear shaded in the menu and you will not be able to choose it. As an example, the Print command in the figure above is shaded, as would be appropriate if no database were loaded.

When a menu command is followed by two dots, it indicates that choosing that command will bring up a tool.

**CHOOSING A MENU COMMAND**

Reflex provides three ways to choose a menu command: using the cursor keys, typing first letters, and using the mouse.

**CURSOR KEYS**

1. Press [ ] to activate the main menu line.
2. Use [ → ] or [ ← ] to pop down the menu you want.
3. Use [ ↓ ] or [ ↑ ] to highlight the menu command you want.
4. Press [ ].

If you change your mind, press [ Esc ] before you press [ ].
TYPING FIRST LETTERS

1. Press [Z] to activate the main menu line.
2. Type the first letter of the main menu title you want.
3. Type the first letter of the menu command you want.

For example, to choose the Form View from the Views menu, the sequence is: /VF.

If you change your mind, press [Esc] before step three.

USING A MOUSE

1. Without pressing [Z], put the tip of the pointer on the menu title you want.
2. Press-and-hold the left button.
3. While still holding down the left button, move the pointer to the menu command you want.
4. When the menu command you want is highlighted, release the button.

If you change your mind, move the pointer away from the menu and release the button. A menu option will be chosen only if it is highlighted when you release the button.
PART 2
SCREENHANDLING

A MANAGING THE VIEWS 16
Opening a View 16
Opening multiple Views 16
Closing a View 17
Changing the Active View 18
Resizing a View 18
Expanding and shrinking a View 18

B TOOLS 19
Moving around in tools 19
This section describes how to work with the display of windows, views, and tools.

MANAGING THE VIEWS

Of Reflex's five views, four are on the Reflex System Disk: the Form View, the List View, the Graph View and the Crosstab View. The Report View is found on the Report & Utilities disk.

The Views menu provides all the commands necessary for displaying and arranging the views on the screen.

OPENING A VIEW

To open a view, choose it from the Views menu. For example, to open the Form View, choose Form under the Views menu (/VF).

The first view opened takes the entire windows area.

OPENING MULTIPLE VIEWS

Form, List, and Graph Views can share the screen in separate windows.

To open a second or third view, choose it from the Views menu. Reflex then asks you whether to replace the active view with the one you just chose or whether to split the window and show the two views together. You have three choices:

Which Way? Replace Vertical Horizontal
<table>
<thead>
<tr>
<th>CHOICE</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace</td>
<td>Replace the active view with the new one.</td>
</tr>
<tr>
<td>Vertical</td>
<td>Split the active view in half vertically. The chosen view is displayed on the right and becomes the active view.</td>
</tr>
<tr>
<td>Horizontal</td>
<td>Split the active view in half horizontally. The chosen view is displayed below and becomes the active view.</td>
</tr>
</tbody>
</table>

There are three ways to make this choice:

- Use → or ← to highlight your choice and press ↓.
- Type in the first letter of your choice.
- Use the mouse pointer.

[m] If you are using a mouse, you tell Reflex how to split the window by putting the pointer inside the active view, near an edge of the window, and clicking the left button.

[m] If you click near the left side of the active view, Reflex divides the window horizontally in line with the point of the arrow. The chosen view is displayed below and becomes the active view. If you click near the top of the active view, Reflex divides the window vertically in line with the point of the arrow. The chosen view is displayed on the right and becomes the active view.

[m] To replace the active view, put the pointer on the word Replace in the message line and click the left button. (Make sure the tip of the pointer is below the windows area.)

**CLOSING A VIEW**

The active view may be closed by choosing Close from the Views menu (/VC). The active view disappears. If there are other views on the screen, the windows area adjusts the display to fill the space. Another view automatically becomes the active view. After you close a view, you may re-open it at any time.

Closing a view does not affect the information in the database.
CHANGING THE ACTIVE VIEW

When one view is on the screen, it is the active view. When more than one view is on the screen, the active view is identified by a highlighted view label.

To change the active view, press the Next View key [F6] or choose Next View from the Views menu (/VN). Reflex cycles through the windows shown on the screen.

[m] If you are using a mouse, move the pointer anywhere in the view and click the left button.

RESIZING A VIEW

To change the size of either the topmost or leftmost view, use the Resize command on the Views menu.

1. Make the leftmost view or the topmost view active.
2. Choose Resize from the Views menu. A dotted line, known as the shadow line, appears on the dividing line between two views.
3. Use the cursor keys to move the shadow line to a new location.
4. Press [→]. The windows adjust.

[m] If you are using a mouse:
1. Choose Resize from the Views menu.
2. Put the top of the pointer on the dividing line and press-and-hold the left button.
3. Move the shadow line to a new location and release the button. The windows adjust.

EXPANDING AND SHRINKING A VIEW

You can expand the active view to fill the entire screen. Expanding a view doesn’t erase other views on the screen; the expanded window merely covers them temporarily until you shrink it back to its former size.

To expand the active view, choose Expand from the Views menu (/VE) or press the Expand key, [F6].

To return the screen to the previous display, choose Shrink (/VS) from Views menu or press [F6] again.
TOOLS

Several Reflex menu commands display a tool in a window that temporarily overlays whatever views are displayed. Tools provide ways for you to give specific directions so that Reflex can carry out important functions.

When a tool is displayed, it is active. Until you put it away, you can't use any of the views.

Tools don't change size; they aren't resized, expanded, or shrunk.

There are a number of ways to put away a tool:

- Press Esc. The tool is canceled and any changes made are forgotten. (This works with all tools except Field & Sort Settings, where changes are accepted.)
- Select the Proceed box and press \[→\]. Reflex carries out the function and puts away the tool.
- Select the Cancel box and press \[←\]. The tool is cancelled, and any changes made are forgotten.
- Select the Put Away box and press \[←\]. Changes made are retained.
- Press Ctrl \[←\]. This is a shorthand for proceeding from anywhere in the tool.

MOVING AROUND IN TOOLS

Tools often contain a variety of places to provide instructions to Reflex for carrying out commands. The parts of a tool are shown on the next page.
The Search Conditions Tool.

**Instruction cell**  this is a type-in cell in which you enter information.

**Check boxes**  these are enumerated choices, from which you pick one. The choice picked is identified by an X in the box next to it on the left.

**Tables**  row and column grids for entering information, typically on a field-by-field basis.

**Buttons**  typically, Proceed and Cancel, buttons are at the bottom of the cell and cause immediate actions, such as carrying out the command and putting away the tool.

In moving between these elements of a tool, cursor keys operate normally, moving the selection from one to another.

One point of note, however, is the operation of checkboxes. In making a choice from those shown in a group of checkboxes, you’ll cursor to the desired choice and then use either the $\leftarrow$, $\uparrow$, $\downarrow$, or $\rightarrow$ keys to move on to the next selection. This will leave the desired checkbox checked. If you were to use $\rightarrow$ or $\leftarrow$ keys, it would simply move the check to the next checkbox.

Pressing $\leftarrow$ accepts the entry in the currently selected cell and moves the selection to the next cell. Selecting a button, e.g. Proceed or Cancel and pressing $\leftarrow$, causes the indicated operation to be immediately performed and, in the case of Proceed, Cancel, and Put Away, put away the tool.
PART 3
ENTERING AND EDITING DATA

A THE DATABASE—RECORDS AND FIELDS 22
   Creating the database 22
   Entering data 23
   The current record 24

B FIELD SPECIFICATIONS 25
   Field names 25
   Field types 26

C CHOICES 28
   Selecting from a choice list 29

D EDITING 30
   The edit mode 31
   The edit menu 31
This section describes the basic functions of setting up a database, entering information, and modifying information.

THE DATABASE—RECORDS AND FIELDS

At the heart of Reflex is a database. It is the repository for the information you will work with.

A database is a collection of records, each containing related information. Each piece of information is called a field. An example of a database is an address card file:

The entire card file is a database. Each card is a record, and each entry, e.g., Name, Address, and Phone, are fields.

CREATING THE DATABASE

The first step in working with Reflex is to create a database. While this may be done with the Translate facility to use information from other sources, more commonly you'll start from scratch.

There are 2 steps to creating a database:

1. Naming the fields.
2. Entering information.

NAMING THE FIELDS

Prior to entering data, the only required step is telling Reflex which fields will be in the database. This can be done in one of two ways:
1. Create the Form using Form Design.
2. Enter the field names in the Field & Sort Settings Tool.

Either way, once you've specified the field names, the database is set up and ready to accept information.

**NOTE**
Fields may be added, deleted, moved, or renamed at any time, even after information is entered in the database. So don't worry about getting it exactly right and anticipating all your needs from the start.

**CREATING RECORDS**
When the database is created, a blank record is automatically provided to accept information.

When you enter data in the blank record, Reflex enters it into the database and creates another blank record for further entry. This process is repeated. A blank record can always be found immediately following the last record in the database, and may be reached by pressing the Last Record Key \[F8\], then the Next Record Key \[F8\]. In the List, you may also press the \[End\] key.

You can also add additional blank records any place within the database. Choosing Add Record from the Records menu (/RA) will add a record immediately following the current record. To add a record immediately before the current record (e.g., before the first record), use the List View as follows:

1. Open List View.
2. Press \[Home\] to get to the first record.
3. Press the Row Key \[F3\] or choose Row Select from the Edit menu (/ER).
4. Press the \[Ins\] Key or choose Insert from the Edit menu (/EI).

You can create records and enter information at any time. You do not need to give a special command to begin or stop entering data and creating records.

**ENTERING DATA**

Once a field has been created, you can enter data into it. You enter one piece of information in each field. (We use the terms *data* and *information* interchangeably throughout this User's Guide.)
The rule for entering data is: Select the field, type in the information, and press ← or a cursor key.

<table>
<thead>
<tr>
<th>Views</th>
<th>Edit</th>
<th>Print/File</th>
<th>Records</th>
<th>Search</th>
<th>Form</th>
</tr>
</thead>
</table>

Customer List
Name: Chris Kyle
Address: 444 B Street
City: San Francisco State: Zip Code:

DITTO
When you enter a ditto ("), Reflex duplicates the field entry from the same field in the previous record.

CALCULATED FIELDS
Reflex will automatically calculate data based on entries in other fields. See Part 8, Calculated Fields.

CONSTANTS
Reflex will duplicate an entry in a field in all records if you enter = in front of it. For example, = 145 will enter 145 in the field in every record in which you have not entered another value in that field. See Part 8, Calculated Fields.

THE CURRENT RECORD
Reflex always keeps one record as the current record. This record—and the designation can easily be moved from record to record—is the object of record commands, such as Delete Record. It is also the record that is highlighted within the Views.

The current record is whichever record you’re working with. If a field in the Form View or List View, a row in the List View, or a point in the Graph View is selected, the encompassing record is automatically made the current one.

In Form View, the current record is the one displayed. In List View, the current record is indicated by an arrowhead just to the left of the row. In Graph View, the current record is indicated by a highlight on the point or by a box drawn around the x-axis label.
CHANGING THE CURRENT RECORD
Press the following function keys to change the current record.

<table>
<thead>
<tr>
<th>KEY</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>F7</td>
<td>Makes the previous record current.</td>
</tr>
<tr>
<td>F8</td>
<td>Makes the next record current.</td>
</tr>
<tr>
<td>&quot; &quot; F7</td>
<td>Makes the first record current.</td>
</tr>
<tr>
<td>&quot; &quot; F8</td>
<td>Makes the last record current.</td>
</tr>
</tbody>
</table>

The records appear in the order they are entered, until you sort them (see Field & Sort Settings in Section 6, “Records”).

FIELD SPECIFICATIONS
Reflex keeps track of information by means of the field names. You use the field names to direct Reflex to manipulate the information in the various views and in the tools.

FIELD NAMES
Field names may be a maximum of 72 characters long. Reflex has minor restrictions on what field names may be used.

UPPERCASE AND LOWERCASE
Reflex does not distinguish between uppercase (capital) and lowercase letters, except when sorting. Some items are printed in uppercase in the User’s Guide for quick recognition on the page. However, you may enter them without using uppercase.

RESERVED WORDS AND CHARACTERS
Field names can contain any characters on the keyboard, including numbers and spaces, except for the words and characters listed below. These are reserved for use in Reflex formulas.

Reserved Words
AND, OR, NOT, UPTO, DNTO, THRU, BTWN, ALL, and any of the @ functions are reserved words and may not be used within a
field name if they are surrounded by spaces; they may be used as letter combinations happening to fall within another word.

**Reserved Characters**

( ) <> = + - / * ^, are not valid as field names or within field names. Spaces may be used within field names, but not as a leading or trailing character. Note that while the reserved words may appear within field names if they are not surrounded by spaces, reserved characters may not, regardless of whether there are spaces around them. Numbers may not be used alone as field names. They are valid within field names.

<table>
<thead>
<tr>
<th>VALID</th>
<th>INVALID</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Price</td>
<td>and</td>
<td>(&quot;and&quot; is a reserved word)</td>
</tr>
<tr>
<td>More</td>
<td>True or False</td>
<td>(&quot;or&quot; is a reserved word)</td>
</tr>
<tr>
<td>Overall</td>
<td>All totaled</td>
<td>(&quot;All&quot; is a reserved word)</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Variable + Fixed</td>
<td>(&quot; + &quot; is a reserved character)</td>
</tr>
<tr>
<td>$Margin</td>
<td>Variable + Fixed</td>
<td>(&quot; + &quot; is a reserved character)</td>
</tr>
<tr>
<td>% Margin</td>
<td>99</td>
<td>(numbers can't be used alone)</td>
</tr>
</tbody>
</table>

In addition, you cannot use the same field name for two fields. *Date 1* and *Date 2*, however, are perfectly acceptable.

**FIELD TYPES**

Every field has a type. The **field type** indicates the kind of data that can be entered in that field: text, numeric, or date. When we say a text field, a numeric field, or a date field, we are referring to a field of that type.

**ESTABLISHING THE FIELD TYPE**

When you first enter a field name, it has an undefined type. There are two ways to establish the field type:

- Reflex recognizes the type of data you first enter into a field. After that, the field is reserved for the same type of data.
- You can set or change the field type yourself in Field & Sort Settings. (See Part 6, "Records.")
Text
A text field contains letters, words, sentences, punctuation marks, special characters, letters and numbers together, and any number or date that you want to treat as a text entry.

Here are some examples of entries that are automatically text:

- Letters, words, and sentences: Bill, San Francisco, CA, North, Product out of stock
- Mixed entries: 5460 Bouyant Avenue, (415) 555-1212, 1 ABC 717, 16d, 17#

Numbers treated as text: Typically you treat zip codes as text because Reflex doesn't display a leading zero in a numeric field. To cause a number to be treated as text, enter a single quote mark (') before the number the first time you enter data in that field. After the first entry, you do not need to use the quote mark.

Numeric
A numeric field contains only numbers (plus a decimal point or a minus sign) or a calculation that produces a number. When you enter numbers, do not include $, or commas. You can use the Field & Sort Settings Tool to set the display format to display dollar signs and commas.

Date
A date field contains dates entered in the format month/day/year—for example, 1/17/84. You do not need to enter a zero in front of a single-digit month or day. You can set the display format to display the date in one of several ways: 17-Jan-84, Jan-84, January 17, 1984, 1/84, and 1/17/84.

FIELD TYPE RECOGNITION
The first time you enter data into a field, Reflex assumes that you want to set the field type for that kind of data.

- If the first entry contains any letters or special characters, or if it begins with a single quote ('), Reflex sets the field type as text.
- If the first entry is all numbers, Reflex sets the field type as numeric.
- If the first entry is in the form of mm/dd/yy, Reflex makes the field a date field.
- If the first entry begins with =, +, or @, Reflex determines the field type from the formula that follows.
Reflex automatically recognizes the field types, so you can go directly from designing your form to entering data. You do not need to take a separate step of establishing the field types.

In certain cases, however, you will need to use the Field & Sort Settings tool to establish the field type.

- If your first entry is the wrong type (for instance, you accidentally enter text in a field you want to use for numbers), you must use Field & Sort Settings to change the type.
- If you write a formula for a calculated field in the first record, the field type will be set according to the formula. However, you cannot use untyped fields in the formula. Either set the types for any untyped fields in the formula by using the Field & Sort Settings Tool or make sure that your formulas refer to already-typed fields.

**CHOICES**

The Reflex Choices feature enables you to enter keywords and field names without having to remember them or type them in.

Choices may be used anywhere in the program. Pressing the Choices key [F10] causes Reflex to display a choice list on the screen. It contains available entries for whatever is currently selected.

Typically, a choice list contains all the current field names. You select the field name from the choice list for use in formulas, list column headings, and other places where you need to refer to them.

Other examples of where Choices may be used are:

- In the Save, Retrieve, and Erase tools, the choice list contains all the relevant file names in the current directory.
- In Report View, the list of choices shows the available attribute options.
- In the Field & Sort Settings tool, the choice list contains the available choices for field type or display format, depending on which is currently selected.
- In the Crosstab View, the choice list shows the available summary functions when the Summary cell is selected.
A typical Choices display. All the current field names are listed.

```
Tyler Canoe Company
Monthly Sales Report
Rep: Alan
Product: Paddles
Quantity: 81
Unit Cost: $77
Total Cost: =Unit Cost * 1
Avg Price: $81

Commission
Date
Product
Quantity
Rep

% Margin: 4.8
Margin: $313
Commiss: $78.25
```

**SELECTING FROM A CHOICE LIST**

After you have selected the location for your entry, press Choices \[F10\].

- Use \[ ↑ \] and \[ ↓ \] to move the cursor to the choice you want. Then press \[ \longleftarrow \].

- Or: Type in the first letter of the desired choice. The first choice beginning with that letter will be highlighted. Press \[ \longleftarrow \].

**NOTE** When the choice list appears, you may not see all the available choices. Use the arrow keys to scroll to see all the choices.

The other cursor movement keys also work in choices. \[ \text{Home} \] and \[ \text{End} \] move the cursor to the first and last choices. \[ \text{Pg Up} \] and \[ \text{Pg Dn} \] scroll the list by pages. \[ \longleftarrow \], \[ \rightarrow \], and \[ \longleftarrow \] enter the choice and then move the selection in the indicated direction.

\[ \text{m} \] If you have a mouse, you can select a choice from the list by putting the pointer on it and clicking the left button.
EDITING

Editing is used to change any entry, whether it's information in the database or cells in a view or tool.

To correct a typing mistake as you make it, simply backspace over it and retype.

You can edit an entry in two ways:

☐ Select the cell and retype the entry.
☐ Select the cell and press the Edit key [F2] to enter the Edit mode. This allows you to change the entry without retyping it.

THE EDIT MODE

Edit mode allows you to modify an entry without retyping all of it. Special functions are made available to insert, delete, and change individual characters.

Begin by selecting what you want to change. Then press the Edit key [F2] to enter the Edit mode. While Reflex is in the Edit mode, you can use the ← and → keys to move the cursor to any location in the entry without disturbing any of the characters. Then simply type in corrections or changes. Press ← to enter the changed data in the selected cell and leave the Edit mode.

While you are in Edit Mode, the selected cell and the Edit line display the entry being edited. Since data entries may be 254 characters long, the entry will scroll automatically when you move the cursor past the part shown. The Edit line will show 80 characters at a time, while the amount shown by the cell will vary depending on where it is.

Any value being edited is displayed in the format it was typed in, rather than the format in which it is normally displayed. For example, if there is a formula producing the value for a particular field, you will edit the formula, not the value. If a field contains a number, you will edit the underlying number, regardless of the display format.
The following keys have particular functions in Edit mode:

<table>
<thead>
<tr>
<th>KEY</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Esc</td>
<td>Returns the old data to the cell and takes you out of Edit mode.</td>
</tr>
<tr>
<td>←</td>
<td>Moves the cursor one space to the left.</td>
</tr>
<tr>
<td>→</td>
<td>Moves the cursor one space to the right.</td>
</tr>
<tr>
<td>←</td>
<td>Moves the cursor five spaces to the right.</td>
</tr>
<tr>
<td>Home</td>
<td>Moves the cursor five spaces to the left.</td>
</tr>
<tr>
<td>End</td>
<td>Moves the cursor to the first character in the cell.</td>
</tr>
<tr>
<td>(Backspace)</td>
<td>Moves the cursor to the last character in the cell.</td>
</tr>
<tr>
<td>Ins</td>
<td>Moves the cursor to the left, deleting characters as it moves.</td>
</tr>
<tr>
<td>Del</td>
<td>Inserts a space at the cursor location.</td>
</tr>
<tr>
<td>↑</td>
<td>Deletes a character at the cursor location.</td>
</tr>
<tr>
<td>↓</td>
<td>Enters the data and then moves the selection to the next cell.</td>
</tr>
<tr>
<td>(Backspace)</td>
<td>Enters the data and then moves the selection to the previous cell.</td>
</tr>
</tbody>
</table>

NOTE: None of the changes you make are permanent until you press Esc, ↑, or ↓. Until then, Esc will remove the changes and return the cell to the way it was before.

THE EDIT MENU

The editing functions apply throughout Reflex.

<table>
<thead>
<tr>
<th>Views</th>
<th>Edit</th>
<th>Print/File</th>
<th>Records</th>
<th>Search</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td>Insert</td>
<td>Set Column Width</td>
<td>Row Select</td>
<td>Column Select</td>
</tr>
</tbody>
</table>

DELETE

Choosing Delete (/ED), or using the Del Key, erases whatever is selected.
If a cell is selected, its contents become null.
If a row or column is selected, it is removed from the display.
In Edit mode, Delete erases the character at the cursor location.

**INSERT**

Where appropriate, choosing Insert (\EI), or pressing the Ins Key, adds to the display.

- When a row or column is selected, Insert adds another row immediately above, or column immediately to the left, of the selection.
- In Form Design, Insert adds a row above the selection.
- In Edit mode, Insert adds a space at the selection.

**SET COLUMN WIDTH**

If the current selection is in a column, such as in the List View, choosing Set Column width (/ES) allows you to adjust the width of that column.

To change the width of a column:

1. Select any cell in the column and choose Set Column Width from the Edit menu.
2. Use \[ \rightarrow \] and \[ \leftarrow \] to change the width.
3. When the column width is as desired, press \[ \leftarrow \].

[m] If you are using a mouse, you can change the column width with the pointer:

1. Put the tip of the pointer on the dividing line between two columns.
2. Press-and-hold the left button.
3. Move the pointer to the new location (a shadow line moves with the pointer).
4. Release the button.

The maximum width of a column is 70 screen spaces.
**ROW SELECT**

Choosing Row Select (/ER), or pressing **F3**, is a preparatory action. You select a row in order to delete it or to insert another one above it. Once you have selected a row, the **↑** and **↓** keys move the highlight from row to row.

To un-select a row: Press **Esc**, **→**, or **←**.

**COLUMN SELECT**

Choosing Column Select (/ES), or pressing **F4**, is a preparatory action. You select a column in order to delete it or to insert another one to the left. Once you have selected a column, the **→** and **←** keys move the highlight from column to column.

To un-select a column: Press **Esc**, **↑**, or **↓**.

**WINDOW CLEAR**

To clear the active window (either a view or a tool), choose Window Clear from the Edit menu (/EW). It does not apply to Form View. It has no effect on the database itself.

Clear a view whenever you want to build up a new display from scratch.

Clear a tool whenever you want to make extensive changes in the instructions.

**WARNING**

Do not confuse this command with Clear Database on the Records menu. Clear Database erases the current database from the computer’s memory.
### PART 4

#### THE VIEWS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A FORM DESIGN</td>
<td>35</td>
</tr>
<tr>
<td>Opening form design</td>
<td>36</td>
</tr>
<tr>
<td>Closing form design</td>
<td>37</td>
</tr>
<tr>
<td>Positioning the cursor</td>
<td>37</td>
</tr>
<tr>
<td>Entering field names</td>
<td>38</td>
</tr>
<tr>
<td>Adding field names</td>
<td>38</td>
</tr>
<tr>
<td>Deleting field names</td>
<td>39</td>
</tr>
<tr>
<td>Renaming fields</td>
<td>39</td>
</tr>
<tr>
<td>Entering labels</td>
<td>40</td>
</tr>
<tr>
<td>B THE FORM VIEW</td>
<td>40</td>
</tr>
<tr>
<td>Opening and closing the Form View</td>
<td>41</td>
</tr>
<tr>
<td>Moving around the Form View</td>
<td>42</td>
</tr>
<tr>
<td>Scanning the records</td>
<td>42</td>
</tr>
<tr>
<td>Entering data in Form View</td>
<td>43</td>
</tr>
<tr>
<td>C THE LIST VIEW</td>
<td>44</td>
</tr>
<tr>
<td>Opening and closing the List View</td>
<td>45</td>
</tr>
<tr>
<td>Working in the List View</td>
<td>45</td>
</tr>
<tr>
<td>Re-arranging the columns</td>
<td>46</td>
</tr>
<tr>
<td>Entering and editing data in the List View</td>
<td>48</td>
</tr>
<tr>
<td>D THE GRAPH VIEW</td>
<td>49</td>
</tr>
<tr>
<td>The Graph View screen</td>
<td>49</td>
</tr>
<tr>
<td>Opening and closing the Graph View</td>
<td>51</td>
</tr>
<tr>
<td>Setting up a graph: plotting data</td>
<td>51</td>
</tr>
<tr>
<td>Working with records in the graph</td>
<td>54</td>
</tr>
<tr>
<td>Graph types</td>
<td>56</td>
</tr>
<tr>
<td>Graphing summaries and For Each</td>
<td>60</td>
</tr>
<tr>
<td>Scaling, titles, and grids</td>
<td>63</td>
</tr>
<tr>
<td>E THE CROSSTAB VIEW</td>
<td>66</td>
</tr>
<tr>
<td>Opening and closing the Crosstab View</td>
<td>67</td>
</tr>
<tr>
<td>Moving around the Crosstab View</td>
<td>68</td>
</tr>
<tr>
<td>Row and column manipulation</td>
<td>69</td>
</tr>
<tr>
<td>Creating a Crosstab</td>
<td>70</td>
</tr>
<tr>
<td>Display options</td>
<td>76</td>
</tr>
<tr>
<td>Additional formulas</td>
<td>77</td>
</tr>
<tr>
<td>Saving, retrieving, and deleting Crosstabs</td>
<td>80</td>
</tr>
</tbody>
</table>
The information in a paper database is static. You can see it in only one way, so it can be difficult to understand how the pieces of information are related. The information in a Reflex database is fluid; you can display it many ways and examine it from many angles.

Reflex provides different views of the information, each providing a different perspective on what the information means.

There are five Reflex Views:

- **The Form View** the detail, displayed one record at a time.
- **The List View** the row-and-column display of the records.
- **The Graph View** the visual overview for analyzing trends and making comparisons.
- **The Crosstab View** the numeric overview for analyzing trends and making comparisons.
- **The Report View** for creating customized reports from the database.

In this section, we discuss the Form, List, Graph, and Crosstab Views. Report View is discussed in Reference B.

---

**FORM DESIGN**

You use Form Design to create your Form View and thereby set-up your database. With it you enter field names and position them on the form. The field names you enter become the fields in the database.

You use Form Design to:

- Enter field names and create the Form.
- Position field names on the Form.
- Rename fields.
- Add and delete fields.
- Place labels on the form.
Using Form Design is easy. The form is treated like a blank piece of paper, on which you enter field names wherever you like. In the same fashion, the form may be modified at any time, even after information is entered in the database.

Upon exiting Form Design, the database is "live" and you can begin entering information.

**OPENING FORM DESIGN**

Form Design is part of Form View. There are two ways to open Form Design:

- If you have not yet set up a database, Choose Form from the Views menu (/VF). It will automatically open in Form Design.
- If you are currently working with a database, you must first make Form View the active view. Then choose Design Form from the Form menu (/FD).

The Form Design screen fills the entire windows area. It displays whatever field names or labels have been previously established. It does not display data.
Form Design is 500 characters wide and 500 rows long. You can enter field names anywhere in this area. **Position numbers** on the bottom line of the Form Design window specify the location of the cursor on the Form Design screen; use them to align field names.

### CLOSING FORM DESIGN

When you have finished with Form Design, you will return to one of the Views.

- To close the Form Design screen and return to the Form View, choose Exit Design from the Form menu (/FE).
- To close the Form Design screen and return to the List View, Graph View, or Crosstab Views, choose the view from the Views menu.

### POSITIONING THE CURSOR

To enter or edit a field name at a particular location, the first step is to position the cursor at that location.

You can move your cursor to any position on the form by using the cursor keys.

<table>
<thead>
<tr>
<th>KEY</th>
<th>WHERE YOUR CURSOR MOVES</th>
</tr>
</thead>
<tbody>
<tr>
<td>↑</td>
<td>Up one line</td>
</tr>
<tr>
<td>↓</td>
<td>Down one line</td>
</tr>
<tr>
<td>←</td>
<td>Left one space</td>
</tr>
<tr>
<td>→</td>
<td>Right one space</td>
</tr>
<tr>
<td>Home</td>
<td>Top left corner of the form</td>
</tr>
<tr>
<td>End</td>
<td>Bottom right-hand corner of the form</td>
</tr>
<tr>
<td>←</td>
<td>Right five spaces</td>
</tr>
<tr>
<td></td>
<td>Left five spaces</td>
</tr>
<tr>
<td>Pg Dn</td>
<td>Down one page</td>
</tr>
<tr>
<td>Pg Up</td>
<td>Up one page</td>
</tr>
<tr>
<td>Ctrl ←</td>
<td>Left one page</td>
</tr>
<tr>
<td>Ctrl →</td>
<td>Right one page</td>
</tr>
<tr>
<td>←</td>
<td>Down one row and to the left edge of the leftmost field of the previous row.</td>
</tr>
</tbody>
</table>
ENTERING FIELD NAMES

To enter a field name, position the cursor, type the name, and either press ↓ or reposition the cursor. Field names can be located anywhere on the form as long as they do not overlap any other entry. Three spaces are required between field names (however a label may immediately precede a field name.) You may enter up to 128 field names.

Spaces before and after a field name are not allowed. Spaces within a field name count.

NOTE Do not type a colon (:) after your field names. Reflex automatically displays a colon after each field name on the Form View when you leave Form Design.

For rules on valid field names, see Section B, Field Specifications, of Part 3, Entering and Editing Data.

MOVING FIELD NAMES

To move a field name, select the field name you wish to move, choose Move Field from the Form menu (/FM), and use the cursor keys to position the field name where you want it. Press ↓.

[m] To move a field name with a mouse, position the pointer on the field name, press-and-hold the left button, and move the pointer to the new location. Release the button.

Moving a field name does not affect the data entered in the field. You can move a field name to any other location at any time.

ADDING FIELD NAMES

You can add fields to an existing database in Form Design.

To add a field, simply position the cursor where you want the new field name and type it in.

To insert a row for adding a field name, use the Insert command on the Edit menu (/EI) or the Ins key.
DELETING FIELD NAMES

You can delete a field from the database by deleting the field name. Follow this procedure:

1. Select the field name you want to delete.
2. Choose the Delete option from the Edit menu (ED) or press Del. Reflex will display a confirmation message.
3. Type Y to confirm.

The field name disappears. The field and all its entries are removed from the database.

WARNING

When you delete a field name, you delete the field and all the data in that field. Once you’ve deleted a field name, the field and its data no longer exist in your computer’s memory.

If you mistakenly delete a field and then want to restore the data to the database, you will have to retrieve the database from your data disk. Any changes made since the last time the database was saved to disk will be lost, though.

To delete a blank row, position the cursor anywhere in the row and press Del. Reflex will not allow you to delete a row with a field name in it.

EFFECTS ON FORMULAS

Because Reflex can use field names in formulas that calculate field values, deleting one field can affect calculated fields. If you delete a field that is used in a formula, error values result in the remaining affected fields.

RENAMING FIELDS

You can edit field names to correct or rename them by using either of the two methods below.

□ Select the field name and type in the new field name. Press \("\).  
□ Select the field name, then press the Edit key [F2]. When you have finished making changes, press \("\).
Editing field names doesn't affect the data in those fields. Renaming a field will also rename it in any formula using that field name.

**WARNING** If you mean only to change a field name, do not delete it first. If you delete a field name, the data in that field disappears.

**ENTERING LABELS**

Anything entered in Form Design that is not to be used as a field name is called a label. Enter a label by typing an apostrophe (single quote) before the words in the label. Labels can be used for titles, comments, directions, or other information which appear on the Form but do not affect the database.

Labels may be entered anywhere on the form. They will appear in Form View only. They can be edited only in Form Design.

**THE FORM VIEW**

The Form View displays one complete record at a time. You see the field names, the data in each field, and whatever labels you have included on your form.
You can use the Form View to enter and edit data.

You can also use the Form View to add or delete records, find a specific record, cycle through the sequence of records, and enter formulas for calculated fields.

**OPENING AND CLOSING THE FORM VIEW**

*To open the Form View,* choose Form from the Views menu (/VF). (If another view is currently active, Reflex will display the Replace/Vertical/Horizontal message and wait for your instructions.) If you are in Form Design, choose Exit Design from the Form menu (/FE).

*To close the Form View,* choose Close from the Views menu (/VC).
MOVING AROUND THE FORM VIEW

The cursor movement keys take you from field to field in sequence. Reflex looks across, then down, for the next field.

**KEY** | **MOVES THE CURSOR TO**
---|---
← | Previous field
→ | Next field
↑ | Previous field
↓ | Next field
Home | First field
End | Last field
\[\leftarrow\] | Next field
\[\rightarrow\] | Previous field
Pg Up | Moves up one page
Pg Dn | Moves down one page
Ctrl \[←\] | Moves left one page
Ctrl \[→\] | Moves right one page

The Form View can be larger than the window in which it is displayed. If a field is not visible in the window, selecting it causes the view to scroll so that it is shown.

SCANNING THE RECORDS

Use the Record keys, \[F7\] and \[F8\], to display successive records in the Form View.

**KEY** | **DISPLAYS**
---|---
\[F7\] | Previous record
\[F8\] | Next record
\[\uparrow\] \[F7\] | First record
\[\uparrow\] \[F8\] | Last record
ENTERING DATA IN FORM VIEW

The field established by each field name is just to the right of the field name. You can enter data in the fields at any time. No special commands are necessary.

CREATING A RECORD

To create a record, you simply enter data into a blank form. Reflex automatically creates a new record with that data and puts it into the database.

A blank form is always available at the end of the database, after the last filled-in record. To reach it, first press the Last Record Key, \[Q\[Q\[F8\], and then the Next Record Key \[F8\]. Since there are no more records at that point, Reflex displays a blank form, which can be filled out. As soon as you enter data into it, a record is created and a new blank form is available after it.

To add a new record in the middle of the database, choose Add Record from the Records menu (/RA). This will add a blank record after the current record.

ENTERING AND MODIFYING DATA

To enter and modify data in the form, follow the general editing rules:

1. Select the field, type in the new data, press \[\leftarrow\].
2. Or select the field, press the Edit key, \[F2\], to enter the Edit mode, make whatever changes are necessary, and press \[\leftarrow\].

Selecting a different field automatically enters the data you have typed in. A common sequence, then, is to enter data in a field, press \[\leftarrow\] to move the the next field, enter data in that field, and so on until the record is filled out. If you are at the end of the database, the Next Record Key \[F8\] brings a blank form for continued data entry.
SAVING THE DATABASE

WARNING

Bear in mind that once you've created records, they exist only in the computer's memory. To make them permanent, you must save your work in a file on a data disk. Choose Save File from the Print/File menu (IPS). It is a good idea to save the database every 20 minutes or so. This will limit loss of data due to power failures or mistakes.

THE LIST VIEW

In the List View, the records are displayed in rows and columns. The records are displayed one per row, with each field in a separate column. At the top of each column is the name of the field shown within that column.

<table>
<thead>
<tr>
<th>Date</th>
<th>Product</th>
<th>Rep</th>
<th>Quantity</th>
<th>Unit Cost</th>
<th>Sales$</th>
<th>Avg Price</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan-85</td>
<td>Paddles</td>
<td>Alan</td>
<td>81</td>
<td>$77</td>
<td>$6,550</td>
<td>$81</td>
<td>$6.2</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Silent</td>
<td>Alan</td>
<td>16</td>
<td>$570</td>
<td>$16,355</td>
<td>$1,852</td>
<td>$9.1</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Sport</td>
<td>Alan</td>
<td>18</td>
<td>$390</td>
<td>$4,376</td>
<td>$438</td>
<td>$3.9</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Swiftwater</td>
<td>Alan</td>
<td>9</td>
<td>$457</td>
<td>$6,672</td>
<td>$741</td>
<td>$3.9</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Paddles</td>
<td>Bob</td>
<td>51</td>
<td>$77</td>
<td>$5,235</td>
<td>$183</td>
<td>$3.9</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Silent</td>
<td>Bob</td>
<td>6</td>
<td>$570</td>
<td>$6,450</td>
<td>$1,875</td>
<td>$3.4</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Sport</td>
<td>Bob</td>
<td>7</td>
<td>$390</td>
<td>$3,794</td>
<td>$542</td>
<td>$2.7</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Swiftwater</td>
<td>Bob</td>
<td>9</td>
<td>$457</td>
<td>$7,433</td>
<td>$826</td>
<td>$3.9</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Paddles</td>
<td>Cathy</td>
<td>45</td>
<td>$77</td>
<td>$4,613</td>
<td>$183</td>
<td>$3.4</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Silent</td>
<td>Cathy</td>
<td>7</td>
<td>$570</td>
<td>$6,789</td>
<td>$958</td>
<td>$3.9</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Sport</td>
<td>Cathy</td>
<td>5</td>
<td>$390</td>
<td>$2,667</td>
<td>$533</td>
<td>$1.9</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Swiftwater</td>
<td>Cathy</td>
<td>7</td>
<td>$457</td>
<td>$5,728</td>
<td>$818</td>
<td>$3.8</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Paddles</td>
<td>Dave</td>
<td>68</td>
<td>$77</td>
<td>$6,325</td>
<td>$93</td>
<td>$5.2</td>
</tr>
</tbody>
</table>

The list may be customized, showing the fields in different orders, or showing only some fields, by entering the field.
names in the column headers in the order in which you wish to see them.

Filtering the database allows you to control which records are displayed.

**OPENING AND CLOSING THE LIST VIEW**

To open the List View, choose List from the Views menu (/VL). If there are other Views on the screen, Reflex displays the Replace/Vertical/Horizontal message and waits for instructions.

The List View displays the current record at the top of the list. To display the first record in the database (according to the current sort order), press [Home] or [Esc] [F7].

To close the List View, choose Close from the Views menu (/VC).

**WORKING IN THE LIST VIEW**

**THE CURRENT RECORD**

The current record indicator is an arrowhead (▶) located to the left of the current record. Selecting any field in a record makes it the current record.

To change the current record use the Record keys [F7], [F8], [Esc] [F7], and [Esc] [F8]. These keys make current the previous, next, first, and last records, respectively.

**MOVING AROUND THE LIST VIEW**

The cursor movement keys enable you to select any cell in the List View table.
The List View can be larger than the window in which it is displayed. You can see the hidden parts of the List View by scrolling.

To scroll the List View, use the cursor movement keys to select cells. The View will scroll to display the selected cell.

**CHANGING THE COLUMN WIDTH**

Columns have preset widths, which may not always allow you to see the entire field entry. (The Edit line also displays the entry in any selected field.) You can change the width of any column to see the contents.

To change the width of a column, first select any cell in the column, then choose Set Column Width from the Edit menu (/ES). Use \[\rightarrow\] and \[\leftarrow\] to move the column dividing line to where you want it, then press \[\leftarrow\].

[m] If you are using a mouse, you can change the width of a column with the pointer. Put the tip of the pointer on the dividing line you want to move. Press-and-hold the left button. While still holding down the button, move the pointer and the “shadow line” to the location you want. Release the button.

The maximum width of any column is 70 characters.

**RE-ARRANGING THE COLUMNS**

You can rearrange the columns to display particular fields side-by-side or to make data entry easier. You can also move and delete columns without losing any data. Deleted columns can be recalled at any time.

The general approach to arranging the List is to put the field names in the column headings in the order you’d like to see the fields displayed.

*Putting a field name in a column heading causes that field’s values to be displayed in the column.*

**NOTE** The Choices Key \[F10\] is a particularly convenient method of entering field names in the column headings.

**SELECTING A COLUMN**

Before inserting or deleting a column, you must select it. To select a column, choose Column Select from the Edit menu (/EC) or press the Column key \[F4\].
To unselect a column, press \( \uparrow \) or \( \downarrow \). The cursor will highlight the column heading cell. If you press \( \text{Esc} \), the cursor will return to its previous location.

To insert a blank column, first select a column. Then choose Insert from the Edit menu (/EI) or press \( \text{Ins} \). A blank column will be inserted to the left of the selected column. A field name can then be entered in the column heading to display its values in that column.

To delete a column, first select the column you want to delete. Then choose Delete from the Edit menu (/ED) or press \( \text{Del} \). The selected column is deleted from List View.

Although the column is no longer displayed, the data remains in the database. You can recall a column at any time. See Recalling a Column, below.

MOVING A COLUMN

To move a column, insert a blank column where you want it to go. Select the column heading cell of the blank column by scrolling to it or by pressing \( \uparrow \) \( \text{F4} \). Enter the field name of the column you want displayed in that location.

The column moves from its old location to the new location.

REPLACING A COLUMN

To replace a column with another, enter the field name of the column you want to display in the heading of the column you want to replace.
The new column replaces the old column, and the old column is deleted.

RECALLING A COLUMN
Any deleted column can be recalled.

You may insert a blank column for this purpose, replace an existing column, or use the blank column that is always available on the far right of the List.

CLEARING AND RESTORING THE VIEW
To delete all the columns at once, choose Window Clear from the Edit menu (/EW). Only one blank column remains. Entering a field name in any column heading will recall that column.

To recall all deleted columns and restore the List View to its original order, choose Show All Fields from the List menu (/LS).

NOTE: The List View will display existing fields; it is not used to create new fields. New fields may be added in Form Design or in the Field & Sort Settings tool.

ENTERING AND EDITING DATA IN THE LIST VIEW

To enter data in the List View, select the cell, type in the information, and press [Enter] or select another cell. The value is then entered in that field for that record.

ADDING A RECORD
Just as in the Form View, the List View allows you to fill in a blank record at the end of the database. To reach it, you can scroll, use the End Key, or the Last and Next Record Keys.

Entering data in any field in the blank record adds the record to the database.

The List View provides two ways to add a record between existing records:

- To add a record after the current record (below it in the list), choose Add Record from the Records menu (/RA). A blank record appears and becomes the current record.
- To insert a record before the current record (above it in the list), first select the row by choosing Row Select from the Edit menu (/ER) or by pressing the Row Key, [F3]. Then choose Insert from the Edit menu (/EI) or press
A blank record appears. Press \( \rightarrow \) to select the first field in the row.

**DELETING A RECORD**

Just as there are two ways of inserting records in the List View, there are two ways of deleting records.

- To delete the current record, choose Delete Record from the Records menu (/RD). The current record is deleted.
- You may also delete the current record by deleting the row. Choose Row Select from the Edit menu (/ER) or press the Row key \( F3 \). Then choose Delete from the Edit menu (/ED) or press \( \text{Del} \). The current record is deleted.

**THE GRAPH VIEW**

The Graph View provides a visual representation of information. It can show data plotted in any of five ways—as a scatter graph, a line graph, a bar chart, a cumulative (stacked) bar chart, or a pie chart.

Values plotted on the graph are drawn from records in the database. Reflex can plot individual values (i.e., one from each record), or it can create summary graphs showing totals, averages, counts, minimums, maximums, variances, and standard deviations.

Reflex also takes graphs beyond presentation graphics into interactive analysis. Points on the graph may be selected, causing the underlying detail to be displayed in the form or list.

**THE GRAPH VIEW SCREEN**

The Graph window contains a variety of cells which indicate what's being graphed, e.g. the x-axis field and the y-axis fields. These cells are under your control—not only do they tell you what's being graphed, but by filling them in with field names, you control what's graphed.
Below are the parts of the Graph View.

**Title**  An optional title for the graph.

**Graph area**  Plotted data appears in the graph area.

**X-axis field**  The field being plotted on the horizontal axis.

**Summary Indicator**  Indicates that Reflex has summarized the values for each unique entry in the x-axis field.

**For Each field Indicator**  Indicates that Reflex has created a separate y-graph for each unique entry in this field.

**X-axis scale or labels**  Identifies the entries for each interval on the x-axis.

**Y-axis legends**  These legends associate a particular graph segment, e.g., particular line or bar, with the name of the field being graphed.

**Y-axis scale**  The numeric scale for the y-axis fields being graphed.
OPENING AND CLOSING THE GRAPH VIEW

To open the Graph View, choose Graph from the Views menu (/VG).

If the window is too small to display a graph, a message is shown indicating that. If this occurs, Resize (/VR) or Expand (/VE) to make the window larger.

To close a Graph View, choose Close from the Views menu (/VC).

SETTING UP A GRAPH: PLOTTING DATA

The steps to create a Reflex graph are:

- Enter a field name in the x-axis field cell.
- Enter successive field names in the y-axis legend cells.

As soon as the x-axis field and one y-axis field have been entered, Reflex draws the graph representing those values. Changes to the graph (additional values, changing graph type, etc.) cause Reflex to redraw the graph appropriately.

MOVING AROUND THE GRAPH VIEW

The Graph View has a number of cells in which you see and enter data and field names. Moving between these cells is important, since selecting them and entering field names is how you control what is graphed.

At minimum, there are three areas:

- The graph area—the large rectangle where the graph is displayed.
- The x-axis field cell—where you enter the field to graph on the x-axis.
A y-axis legend cell—where you enter a field to graph on the y-axis.

The minimum display: three areas.

In addition to the three areas above, you can select:

- Up to seven more y-axis legend cells.
- A For Each field cell.
- A graph title cell.

The maximum display: several areas.
The graph areas are ordered in sequence. You use ↑ and ← to select the previous area and ↓ and → to select the next area.

**THE X-AXIS FIELD**

When you enter a field name in the x-axis field cell, you're identifying the data that you want Reflex to plot on the x-axis. You can plot one field at a time on the x-axis.

○ To enter the x-axis field, select the x-axis field cell, type a field name, and press ←.

○ Or select the x-axis field cell, press the Choices key [F10], and select a field name from the choice list.

To change the values displayed on the x-axis, select the x-axis field and enter a new field name.

If the x-axis field is numeric and a line or scatter graph is chosen, Reflex automatically scales the x-axis scale to show all the data. If the x-axis field is text or date, or a bar or cumulative bar graph is chosen, one entry is made for each record, with the values displayed in ascending order along the x-axis. If there are too many entries to be shown, further entries may be seen by scrolling to the right.

**Y-AXIS FIELDS**

You can plot values for up to eight fields along the y-axis. You do so by specifying field names in successive legend cells. To specify the field for the y-axis, select a legend cell and enter the field name. When you enter a field name in a blank legend cell, a new blank legend cell appears to enter additional fields.

You can identify the graph for each field by the graphic symbol or pattern next to the field name in the legend cell.

**Y-AXIS FIELD TYPE**

Y-axis fields *must* be numeric. Text and date fields cannot be graphed on the y-axes.

To change a field displayed on the y-axis, select the legend cell and enter a new field name. To remove a field from the graph, delete the field name from the legend cell. Select the legend cell, then choose Delete from the Edit menu ([ED]) or press Del.
WORKING WITH RECORDS IN THE GRAPH

THE CURRENT RECORD
When individual records are represented on the graph, by either points or bars, there is a one-to-one relationship between records in the database and points or bars on the graph.

The current record is indicated by a rectangle around the graph point or, in the case of bar graphs, around the x-axis label.

MOVING THROUGH RECORDS
The entries on the x-axis are ordered left to right in ascending order of the entries in the field. The order is independent of the current sort order.

The sort order, however, determines the first, last, next, and previous records. Thus, the Record keys, [F7] and [F8], may select records in a sequence different from the sequence represented on the graph. The [→] and [←] keys select records in the order they are represented on the graph.

SCROLLING THE GRAPH AREA
If the graph extends past the edges of the graph area, you can scroll the graph horizontally to bring each graphed value into view.

The graph can be scrolled either in whole pages or one record at a time.
To scroll a whole page, use the following keys:

<table>
<thead>
<tr>
<th>KEY</th>
<th>MOVEMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl →</td>
<td>Page right</td>
</tr>
<tr>
<td>Ctrl ←</td>
<td>Page left</td>
</tr>
</tbody>
</table>

To scroll the graph one record at a time, you must first select the graph area. Do this by pressing until the current record indicator changes to a solid cursor highlight. Then press ← or → to scroll additional points into viewing.

**GRAPHIC RECORD SELECTION (SEE A POINT OF INTEREST?)**

Often when you're looking at a graph, a particular point grabs your attention—it's unusually high or low, or is at the peak of an unexpected trend. You'd like to know what's behind it. Graphic record selection is a fast way to see the detail behind any point on the graph.

By selecting a point on the graph, you make that record current, so it will be automatically displayed in the Form View or List View. Open the Form View or List View, either sharing the screen with the Graph View, or alone, and you'll see the record behind any selected point on the graph.

To select a point in the graph, follow these steps:

1. Cursor up to the graph area. This will be indicated by the rectangle around the current point or bar selection highlighting. This rectangle indicates the graph point representing the current record.

2. You can now move the point or bar selection from record to record with the ← and → cursor keys. Doing so changes the current record to the one behind whichever point is highlighted.

If you are using a mouse, select a point or bar with the mouse pointer. The record corresponding to the selected data becomes the current record.
### GRAPH TYPES

When the Graph View is active, the Type menu added to the main menu line provides commands for five types of graphs: scatter, line, bar, cumulative (stacked) bar, or pie chart.

To set the graph type, choose one of the five types from the Type menu. You can change the graph type at any time by choosing a new type. Reflex will immediately replot the new graph. If you don't choose, Reflex will plot a line graph.

#### LINE GRAPH

A line graph plots individual points which are connected with a line. When multiple fields are being graphed, lines connect points shaped differently for each field. The legends at the bottom of the Graph view associate each point shape with the corresponding field.
A line graph.

Line graphs are often useful for showing trends and relationships.

**SCATTER GRAPH**

A scatter graph plots individual points. When multiple fields are being graphed, differently shaped points are used for each field. The legends on the bottom of the Graph View associate each point shape with the corresponding field.

A scatter graph.

Scatter graphs are often used for identifying trends and groupings of data.
BAR GRAPH

A bar graph represents y-axis values as solid bars. When multiple fields are graphed, each field has its own bar, with a pattern corresponding to the legend on the bottom of the Graph View.

Bar graphs are often used for showing several fields side-by-side for comparison.

CUMULATIVE BAR GRAPH

A cumulative bar graph is like a bar graph except that the values for different fields are shown stacked on one bar, rather than on separate bars. The bar section for each field has its own pattern, corresponding to the legend on the bottom of the Graph View.
A cumulative bar graph is often used for comparing the relative contribution of several parts of a whole and growth of the sum of the parts.

**PIE CHART**

A pie chart shows a circle ("pie") split up proportionally by the values of the field being graphed.

A pie chart is often used to represent the relative contribution of several parts to the whole.
GRAPHING SUMMARIES AND FOR EACH

Two options in the Graph View enable you to change the graph significantly to display summaries for each entry in the x-axis field, and to display graphs of groups of records (e.g., for each year) side-by-side on the y-axis.

DISPLAYING SUMMARIES

Often you will want to display summaries instead of individual records. The summaries available are @SUM (total), @AVG (average), @COUNT (count), @MAX (maximum), @MIN (minimum), @STD (standard deviation), and @VAR (variance).

The Summaries option tells Reflex to group the records by the values in the x-axis field, i.e. all the records with the same value (e.g., Company Name) belong to one group. Reflex summarizes the values for each group and graphs the summary, not the individual values.

For example, let's suppose you have 30 records in your database. For the x-axis field named Company, 15 of those records have General Motors, 10 have Ford, and the remaining 5 have Chrysler. Initially, when Reflex plots the graph, it shows 30 entries—one for each record. Entering a summary causes it to show only 3 entries—one for each company. Each plotted point is the summary of all the data for each company.

1. To enter a summary, choose Options from the Graph menu (/GO). The Options tool is displayed.
2. Enter a summary function in the Summary cell and Proceed. The graph changes to reflect the summary you have entered.

The summary functions are:

- **@SUM** Displays the total of the y-field values for each x-axis value.
- **@AVG** Displays the average of the y-field values for each x-axis value.
- **@COUNT** Displays the number of y-field values for each x-axis value.
- **@MAX** Displays the maximum y-field value for each x-axis value.
- **@MIN** Displays the minimum y-field value for each x-axis value.
FIVE

REFERENCE A

@STD Displays the standard deviation of the y-field values for each x-axis value.

@VAR Displays the variance of the y-field values for each x-axis value.

When the Summary cell is selected, Choices [F10] displays a list of these summary functions.

☐ To remove the summary, delete it from the Summary cell.

FOR EACH

Just as Summaries groups the records by similar values for the purpose of showing totals, For Each groups the records by similar values to show side-by-side comparisons.

For example, suppose you have a database of sales by month by company:

<table>
<thead>
<tr>
<th>Month</th>
<th>Company</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Consolidated</td>
<td>70</td>
</tr>
<tr>
<td>1</td>
<td>National</td>
<td>189</td>
</tr>
<tr>
<td>1</td>
<td>United</td>
<td>128</td>
</tr>
<tr>
<td>2</td>
<td>Consolidated</td>
<td>65</td>
</tr>
<tr>
<td>2</td>
<td>National</td>
<td>120</td>
</tr>
<tr>
<td>2</td>
<td>United</td>
<td>138</td>
</tr>
<tr>
<td>3</td>
<td>Consolidated</td>
<td>73</td>
</tr>
<tr>
<td>3</td>
<td>National</td>
<td>188</td>
</tr>
<tr>
<td>3</td>
<td>United</td>
<td>136</td>
</tr>
<tr>
<td>4</td>
<td>Consolidated</td>
<td>85</td>
</tr>
<tr>
<td>4</td>
<td>National</td>
<td>65</td>
</tr>
<tr>
<td>4</td>
<td>United</td>
<td>152</td>
</tr>
</tbody>
</table>
you can graph Sales by Month:

It's not very clear, though, since there are 3 points per month, all graphed together without any differentiation by company.

For Each will provide this differentiation. Choosing For Each from the Graph menu (/GF) and specifying the Company field will group the records for each company and display a separate graph for each:
Sales for each Company.

To use For Each:

- Choose For Each from the Graph menu (/GF). Reflex displays a cell to enter the field to use.
- Enter a field name. Reflex enters one legend for each unique entry in that field and graphs the data for each.

For Each will only act on one y-axis field. If more than one is displayed, the others will be removed from the graph.

If there are more than eight unique entries in the field, Reflex won't be able to display all the values because the graph is limited to eight legend cell entries. The message line will indicate that fewer than all the entries are displayed. In this case, you can filter the database to remove some of the values.

NOTE You may well want to use For Each and Summaries at the same time. In the example above, if you had multiple sales records for each company each month, you would have used the Summary @SUM in addition to For Each to get the same result.

SCALING, TITLES, AND GRIDS

When you first set up a graph, you identify the values for Reflex to plot. Subsequently, it is possible to modify the graph for clarity. You can change the scale, add a title, and use grid lines to make the information easier to read.
CHANGING THE SCALE
Reflex automatically scales the x-axis and y-axis to show as much data as is practical. You can change either scale by using the Scaling option on the Graph menu. You can also set the origin of the graph (the point at which the x-axis crosses the y-axis) and define the size of the intervals between tick marks on the x- and y-axes.

The Graph Scaling tool.

When you set the scales, you determine the amount of space to be given each value on the axis. On the x-axis, such scaling is applicable only when a numeric field is graphed and a Line or Scatter graph is shown. Otherwise discrete labels are shown.

There are three scaling elements: the minimum value, the maximum value, and the interval between numbers. For example, you may want a scale to be from 0 to 100 with intervals of 10, or from 23.5 to 53.5 with intervals of 3.

To change the scales, select Scaling from the Graph menu (/GS). Enter the values you want in the instruction cells. Proceed. Reflex replots the graph with the new scales.

If you set a scale so the interval doesn't divide equally, the maximum will not be shown. For example, if you set a scale from 0 to 10 with intervals of 3, Reflex will set the scale at 0, 3, 6, and 9.

REPOSITIONING THE ORIGIN
You can use Scaling to change the origin of the graph. Simply enter the Y Origin value in the Origin cell and Proceed.
GRAPH DISPLAY OPTIONS: TITLE AND GRID LINES

To display a title or to use grid lines in the graph area, choose Options from the Graph menu (/GO).

To display a title for the graph, select the Title On checkbox, and proceed. A title cell will then be shown at the top of the graph. Select it and enter the desired title. Titles will display up to 42 characters.

To display grid lines, select the appropriate Grid On checkbox in the Options tool. Grid lines may be displayed horizontally (Y Grid), vertically (X Grid), or both.

PRINTING THE GRAPH

To print a Reflex graph, you name it and save it on your data disk. Then you use the Graph Print program to actually...
print it. The Graph Print program is included on the Report & Utilities Disk.

To print a graph, start by choosing Print under the Graph menu (/GP). The Save Named Graph tool is displayed.

Enter a drive and directory in the Directory cell. In the Name cell, enter the file name to be used for the file on disk. Then select Proceed and Press ←.

That’s as far as you go here; further instructions are given in “Graph Print” in Reference B.

Follow this procedure for each graph to be printed. Use a separate file for each.

THE CROSSTAB VIEW

The Crosstab View provides a numeric summary of the information in your database by means of a cross-tabulation. A crosstab breaks information down by category, such as by product or division or year, and then summarizes information for each. So you might see total sales by product, average margin by month, and so on.

The crosstab will calculate:

- totals.
- averages.
- counts.
- maximums.
- minimums.
- standard deviations.
- variances.

The Crosstab View will automatically break your information down into individual categories (e.g., by product), or within numeric ranges (e.g., salaries within $10,000 spreads), or by any set of conditions you specify (e.g., sales from the Eastern region where the margin is greater than 30% and the salesrep was over quota for the month).
OPENING AND CLOSING THE CROSSTAB VIEW

On the Views menu, the Crosstab View is abbreviated to Xtab.

To open the Crosstab View, choose Xtab from the Views menu (/VX). The Crosstab View takes the entire windows area, replacing whichever views are already on the screen. When you close the Crosstab View, they will reappear, just as you left them.

To close the Crosstab View, choose Close from the Views menu (/VC).

You cannot open another view directly from the Crosstab View. After you close the Crosstab View, you can open and display the other views as usual.

THE CROSSTAB VIEW SCREEN

Below are the parts of the Crosstab View.

Salesrep = "Dave"

<table>
<thead>
<tr>
<th>Views</th>
<th>Edit</th>
<th>Print/File</th>
<th>Records</th>
<th>Search</th>
<th>Crosstab</th>
</tr>
</thead>
<tbody>
<tr>
<td>CROSSTAB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Summary:</td>
<td>GSUM</td>
<td>1 Field:</td>
<td>Sales $</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 Salesrep</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 &quot;Alan&quot;:</td>
<td>&quot;Bob&quot;:</td>
<td>&quot;Cathy&quot;:</td>
<td>&quot;Dave&quot;:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5 ALL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;Paddles&quot;</td>
<td>34,287</td>
<td>33,835</td>
<td>34,897</td>
<td>46,925</td>
<td>149,144</td>
</tr>
<tr>
<td>&quot;Silent&quot;</td>
<td>147,588</td>
<td>22,228</td>
<td>81,785</td>
<td>76,366</td>
<td>327,791</td>
</tr>
<tr>
<td>&quot;Sport&quot;</td>
<td>43,578</td>
<td>23,533</td>
<td>39,14</td>
<td>9,843</td>
<td>146,888</td>
</tr>
<tr>
<td>&quot;Swiftwater&quot;</td>
<td>84,148</td>
<td>56,925</td>
<td>74,888</td>
<td>92,567</td>
<td>388,448</td>
</tr>
<tr>
<td>ALL</td>
<td>389,497</td>
<td>135,711</td>
<td>230,552</td>
<td>255,781</td>
<td>931,463</td>
</tr>
</tbody>
</table>

1 Summary cell
2 Field cell
3 Automatic column title
4 Automatic row title
5 Column heading
6 Row heading
7 Results area
8 Results cell
Summary  Shows the Crosstab function currently being used to calculate the results. In the illustration, @SUM adds up the values in the Sales $ field.

Field  Shows the field currently being summarized in the Crosstab results. In the illustration, the results reflect values in the Sales $ field.

Automatic column title  Shows the field name being used for the column headings. In the illustration, the column headings are unique entries in the Salesrep field.

Column heading  Identifies the data summarized in the column below. In the illustration, the numbers in the “Dave” column show the sum of the Sales $ within the subset of records with ‘Dave’ in the Salesrep field.

Automatic row title  Shows the field name being used for the row headings. In the illustration, the row headings are unique entries in the Product field.

Row heading  Identifies the data summarized in the row to the right. In the illustration, the numbers in the “Silent” row show the sum of the Sales $ within the subset of records with ‘Silent’ in the Product field.

Results area  The grid of results cells in which the calculations are displayed.

Results cell  Shows the result of the calculation applied to the data identified by both the column heading and the row heading. In the illustration, the numbers in the results cell show the sum of the Sales $ field within the subset of records with ‘Dave’ in the Salesrep field AND ‘Sport’ in the Product field.

The ALL row and column headings indicate that all the records in the database should be included for that row or column. Where the ALL column and the ALL row intersect in the figure above, the result is total sales for all the records.

MOVING AROUND THE CROSSTAB VIEW

The cursor movement keys enable you to select any cell in the Crosstab View. Within the results area, they work as is usual within a rows-and-columns table. When you move up from the table, either with ↑ or ▲ [↓], the Field cell is
selected. To reach the Summary cell, select the Field cell and press \[ \leftarrow \) or \[ \leftarrow \rightarrow \].

When the cursor is within the results area, \[ \text{Home} \] takes you to the upper left corner of the results area.

\[ \text{F3} \] selects the row heading.
\[ \text{F4} \] selects the column heading.

**SCROLLING THE CROSSTAB VIEW**

The Crosstab View can be larger than the windows area. You can see the hidden parts of the crosstab by scrolling.

To scroll, use the cursor movement keys to select cells. The view scrolls to display the selected cell.

The column and row headings always remain visible.

**ROW AND COLUMN MANUPULATION**

The Crosstab View has a flexible display. You can:

- insert and delete columns and rows.
- change the width of individual columns or all columns.

**INSERTING AND DELETING COLUMNS AND ROWS**

To insert a row, use the Row Key \[ \text{F3} \] or choose Row Select from the Edit menu (/ER) to select the row directly below where you would like the new row to be. Then insert the new row by either pressing the \[ \text{Ins} \] Key or choosing Insert from the Edit menu (/EI).

Inserting a column is done similarly.

To delete a row or column, select it and then delete it by either pressing the \[ \text{Del} \] Key or choosing Delete from the Edit menu (/ED).

**CHANGING THE COLUMN WIDTH**

You can change column widths in the Crosstab View just as you change them in the List View. Select any cell in the column, then choose Set Column Width from the Edit menu (/ES) and use the \[ \leftarrow \] and \[ \rightarrow \] keys to adjust the column width. Press \[ \leftrightarrow \] when the width is as desired.
[m] If you are using a mouse, you can change the width of a column with the pointer. Put the tip of the pointer on the dividing line you want to move. Press-and-hold the left button. While still holding down the button, move the pointer and the "shadow line" to the location you want. Release the button.

To set the width of all the columns, you use the Crosstab options tool:

- Choose Options from the Crosstab menu (/CO). This tool includes an instruction box for column width. Enter a number from 2 to 40 and proceed. The display adjusts, setting all the columns to that width.

If you want to set the width for all columns and then further adjust specific columns, first use the general facility, since that will override any previous adjustments.

CLEARING THE CROSSTAB VIEW

To clear the Crosstab View, choose Window Clear from the Edit menu (/EW). This erases all data from the Crosstab View and displays the original empty crosstab.

CREATING A CROSSTAB

A crosstab formula consists of a Summary function, a field name, and row and column headers. You enter the function in the Summary cell, the field name in the Field cell, and the appropriate conditions in column and row headings.

THE CROSSTAB SUMMARY FUNCTIONS

The Summary cell can use any of the seven summary functions.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@SUM</td>
<td>Totals the values in the field</td>
</tr>
<tr>
<td>@AVG</td>
<td>Averages the values in the field</td>
</tr>
<tr>
<td>@COUNT</td>
<td>Counts the entries in the field</td>
</tr>
<tr>
<td>@MAX</td>
<td>Finds the largest value in the field</td>
</tr>
<tr>
<td>@MIN</td>
<td>Finds the smallest value in the field</td>
</tr>
<tr>
<td>@STD</td>
<td>Calculates the standard deviation of the values in the field</td>
</tr>
<tr>
<td>@VAR</td>
<td>Calculates the variance of the values in the field</td>
</tr>
</tbody>
</table>
When the Summary cell is selected, Choices [F10] presents a choice list of these functions.

You can change the function at any time. The crosstab will automatically recalculate.

**FIELD NAMES**
In the Field cell, you enter a field name from the current database. Choices [F10] presents a choice list of current field names when the Field cell is selected.

Numeric fields can be used with any of the functions. Text fields can be used only with @COUNT. Date fields can be used with @COUNT, @MIN, and @MAX.

You can enter a different field name in the Field cell at any time. The crosstab will automatically recalculate.

**ROW AND COLUMN HEADERS**
The row and column headers control which records from the database are considered in each column and row.

Two built-in facilities are provided to create the row and column headers for most common cases. The facilities are **For Each** and **Make Ranges**. For more general needs, the column or row headings can be set up using search conditions written as they are in the Search Conditions tool.

**For Each** will create one row or column for each unique value in a field. For example, if you wanted to look at average margin by product, you’d want to create one row or column for each product. For Each creates the rows or columns, with appropriate headers, automatically.

**Make Ranges** creates a row or column for a series of value ranges. For example if you wanted to count sales within ranges of margin rates—0 to 10, 10 to 20, 20 to 30, and so on, you’d want to create one row or column for each range. Make Ranges creates the rows or columns automatically, with the headers set up to accept records falling in those value ranges.

**Search conditions** can be put in the row and column headers to perform crosstabs on arbitrary subsets of records. For example, if you wanted to see total sales where the margin was greater than 25%, you could enter **Margin > .25** in a column header. That column would then only look at records whose Margin field contained a value greater than .25.
FOR EACH

You can automatically create one row or column heading for each unique entry in a field by using the For Each option on the Crosstab menu. Choose For Each from the Crosstab menu (/CF).

Column or Row Select the appropriate checkbox to set up either rows or columns.

Field name Enter a field name. This is the field which will be used for setting up the column or row headers.

Select Proceed and press [→].

Reflex automatically creates as many rows or columns as there are unique entries in the field and enters each one in a heading. The field name is displayed above or to the left of the heading cells, as an automatic title for the headings.

In the example shown, there are many entries in the Rep field, but only four unique entries: Alan, Bob, Cathy, and Dave. Reflex has created a separate column for each of them. An ALL is automatically entered in the last column heading.

You may add additional Crosstab columns after using For Each. You can insert a column or use the blank column at the right side of the crosstab. Then enter a search condition in the column heading. Rows may be added similarly.

NOTE

Do For Each first, before you add other rows or columns. In whichever dimension it is applied (i.e. rows or columns), For Each erases whatever headings are previously displayed.
Changes to the database do not affect the For Each row and column headers when the Crosstab View is reopened. If you add or delete a unique entry in the For Each field, you need to apply For Each for that field again to make the headers reflect the current database. Database changes are automatically reflected in the results cells, however.

**MAKE RANGES**

Numeric fields can be automatically divided into ranges. The Make Ranges tool automatically creates a row or column header for each range, dividing the records into subsets defined by the ranges.

Choose Make Ranges from the Crosstab menu (/CM).

The Make Ranges tool

![The Make Ranges tool](image)

- **Column or Row** Select the appropriate checkbox to display the Ranges in either row headings or column headings.
- **Field Name** Enter a field name for a numeric field. This is the field that will be divided into the ranges you specify.
- **From** Enter the number that starts the range.
- **To** Enter the number that ends the range.
- **By** Enter the number that defines the interval.

Select **Proceed** and press `[→]`.

Reflex automatically creates as many rows or columns as there are ranges specified and enters each range in a heading. The field name is displayed above or to the right of the heading cells as an automatic title for the headings.
In the example shown, the Margin field has been divided into equal ranges. Reflex has created a separate column for each of them. An ALL is automatically entered in the last column heading.

You may add additional Crosstab columns after using Make Ranges. You can insert a column or use the blank column at the right side of the crosstab. Then enter a search condition in the column heading. Rows may be added similarly.

**NOTE**

Do Make Ranges first, before you add other rows or columns. In whichever dimension it is applied (i.e. rows or columns), Make Ranges erases whatever headings were previously displayed.

Changes to the database do not affect the Make Ranges row and column headers when the Crosstab is reopened. If you add or delete a unique entry in the Make Ranges field, you need to apply Make Ranges for that field again to make the headers reflect the current database. Database changes are automatically reflected in the results cells, however.

**A Note on Ranges**

*From* is the starting point of the range, *To* is the ending point, and *By* is the interval. For example, if the data in the field goes from 10 to 1000, and you want to include only data from 100 to 500 and to partition the data in steps of 50, you type: From 100 To 500 By 50. Proceed.

If the range is not evenly divisible by the interval, the last entry will be the remainder.

**SEARCH CONDITIONS IN ROW AND COLUMN HEADERS**

Sometimes you'll want to use Crosstabs to summarize and compare groups or records based on criteria other than values in a particular field (as For Each would do) or values falling
into a range (as Make Range would do). You might want to compare revenues for sales with less than 25% margin vs sales with greater than 25% margin. Or you might want to look at more complex groups of records, such as a salary average for all employees in a particular department who have more than 10 years seniority.

Just as you can set search conditions for identifying records to be included when you apply a filter, so can you use search conditions for identifying records to be included in a Crosstab row or column. This allows you to perform Crosstab calculations on arbitrary sets of data such as:

Rep = "Bob" or Rep = "Alan"
Margin > .25
Price > 1000 AND Date > 1/1/84

Any of the conditions which may be used in search conditions may be used in a row or column header. The conditions are entered into the header exactly as they would be in the Condition cell in the Search Conditions tool. Part 7, Search, provides the full specifications for using these conditions.

An example crosstab using search conditions to compare average margins for sales by salesrep broken down by whether the margins were less than 25% or greater than or equal to 25% is shown below.

![Crosstab using search conditions in column headings.](image-url)
DISPLAY OPTIONS

You can see the results of your crosstab analysis in various ways: the Numbers, Percent of Total, Percent of Row, Percent of Column, or Index (amount of difference from the average).

To change the display, choose Options from the Crosstab menu (/CO). The checkboxes enable you to select the display option you want.

**Number** Displays results as numbers. This is the usual way of displaying results, and Reflex defaults to this choice.

**% Total** Displays the value of each cell as a percentage of the value of all the records in the working database (subject to any database filter that may be in effect.)

**% Row** Displays results as percentages of each row. Reflex calculates the percentage each result cell contributes to the total for all database records matching the search conditions for that row (subject to any database filter that has been applied.) Since individual records in the database may be not be included in a particular crosstab, or may be included in more than one row or column, the percent numbers in a row may not total 100%.

**% Column** Displays results as percentages of each column. Reflex calculates the percentage each result cell contributes to the total for all records matching the filter conditions for that column (subject to any database filter that has been applied.) Since individual records in the database may be not be included in a particular crosstab, or may be included in more than one row or column, the percent numbers in a column may not total 100%.

**Index** Displays results as the weighted index of the data cell. In numerical terms, an index of 100 is average. Indexes over
100 represent data above the crosstab average, while indexes below 100 represent data below the crosstab average.

**A Note on Index**

Index shows a result in relation to the average for the column and row it is in. It is a way of normalizing the data and seeing at a glance what cell is “better” or “worse” than average.

Reflex calculates the index for each cell using the following formula:

\[(\text{Number value/Expected value}) \times 100\]

The Expected value is:

\[\%\text{Row} \times \%\text{Column} \times \text{Number value for ALL records}\]

**NUMERIC DISPLAY FORMATS**

You can establish the display format for the numbers in the results cells. Set the numeric display format in the Crosstab Options tool:

- Choose Options from the Crosstab menu (/CO). The tool includes an instruction box for numeric display format. Enter the display format you want and proceed. Choices [F10] provides a choice list of numeric display formats when that instruction box is selected.

The numeric display formats are the same as those for numeric fields. For a complete description of numeric display formats, see Field & Sort Settings in Part 6, “Records.”

Dates are displayed as set in the Field & Sort Settings tool.

**ADDITIONAL FORMULAS**

Occasionally you will want to perform different calculations within one crosstab. For example, you might want to look at total sales, average price, and average margin by product. The Crosstab facility for using additional formulas in particular rows or columns provides this flexibility.
Crosstab with Additional Formulas.

To perform a different calculation within a particular row or column, enter an additional formula in that row or column header. It is often desirable to add a row or column to the crosstab for this purpose.

The additional formula row or column will perform its calculation without affecting the rest of the crosstab.

An additional formula has the following structure:

= @summary(field name)

or

=%@summary(field name)

If the prefix is only an "=" , the result cells display the number. If the prefix includes a "%" , the result cells display the percentage of the row or column, depending on whether the additional formula was put in a row or column.

Examples:

= @SUM(Sales)

=%@SUM(Sales)

= @AVG(Margin)
Crosstab with Additional Formulas.

### Summary:

**Rep**

<table>
<thead>
<tr>
<th>Field</th>
<th>Ann</th>
<th>Ed</th>
<th>George</th>
<th>Joe</th>
<th>ALL</th>
</tr>
</thead>
<tbody>
<tr>
<td>@SUM(Chairs)</td>
<td>123</td>
<td>158</td>
<td>250</td>
<td>195</td>
<td>736</td>
</tr>
<tr>
<td>@SUM(Chairs)</td>
<td>17%</td>
<td>21%</td>
<td>35%</td>
<td>26%</td>
<td>188%</td>
</tr>
<tr>
<td>@SUM(Chairs)</td>
<td>62</td>
<td>79</td>
<td>138</td>
<td>98</td>
<td>92</td>
</tr>
<tr>
<td>@SUM(Sofas)</td>
<td>650</td>
<td>939</td>
<td>1989</td>
<td>918</td>
<td>3698</td>
</tr>
<tr>
<td>@SUM(Sofas)</td>
<td>23%</td>
<td>25%</td>
<td>27%</td>
<td>25%</td>
<td>100%</td>
</tr>
<tr>
<td>@SUM(Sofas)</td>
<td>425</td>
<td>465</td>
<td>589</td>
<td>455</td>
<td>461</td>
</tr>
<tr>
<td>@SUM(Descs)</td>
<td>629</td>
<td>480</td>
<td>529</td>
<td>548</td>
<td>2168</td>
</tr>
</tbody>
</table>

### EFFECTS ON RESULTS CELLS

Additional formulas apply only to their particular rows or columns; they do not affect any of the results in any of the other results cells.

For example, if you perform a For Each on Product, then insert an additional formula between two of the resulting row headings, the ALL column will not include the results of the additional formula in the totals.

### DISPLAY OPTIONS

Rows and columns that contain additional formulas are not included in or otherwise affected by the display options (% Total, % Row, % Column, Index). An additional formula with a % prefix will display % Row results if it is entered in a row heading and % Column results if it is entered in a column heading.

### NUMERIC DISPLAY FORMATS

Additional formula results will display with the format of the field being used, as set in the Field & Sort Settings tool, rather than the general Crosstab format.

### INTERSECTING ADDITIONAL FORMULAS

Result cells that are the intersection of two additional formulas are often meaningless. For example, if a column heading cell contains = @STD(Price) and a row heading cell contains...
FIVE

REFLEX THE ANALYTIC DATABASE SYSTEM

= @COUNT(Product), the result cell will display N/A, for not applicable.

Unless both formulas are exactly the same Reflex displays N/A in a results cell for two intersecting additional formulas.

SAVING, RETRIEVING, AND DELETING CROSSTABS

You can save, retrieve, and delete crosstabs on a data disk. When you save a crosstab, Reflex creates a file for the crosstab specifications, without saving the data. When you retrieve it, the specifications are entered in the crosstab, recreating the crosstab with whichever data is currently in the database. Erasing a crosstab file deletes it from the data disk.

To save a crosstab specification, choose Save Crosstab from the Crosstab menu (/CS).

To retrieve and display a crosstab specification, choose Retrieve Crosstab from the Crosstab menu (/CR).

To erase a crosstab specification file from the disk, choose Erase Named Crosstab from the Crosstab menu (/CE).

In each tool, enter the directory and file name in the respective cells. Then select Proceed and press [→].
PART 5

THE PRINT/FILE MENU

A  DOS DIRECTORIES  82
   Using directories  82
   The current directory  83
   DOS file extension  83

B  GLOBAL SETTINGS  84

C  RETRIEVING A DATABASE  86
   Retrieving part of a file  87

D  SAVING A DATABASE  89
   Updating a file  90
   Saving a filtered database  90

E  ERASING A DATABASE  90

F  PRINTING  91
   Margin and page length limits and defaults  94
   Setup strings  94
   Saving the print settings  95
   Printer setup  95
The commands under the Print/File menu are used to:

- Print the active view.
- Save, retrieve and erase Reflex databases from disk.
- Establish system settings.

DOS DIRECTORIES

USING DIRECTORIES

Reflex runs under the IBM PC-DOS, Version 2.0 or later, operating system. To help manage files, DOS uses a directory structure to store and locate files. This feature is of particular value when you are using a hard disk, which has the capacity to store a large number of files. If you take advantage of this feature, you will need to specify the directory in which your files are stored when you use any of the Reflex Save, Retrieve, or Erase commands.

HOW DIRECTORIES WORK

Directories allow you to compartmentalize your files, so you can work with a few of them at once. This is desirable when you have many files, as is common with a hard disk. Rather than looking through dozens of file names, using a directory can allow you to only work with a few at a time.

When you’re at the DOS level, rather than in Reflex or another program, you can tell DOS to create directories, move files around between directories, and show which files are in a particular directory.

There is also an important concept called the “current directory”. This is the directory whose files are available at any given time; essentially, by making a directory the current directory, you’re saying “I want to work with these files for the time being.” Actually, you can access files outside the current directory, but it takes a little more work than for files within it. You can make any directory, or no directory, the current one at any time.

The advantage of using directories comes by grouping files that you will use together within a directory and then making it
the current directory when you want to use those files. For example, you might create a directory called "Sales" and keep all your sales databases in it. Then when using Reflex, specify "Sales" as the current directory and Reflex will show you only those files when saving and retrieving databases.

The important directory management commands in DOS are:

MK make (create) a directory
CD change the current directory

Instructions for using these commands are discussed in your DOS manual.

NOTE Using directories is entirely optional. It is common not to bother when using floppy diskettes, while it is often quite valuable when using hard disks.

THE CURRENT DIRECTORY

When working with files, Reflex looks to the current directory. You set this to tell Reflex where to store and look for files. This is optional, though. You are free not to use directories at all.

The current directory can be specified in either of two places:

□ As a default for all file operations, in the Global Settings tool (/PG).
□ In the tools performing the actual operations.

In either case, it is entered along with the disk drive designation (e.g., "A:" in the tool's Directory cell. If a directory is not specified, you simply see a backslash (e.g., "A:\").

Directory and File Name cells in the Save Database tool.

DOS FILE EXTENSION

When you save a database or other Reflex files, Reflex adds a DOS file extension to the name you provide. This extension is used by the operating system. You won't see it in Reflex, but you will see it if you use operating system utilities. So, for
example, if you save a database under "Sales", you will see it as
"Sales" in the Retrieve and Save Database tools, but the DOS
Dir command will show it as "Sales.RXD".

The types of Reflex files, and the extensions added are:

<table>
<thead>
<tr>
<th>REFLEX FILE</th>
<th>DOS EXTENSION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>.RXD</td>
</tr>
<tr>
<td>Crosstab Specification</td>
<td>.RXC</td>
</tr>
<tr>
<td>Graph Picture File</td>
<td>.RXP</td>
</tr>
<tr>
<td>Report Specification</td>
<td>.RXR</td>
</tr>
<tr>
<td>Translate Specification</td>
<td>.RXT</td>
</tr>
<tr>
<td>Configuration File</td>
<td>.RX</td>
</tr>
<tr>
<td>Driver File</td>
<td>.RX</td>
</tr>
<tr>
<td>Print to disk</td>
<td>.PRN</td>
</tr>
</tbody>
</table>

Using the extensions in DOS provides an easy way to handle all
the Reflex files on a disk or directory at once. For example,
the following DOS command will copy all the Reflex files from
Drive A: to Drive B: (this example assumes that directories
aren't used):

Copy A:\*.RX*  B:

GLOBAL SETTINGS

The Global Settings tool enables you to provide instructions
that will be used generally throughout Reflex activities.

The Global Settings tool is used for specifying:

☐ The default directory for Reflex files.
☐ Printer set-up options.
☐ Automatic or manual formula recalculation.

The Global Settings are saved in a configuration file called
"Config.RX". Each time Reflex is run, the file is read. In this
way, your settings are carried through from session to session
and there is no need to re-enter them.
To open the Global Settings tool, choose Global Settings from the Print/File menu (PG).

The Global Settings Tool includes the following settings and options:

<table>
<thead>
<tr>
<th>Views</th>
<th>Edit</th>
<th>Print/File</th>
<th>Records</th>
<th>Search</th>
<th>Global Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**GLOBAL SETTINGS**

Status: Memory Available: 369K Remaining 369K Starting
Records: 0 in Filter 0 Total in Database

- **System Directory**: B:
- **Recalculation**: □ Manual □ Automatic
- **Printer Connection**: Serial □ 1 □ 2 Parallel □ 1 □ 2
- **Printer Has Auto-LineFeed**: □ No □ Yes

**Status**  Displays current memory available and number of Records in the database.

**Memory** The number of K bytes (thousands of bytes) of available internal memory (RAM, as opposed to on the diskette.) The first number is the number of bytes free beyond the data currently in the database, and the second number is the total amount of memory available to the database, including the amount already used.

**Records** The number of records in the database. The first number is the number of records in the working (filtered) database, and the second number is the number of records in the whole database. The difference is the number of records that are currently filtered out.

**Recalculation** Select **Automatic** to instruct Reflex to recalculate formulas whenever a value affecting one changes. Alternatively, select **Manual** in which case formulas will only be recalculated when the Recalc command is given (/RR) or the Recalc key [F9] is pressed.

**System directory** This is the current directory—where Reflex will look when saving and retrieving files. This is the
default; it can be overridden in any of the tools that make use of it.

**Connection**  This setting should reflect how your printer is connected. Indicate which of the two serial or two parallel ports the printer is attached to. The default is that your printer is connected to the first parallel port.

**NOTE**  Serial printers require a “baud rate” setting in DOS. See “Printers,” Appendix D.

**Auto-line feed**  Some printers automatically perform a linefeed at the end of each line; most do not. If your printer does linefeed automatically, change the checkbox selection to **Yes**; otherwise leave it at **No** and Reflex will send linefeed commands at the end of each line.

If your printer documentation isn’t handy, an easy way to determine this is by looking at the printer output. If the vertical spacing is fine, it is set correctly. If it double spaces, change the selection to **Yes**. If it does not space, i.e. all the output is over-struck on one line, and the **Yes** cell is selected, change the selection to **No**.

**Proceed**  Establishes the Global Settings as the settings for your system.

**Cancel**  Resets the Global Settings to what they were when the tool was opened and puts away the tool.

To save the Global Settings on your system disk, choose **Save Settings** from the Global Settings menu (/GS). Reflex will make the settings permanent. The new settings will be assumed each time you start the program.

---

**RETRIEVING A DATABASE**

Retrieving a database brings a previously saved Reflex database in from disk so you may work on it.

*To retrieve a database*, insert the data disk containing the file into a disk drive, if it is not already there (or on a hard disk.) Then choose **Retrieve File** from the Print/File menu (/PR).
This displays the Retrieve tool, into which you enter the file name to be retrieved and, if desired, specify which set of records you want to retrieve.

The Retrieve tool has the following settings and options:

**Directory**  This is the current directory—where Reflex will look for the file. You can change this entry by selecting it and entering a different directory.

**Name**  Enter the name of the file you wish to retrieve in this cell. Choices [F10] displays a choice list of all the Reflex databases in the current directory.

**Proceed**  When you select Proceed, Reflex retrieves the file specified in the Retrieve tool.

**Cancel**  Cancel puts away the tool and returns the settings in the tool to what they were before it was opened.

**WARNING**  If you retrieve a database from a file while working with another database, the database you retrieve will erase the one currently in memory. If you want to keep that database, save it before retrieving another.

**RETRIEVING PART OF A FILE**

Reflex allows you to retrieve an entire database, or only certain records from a database. This partial retrieve may be
done by specifying a range of records to be retrieved, e.g., records 100 through 200, or a filter condition, such as only those records where Margin > .25.

To retrieve part of a file, choose Partial Retrieve from the File menu (/FP).

The Retrieve tool adds two checkboxes, giving you a choice of the two ways to define which subset of records you want to retrieve.

The Retrieve tool for partial retrieve.

**RANGE**

If you want to retrieve a range of records, select the Range checkbox. Reflex then adds two cells in the tool: From and To. Enter the first and last record numbers you want to include. For example, if you enter 1..10, Reflex will retrieve the first 10 records in the database. If you enter 35..50, Reflex will retrieve the thirty-fifth through the fiftieth records.

**CONDITION**

To retrieve only those records meeting a search condition, select the Condition checkbox. After you then proceed from the Retrieve tool, Reflex will display the Search Conditions tool. Enter the conditions here in exactly the same way as you do when setting conditions for filtering and finding. Refer to Part 7, Search, for instructions on using the Search Conditions tool.

Proceed and Reflex will then retrieve only those records meeting the Search condition.
NORMAL RETRIEVE
If, after selecting Partial Retrieve, you change your mind and wish to retrieve the entire file, choose Normal Retrieve from the File menu (/FN).

SAVING A DATABASE

Saving a database stores the Reflex database and all its associated settings in a disk file. This keeps it stored safely while your computer is turned off or while you are working on other databases (or even other programs.)

Once a database is saved on a data disk, you can retrieve it with the Retrieve File command (/PR).

You should save your database on a data disk at regular and frequent intervals. This limits your loss of data if the computer is accidentally turned off or the power fails.

To save a database, with a data diskette in a disk drive (or an attached hard disk), choose Save File from the Print/File menu (/PS). This displays the Save tool, into which you enter the file name that the database should be stored under.

The Save tool has the following settings and options:

The Save tool.

Directory  This is the current directory—where Reflex will look for and store files. You can change this entry by selecting it and entering a different directory.

Name  Enter the file name in this cell. The Choices key [F10] displays a choice list of all the Reflex database files in the current directory.
**Proceed**  When you select Proceed, Reflex saves the database under the file name provided.

**Cancel**  Cancel puts away the tool without performing any action.

**WARNING**  If you try to save a database into a file that already exists, you will be asked for confirmation, to prevent unknowingly writing over an existing file.

**UPDATING A FILE**

To save an updated database (if you don't want to keep the old version), save it under the old file name. The old file is erased, and the new file reflects the changes you made.

If you want to keep both the old file and the updated file, save the updated file under a different file name.

**SAVING A FILTERED DATABASE**

When you save a database with a filter applied, the entire database is saved, not just the working database. The filter, as with all database settings, is saved with the database and appears when you retrieve it.

In order to save only part of a database, you first need to delete the records you don't want to save by applying a filter and then choosing Keep Records from the Search menu.

**ERASING A DATABASE**

You may wish to erase a database you have previously saved when it is of no further use, or you may want to delete one if you've created a new database and find that your only data diskette doesn't have enough room to save it. Erasing a database removes it from the disk and frees up the disk space.
To erase a database from a data disk, choose Erase File from the Print/File menu (/PE).

The Erase File tool has the following settings and options:

**Directory** This is the current directory—where Reflex looks for files. You can change this by selecting it and entering a different directory.

**Name** Enter the file name in this cell. The Choices key \[F10\] displays a choice list of all the files in the current directory.

**Proceed** When you select Proceed, Reflex erases the specified file.

**Cancel** Cancel puts away the tool without performing any action.

**WARNING** If you erase a file, its contents are lost permanently.

---

**PRINTING**

The Print Settings tool is used to print the Form View, List View, or Crosstab View. The Graph and Report Views contain their own printing facilities.

To print the active view, choose Print from the Print/File menu (/PP). The Print Settings tool assumes that the active view is to be printed.

The Print Settings tool contains the following settings and options:
Title lines  You may place two title lines centered at the top of the first page of the printout. They will be printed spaced with 1 line between them. Up to 50 characters will be printed in each of the title lines.

Output: To Printer, To Disk File  Select To Printer to print the view immediately or select To Disk File to save the print image of the information in a disk file for later printing or use by other programs.

If To Disk File is selected, the File Name cell is displayed. Enter the file name to save the print image in.

Left and right margins  The side margins are measured in character widths, or spaces, from the edge of the paper. Both the left and right margins are measured from the left side of the paper.

Top and bottom margins  The top and bottom margins are measured in rows, or lines of printing. The top margin is measured from the top of the paper and the bottom margin from the bottom.

Page length  The number of lines on a page.

Setup string  You may enter a string of characters that provide special printing instructions to the printer. See Setup Strings, below.

Paper feed  If you select Single-Sheet, Reflex prompts you to enter a new sheet of paper before it prints each page. If
you select Continuous, Reflex prints without interruption, advancing the paper to the top of the next page automatically.

**Print from page** You may specify a range of pages to print. This range applies to “horizontal slices”; for each page in the range, Reflex will print all the way across.

**Print** Print initiates the actual printing.

**Put away** Puts away the Print tool and saves any changes you have made.

**Cancel** Puts away the Print tool and restores the settings to what they were when the tool was opened.

### GRAPH PRINTING

To print the Graph View, choose the Print command in the Graph menu. This is described fully in Graph Printing in Chapter 6, Reference B.
MARGIN AND PAGE LENGTH LIMITS AND DEFAULTS

Following are the limits and default values for the margins:

<table>
<thead>
<tr>
<th>MARGIN</th>
<th>MINIMUM</th>
<th>MAXIMUM</th>
<th>DEFAULT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>0</td>
<td>240</td>
<td>2</td>
</tr>
<tr>
<td>Right</td>
<td>1</td>
<td>255</td>
<td>74</td>
</tr>
<tr>
<td>Top</td>
<td>0</td>
<td>10</td>
<td>2</td>
</tr>
<tr>
<td>Bottom</td>
<td>0</td>
<td>10</td>
<td>6</td>
</tr>
<tr>
<td>Page Length</td>
<td>5</td>
<td>200</td>
<td>66</td>
</tr>
</tbody>
</table>

If your printer skips over the perforations in the paper, you will want to decrease the page length from 66. Try 60, although depending on the printer that may need adjustment.

SETUP STRINGS

Printers often require special codes be sent to them to invoke special functions, such as bold or compressed printing. The Setup String allows you to send such codes to the printer.

Unfortunately, since there isn’t standardization among printers on codes used, you’ll need to refer to your printer manual to see which to use.

The setup string is specified as a sequence of characters in the Setup String cell. There are two ways to specify a particular code:

- Type the appropriate character on the keyboard.
- Since often these codes aren’t represented by characters on the keyboard, you can also enter a code as a backslash followed by a 3 digit decimal number.

For example, for an IBM or Epson dot-matrix printer:

- \015 turns on compressed print
- \018 turns off compressed print
- \027E turns on compressed and bold print

Printer setup strings may be used in combination with the other printer settings to fit large printouts on standard-size paper. For example, some of the most popular combinations that can be used with Epson and IBM printers are:

To print 132 columns on 8½ inch-wide paper, use:
Printer Setup \015
Right Margin 132

To print 240 columns on a 14 inch-wide paper, use:

Printer Setup \015
Right Margin 240

SAVING THE PRINT SETTINGS

To tell Reflex to save the current print settings as the default settings in the configuration file, choose Save Settings from the Options menu (/OS). The same settings are then displayed each time you open the Print tool.

PRINTER SETUP

Before you can print:

☐ You must have a printer connected to one of your computer’s output ports (either serial or parallel).
☐ The printer must be turned on.
☐ You must specify the type of connection for your printer in the Global Settings tool.

At this point, you can give the Print command (/PP), fill the appropriate information in the Print Settings tool, and select Print.

NOTES ON PRINTING

A few additional notes on printing:

☐ To halt printing, press [Ctrl] [Break].
☐ Reflex prints everything in the active view, including whatever you cannot see on the screen. For example, if you print from the List View, Reflex prints all records from your working database in the list format even though you may view 13 records on the screen at one time.
☐ Reflex prints only records from the working database, so applying a filter can be used to control what’s printed.
☐ Printing the Form View prints the current record only.
☐ Print view respects column widths. If you wish to print the full contents of a column that extend beyond the set width, you must widen the column before printing.
PART 6

RECORDS

A  FIELD & SORT SETTINGS  97
   Using the field & settings tool  97
   Fields  99
   Field types  99
   Formulas  102
   The sort order  102
   Display formats  105
   Precision  106

B  VARY  107
   The Vary tool  108
   Conditions and effects  110

C  RECORDS COMMANDS  112
   Add record  112
   Delete record  112
   Perform sort  113
   Recalc  113
   Clear database  113
The Records menu contains commands which are used for working with the database. They are:

- **Field & Sort Settings**: used for setting the sort order, field types, display formats, formulas, and adding fields.
- **Vary**: sets up the skeleton of a database automatically.
- **Add Record**: creates a new record.
- **Delete Record**: deletes the current record.
- **Perform Sort**: sorts the records in the database according to the sort order specified in the Field & Sort Settings tool.
- **Recalc**: recalculates the values in all calculated fields.
- **Clear Database**: clears the current database from memory.

### FIELD & SORT SETTINGS

The **Field & Sort Settings** tool shows you all the important internal information about the database. It is a table with one row for each field, allowing you to view and change:

- Field names.
- Field types.
- Formulas.
- Sort Order.
- Display format.
- Display precision.

### USING THE FIELD & SORT SETTINGS TOOL

*To open the Field & Sort Settings tool, choose Field & Sort Settings from the Records menu (/RF).*

The tool is a table with one row for each field and one column for each of the settings.
The Field & Sort Settings tool.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Formula</th>
<th>Sort #</th>
<th>A/D</th>
<th>Format</th>
<th>Prec</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Product</td>
<td>Text</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rep</td>
<td>Text</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quantity</td>
<td>Numeric</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unit Cost</td>
<td>Numeric</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sales$</td>
<td>Numeric</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Name**  Shows all the field names.

**Type**  Identifies the type of each field.

**Formula**  Shows the formulas for each calculated field.

**Sort #**  Establishes the sort order of the records.

**A/D**  Specifies whether the field is to be sorted in ascending or descending order.

**Format**  Sets the display format of the data in the fields.

**Precision**  Identifies how many digits to the right of the decimal point are displayed for each numeric field.

To modify the attributes of any field, select the appropriate cell and enter the new definition. You can change the column widths and scroll the table in the usual fashion.

Press the Choices key [F10] to display a choices list appropriate to the cell you have selected: field type choices, field names for formulas, and display formats.

When you have finished making entries in the cells, select Proceed. Whatever changes have been made in the Field & Sort Settings tool are reflected in the views.

The Esc key will put away the tool; however unlike other tools, the settings will not revert to their values prior to the tool being opened. Actions taken in the tool, such as changing field types and formulas, are effected immediately. For this reason, a Cancel button is not provided.
FIELDS

The field names in the database are listed in the first column of the table. They are listed in the order that they were added to the database.

ADDING A FIELD

To add a field to the database, select the blank cell at the bottom of the Name column. Type the new field name and press [→]. (As you do so, another blank row automatically appears.)

You can define the field type here, or you can let Reflex recognize the field type from the data you enter into the field. When you add a field, the field appears last in the List View and on the bottom left of the Form View.

DELETING A FIELD

To delete a field, position the cursor in that row, press [F3] to select the entire row, and then choose Delete from the Edit menu (ED) or press [Del]. Reflex asks you to confirm the deletion. Type Y to confirm. The field and all its data are erased.

WARNING

Deleting a field name permanently deletes the data in that field in all the records.

RENAME MA FIE LD

To rename a field, select the field name and then edit it in the usual fashion. Changing a field name does not affect the data. All formulas using the old field name will change to reflect the new field name.

WARNING

Do not delete the field if you only intend to rename it.

FIELD TYPES

The second column of the table identifies the field type—the type of data Reflex will accept for that field.

There are three kinds of data: text, date, and numeric. However, there are five field types; there is a special type for text and numeric which save memory in certain circumstances.
These types are:

- Text.
- Repeating text.
- Date.
- Numeric.
- Integer.

Text, numeric, and date are as discussed under Field types in Section 3, Entering and Editing Records.

**Repeating text** is a variation of Text. It looks and acts like text. However, internally, if there are duplicate values in a field in different records, that value will be stored only once, rather than in each record. For example, if you have 1000 sales records, each with a salesman's name, and there are 10 salesmen, then on average each name would be stored 100 times. By making the Salesman field Repeating Text, each name would only be stored once. This can save a substantial amount of memory.

**Integer** is a variation of Numeric. It is for fields whose values are integers (whole numbers) between \(-32,766\) and \(+32,767\). By making a field integer, rather than numeric, you'll save roughly 75% of the space needed for that field. A Years field is a common example of a field which could be integer.

When Reflex establishes a field type by examining the value entered in the first record, it will type it as Text, Numeric, or Date. If, knowing what sort of values will be in a field, you believe it would be appropriate to re-type it as Repeating Text or Integer, do so in the Field & Sort Settings tool.

To set or change a field type, select the Field Type cell in the row for the desired field and either type in the new field type, or use the Choices key [F10] and select the desired type. Type Y to confirm.

**CHANGING FIELD TYPES**

After you enter data, it is possible that you will want to change the type of a field.
**WARNING** You may change any field type to any other, but in some cases you will lose data. Reflex does as much as possible to retain data, but it is not always possible. For example, changing the number 777 to text is easy—you get “777”. Changing the text “Eastern Region” to a number is not possible—there is no numeric representation.

A table of changes and their effect on the data and any formulas in the fields appears below.

<table>
<thead>
<tr>
<th>FROM</th>
<th>TO</th>
<th>EFFECT ON DATA</th>
<th>EFFECT ON FORMULAS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Repeat</td>
<td>No change</td>
<td>No change</td>
</tr>
<tr>
<td>Text, Repeat</td>
<td>Date</td>
<td>If text entries are in date format with leading quote, they become dates, otherwise ERROR</td>
<td>ERROR</td>
</tr>
<tr>
<td>Text, Repeat</td>
<td>Num</td>
<td>If text entries are numbers with leading quote, they become numbers; otherwise, ERROR</td>
<td>ERROR</td>
</tr>
<tr>
<td>Text, Repeat</td>
<td>Int</td>
<td>If within range, same as above</td>
<td>ERROR</td>
</tr>
<tr>
<td>Repeat</td>
<td>Text</td>
<td>No change</td>
<td>No change</td>
</tr>
<tr>
<td>Date</td>
<td>Text</td>
<td>Puts quote before date, treats as text</td>
<td>ERROR</td>
</tr>
<tr>
<td>Date</td>
<td>Repeat</td>
<td>Same as above</td>
<td>ERROR</td>
</tr>
<tr>
<td>Date</td>
<td>Num, Int</td>
<td>Becomes null</td>
<td>ERROR</td>
</tr>
<tr>
<td>Num, Int</td>
<td>Text</td>
<td>Puts quote before number, treats as text</td>
<td>ERROR</td>
</tr>
<tr>
<td>Num, Int</td>
<td>Repeat</td>
<td>Same as above</td>
<td>ERROR</td>
</tr>
<tr>
<td>Num, Int</td>
<td>Date</td>
<td>Becomes null</td>
<td>ERROR</td>
</tr>
<tr>
<td>Num</td>
<td>Int</td>
<td>Within range, rounded; out of range, ERROR</td>
<td>No effect if within range (though rounding may affect results)</td>
</tr>
<tr>
<td>Int</td>
<td>Num</td>
<td>No change</td>
<td>No change</td>
</tr>
</tbody>
</table>
FORMULAS

The Formula column of the table shows the formulas for any fields which have them. The formulas shown may have been entered in the Field & Sort Settings or they may have been entered with the field selected in the Form View or List View.

To enter a formula, select a Formula cell and enter the formula. You do not need to use the leading = when you enter a formula in the Field & Sort Settings tool.

To modify an existing formula, select it and edit it. Reflex recalculates your data accordingly.

To delete a formula, select it and then choose Delete from the Edit menu or press Del. Any values calculated from the formula deleted will become null.

See also Part 8, “Calculated Fields.”

REMOVING LOCAL VALUES

Removing local values means removing all values from a given field, in all records, other than those values resulting from the formula. In other words, any constants are removed.

To delete non-calculated data from a particular field, select the Name cell in the row for that field and choose Remove Local Values from the Fields menu (FR).

This is a useful command when you translate files from other programs into Reflex files. You must delete entries from any field you wish to make a calculated field. It is also useful when you simply want to start over in a particular field after entering a lot of values.

THE SORT ORDER

The sort order is the sequence in which the records in your database are displayed. This includes the display in the List and also the order in which the First, Last, Next, and Previous Record commands (the F7, F7, F7, and F8 keys) display the records. The Next Record key, for example, determines which record is next from the sort order. If you change the sort order, the order in which you see the records will change.
You indicate which fields Reflex is to use in sorting the records in the Sort # column. In the A/D column, you indicate whether the fields should be sorted in ascending or descending order.

**THE PRIMARY SORT FIELD**

The primary sort field is the one Reflex uses first in sorting the records. You create the primary sort field by entering 1 in the Sort # cell. Reflex then sorts your records according to the data in that field and the ascending or descending designation. For example, if you make a text field the primary sort field, Reflex sorts your records alphabetically according to the entries in that field.

<table>
<thead>
<tr>
<th>Views</th>
<th>Edit</th>
<th>Print/File</th>
<th>Records</th>
<th>Search</th>
<th>List</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rep</strong></td>
<td><strong>Product</strong></td>
<td><strong>Date</strong></td>
<td><strong>Quantity</strong></td>
<td><strong>Unit Cost</strong></td>
<td><strong>Sales $</strong></td>
</tr>
<tr>
<td>Alan</td>
<td>Paddles</td>
<td>Jan-85</td>
<td>81</td>
<td>$77</td>
<td>$6,558</td>
</tr>
<tr>
<td>Alan</td>
<td>Paddles</td>
<td>Feb-85</td>
<td>65</td>
<td>$77</td>
<td>$6,135</td>
</tr>
<tr>
<td>Alan</td>
<td>Silent</td>
<td>Jan-85</td>
<td>16</td>
<td>$578</td>
<td>$16,835</td>
</tr>
<tr>
<td>Alan</td>
<td>Silent</td>
<td>Feb-85</td>
<td>17</td>
<td>$578</td>
<td>$16,317</td>
</tr>
<tr>
<td>Alan</td>
<td>Sport</td>
<td>Jan-85</td>
<td>10</td>
<td>$390</td>
<td>$4,376</td>
</tr>
<tr>
<td>Alan</td>
<td>Sport</td>
<td>Feb-85</td>
<td>11</td>
<td>$390</td>
<td>$4,877</td>
</tr>
<tr>
<td>Alan</td>
<td>Swiftwater</td>
<td>Jan-85</td>
<td>9</td>
<td>$437</td>
<td>$6,672</td>
</tr>
<tr>
<td>Alan</td>
<td>Swiftwater</td>
<td>Feb-85</td>
<td>14</td>
<td>$437</td>
<td>$9,244</td>
</tr>
<tr>
<td>Bob</td>
<td>Paddles</td>
<td>Jan-85</td>
<td>51</td>
<td>$77</td>
<td>$5,235</td>
</tr>
<tr>
<td>Bob</td>
<td>Paddles</td>
<td>Feb-85</td>
<td>41</td>
<td>$77</td>
<td>$4,583</td>
</tr>
<tr>
<td>Bob</td>
<td>Silent</td>
<td>Jan-85</td>
<td>6</td>
<td>$578</td>
<td>$6,435</td>
</tr>
<tr>
<td>Bob</td>
<td>Silent</td>
<td>Feb-85</td>
<td>3</td>
<td>$578</td>
<td>$3,257</td>
</tr>
<tr>
<td>Bob</td>
<td>Sport</td>
<td>Jan-85</td>
<td>7</td>
<td>$390</td>
<td>$3,794</td>
</tr>
</tbody>
</table>

**SECONDARY SORT FIELDS**

Often your records will have repetitive data in the primary sort field. For example, if you sort by date and several records have the same date, you may need to specify further sort fields. You can define up to five sort fields by typing in successive numbers in the appropriate rows in the Sort # column.
Four fields used in the sort order.

For example, the sort order specification in the illustration above tells Reflex to arrange the records by Rep; within each Rep's records, arrange them by Product; within Product, arrange by Date; and within Date, arrange by Sales $.

**ASCENDING/DESCENDING**

For each field that is used in the sort order, i.e. has a 1 through 5 in the Sort # column, Reflex must be told whether to arrange the field in ascending or descending order. This is done in the A/D column: A for ascending and D for descending.

A is automatically entered in the A/D column as soon as a sort number is given for a field. Select the cell and change it to a D if you would like to see your records in descending order.

For text fields, ascending order means alphabetical order (A to Z); descending means the reverse (Z to A).

For date fields, ascending order means ordering from the earliest to the latest date; descending means latest to earliest.

For numeric fields, ascending order means smallest to largest number; descending order means from largest to smallest.

**CHANGING THE SORT ORDER**

To change the sort order, edit the entries in the Sort # and A/D columns.

You will see that when you change one number in the Sort # column, all the other entries adjust accordingly, so there is always a proper order. If for example, field B is number 2 in
the sort order and you enter a 2 for field C, field B will automatically be adjusted to 3. If field D was 3, it would be adjusted to 4, and so on. Similarly if you delete a number from the sort order column, the other entries are adjusted downwards. This means that you can edit only the portion of the sort order which changes, and the other parts are automatically adjusted to keep the same relative order.

DISPLAY FORMATS

In the Format column, you can define the display format of the data in the field. When you select a format cell, Choices [F10] displays a list of available formats.

NOTE The display format chosen has no effect on the format in which values may be input. Specifically, regardless of the display format, dates are entered as mm/dd/yy, and numbers are entered as a string of digits with an optional decimal point and minus sign, but without commas, dollar signs, or parentheses.

TEXT FORMATS
Text fields display what you enter, exactly as you enter them. No other display formats are available.
NUMERIC FORMATS

Numbers may be displayed in one of five ways:

<table>
<thead>
<tr>
<th>CHOICE</th>
<th>DISPLAY</th>
<th>EXAMPLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Regular or scientific display, depending on field width and magnitude of number. The number will be fully displayed, with as many decimal places as necessary, up to 15.</td>
<td>1234.567</td>
</tr>
<tr>
<td>Fixed</td>
<td>Set number of digits to the right of the decimal (up to 15) are displayed.</td>
<td>1234.57</td>
</tr>
<tr>
<td>Financial</td>
<td>Fixed precision, with commas, and parenthesis around negative numbers.</td>
<td>1,234.57</td>
</tr>
<tr>
<td>Currency</td>
<td>Fixed precision, with leading $, commas, and parenthesis around negative numbers.</td>
<td>$1,234.57</td>
</tr>
<tr>
<td>Scientific</td>
<td>Scientific notation</td>
<td>1.234567E+03</td>
</tr>
</tbody>
</table>

DATE FORMATS

Dates may be displayed in one of five ways:

<table>
<thead>
<tr>
<th>CHOICE</th>
<th>DISPLAYS</th>
</tr>
</thead>
<tbody>
<tr>
<td>mm/dd/yy</td>
<td>11/18/84</td>
</tr>
<tr>
<td>mm/yy</td>
<td>11/84</td>
</tr>
<tr>
<td>dd-mmm-yy</td>
<td>18-Nov-84</td>
</tr>
<tr>
<td>mmm-yy</td>
<td>Nov-84</td>
</tr>
<tr>
<td>mmm dd, yyyy</td>
<td>November 18, 1984</td>
</tr>
</tbody>
</table>

PRECISION

Use the Precision column to enter the number of digits to display to the right of the decimal point for fields with Fixed, Financial, Currency, or Scientific display formats. The Precision column does not affect fields with the General display format, since General format does not limit the number of digits displayed (up to 15).
For example, for fields displaying dollar amounts (e.g., financial or currency), a precision of 2 will show the two cents digits, while a precision of 0 will show only the whole dollar amounts.

The range for precision is 0 to 15 digits. When the display is set to fewer digits than are necessary to fully display a number, the number will be rounded, rather than truncated.

No matter what the display, Reflex calculations are based on 15 digits of significance.

---

VARY

Vary is a facility which will automatically create a range of records. This has two primary uses:

- Create the skeleton of a database—suppose you want to analyze results for 5 divisions by month over the past 5 years. That's 300 records (5 divisions times 12 months times 5 years). Rather than entering all those records, you can use Vary to create 1 record for each division for each month for each year, 300 records in all. You then only enter the additional information in each record.

- Quickly create hypothetical scenarios—suppose you want to look at the results of 10 possible pricing scenarios. You can set up a database with the appropriate fields and formulas to calculate revenue, cost, and profit based on the price level. You can then use Vary to create 10 records, one for each price level, and examine the results.

The key to Vary is that it creates a range of records with a specified range of values in a particular field (that field being varied over the range of values.)

Here's an example. Suppose you want a 12 month sales history for each of 4 salesreps. You set up a form with three field names:

Month
Salesrep
Monthly Sales

You know you will need one record for each month and each salesrep. First you use Vary to create one record for each salesrep.
One record is the basis for four records. Alan, Bob, Cathy, Dave

Then use Vary to add twelve monthly records for each Sales-rep's record.

Each record is the basis for twelve more records.
(Shaneary through December).

Now, after two Vary operations, your database consists of 48 records, 12 for each of four salesreps. The Monthly Sales field on each one is blank, waiting to be filled in during the year.
THE VARY TOOL

Vary is performed with the Vary tool, in which you provide the field to vary and the range to vary it over.

To open the Vary tool, choose Vary from the Records menu (/RV). The tool has the following settings and options:

**Field to Vary** In this cell, you enter the field in which you will want to enter a series of values. You can use the Choices key [F10] to display a list of current field names.

**From...To...By** If the field to Vary is a numeric or date field, enter a range and an interval for the field values. If the field is a text field, the From...To...By cells will be replaced with one cell into which you enter the text values. This is shown below.

**Text** Enter text entries, separated by commas, to create one record for each entry.

**Vary current record/Vary all records** Choose between creating the new set of records for just the current record, or creating one set for each record in the working database.

**Proceed** Performs the Vary operation and puts away the tool.

**Cancel** Puts away the tool without performing the Vary operation and returns entries in the tool to what they were before it was opened.
CONDITIONS AND EFFECTS

FIELD TYPE
Before you can use Vary, you must have already established the field type for the field you are going to vary. (Reflex recognizes the field type based on the first value you enter into a field. Or you can define the type in the Field & Sort Settings tool.)

VARY THE CURRENT RECORD OR ALL RECORDS
The Vary All records option performs the Vary operation for all the records in the working database. If you have one record for each of five regions and then Vary All to create 12 monthly records, the result will be 60 records, 12 for each region.

This has the effect of varying multiple fields, creating all the different combinations.

If you selected Vary Only the current record, 12 records would be created, one for each month and all with the same region.

Be careful when using Vary All that there aren't other records in the working database that you don't want Vary'ed. You could end up with extraneous records.

If there are records which you don't want Vary'ed when doing a Vary All, filter them out. Only records in the working database are Vary'ed.

A common example is that you have monthly records for, say, five departments over 4 years and you want to create another year's records (e.g. for 1985) for each department. That's 60 records you want to create: one for each month, for each department. You can't Vary all the records since that would yield 4 more years' worth. So, filter out all but one year's records and then do a Vary All, Varying Year from 1985 to 1985 By 1. That will create one record for each month for each department, each with 1985 as the Year.

EFFECT ON THE ORIGINAL RECORDS
Sometimes when you Vary, you'll want to use the current record as the first record in the Varied sequence and sometimes you'll want to create an entirely new set of records apart from the current record. Generally, if the current record has a value already in the Field to Vary, you'll want all new records;
If it doesn’t have a value, you’ll want to start with that record as the first one in the Vary’ed sequence. That’s exactly what Reflex does:

*If the field contains an entry*, all newly created records are added to the database, and the current record remains unaffected.

*If the field is null*, the current record becomes the first in the Vary sequence.

*If you vary all records*, and the field contains an entry in *any* record, all newly created records are added to the database and all the old records remain unaffected. If the field is Null in *all* records, each existing record becomes the first in its Vary sequence.

**VARYING NUMERIC RANGES**

If the field name in the Field to Vary cell is a numeric or date field, Reflex retains the From...To...By cells. Here, you specify the range of values to enter in the field in the new records.

For example, if you want to vary entries in the field from 25 to 75 with intervals of 5, enter: FROM 25 TO 75 BY 5.

If the interval doesn’t divide evenly into the range, it goes up to, but not including the top of the range. For example, if you enter From 10 to 20 by 3, Reflex creates four new records and enters 10, 13, 16, and 19 in the named field.

The varied entries can be increasing or decreasing. Thus, if you tell Reflex to vary the named field From 25 To 10 By 5, Reflex creates records with 25, 20, 15, and 10 in the field. You can also vary fields in intervals less than 1, using decimals.

**VARYING DATE FIELDS**

To vary date values, use the date entry format (mm/dd/yy) in the From and To cells. In the By cell, enter the number of *days* for the interval.

For example, From 1/1/84 To 7/1/84 By 7 creates one record for each week (seven days) for the first six months of 1984. How those dates appear on your records is determined by the display format you establish in the Field & Sort Settings tool.

**VARYING TEXT FIELDS**

When you enter a text field name in the Field to Vary cell, Reflex replaces the From..To..By cells with a cell titled Text.
You enter a list of the actual entries you want to appear in the field in each new record, separated by commas. Reflex then creates one record for each entry on the Text line.

For example, if you want Reflex to create new records for sales regions North, South, and West, you enter North, South, West in the Text cell. When you proceed, Reflex automatically creates three new records. The first new record has North in the field, the second has South, and the third has West.

Use commas to separate text entries. This means that none of the text entries themselves can include commas. For example, if you enter Smith, Fred Reflex creates one record for Smith and another for Fred.

Reflex ignores leading and trailing blank spaces. Text entries can be up to 254 characters long. This is the overall maximum for the combined entries in the text cell, as well as the maximum for any one field.

**RECORDS COMMANDS**

The remaining commands on the records menu add and delete individual records, re-apply the sort order, recalculate all formulas, and enable you to clear the current database from memory.

**ADD RECORD**

The Add Record command (/RA) creates a blank record following the current record. In Form View, the blank record is displayed. In List View, the blank record is inserted below the current record in the list and is made current.

**DELETE RECORD**

The Delete Record command (/RD) deletes the current record. In Form View the next record is displayed. In the List View, the row is removed, and the next record becomes current.
FIVE REFERENCE A

WARNING
No confirmation is required.
When you choose Delete Record, the current record is deleted instantly.

PERFORM SORT

The **Perform Sort** command (/RP) sorts the records according to the current sort order. You establish the sort order in Field & Sort Settings.

When you first proceed from the Field & Sort Settings tool, the database is sorted. If you add or modify records afterward, they are not necessarily in the right order. Choose Perform Sort, and the records are re-sorted.

RECALC

If you have set Recalculation to Manual in the Global Settings tool, use the **Recalc** command (/RR) to recalculate all the formula values.

When manual recalculation is set, no formulas will be recalculated until and unless you give this command. With a lot of complex formulas, this allows you to enter data without waiting for recalculation, recalculating only when you're done and want to see all the correct values.

CLEAR DATABASE

The **Clear Database** command (/RC) erases the current database from your computer's memory. This is as if you had just brought up Reflex and had not yet created or retrieved a database.

This includes all records, field names, and data. The Reflex program itself remains in memory, ready to work on a new database.

When you choose Clear Database, a confirmation message will appear. Type Y to confirm.
PART 7
SEARCH

A SEARCH CONDITIONS 115
   Operators 117
   Text search conditions 120
   Numeric search conditions 123
   Date search conditions 124
   Special search conditions 124
   How are search conditions evaluated? 125

B SET SEARCH CONDITIONS 126
   Using the conditions table 127
   Using the condition cell 129
   Use conditions as entered or opposite 130

C FILTER, FIND, AND KEEP 131
   Apply filter 131
   Remove filter 132
   Find record 132
   Keep records 133
The commands on the Search menu enable you to establish search conditions for Reflex to find, filter, or keep a subset of records in your database.

Set Conditions displays the Search Conditions tool in which you enter the search conditions that tell Reflex which records to filter or find.

Apply Filter creates a “working database” of only the records that meet the search conditions, and temporarily sets aside all the records which do not meet the search conditions.

Remove Filter brings back all the records which were temporarily set aside when the filter was applied.

Find Record makes current the next record in the database that meets the search conditions.

Keep Records retains in memory only those records that meet the search conditions, deleting the rest.

SEARCH CONDITIONS

Search conditions define what records you want to find or filter. They are criteria upon which to judge each individual record, looking for those with particular characteristics. For example, “Price > 100” is a search condition which would look for all records in which the Price field contains a number greater than 100.
Finding records based on a search condition.

The general format for a search condition is:

\[ \text{field name} \quad \text{operator} \quad \text{value} \]

1. The **field name** may be any field name currently being used in your database.
2. The **operator** tells Reflex how to compare the value to the entries in the specified field in each record.
3. The **value** is the text characters, number, date, or formula that is compared to the entries in the specified field in each record.

Records which satisfy the condition are said to "meet the condition".

Here are some examples of search conditions:
<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>OPERATOR</th>
<th>VALUE</th>
<th>MEANING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rep</td>
<td>=</td>
<td>“Bob”</td>
<td>All records with Bob in the Rep field meet this condition.</td>
</tr>
<tr>
<td>Price</td>
<td>&gt;</td>
<td>250</td>
<td>All records with a value greater than 250 in the price field meet this condition.</td>
</tr>
<tr>
<td>Date</td>
<td>&lt;</td>
<td>1/15/83</td>
<td>All records with a date earlier than 1/15/83 in the Date field meet this condition.</td>
</tr>
</tbody>
</table>

**OPERATORS**

There are two different kinds of operators used in search conditions: Logical operators and Range operators.
LOGICAL OPERATORS
The Logical Operators are shown below:

<table>
<thead>
<tr>
<th>OPERATOR</th>
<th>MEANING</th>
<th>FORMAT</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Equals field name = value</td>
<td>Field name = value</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than field name &gt; value</td>
<td>Field name &gt; value</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or equal to field name &gt;= value</td>
<td>Field name &gt;= value</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less than field name &lt; value</td>
<td>Field name &lt; value</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to field name &lt;= value</td>
<td>Field name &lt;= value</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Not equal to field name &lt;&gt; value</td>
<td>Field name &lt;&gt; value</td>
</tr>
<tr>
<td>AND</td>
<td>Combines two or more conditions into one</td>
<td>condition AND condition</td>
</tr>
<tr>
<td></td>
<td>one condition; all of the conditions must be</td>
<td></td>
</tr>
<tr>
<td></td>
<td>met for a record to be found</td>
<td></td>
</tr>
<tr>
<td>OR</td>
<td>Combines two or more conditions; any one</td>
<td>condition OR condition</td>
</tr>
<tr>
<td></td>
<td>of the conditions may be met for a record to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>be found</td>
<td></td>
</tr>
<tr>
<td>NOT</td>
<td>Inverts a Search condition so as to find its</td>
<td>NOT (condition)</td>
</tr>
<tr>
<td></td>
<td>opposite; i.e., everything but that condition</td>
<td></td>
</tr>
</tbody>
</table>

Here are some examples using these logical operators:

Cost > 150 AND Cost < 250

Records in which the value in the Cost field is greater than 150 and is less than 250, meet this condition.

Cost > 250 AND Rep = “Bob”

Records in which the value in the Cost field is greater than 250 and the entry in the Rep field is Bob meet this condition.

Cost > 250 OR Margin > .25

Records in which the value in the Cost field is greater than 250 meet this condition, and records in which the value in the Margin field is greater than .25 also meet this condition.

NOT (Rep = “Bob”)
Records in which any entry except Bob is in the Rep field meet this condition.

**RANGE OPERATORS**

The Reflex Range Operators THRU, BTWN, UPTO, and DNTO filter or find records with numeric or date values within specified ranges. The Range Operators may be used with numeric or date fields, but not text fields.

<table>
<thead>
<tr>
<th>OPERATOR</th>
<th>MEANING</th>
<th>FORMAT</th>
</tr>
</thead>
<tbody>
<tr>
<td>THRU (Low value, high value)</td>
<td>From and including the low value to and including the high value</td>
<td>Field name THRU (low value, high value)</td>
</tr>
<tr>
<td>BTWN (low value, high value)</td>
<td>Greater than the low value and less than the high value</td>
<td>Field name BTWN (low value, high value)</td>
</tr>
<tr>
<td>UPTO (low value, high value)</td>
<td>From and including the low value to but not including the high value.</td>
<td>Field name UPTO (low value, high value)</td>
</tr>
<tr>
<td>DNTO (high value, low value)</td>
<td>From and including the high value but not including the low value.</td>
<td>Field name DNTO (high value, low value)</td>
</tr>
</tbody>
</table>

Here are some examples using Range operators:

Cost THRU (150, 250)

When the value in the Cost field is from 150 through 250 (including both 150 and 250), the record meets this condition. This is the same as Cost >= 150 AND Cost <= 250.

Cost BTWN (150, 250)

When the value in the Cost field is greater than 150 and less than 250 the record meets the condition. This is the same as Cost > 150 AND Cost < 250.

Cost UPTO (150, 250)

When the value in the Cost field is from 150 to 250 (including 150, but not 250), the record meets this condition. This is the same as Cost >= 150 AND Cost < 250.

Cost DNTO (250, 150)

When the value in the Cost field is from 250 to 150 (including 250, but not 150), the record meets this condition. This is the same as Cost <= 250 AND Cost > 150.
TEXT SEARCH CONDITIONS

Search conditions for text fields require that the text value be enclosed in single or double quotes. Only the logical operators may be used.

EXACT MATCH

Exact match text field conditions always use an equal sign (=), the not equal sign (<>), or the NOT operators. Reflex does not make a distinction between upper and lower case in text search conditions.

For example:

Salesrep = "Alan"

All records that have Alan in the Salesrep field meet this condition.

Salesrep <> "Alan"

All records except the ones that have Alan in the Salesrep field meet this condition.

NOT (Salesrep = "Alan")

This is the same as Salesrep <> "Alan"

PARTIAL MATCH

You can also match part of a text value. Using two dots within the quotes before, after, or before and after text characters instructs Reflex to compare the characters to part of the field entry. This is called a wildcard match because the two dots match anything. For example:

Name = "jam . . " Means "find records that begin with jam as the first three letters in this field, no matter what follows."

For example, James Smith, Jamestown, and Jamboree, all meet the condition.
Name = “. . jam” Means “find records that end with jam as the last three letters in this field, no matter what precedes them.” For example, strawberry jam, and log jam both meet the condition.

Name = “. . jam . .” Means “find records that include the letters jam together anywhere in this field, no matter what precedes or follows.” John Jameson, R. James Butterworth III, pajamas, and James Smith all meet the condition.
The wildcard match is useful for keeping a list within a field. Suppose you keep track of which industries your clients are interested in for investments. You might have a field called Industry Preference with entries such as:

<table>
<thead>
<tr>
<th>CLIENT</th>
<th>INDUSTRY PREFERENCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Technology, Oil, Retail</td>
</tr>
<tr>
<td>B</td>
<td>Aerospace, Retail, Steel</td>
</tr>
<tr>
<td>C</td>
<td>Oil, Utilities</td>
</tr>
</tbody>
</table>

You could find all clients interested in Oil by using the following search condition:

Industry Preference = "..Oil.."

All the records with Oil anywhere in the Industry Preference field would be found.

**TEXT RANGES**

To find records that alphabetically precede or follow the text value, use the >, >=, <, and <= logical operators.

For example:

Client Name < "N"

All records in which the Client Name begins with a letter before N in the alphabet meet this condition.
Salesrep >= “Cathy”

All records in which the entry in the Salesrep field is Cathy or follows Cathy alphabetically meet this condition. Note that “cb” follows “Cathy”, while “c” precedes it.

You can establish a search condition for a range of text by using the AND operator:

Product >= “A” AND Product < “N”

All records in which the entry in the Product field begins with A or is between A and N meet this condition.

**NUMERIC SEARCH CONDITIONS**

Numbers in search conditions for numeric fields can contain a decimal point and a minus sign. They cannot contain commas, dollar signs, or percent symbols. Numeric conditions may use both the Logical and Range Operators.

For example:

Profit = 250.95

All records in which 250.95 is the entry in the Price field meet this condition.

Profit Thru(-250,250)

All records in which the entry in the Profit field is from -250 through +250 meet this condition.

**CALCULATED CONDITIONS**

Search conditions for numeric fields can include formulas to calculate a value. This is called a calculated condition. All mathematical, financial, date, and special functions may be used in calculated search conditions. (For complete details about writing formulas, see Part 8, “Calculated Fields”.)

For example:

Cost > Price * .5

All records in which the Cost field is greater than one-half the Price field meet this condition.
DATE SEARCH CONDITIONS

Conditions for date fields may use both the Logical and Range Operators. For example:

Date > 3/15/84

All records which have a date in the date field later than March 15, 1984 meet this condition.

Date THRU(1/15/84, 3/15/84)

All records which have dates in the date field from January 15, 1984 through March 15, 1984 (inclusive) meet this condition.

SPECIAL SEARCH CONDITIONS

Reflex provides several special functions to isolate records with specific conditions.

<table>
<thead>
<tr>
<th>OPERATOR AND FORMAT</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>@LOCALVAL(Field Name)</td>
<td>Finds all records that have a local value in the specified field.</td>
</tr>
<tr>
<td>@ISNULL(Field Name)</td>
<td>Finds all records that have a null value (no entry) in the specified field</td>
</tr>
<tr>
<td>@ISERR(Field Name)</td>
<td>Finds all records that have an ERROR in the specified field</td>
</tr>
</tbody>
</table>
These special functions are not used in the normal search condition format. Typically, these functions are entered in the Condition cell in the Search Conditions tool, stand-alone, as shown as below:

@ISNULL(Name)

Each record is evaluated and if the Name field has no value entered, the record meets this condition.

**HOW ARE SEARCH CONDITIONS EVALUATED?**

Although it is not necessary to understand the evaluation process that Reflex performs in determining which records are found, it can be useful in taking advantage of the full power of filters.

When a filter is applied, Reflex evaluates the Search condition once for each record in the database. If for a given record, the result of this evaluation is false, that record does not pass the filter. If the result is true, the record does pass. In doing the evaluation for a given record, fields in the condition take their values from that record.

For a simple condition such as Price = 100, then, Reflex goes through each record, plugs that record's Price value into the condition and sees whether the condition is true or not. If the Price is 100, it's true; otherwise it's false. Any valid formula calculations may be included in the condition.

@ABS(Yield − 24) < 1, is a perfectly acceptable, albeit more complex, search condition.

A subtler condition, such as @ISNULL(Name), is still evaluated once per record. The function @ISNULL is designed to return a true or false depending on whether the value it is given is null or not. So the condition is true for any record in which the name field is null, false otherwise.

Taking this further, if you wanted to filter out all records (to save the fields and formulas but no records), you'd want a filter which was always false. The simplest is just @false. To do this, enter @false (just one word) in the condition cell. It will be evaluated once for each record and always come up false (of course). No records will pass the filter condition.

Finally, to get really fancy, suppose you wanted to randomly filter out 80% of the records; i.e. look at a random sample of 20% of the database. You'd want a condition which was ran-
domly true 20% of the time and false 80% of the time. A filter which does this is:

@RAND() < .2

The @RAND function returns a random number, evenly distributed between 0 and 1. So, 20% of the time it will return a number < .2, and 80% it will return a number > .2. By entering that condition in the condition cell, 20% of the time it will evaluate to true, and therefore the record will pass, and 80% of the time it will evaluate to false and the record will not pass. The fact that when it was evaluated for each record, no values were actually taken from the record is unusual, but acceptable.

SET SEARCH CONDITIONS

Search conditions are entered in the Search Conditions Tool. Once the conditions are established, Reflex is ready to filter, find, or keep the records specified by the conditions.

To open the Conditions Tool, choose Set Conditions from the Search menu (/SS). The Search Conditions tool has the following options and settings:
Method of Entry  You can select Cell or Table. The Table checkbox is preselected, and the conditions table is displayed. Choose Cell to enter a single-line condition, instead of using the table.

Condition  This cell appears when you select Cell as the Method of Entry.

Conditions Table  provides a “Query-by-Example” table for entering search conditions. The first column presents all the field names in the database. You enter the conditions in the cells in the subsequent columns.

Use  You can use either the conditions as entered or their opposite.

Proceed  This establishes the search conditions and puts away the tool.

Cancel  The search conditions are not established and the tool returns to the way it was before you opened it.

USING THE CONDITIONS TABLE

When you select the Table Method of entry, the tool shows the table display. The first column lists all the field names in your records. You enter conditions into the second and further columns.
The Conditions Table.
Enter conditions in the Conditions columns.

<table>
<thead>
<tr>
<th>Field</th>
<th>Condition</th>
<th>OR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rep</td>
<td>&quot;Cathy&quot;</td>
<td></td>
</tr>
<tr>
<td>Product</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sales</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cost</td>
<td>&gt; 250</td>
<td></td>
</tr>
<tr>
<td>Margin</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Use: ☑ Conditions as Entered ☐ Opposite of Conditions

Do not include the leading field name in the search condition. The field name in the first column establishes the field name on the left side of the search condition. Also, equal signs are not required in the table, although all other operators are required. For example, if the search condition is Cost > 250, enter >250 in the cell to the right of Cost. If the search condition is Rep = “Cathy”, enter “Cathy” in the cell to the right of Rep (the quotes are needed for text fields).

As soon as you enter a condition, another condition column appears to the right of the first. This additional column allows you to enter more conditions which are combined with the conditions in the first column using the OR operator. A maximum of 10 columns can be used.

Conditions entered in the columns work like this: search conditions typed in the same column are connected by the logical operator AND, and are combined into one condition. For a given column, only records which meet all of the conditions will be found. Search conditions typed in different columns are connected by the logical operator OR, and records which meet the conditions of any one column are found.
For example, in the figure above, Reflex finds all the records in your database that meet both conditions—that is, all records with dates after June 30, 1984 in the Date field AND with the value 29.95 in the Cost field. Reflex treats the entries in the grid as if you had typed in Cost = 29.95 AND Date > 6/30/84 into the Condition Cell.

If, instead, you enter 29.95 in the “OR” column, as shown above, Reflex then finds all the records in your database that meet either of those conditions—that is, all records with dates after June 30, 1984, in the Date field OR with the value 29.95 in the Cost field, not necessarily on the same record. Reflex would treat these entries as if you had entered in Date > 6/30/84 OR Price = 29.95 in the Condition Cell.

Each cell on the grid is an independent Condition Cell with fieldname = implied as the start of the condition. Thus, in the cell next to Cost, you could enter: 29.95 AND Date > 6/30/84.

**USING THE CONDITION CELL**

When you select Cell, the table is replaced by the word Condition and a cell for entering a search condition.
The Condition cell.

Method of entry: Yes Cell  No Table

Condition [Avg Price > 2000]

When you use the Condition cell your search condition must be complete, including field name(s), operator(s), and value(s) in the formats shown in the preceding sections. For example:

Avg Price > 2000

The search condition may be up to 254 characters long.

**WHEN TO USE THE CONDITION CELL**

Although you can use either the conditions table or condition cell to create the same filters, most people generally prefer the table.

Some conditions, however, are more straightforward in the condition cell. In particular, the special search conditions—@ISNULL, @ISERR, and @LOCALVAL—are used without a leading field name, e.g. @ISERR(Yield). They can be entered directly into the condition cell. To use them in the table requires some sleight-of-hand to attach them to a normal condition format. For example, entering:

>0 AND @ISNULL(Yield)

in any field which will always be greater than zero, has the effect of finding all the records with a null value in the Yield field.

**USE CONDITIONS AS ENTERED OR OPPOSITE**

Every search condition you establish divides the database into two groups:

- Records that meet the condition.
- Records that don't.

Reflex assumes that you want to see the records that *meet* the conditions you establish. If you want to see the records that don't meet the conditions, select the Opposite of Conditions checkbox.

For instance, the search condition **Cost = 100** would normally give you all records with the 100 in the Cost field. By selecting the Opposite checkbox, Reflex finds all those records that do not have 100 in the Cost field. You'll find the Opposite of
Conditions useful for comparing a set of filtered records with the set of remaining records.

**NOTE** Selecting "Opposite" does not simply reverse the operators, it searches for those records not meeting the conditions. For example, using the opposite for the conditions "Sales < 100 And Date < 1/30/84" will not filter for "Sales > 100 And Date > 1/30/84." It will search for "Sales > 100 Or Date > 1/30/84."

---

**FILTER, FIND, AND KEEP**

**APPLY FILTER**

Applying a filter gives you a way of seeing only selected parts of your database. When you apply a filter, Reflex temporarily sets aside records that do not meet the conditions. The records that meet the conditions remain as your *working* database.

*To apply a filter*, choose Apply Filter from the Search menu (/SA) or press the Filter key [F]. This commands Reflex to show only those records that meet the search conditions.

When a filter is applied, Reflex operates exactly as it did before, except that the database is temporarily reduced to the specified records. The views show only these records.

These records are the same records that were part of the whole database, and any changes to them will be retained when the filter is removed.

If you have applied the filter and you add records that do not meet the current search conditions, they will remain part of your working database until you apply the filter again.

**FILTER STATUS MESSAGES**

When a filter is applied, a highlighted FILT message appears on the message line.

Status information in the Global Settings tool includes the number of records in the working database.
REMOVE FILTER

A Filter can be applied and removed as often as you like.

To remove a Filter, choose Remove Filter from the Search menu (/SR) or press the Filter key [F5] again. The filter is removed, and the database returns to its normal size.

Note that when the filter has been applied, the [F5] key removes it. And when the filter is not applied the [F5] key applies it. A tip to remember is that if you have applied a filter and then enter more records which may not meet the conditions, or change the search conditions to look at a different set of records, the [F5] function key must be pressed once to remove the filter and then again to re-apply it. You can apply the new filter in one step by choosing Apply Filter from the Search Menu (/SA).

FIND RECORD

If you want to view the records meeting the search conditions while still viewing the whole database, use the Find Record command.

Find locates the next record (starting at the current record) which meets the conditions and makes it the current record. As is always the case for the current record, this causes it to be displayed in the Form View and indicated in the List View and Graph View.

To see the next record that meets the conditions, choose Find from the Search menu (/SF) or press the Find key [F5].

Since Find starts with the current record, to ensure that you find all the relevant records start at the first record by pressing the [F7] key.

You can use Find as many times as you want. When Reflex reaches the last record that meets the conditions, it remains on that record when you perform Find again.

When you find records, all the other records remain available. You can use the cursor movement keys and [F7] and [F8] to select any record, just as usual.
KEEP RECORDS

To retain all records that meet the search conditions, deleting the rest, use the Keep Records command.

To delete all records that do not meet the conditions:

1. Apply the filter (/SA or F5).
2. Choose Keep Records from the Search menu (/SK).
3. Type Y to confirm.

All the records that do not meet the conditions are deleted.

WARNING  These records are permanently deleted from memory, just as if you had selected them one at a time and deleted them.
PART 8

CALCULATED FIELDS

A FORMULAS 135
Values: the basic elements 135
Formulas 136

B FORMATS FOR FORMULAS 138
Arithmetic operators 138
The general format 138
Precedence of operators in calculations 139
Using parentheses to change the order of calculations 139

C ENTERING FORMULAS 140
Local values and formulas 141
Entering numbers, dates, and text in formulas 142
Entering constants 143

D FUNCTIONS 143
Format of functions 144
Function type 144
Function list 145

E WORKING WITH DATES 147
Date consolidation 147
Date arithmetic 153

F RECALCULATION: AUTOMATIC AND MANUAL 154

G EDITING AND DELETING FORMULAS 155

H CONVERTING A FORMULA TO ITS RESULT 155
A calculated field is one whose value is derived from other fields. The derivation is called a formula, or model. For example, Profit might be derived from Revenue and Cost with this formula:

\[ \text{Profit} = \text{Revenue} - \text{Cost} \]

Using this formula would have the effect of calculating Profit from the Revenue and Cost fields in each record and filling the Profit field with the result for each record:

Formulas provide a way to automatically enter values. This provides a number of benefits:

- Values are calculated automatically, saving the need for you to do calculations.
- Values are entered automatically, saving the need to enter them.
- Values are changed automatically when other fields change, saving the need to update dependent fields.

Using a formula for a field has the effect of applying it to that field for all records. However, you can enter a different value in any individual record, superseding the formula for that record.

---

**FORMULAS**

**VALUES: THE BASIC ELEMENTS**

There are three basic elements for giving a value to a field: constants, other field names, and functions.
**Constant**  A number, date, or text string that you type in, e.g.:

Price = 495

Customer Name = General Auto

Invoice Date = 11/18/84

**Field Names**  Other field names can be used to represent the value in that field, e.g.:

Shipping Address = Billing Address.

**Functions**  These are special, built-in facilities which perform a calculation and return a value. For example, to calculate the payment on a $1000 loan at 12% interest over 60 months, you could use the PMT function:

Payment = @PMT(1000, .01, 60)

and the payment would be automatically calculated and stored in the Payment field. There are many built-in functions in Reflex, performing a wide variety of functions.

---

**FORMULAS**

Formulas combine these basic values into larger expressions which *calculate and produce a single value*. This value is stored in a field, just as if you had typed it in. For example:

Profit = Revenue - Cost

Here we are calculating the Profit field from two other fields, Revenue and Cost. The expression “Revenue - Cost” is a formula.

Notice the form of the formula above. It is built up from two basic elements, field names in this case. The field names are “joined” by the minus sign, which is an **operator**. This is the general form for formulas—constants, field names, and functions joined by operators.

Some other examples of formulas are:

Price = Cost * 4
Calculating Price from Cost.

Calculating Total Cost from Fixed Cost and Units.

Total Cost = Fixed Cost + 40 * Units

Formulas recalculate themselves when any of their components change. For example, where Profit is calculated as Revenue - Cost, the form might look like:

Revenue: 100
Cost: 70
Profit: 30

If you were to change Cost to 80, Profit would automatically change to 20:

Revenue: 100
Cost: 80
Profit: 20
This **recalculation** feature means that you don’t have to worry about entering or re-entering values into fields that are derived. You enter values into the input fields and the calculated fields are automatically kept up to date.

It also allows you to easily try “What If?” analysis. What if this number were different? Change it and you’ll immediately see the result.

---

**FORMATS FOR FORMULAS**

Formulas use operators to combine constants, field names, and functions into larger expressions. The operators used in formulas are called **arithmetic operators** (as opposed to the logical operators and range operators used in search conditions.)

**ARITHMETIC OPERATORS**

The arithmetic operators are:

+ Add  
- Subtract  
* Multiply  
/ Divide  
^ Exponent (to the power of)  
− Negation

**NOTE** Negation has a different meaning from the subtract sign, although it is the same character. It may be used in front of any value, function, or formula to make it a negative value, such as −2, or 6 + −2 (resulting in 4).

**THE GENERAL FORMAT**

The general format for entering formulas is:

```
value operator value
```

where the values are constants (numbers, dates, text strings), fieldnames, functions, or formulas; and the operator is an arithmetic operator.
For example:

4 + 7

Sales - Cost  This formula subtracts the value in the Cost field from the value in the Sales field on the same record.

60 * @PMT(1000, .01, 60)  This formula calculates total payments over 60 periods.

Formulas may also be used in formulas. Anywhere a value can be used, a formula can be used (since a formula produces a value). This capability allows you to build up arbitrarily complex formulas. For example:

Invoice Amt = ((Billing Rate * # Hours) + (Outside Costs * Markup)) * Discount

### PRECEDENCE OF OPERATORS IN CALCULATIONS

If all the arithmetic operators in a formula are the same, Reflex will perform the calculations as it reads the formula from left to right. However, if the operators are different, Reflex performs the calculations in the order (precedence) shown in the following list:

<table>
<thead>
<tr>
<th>PRECEDENCE</th>
<th>OPERATOR</th>
<th>EXAMPLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>negation</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>^</td>
<td>to the power of (exponentiation)</td>
</tr>
<tr>
<td>3</td>
<td>* or /</td>
<td>multiply or divide</td>
</tr>
<tr>
<td>4</td>
<td>+ or -</td>
<td>add or subtract</td>
</tr>
</tbody>
</table>

So, for example, exponentiation will be done before multiplication.

### USING PARENTHESES TO CHANGE THE ORDER OF CALCULATIONS

To change the order in which parts of a formula are calculated, use parentheses to enclose the portion you want to calculate first. Parentheses may be nested inside other parentheses, and the innermost part will be calculated first.
For example:

<table>
<thead>
<tr>
<th>FORMULA</th>
<th>RESULT</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 + 2 * 3</td>
<td>16</td>
</tr>
<tr>
<td>(10 + 2) * 3</td>
<td>36</td>
</tr>
<tr>
<td>((10 + 2) * (3 + 5)) * 4</td>
<td>384</td>
</tr>
</tbody>
</table>

**ENTERING FORMULAS**

Formulas are entered in the field cells of the Form or List Views, just as numbers, text, or dates are. They may also be entered in the Formula column in the Field & Sort Settings tool.

*To enter a formula,* select the cell in the Form or List and enter the formula with a leading `=`:

`= formula`

The `=` tells Reflex that what you're entering is a formula, rather than a text string.

$\text{Margin: } = \text{Price} - \text{Cost}$

Once entered, what is displayed in the cell is the result of the formula, not the formula itself. When the cell is selected, the formula is displayed on the Edit Line at top. When the cell is selected and Edit Mode is entered, the formula is displayed in the cell, as well as on the edit line, for editing.

While entering formulas, choices shows a list of the field names, which you can select from to build up the formula. Of course, you can also type them in.

When entering formulas, spelling counts. Field names and functions must be spelled correctly. If there is a mistake of some sort, either a misspelled word, unrecognized operator, or such, Reflex will not accept it. Instead, it will beep, change to Edit mode, and position the cursor near the error.

Spaces are allowed between any of the elements, i.e. between operators, field names, functions, and parentheses. Where one space is allowed, any number or none is also allowed. Extra spaces are not allowed *inside* any elements, i.e. inside field names, functions, or operators. For example:


### LOCAL VALUES AND FORMULAS

A formula calculates values for a particular field in all records. However, you can still enter a different constant into that field in any given record. This is done just as entering values is always done—select the cell and type it in. Such a **local value** takes precedence over the value calculated by the function and is the value displayed for that record.

<table>
<thead>
<tr>
<th></th>
<th>VALID</th>
<th>INVALID</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;=</td>
<td>&gt;=</td>
<td>=</td>
</tr>
<tr>
<td>@MONTH(Date)</td>
<td>@MONTH(Date)</td>
<td>@MONTH(Date)</td>
</tr>
<tr>
<td>Price - Total Cost</td>
<td>Price - Total Cost</td>
<td>Price - Total Cost</td>
</tr>
</tbody>
</table>

---

### REMOVING LOCAL VALUES

You can remove a local value from a field on a particular record by selecting the field and deleting the contents (/ED) or ...

---

A calculated field with local values.
The formula, if one exists, will then take over and recalculate the value for that field on that record.

To remove local values from a field on all the records at once:
1. Open the Field & Sort Settings tool (/RF).
2. Select the field name cell for the field from which you wish to remove local values.
3. Choose Remove Local Values from the Fields menu (/FR); this command restores the underlying Formula to all the records.
4. Press Y to confirm.

NOTE Select the field name cell for the field you want before you choose the Remove Local Values command. It removes the local values from the field selected in the Field & Sort Settings tool only, not the field that was selected in the View being used before opening this tool.

ENTERING NUMBERS, DATES, AND TEXT IN FORMULAS

NUMBERS IN FORMULAS
Numbers in formulas may be any number including a decimal point and a negation sign. Note that the negation sign does not replace the leading = if a formula begins with a negative number.

DATES IN FORMULAS
Dates in formulas must be entered in the mm/dd/yy format, or by using any of the functions which produce a date.

TEXT IN FORMULAS
All values which are text characters in formulas must be surrounded by quotes. If the word or characters contain a double quote, then the surrounding quotes must be single (the apostrophe). Conversely, if the word or characters contain a single quote, then the text value must be surrounded by double quotes.

Here is an example of how to enter text characters in a formula:
@IF(Price > 25, “Sell”, “Hold”)
This means that if the value in the Price field is greater than 25, the word "Sell" will be entered (without quotes) otherwise the word "Hold" (without quotes) is entered.

**ENTERING CONSTANTS**

A convenient way to put the same value in a field in all records is to make a formula out of it. For example, to set Interest Rate to 12 in all records, you would enter = 12 in the Interest Rate cell. Constants can be a number, date, or text string.

**FUNCTIONS**

Functions are built-in facilities which perform certain calculations and provide the resulting value. They may be used in formulas just like any other element such as field names and constants.

The Compound Growth Rate function.

- Present value = 100
- Future value = 200
- # of periods = 12
- Rate = .059

There are different types of functions:

- Financial.
- Mathematical.
- Date.
- Logical.
- Special.

A sixth type of function, Summary functions are used in the Crosstab, Graph, and Report Views, but are not available for use in calculated fields.

Each function performs a different operation, serving a different purpose.
Functions often take arguments, which are values given to them to be used for performing the calculation. For example, in

\[ \text{Invoice Age} = \@\text{DAYSBTWN}(\text{Invoice Date}, \text{Payment Date}) \]

the \@DAYSBTWN function is given two arguments: the Invoice Date field and the Payment Date field. It will calculate the number of days between these two values for each record and store it in the Invoice Age field. Constants and even other functions can be used as arguments. To calculate the age of open invoices, you might use the Today function to provide the current date:

\[ \text{Invoice Age} = \@\text{DAYSBTWN}(\text{Invoice Date}, \@\text{Today}()) \]

Formulas may also be used as arguments to functions, as in:

\[ \@\text{ABS}(\text{Yield} - .24) \]

This formula measures how close the value in the Yield field is to .24 by taking the absolute value of the difference.

**FORMAT OF FUNCTIONS**

Functions have the following format:

\[ @\text{function}(\text{argument1, argument2, \ldots}) \]

- There is always a leading @.
- The function name is followed by arguments in parentheses (there are some exceptions to this for functions which do not take arguments).
- When there is more than one argument, the arguments are separated by commas.
- There are no spaces between the @, the function name and the left parenthesis. There may be spaces between the arguments and the commas.

**FUNCTION TYPE**

Just as fields have types, i.e. numeric, date, or text, so do functions. A function's type is determined by what type of value it returns.

To assign the value of a function to a field, the function must be of the same type as the field. For example, the \@CDATE function, which returns a date, would be assigned to a date
field. The @MONTH or @DAYSBTWN functions, which return numbers, would be assigned to a numeric field.

You can use a field or function of one type in a formula which calculates a value for a field of another type as long as the whole formula produces a value that matches the target field. For example, in:

\[
\text{RATING} = \text{IF}(\text{Return} > .15, \text{"Buy"}, \text{"Sell"})
\]

Return, which is a numeric field, is used in a function to calculate a value for Rating, which is a text field.

**FUNCTION LIST**

Following is a list of Reflex functions. A detailed description, with examples, of each function may be found in Appendix B.

**FINANCIAL FUNCTIONS**

- \(@\text{PMT}(\text{Principal}, \text{Interest}, \text{Life})\) Calculates the payment for a loan
- \(@\text{PV}(\text{Payment}, \text{Interest}, \text{Life})\) Calculates the present value of an annuity
- \(@\text{FV}(\text{Payment}, \text{Interest}, \text{Life})\) Calculates the future value of an annuity
- \(@\text{CGR}(\text{Present Value}, \text{Future Value}, \text{Life})\) Calculates the Compound Growth Rate
MATHEMATICAL FUNCTIONS

@PI  Returns the value PI (3.14159...)
@RAND()  Returns a random number between 0 and 1
@ABS(X)  Returns the absolute value of X
@INT(X)  Returns the integer portion of X
@SQRT(X)  Returns the square root of X
@SIN(X)  Returns the sine of X
@COS(X)  Returns the cosine of X
@TAN(X)  Returns the tangent of X
@EXP(X)  Returns e raised to the X power
@LOG(X)  Returns the Log base 10 of X
@LN(X)  Returns the Log base e of X
@ROUND(X, digits)  Rounds X to the number of digits specified (up to 15)
@MOD(X,Y)  Returns the remainder of X/Y

DATE FUNCTIONS

@TODAY()  Returns today's date (from DOS)
@YEAR(Date)  Returns the year
@QTR(Date)  Returns the quarter (1-4)
@MONTH(Date)  Returns the month (1-12)
@WKDAY(Date)  Returns the day-of-week (1-7)
@DAY(Date)  Returns the day of the month (1-31)
@DATE(Month, Day, Year)  Returns a Date value
@CMONTH(Date)  Returns the first day of the month as a date value
@CDATE(Month, Day, Year)  Returns the first day of the month as a date value
@CQTR(Date)  Returns the first day of the quarter as a date value
@ADAYS(Date, X)  Adds X days to Date
@ADMNTHS(Date, X)  Adds X months to Date
@ADYRS(Date, X)  Adds X years to Date
@DAYSBTWN(Date1, Date2)  Returns the number of days between two dates
@MNTHSBTWN(Date1, Date2)  Returns the number of full of months between two dates
@YRSBTWN(Date1, Date2)  Returns the number of full of years between two dates
LOGICAL FUNCTIONS

@IF(Condition, True Result, False Result)
Returns one of two values based on whether the condition is true.

@CASE(Condition1, Result1, Condition2, Result2, ... )
Returns result based on which condition is true.

@CHOOSE(X, Result1, Result2, Result3, ... )
Returns result based on value of X

SPECIAL FUNCTIONS

@ISERR(Field)
Returns true or false based on whether Field has error value

@ISNULL(Field)
Returns true or false based on whether Field has null value

@NULL
Returns null value

@DNULL
Returns null date value

@ERROR
Returns error value

@DERROR
Returns error date value

NOTE
To enter a null text value, use two double quotes (""") with no space between.

WORKING WITH DATES

DATE CONSOLIDATION

It is often desirable to analyze the information in the database by a particular time period, such as day of the week, month, quarter, or year.

To do this Reflex provides many different functions which help you consolidate the information by time period.

The following table summarizes the date functions which are used to consolidate dates, the result they produce, and an example based on an input date of 6/25/84.
FUNCTION | RESULT | EXAMPLE
--- | --- | ---
@CMONTH(Date) | first day of the month | 6/1/84
@CDATE(6,25,84) | first day of the month | 6/1/84
@CQTR(Date) | first day of the quarter | 4/1/84
@YEAR(Date) | the year (as a number, not a date) | 1984
@QTR(Date) | the quarter (as a number, not a date) | 2
@MONTH(Date) | the month (as a number, not a date) | 6
@DAY(Date) | the day (as a number, not a date) | 25
@WEEKDAY(Date) | the day of the week (as a number, not a date) | 2

Notice that these functions fall into two categories:

1. Those that produce a number representing the time period, and
2. Those that produce a date, being the first day of the time period. These functions begin with "C".

The difference in use of these functions can best be demonstrated by an example of tracking sales by month. Note that the way these functions are typically used is by creating a new field which is calculated with a function based on a regular date field. That new field is then used for consolidating the records.

**TRACKING SALES BY MONTH**

One use of these date consolidation functions is to track sales by month. There are generally two ways you might want to use monthly data:

1. Reviewing sales by month over several years, or
2. Totaling the sales of each month for several different years (adding all the Januarys together, all the Februarys together, etc.).

The @CMONTH function allows you to do the first, while the @MONTH function allows you to do the second.
Say that you are tracking sales by date. You have a simple form with two fields:

Date: 4/15/84
Sales: 8,995.00

If you looked at the List, you'd see:

<table>
<thead>
<tr>
<th>Date</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/12/84</td>
<td>17,888.88</td>
</tr>
<tr>
<td>1/22/84</td>
<td>21,958.88</td>
</tr>
<tr>
<td>2/8/84</td>
<td>5,797.88</td>
</tr>
<tr>
<td>2/15/84</td>
<td>56,789.88</td>
</tr>
<tr>
<td>2/19/84</td>
<td>17,688.88</td>
</tr>
<tr>
<td>3/15/84</td>
<td>13,999.99</td>
</tr>
<tr>
<td>3/16/84</td>
<td>14,088.81</td>
</tr>
<tr>
<td>3/24/84</td>
<td>8,995.88</td>
</tr>
<tr>
<td>4/15/84</td>
<td>8,995.88</td>
</tr>
<tr>
<td>4/29/84</td>
<td>39,958.88</td>
</tr>
<tr>
<td>5/8/84</td>
<td>39,949.88</td>
</tr>
<tr>
<td>5/18/84</td>
<td>9,979.95</td>
</tr>
<tr>
<td>5/25/84</td>
<td>67,690.80</td>
</tr>
</tbody>
</table>
Now, suppose you wanted to use Crosstabs to see total sales by month, or use Graph to plot total sales by month. What's needed is a way to group the records by month, being smart about having different entries for, say, December 1983 and December 1984. The @CMonth function will do this. Add a field called Month which is calculated with @CMonth(Date):

```
=CMONTH(Date)
```

The List would look like:

```
Date    Sales    Month
1/12/84  17,888.88  1/31/84
1/22/84  21,958.00  1/31/84
2/01/84   5,797.00  2/01/84
2/15/84  56,789.00  2/01/84
2/16/84  17,688.00  2/01/84
3/15/84  13,999.99  3/01/84
3/16/84  14,888.81  3/01/84
3/24/84  8,995.88   3/31/84
4/15/84  8,995.88   4/30/84
4/29/84  39,958.80  4/30/84
5/01/84  39,949.00  5/31/84
5/10/84  9,979.95   5/31/84
5/25/84  67,688.88  5/31/84
```
Notice that the Month field has the same value for all the records in a given month.

You may want to use the Field & Sort Settings Tool to change the display format for Month to MMM-YY:

Looking at the formatted Month field:

<table>
<thead>
<tr>
<th>Date</th>
<th>Sales</th>
<th>Month</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/12/84</td>
<td>17,888.89</td>
<td>Jan-84</td>
</tr>
<tr>
<td>1/22/84</td>
<td>21,958.89</td>
<td>Jan-84</td>
</tr>
<tr>
<td>2/8/84</td>
<td>5,797.89</td>
<td>Feb-84</td>
</tr>
<tr>
<td>2/15/84</td>
<td>56,769.89</td>
<td>Feb-84</td>
</tr>
<tr>
<td>2/16/84</td>
<td>17,608.89</td>
<td>Feb-84</td>
</tr>
<tr>
<td>3/15/84</td>
<td>13,999.99</td>
<td>Mar-84</td>
</tr>
<tr>
<td>3/16/84</td>
<td>14,888.81</td>
<td>Mar-84</td>
</tr>
<tr>
<td>3/24/84</td>
<td>8,995.89</td>
<td>Mar-84</td>
</tr>
<tr>
<td>4/15/84</td>
<td>8,995.89</td>
<td>Apr-84</td>
</tr>
<tr>
<td>4/29/84</td>
<td>39,958.88</td>
<td>Apr-84</td>
</tr>
<tr>
<td>5/8/84</td>
<td>39,949.88</td>
<td>May-84</td>
</tr>
<tr>
<td>5/18/84</td>
<td>9,979.95</td>
<td>May-84</td>
</tr>
<tr>
<td>5/25/84</td>
<td>67,688.89</td>
<td>May-84</td>
</tr>
</tbody>
</table>

Now a Crosstab can be set up by using the For Each command to create one column for each Month, grouping the records by the month they fall in:

Crosstab for Sales by Month.
Or you could graph total sales by month:

If instead of grouping the records by different months by different years, you wanted to group them by month for all years (e.g., all the Januarys together, all the Februarys together, and so on) you would use the @Month function. Set the Month field to @Month(Date). The List would show:
Then a Crosstab could be created showing:

```
Month = 7
	Views  Edit  Print/File  Records  Search  Crosstab
  Crosstab

Summary:  @SUM  Field:  Sales

Month

<table>
<thead>
<tr>
<th></th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>ALL</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL</td>
<td>30,886</td>
<td>118,856</td>
<td>71,197</td>
<td>92,328</td>
<td>126,355</td>
<td>52,988</td>
<td>1,164,217</td>
</tr>
</tbody>
</table>
```

**DATE ARITHMETIC**

Reflex also provides a variety of functions for calculating the differences between dates and adding time to dates.

**CALCULATING THE TIME BETWEEN TWO DATES**

Reflex provides the following functions which calculate the number of days, months, or years between two dates:

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>RESULT</th>
</tr>
</thead>
<tbody>
<tr>
<td>@DAYSBTWN(10/10/84, 11/5/86)</td>
<td>755</td>
</tr>
<tr>
<td>@MNTHSBTWN(10/10/84, 11/5/86)</td>
<td>24</td>
</tr>
<tr>
<td>@YRSBTWN(10/10/84, 11/5/86)</td>
<td>2</td>
</tr>
</tbody>
</table>

An example of calculating time between two dates would be to track the number of years of employee service, using the date of hire and the system date as entered by the @Today function:

Years Employed = @YrsBtwn(Date Hired, @Today())
ADDSING TIME TO DATES
Reflex also provides functions which allow the addition of days, months, or years to a date:

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>RESULT</th>
</tr>
</thead>
<tbody>
<tr>
<td>@ADDAYS(11/25/84, 4)</td>
<td>11/29/84</td>
</tr>
<tr>
<td>@ADDMNTHS(11/25/84, 3)</td>
<td>2/25/85</td>
</tr>
<tr>
<td>@ADDYRS(11/25/84, 2)</td>
<td>11/25/86</td>
</tr>
</tbody>
</table>

One example of how this is helpful is assigning due dates in project tracking.

RECALCULATION: AUTOMATIC AND MANUAL

Reflex calculates the result of a formula when it is entered. When a change is made to an entry in a field that is used by that formula, the formula is automatically recalculated. Because formulas can be linked together, changing the value in one field may affect several formulas and it is possible to take a noticeable amount of time for all the recalculations to occur.

You can have Reflex automatically recalculate any formula that is affected by an entry (automatic recalculation), or wait until you have finished a series of entries (manual recalculation).

To set automatic or manual recalculation, open the Global Settings tool from the Print/File menu (/PG). Select the appropriate checkbox for Recalculation.

**Automatic** This option has Reflex recalculate any formula in the database that is affected by an entry. Automatic recalculation insures that all the calculated fields reflect current data.

**Manual** By specifying manual recalculation, Reflex will calculate formulas only when they are entered or edited, or when you choose the Recalc command from the Records menu (/RR), press the Recalc key [F9], or turn Automatic Recalculation back on in the Global Settings tool.

Manual recalculation is particularly useful when you are entering a lot of data and don’t care to see the calculated fields until all the data is entered. If there are enough calculated
fields to slow down recalculation, data entry will be faster with recalculation set to manual.

EDITING AND DELETING FORMULAS

Reflex treats formulas just like any other kind of data. The standard editing functions apply. To change a formula, select the field cell and either enter a new one from the beginning or press \texttt{F2} to put Reflex in the Edit mode. You will notice that while in Edit mode, the formula, rather than the result, is displayed in the field cell. (The formula is always displayed on the Edit Line when a calculated field is selected.)

To delete a formula, select it in the Formula column in the Field & Sort Settings tool and choose delete from the Edit Menu (\texttt{ED}) or press \texttt{Del}. Or, on a record in the Form View or List View, select the field with the formula you want to delete and enter the character = and press \texttt{~}.

Deleting a formula does not delete any local values.

CONVERTING A FORMULA TO ITS RESULT

Occasionally, you'll want to remove a formula but leave the value.

To remove the formula but leave the result, select it and type an exclamation point (!) before the formula, using the edit key \texttt{F2} and \texttt{Home}.

When entering a new formula, preceding it with the exclamation point (!) automatically calculates and enters the result(s) and eliminates the formula.

Following is a table of results for different entries for entering formulas, removing them, and converting them to just the values.
<table>
<thead>
<tr>
<th>ENTRY</th>
<th>RESULT</th>
</tr>
</thead>
<tbody>
<tr>
<td>= formula ←</td>
<td>enters the formula for that field.</td>
</tr>
<tr>
<td>!formula ←</td>
<td>calculates result of the formula and enters it for that record only.</td>
</tr>
<tr>
<td>! = formula ←</td>
<td>calculates and enters the result of the formula for each record.</td>
</tr>
<tr>
<td>! ←</td>
<td>converts the current value in the cell (which may be the result of a formula) to a local value. Operates only on the current record.</td>
</tr>
<tr>
<td>! = ←</td>
<td>converts the current value in each record into a local value.</td>
</tr>
<tr>
<td>= ←</td>
<td>removes the formula (for all records).</td>
</tr>
</tbody>
</table>
SIX

REFERENCE B: REFLEX REPORT AND UTILITIES
### THE REPORT VIEW

**PART 1 THE REPORT VIEW**

- A/The Report View Screen
- B/Overview of Reporting
- C/Moving Around Report View
- D/The Design Area
- E/The When Printed Column
- F/Report Menu
- G/The Edit Menu
- H/Print/File
- I/Search
- J/Attributes
- K/Example Reports

### TRANSLATE

**PART 2 TRANSLATE**

- A/Translate
- B/Translating PFS and DBase Files
- C/Translating 1–2–3–, Symphony and DIF Files
- D/Translating ASCII Text Files

### MERGE

**PART 3 MERGE**

### GRAPH PRINT

**PART 4 GRAPH PRINT**
## PART 1

### THE REPORT VIEW

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>THE REPORT VIEW SCREEN</td>
<td>4</td>
</tr>
<tr>
<td>B</td>
<td>OVERVIEW OF REPORTING</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Preliminary steps</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Designing the report</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>Save and print the report</td>
<td>7</td>
</tr>
<tr>
<td>C</td>
<td>MOVING AROUND REPORT VIEW</td>
<td>8</td>
</tr>
<tr>
<td>D</td>
<td>THE DESIGN AREA</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Design elements</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Using fields</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Using text</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>Using special fields</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>Using formulas</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td>Using attributes</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>Using summaries</td>
<td>14</td>
</tr>
<tr>
<td>E</td>
<td>THE WHEN PRINTED COLUMN</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>The row flags</td>
<td>17</td>
</tr>
<tr>
<td>F</td>
<td>REPORT MENU</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Preview on screen</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Change sort settings</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Display values on/off</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>Save report design</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>Retrieve report design</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>Erase report design</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>Quit</td>
<td>25</td>
</tr>
</tbody>
</table>
G  THE EDIT MENU  26
   Delete  26
   Insert  26
   Set column width  27
   Row select  27
   Move  28
   Copy  29
   Window clear  29

H  PRINT/FILE  30
   Retrieve file  30
   Print  31
   Change printer settings  31
   Global settings  34

I  SEARCH  34

J  ATTRIBUTES  35
   Using attributes  35
   Display attributes  36
   Arithmetic attributes  41
   Summary  41
   Cumulative  44
   % of total  48

K  EXAMPLE REPORTS  53
   Basic columnar report  53
   Columnar report with subtotals  54
   Summary report using subtotals  56
   Columnar report using special report functions and cumulative  58
   Mailing labels  61
Reference B describes the use of the parts of Reflex on the Report & Utilities Disk: the Report View, and the Graph Print, Translate, and Merge facilities.

The Report View is used to create customized reports on the information in Reflex databases. These reports may be as simple as mailing labels, straightforward columnar reports, or more sophisticated summary reports containing subtotals, averages, and other calculations.

Designing a report is a process of laying out what elements you want in the report, and where you want them printed.

The Report View is highly interactive. You design the report on the screen. At any time you can *preview* what the printed report will look like. This allows you to start simple, see what the result is by previewing it, make changes and enhancements, preview it again, and so on, easily progressing to the final result.

---

**THE REPORT VIEW SCREEN**

The Report View uses the entire screen. It has its own set of menus on the main menu line. The windows area is divided into two parts: the When Printed column and the Report Design Area.
The Report View screen displaying a typical report design.

The **When Printed column** displays **row flags** which tell Reflex when to print each row.

The **Report Design Area** shows text, fields, and totals arranged on the screen as the report should look.

**Position Numbers** indicate row and column number when moving the cursor about the design area.

When you preview your report, the windows area changes to show the report generated by the design.

The Preview screen displays what the report will look like when it is printed.
**Preview Area** displays the first 21 lines of the report.

**Continue Previewing?** message enables you to see the next 21 lines or to return to the design screen.

---

**OVERVIEW OF REPORTING**

This section provides an overview of the process of producing reports with Reflex. The individual steps are described in more detail in later sections.

**BRINGING UP THE REPORT VIEW**

The Report View is on the Report & Utilities Diskette.

*To bring up the Report View*, select the Report cell on the Report & Utilities title screen. Press ø.[

**PRELIMINARY STEPS**

There are two preliminary steps to producing a report:

1. Retrieve a database.
2. Sort the database.

You need to retrieve a database to report on. Information is drawn from the database and is used by the Report View to produce a report.

*To retrieve a database*, choose Retrieve File from the Print/File menu (/PR).

Next, sort the database. The sort order determines the order in which the records are printed, and it defines which fields are used for subtotals, subaverages, etc. Because the sort fields are used to define the report, they should be specified before you begin the report definition process.

*To set the sort order*, choose Change Sort Settings from the Report menu (/RC).

The sort order established in the main program is carried over, but you may change it for the report.
DESIGNING THE REPORT

Designing a report consists of a series of three steps, repeated as often as necessary:

1. Enter field names, totals, and text in the design area.
2. Modify these elements with attributes and row flag changes.
3. Preview the report as you go along by choosing Preview on Screen from the Report menu.

In brief, you use the design area to lay out what you want the report to look like. In it, you position fields, titles, totals and subtotals, explanatory text, and whatever else you want to see in the report.

You use the When Printed column to specify when each row should be printed. It is used, for example, to indicate which rows are header lines to be printed at the top of each page, which rows are subtotals to be printed whenever a particular sort field changes, which rows are summaries to be printed at the end of the report, and so on.

There's a partnership between the Design area and the When Printed column—the Design Area says what the elements in the report are, and the When Printed column says when and where each element appears in the report. You'll find that the process of building up a report design is a repeated sequence of specifying what you want to see in the Design Area and then going to the When Printed column to specify when to print it in the report.

The other key element in building up a report is the Preview on Screen feature. This shows you immediately on the screen what the report will look like on paper. So at each step in the report definition process, you can see what the report will look like. Report definition is an evolutionary, step-by-step process in which you start simple and build up, at each step checking what the result is, making changes, and moving on from there.

SAVE AND PRINT THE REPORT

If you intend to use the same design for future reports, save the design on your data disk. This is particularly useful when you plan to periodically print the same report with updated data.
To print the report, choose Print from the Print/File menu (/PP). To first modify the printer settings, choose Change Printer Settings from the Print/File menu (/PC).

To save a report design, choose Save Report Design from the Report menu (/RS).

To close the Report View, after you have saved the design and printed the report, choose Quit from the Report menu (/RQ). The Report and Utilities title screen will appear.

---

MOVING AROUND THE REPORT VIEW

You can use the cursor movement keys to position the cursor anywhere in the Report design area:

- **Home**: Takes you to the upper left corner of the design area.
- **End**: Takes you to column 1 on the last row of your report.
- **Ctrl + ~**: Takes you right to pre-set tabs located at column 6, column 11, column 16, and column 21, etc.
- **Ctrl + $**: Takes you left to pre-set tabs located at column 6, column 11, column 16, and column 21, etc.
- **Ctrl + →**: Takes you 30 spaces right.
- **Ctrl + ←**: Takes you 30 spaces left.
- **Ctrl + Home**: Takes you to the upper left of screen.
- **Ctrl + End**: Takes you to the lower right of screen.
- **Pg Up**: Takes you 10 rows up.
- **Pg Dn**: Takes you 10 rows down.

In the design area, **Ins** inserts a space; **Del** deletes the selected object, or deletes a space.

To move to the When Printed column, press the Row key, **F3**. This selects the entire current row (shown by a grey highlight), and enables you to enter a row flag.

In the When Printed column, **Ins** inserts a row above the selected row; **Del** deletes the entire selected row, including its contents in the Design area.
THE DESIGN AREA

The Design Area is the heart of the Report View. In it you lay out what will appear in the report.

DESIGN ELEMENTS

The basic rule for using the design area is to position the cursor where you want to include an element of the report and enter that element.

The elements which may be put in the Design Area, and therefore appear in a report, are:

**Fields**  Entering a field name in the Design Area causes the values from that field to be put in the report in that position.

**Text**  Text annotations for the report—titles, explanations, labels for subtotals, etc.—may be put anywhere in the Design Area.

**Special Fields**  There are four pre-defined Special Fields available, which are used to print the date, time, page numbers, and to cause page breaks at particular places.

**Formulas**  Any formula that can be used for a calculated field may be included in the report definition. Reflex will perform the calculation and include the result in the report.

These elements are modified by the Reflex attributes:

**Display attributes**  Each element may have one or more display attributes added to control the way it appears when printed.

**Arithmetic attributes**  Field values can be modified by the arithmetic attributes to provide totals, averages, and other summaries, and percent and cumulative displays. The arithmetic attributes work together with the row flags to define the kind of summary that will be produced in the report.

USING FIELDS

Entering a field name in the Design Area causes the values from that field to be printed in the report.

Typically, a field name appears in a body row, which means that it will be printed once for each record, showing the value
of that field for that record. When the field name is modified with a Summary Attribute, as described below, then it would typically appear in a sort field row, footer row, or conclusion row, since you wouldn't want to see the summary value once for each record.

To include a field, position the cursor in the desired spot and enter the field name. Using Choices [F10] is the preferred way to enter a field name, although it may also be typed in. Whenever the cursor is positioned on a blank spot in the design area, Choices will show a list of field names and Special Fields.

The figure below shows the use of a field name in the Design Area.

When a field name is entered in the design area, it is underlined to show the width of the entry as it will appear in the report. This width can be changed as necessary.

USING TEXT

Text may be used anywhere in the report. Common uses include titles, column headings, labels for subtotals, and general annotations.

To include text, position the cursor on the desired spot and type in the text. If the text is the same as a field name (which is common with column headings), precede it with a leading single quote. The single quote tells Reflex that what you're entering is text, rather than a field name. The quote won't be printed.
Report design using text for the title, column headings, and summary labels.

### USING SPECIAL FIELDS
There are four Special fields available:

- **@Today**
  - Prints the current date (from DOS).

- **@Now**
  - Prints the current time (from DOS). If your computer has an internal clock, the time is updated while the report is printing.

- **@Page-No**
  - Prints the report page number.

- **@NewPage**
  - Causes a page break. It must be the only element on the row.

To include a Special field, use the same method as entering field names. Position the cursor on a blank spot in the Design Area and press **F10** for Choices.
Report design using Special Fields.

**USING FORMULAS**

Just as you can use formulas for calculated fields, you can also use formulas in the report design. Simple formulas such as **Price − Cost** or **Sales * 100** as well as complex formulas such as those using the `@IF` and `@CASE` statements can all be entered in the report design area. The values will be calculated and printed.

*To include a formula*, position the cursor where you want the formula result to be, and enter the formula with a leading equals sign (=).
Report design using a formula.

Formulas are underlined to show the width of the entry as it will appear in the report. This width can be changed as necessary.

**USING ATTRIBUTES**

Once an element is entered in the design area, it can be modified with one or more of the Reflex attributes. The attributes appear on the Attributes menu.

The **display attributes** control how elements are displayed in the report. These elements include field values, special field values, and the results of formulas. With the display attributes you can control:

- **Format** the same formatting options for numbers and dates as are available for displaying numeric and date values in the other views. In addition, a special report format option allows you to display the formulas used to calculate a field in the main program.

- **Precision** controls the number of decimal places displayed.

- **Justification** controls whether the value is left, center, or right justified.

- **Variable Width** prints a field as wide as needed to display the data in it.

- **On Change/All** allows you to have a field printed for all values or only when the value changes.
Export allows you to delimit fields (separate field values) to be exported for use with other programs.

The arithmetic attributes are used to perform calculations on data within the report.

Summary attributes enable you to insert totals, averages, counts, etc.

Cumulative attributes enable you to insert running totals, averages, counts, etc.

% of Total attributes enable you to print values as percentages of the whole.

**USING SUMMARIES**

A particularly important type of arithmetic attribute is the Summary attribute. This is how totals, subtotals, and other summary information is printed.

The different types of summaries available are:

- Sum (total)
- Count
- Average
- Variance
- Standard Deviation
- Minimum
- Maximum

To print the total for a field, follow these steps:

1. Enter the field name where you want the total to appear in the Design Area.
2. Choose Summary from the Attributes menu (/AS). Summary is the default attribute, so this step is unnecessary unless a different attribute has been previously chosen.
3. With the field name still selected, press [F10] for Choices. The choice list will show the available summary attributes. Choose @SUM for totaling.
4. Enter Conclusion in the When Printed column for that row.
Following these steps would give you a total for all the records in the working database.

Selecting a Conclusion row flag to print a total.

You may also see subtotals within the report. Summaries may be printed for each change in a sort field, such as:

Report with subtotals.

<table>
<thead>
<tr>
<th>Date</th>
<th>Rep</th>
<th>Product</th>
<th>Total Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/07/85</td>
<td>Alan</td>
<td>$16,835</td>
<td></td>
</tr>
<tr>
<td>1/14/85</td>
<td>Alan</td>
<td>$4,976</td>
<td></td>
</tr>
<tr>
<td>1/21/85</td>
<td>Alan</td>
<td>$6,672</td>
<td></td>
</tr>
<tr>
<td>1/28/85</td>
<td>Alan</td>
<td>$6,550</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-----</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Total for Alan</td>
<td></td>
<td>$35,033</td>
<td></td>
</tr>
<tr>
<td>1/07/85</td>
<td>Bob</td>
<td>$5,235</td>
<td></td>
</tr>
<tr>
<td>1/14/85</td>
<td>Bob</td>
<td>$6,450</td>
<td></td>
</tr>
<tr>
<td>1/21/85</td>
<td>Bob</td>
<td>$3,794</td>
<td></td>
</tr>
<tr>
<td>1/28/85</td>
<td>Bob</td>
<td>$7,433</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-----</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Total for Bob</td>
<td></td>
<td>$22,912</td>
<td></td>
</tr>
<tr>
<td>1/07/85</td>
<td>Cathy</td>
<td>$4,613</td>
<td></td>
</tr>
<tr>
<td>1/14/85</td>
<td>Cathy</td>
<td>$6,709</td>
<td></td>
</tr>
<tr>
<td>1/21/85</td>
<td>Cathy</td>
<td>$2,667</td>
<td></td>
</tr>
<tr>
<td>1/28/85</td>
<td>Cathy</td>
<td>$5,728</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-----</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Total for Cathy</td>
<td></td>
<td>$19,717</td>
<td></td>
</tr>
<tr>
<td>1/07/85</td>
<td>Dave</td>
<td>$6,325</td>
<td></td>
</tr>
<tr>
<td>1/14/85</td>
<td>Dave</td>
<td>$11,760</td>
<td></td>
</tr>
<tr>
<td>1/21/85</td>
<td>Dave</td>
<td>$5,831</td>
<td></td>
</tr>
<tr>
<td>1/28/85</td>
<td>Dave</td>
<td>$11,836</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-----</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Total for Dave</td>
<td></td>
<td>$35,752</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-----</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Total for Jan-85</td>
<td></td>
<td>$113,414</td>
<td></td>
</tr>
</tbody>
</table>
To see subtotals, or any other summary for each value of a sort field, follow these steps:

1. Enter a field name with a Summary attribute, as if producing a total for the whole report.
2. Select that row by pressing [F3].
3. Press [F10] for Choices, which will show the row flag options. These control when the row will be printed.
4. Choose the row flag corresponding to the sort field upon which the subtotals should be based.

In the example below, Date is the primary sort field and Rep is the secondary sort field. When the row is selected, Choices shows **1-Date** and **2-Rep**. Select **1-Date** to see subtotals by Date or **2-Rep** to see them by Rep within Date. To see subtotals by Date and Rep, copy the row and assign one row flag to each.
THE WHEN PRINTED COLUMN

The When Printed column controls when each row in the Design Area will be printed.

The When Printed column has one entry on each row. That entry is a row flag, which instructs the Report View when to print that row.

The When Printed column and the Design Area go hand-in-hand. For example:

☐ In the Design Area, you enter a title on the first row. In the When Printed column you enter Intro to print that row once at the beginning of the report.

☐ In the Design Area, you enter fields on a row to show detail information. In the When Printed column you enter Body to print that row once for each record.

☐ In the Design Area, you enter a summary. In the When Printed column you enter Conclusion to print that row once at the end of the report.

THE ROW FLAGS

The following row flags may be used:

Intro prints the row at the beginning of the report.

Header prints the row at the top of each page of the report.

Body prints the row for each record in the working database.

Footer prints the row at the bottom of each page of the report.

Conclusion prints the row at the end of the report.

Sort fields (1-[sort field #1], 2-[sort field #2], etc.) prints the row each time a value changes in the sort field. This is typically used for subtotals.
Choices list for row flags.

The Sort Fields row flag deserves discussion. Whichever fields are currently in the sort order (there may be up to five at any time) are available as row flags. The sort order number precedes the field name.

Any row with a sort-field row flag will print only when the value in that field changes (this is also known as a "key break").

Each summary value printed for a row with a sort-field row flag, will reflect only those records with the same value for the sort field. This is how subtotals are done.

As an example, the figure below shows a report design with subtotals and sub-averages for sales by product. Product is the sort field:
Report Design and results with subtotals.

The subtotal and sub-average designation was entered by applying the @Sum and @Avg Summary attributes to the Sales field.

The report will show the records for the first value of the sort field, and then the subtotal for those records; then the records for the next value of the sort field and the subtotal for those records. And so on.

**ENTERING ROW FLAGS**

To enter a row flag, first press [F3] to select the row, or choose Row Select from the Edit menu (ER). You can enter a row flag one of three ways:

- Press Choices [F10], for a choice list. Select the row flag and press [→], or
- Type in the row flag and press [→], or
- Type the first letter of the row flag (I, H, B, F, C, 1, 2, 3, 4, 5), and press [→]
THE REPORT MENU

The commands on the Report menu provide access to features specific to the Report View.

- Preview on Screen
- Change Sort Settings
- Display Values ON/OFF
- Save Report Design
- Retrieve Report Design
- Erase Report Design
- Quit

PREVIEW ON SCREEN

The Preview on Screen command enables you to preview your report by displaying it on the screen just as it will look when printed. This is a fundamental part of using the Reflex reporting facilities. The Report View is designed to be interactive, to be used by incrementally building a report and viewing it on the screen at each step of the way. Not sure what the result of something will be? Enter it and preview it on the screen to see the result. Return to the Report Design screen to make changes as necessary.

Headers, footers, key breaks, etc. will all be displayed in the order in which they will be printed. Page breaks will display where they will occur when printed. All the data and calculations are as they will appear in the report.

To preview your report, choose Preview on Screen from the Report menu (/RP). The screen will display the first 21 lines of your report. When you are ready to preview the next 21 lines, press C to continue, or Q to Quit back to report design.

Continue Previewing Page 1?  Continue  Quit

Page breaks are indicated by the “End of Page” message. Press “C” to continue previewing the next page, or “Q” to quit back to report design.

End of Page 1. Next Page?  Continue  Quit
Note that page breaks and screen breaks both display a message asking if you would like to continue previewing, but only page breaks have any effect on the printed report.

When the Preview screen displays the last page of your report, the message changes to “Last Page” and the only choice available is “Proceed” which takes you back to the report design screen.

### WIDTH OF PREVIEW

Preview On Screen displays 80 columns of your report, beginning with the leftmost column of the report as displayed in the Design Area. If the Design Area were scrolled so that column 11 were the leftmost column and Preview on Screen were chosen, columns 11 through 90 would be displayed.

To preview the right side of a wide report, scroll the Design Area to the right and choose Preview on Screen. The Design Area is scrolled by moving the cursor with the cursor keys.

Right margins are represented on screen by a dotted vertical line. Items that will be split up when the report is printed will be intersected by this line.

### EFFECT OF PRINT TOOL SETTINGS

Printer settings also affect the on-screen preview. This includes the Print From Page... To option, Margins, and Page length.

Set-up strings will not affect the report preview.

### CHANGE SORT SETTINGS

Sorting plays a central role in designing and printing a report. The sort order controls (1) the order in which records are printed, and (2) which fields may be used for various summary calculations.

For each field in the sort order, you may:

1. Produce summary subtotals, averages, etc., for that field. See Summary attributes, below.
2. Produce running totals, averages, counts, etc., for that field. See Cumulative attributes, below.
3. Produce Percent of Totals, for the entire database, or within each value. See % of Total attributes, below.

4. Set the field to display for all values, or only when a value in the field changes. See On Change/All attributes, below.

**SETTING THE SORT ORDER**

You set the sort order in the Sort Settings tool.

*To open the Sort Settings tool,* choose Change Sort Settings from the Report menu (/RC).

When it is first displayed, the Sort Settings tool shows the sort order in effect when the database was saved in Reflex. You can use this sort order, or establish a new one for your report.

For each field that is to be included in the sort order, enter a number between 1 and 5 in the **Sort #** column, corresponding to the sort number for that field. Entering a 1 makes that field the primary sort field, a 2 makes that the secondary sort field, and so on. Enter an A in the **A/D** column to sort in ascending order and a D to sort in descending order.

When you proceed from the tool, the database is sorted.

For more detailed instructions on using the Sort tool, see “Field & Sort Settings” in Reference A.
DISPLAY VALUES ON/OFF

Sometimes when you're laying out a report it's more obvious to work with actual values, rather than field names. The Display Values On/Off command allows you to do this. Choosing the command causes actual field values, as modified by any of the attributes, to be displayed in place of the field names. You still enter the field names, but what you see in the design area are the values. This is particularly useful when formatting a field or setting its column width.

An example report design, with Display Values on, looks like this:

<table>
<thead>
<tr>
<th>Date</th>
<th>Report</th>
<th>Edit</th>
<th>Print/File</th>
<th>Search</th>
<th>Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Report Design</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Intr</td>
<td>January 21, 1985</td>
<td>2:38:20 pm</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Head</td>
<td>Tyler Canoe Company</td>
<td>Sales Analysis</td>
<td>Swiftwater Canoes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Head</td>
<td>Date</td>
<td>Sales Rep</td>
<td>Sales</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Head</td>
<td>Jan-85</td>
<td>Alan</td>
<td>$6,672</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Body</td>
<td>1-Da</td>
<td>Total for Jan-85 :</td>
<td>$112,814</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Body</td>
<td>1-Da</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conc</td>
<td>Conc</td>
<td>Year-To-Date :</td>
<td>$838,738</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To display values instead of field names, choose Display Values On/Off from the Report menu (RD). To then go back to seeing the field names, choose it again.

The values shown in the Design Area are those from the current record. Any totals (except in footers) are the actual numbers as they will appear in the report. The record selection keys (Previous Record [F7], Next Record [F8], First Record [F7], and Last Record [F8]) will flip between records, showing values from different records.

SAVE REPORT DESIGN

The Save Report Design command is used to store the current report design in a disk file. It may then later be retrieved to
print the same report with new data. This is particularly useful for printing a standard report periodically, such as every week, month, or quarter.

When the report design is saved, the following parts are saved:

- the entries in the Design area
- the row flags in the When Printed column
- the sort order
- the print settings

The data is not saved, nor are any Search Conditions.

*To save a report design:*

2. Enter the Directory and File name in which the report design should be saved.
3. Select Proceed and press [↩].

Only one report design may be saved under a given name. If you use a name for a second report design, the first one will be lost.

**RETRIEVE REPORT DESIGN**

Once a report design has been saved, it may then be retrieved to use with the current database. The effect will be the same as if you had just typed it in.

Typically you will:

1. First retrieve a database.
2. Retrieve the report design.

A database used with a retrieved report design should include the field names that are used within the report design. Any field names which are refered to in the report design but are not in the database will show up as errors in the report design.

When the report design is retrieved, it will sort the database by the sort order that was saved with it.

*To retrieve a report design:*

1. Retrieve the database which is to be used with the report design.
3. Enter the directory and file name in which the report design was saved.
4. Select Proceed and press $\text{[Enter]}$.

**ERASE REPORT DESIGN**

The Erase Report Design command will delete a file containing a saved report design from the disk. This command is used to reclaim the disk space. The saved report design will no longer be accessible.

*To erase a report design file:*
2. Enter the directory and file name in which the report design was saved.
3. Select Proceed and press $\text{[Enter]}$.
4. Press $\text{Y}$ to confirm that you want to erase the report design selected.

**QUIT**

To leave the Report View and return to the Report and Utilities title screen, choose Quit from the Report menu (/RQ).

Make sure to first save your report design if you'll want to use it again.
THE EDIT MENU

The commands on the Edit menu are similar to those in the main program with the exceptions of Move and Copy. They are:

- Delete
- Insert
- Set Column Width
- Row Select
- Move
- Copy
- Window Clear

DELETE

To delete the currently selected item, choose Delete from the Edit menu (/ED) or press the Del key.

Delete works as follows:

- If an item in the Design Area is selected, it is deleted.
- If a row is selected, it is deleted.
- If no item is selected, the space on which the cursor sits is deleted, and all items to the right of the cursor shift left one space.
- If in edit mode, the character selected is deleted.

NOTE: There is no confirmation required to delete an item or a row. If an item or a row is deleted accidentally, you will need to re-enter the object and its attributes.

INSERT

To insert a space or a row, choose Insert from the Edit menu (/EI) or press the Ins key.

Insert works as follows:

- If a row is selected, a row is inserted above the row highlighted.
If no item is selected, a space is inserted to the right of the cursor, and all items to the right of the cursor shift right one space.

When in edit mode, a space is inserted to the left of the cursor.

**SET COLUMN WIDTH**

The Set Column Width command is used to change the width of an item in the design area and to change the width of the When Printed column.

*To change the width of an item in the Design Area:*

1. Select the item.
2. Choose Set Column Width from the Edit menu (/ES).
3. Use \[→\], \[←\], \[\[\], \[\] or the mouse to change the size of the shadow box.
4. Press \[\].

Set Column Width cannot be used to resize text, which is always as wide as the text entered. No item can overlap another.

The maximum width for a field in the Design Area is 70 characters. To print a field that is wider than 70 characters, enter it in the Design Area and then apply the Variable Width option under the Width attribute.

*To change the width of the When Printed column:*

1. Select a row by pressing \[F3\] or by choosing Row Select from the Edit menu (/ER).
2. Choose Set Column Width from the Edit menu (/ES).
3. Use \[→\], \[←\], \[\[\], \[\] or the mouse to change the size of the column.
4. Press \[\].

The maximum width for the When Printed column is 10 characters.

**ROW SELECT**

Selecting a row allows you to make entries in the When Printed column and to insert, delete, copy, and move rows.
To select a row:
1. Position the cursor anywhere on that row.
2. Choose Row Select from the Edit menu (/ER) or press [F3].

MOVE

Move allows you to move a selected item to a different location on the screen. The selected item can be an entry in the Design Area or a whole row. Moving an item also moves all of the attributes applied to that item.

To move an item in the Design Area:
1. Select it.
2. Choose Move from the Edit menu (/EM).
3. Use the cursor movement keys to move the shadow box to the new location.
4. Press [←].

[m] To move an item using the mouse:
1. Position the mouse cursor so its tip is on the item to be moved.
2. Press the mouse button and while holding it down, move the mouse cursor (by moving the mouse) to the desired location.
3. Release the mouse button.

To move an entire row:
1. Select the row by choosing Row Select from the Edit menu (/ER) or press [F3].
2. Select Move from the Edit menu (/EM).
3. Use the cursor movement keys to move the row to the desired location.
4. Press [←].

To move an item to an area off the screen, move it to the edge of the screen, terminate the move operation, scroll the Design Area with the cursor keys, and then perform another move operation. Repeat this sequence as needed to move an object multiple screenfuls.
COPY

Copy allows you to make a duplicate of an item in a different location on the screen. All attributes set for the item will be copied to the new location. The selected item can be an entry in the Design Area or a whole row.

To copy an item in the Design Area:

1. Select it.
2. Choose Copy from the Edit menu (/EC).
3. Use the cursor movement keys to move the shadow box to the desired location for the duplicate.
4. Press $\leftarrow$.

To copy an entire row:

1. Select the row by choosing Row Select from the Edit menu (/ER) or press $F3$.
2. Select Copy from the Edit menu (/EC).
3. Use the cursor movement keys to move the duplicate row to the desired location.
4. Press $\leftarrow$.

To copy an item to an area off the screen, first copy it on the screen and then use the Move procedure for moving an item to an area off the screen.

WINDOW CLEAR

To start fresh with a new Report Design, choose Window Clear from the Edit menu (/EW).

The entire Design Area and When Printed column is left blank.

WARNING

The existing report definition will be lost when this command is used. To save it for possible future use, use the Save Report Design command.
THE PRINT/FILE MENU

The Print/File menu offers the following commands:

- **Retrieve File** retrieves a Reflex database from disk so a report may be generated from it.
- **Print** prints the report.
- **Change Printer Settings** displays and accepts changes for printer settings.
- **Global Settings** Changes the setting for the directory, the type of printer (serial or parallel) and turns auto linefeed on or off.

RETRIEVE FILE

The Retrieve File command is used to retrieve a Reflex database from disk. Once a database is retrieved it is available for reporting.

Choosing the Retrieve File command brings up the Retrieve File tool:

The Retrieve File tool.

To retrieve a Reflex database to Report on:

1. Choose Retrieve File from the Print/File menu (/PR).
2. Select the Directory cell and enter the name of the directory containing the database to be retrieved.
3. Select the Name cell and enter the name of the database to be retrieved.
4. Select Proceed and press →.
PRINT

To print the report currently defined in the Report View, choose Print from the Print/File menu (/PP).

No tool is displayed; the report is immediately sent to the printer when the Print command is chosen.

CHANGE PRINTER SETTINGS

The Change Printer Settings command is used to establish settings that determine how your report will be printed. It is similar to the Print Settings tool in the main program.

To change the printer settings, choose Change Printer Settings from the Print/File menu (/PC). Fill in the desired setting, or select the appropriate checkbox, and select Print to print the report. To save the settings without printing the report, choose Put Away. Printer settings are saved along with the report design when a report design is saved.

The Print Settings tool has the following options and settings:

Output   Enables you to send a copy of your report to the printer or save it to a disk file. A report might be sent to a disk file so it can be printed later, or to store the data for use with another program. See the Export Attribute, below.
When the To Disk File checkbox is selected, the Name cell will be displayed. Enter a name for your file in this box. Include a directory designation if desired. For example:

C:REPORT.PRN

NOTE The DOS extension (.PRN) is supplied automatically unless another extension is specified.

Margins Both the left and the right margins are measured in character spaces from the left side of the paper. The left margin may be set from 0–240, the right margin may be set from 1–255.

The Top margin indicates the number of rows to be left blank at the top of your paper before printing the first line of your report. The Bottom margin indicates the number of rows to be left blank at the bottom of each page. Both Top and Bottom margins can be set from 0–10. The top margin is measured from the top of the page; the bottom margin is measured from the bottom.

Page Length Used to indicate the number of rows that are on each page. Page length can be set from 1 to 200. The page length must be greater than the sum of the top and bottom margins.

Common settings for the following standard paper sizes are:

<table>
<thead>
<tr>
<th>PAPER SIZE</th>
<th>LEFT</th>
<th>RIGHT</th>
<th>TOP</th>
<th>BOTTOM</th>
<th>PAGE LENGTH</th>
</tr>
</thead>
<tbody>
<tr>
<td>8½ x 11</td>
<td>2</td>
<td>74</td>
<td>2</td>
<td>6</td>
<td>66</td>
</tr>
<tr>
<td>11 x 14</td>
<td>2</td>
<td>132</td>
<td>2</td>
<td>6</td>
<td>66</td>
</tr>
<tr>
<td>Mail labels</td>
<td>2</td>
<td>38</td>
<td>0</td>
<td>0</td>
<td>6</td>
</tr>
</tbody>
</table>

Set-Up String Used to enter a string of characters that send special instructions for printing to the printer. For example, a common use is for producing a compressed-print report. Set-up strings vary from printer to printer. Common set-up strings for IBM and Epson printers can be found in Appendix C. For more information on set-up strings accepted by your printer, consult your printer manual.

Paper Feed Enables you to indicate whether or not you would like the printer to pause between pages or print continuously. Select the Single Sheet cell for printing to pause
between pages. Select Continuous Feed to print your report without pausing.

**Print With Page Breaks**  Allows you to print a report without page breaks. Change the checkbox to "NO" when printing to a disk file.

**Print From Page . . To**  Allows you to specify a range of pages to print from and to. The "To" range must be equal to or greater than the "From" range. To print a single page from a report, set the "From" range and "To" range to be equal.

**Print**  Prints the report and saves the settings.

**Put Away**  Saves the settings in the tool and returns you to the report design. The report can then be printed later by choosing the Print command.

**Cancel**  Restores the settings to their values at the time the tool was opened and cancels any changes made.

**ADDITIONAL NOTES ON PRINTING**

*To halt printing* press any key. You will be given the option of halting the printing.

Only records in the working database are printed. Any records which are filtered out will remain a part of the database but will not be printed with the report.

Print settings affect the Preview on Screen feature. The From . . . To settings determine which pages of the report will be previewed. The Page length settings are reflected by page breaks on the preview screen. The Margin settings determine where the dotted line for the right margin appears on the screen.

If your printer stops while your report is printing, correct the problem and turn your printer back on. Align the paper to the top of the page and press "C" to continue. Printing will resume with the first line of the page being printed when the printer stopped.
GLOBAL SETTINGS

The Global Settings tool enables you to provide settings that are used on a system-wide basis and to provide default settings that are saved with the Reflex program so you don't need to enter them with each database.

For complete information, see “Global Settings” in Reference A.

SEARCH

The Commands on the Search menu allow you to establish search conditions to report on a subset of the information in your Reflex database. A report printed with a filter applied will only print information for those records in the working database. Each of the choices under the Search menu as well as the Find [F5] and Apply/Remove Filter [△] [F5] keys are used in the same way as in the main program.

When a filter is applied, FILT appears in a highlighted box on the bottom right hand corner of the screen.

Set Conditions The Set Conditions command displays the Search Conditions tool in which you enter the search conditions that tell Reflex which records to filter or find.

Apply Filter creates a “working database” of only the records that meet the search conditions. All records which do not meet the search conditions are temporarily set aside. Calculations in the Report View are based on those records in the working database only.

Remove Filter brings back all the records which were temporarily set aside when the filter was applied.

Find Record makes current the next record in the database that meets the search conditions. With the Display Values option on, this will be the record displayed on the screen.

Keep Records retains in memory only those records that meet the search conditions. All records not meeting these conditions are deleted from memory but remain in the database on the disk.

For further information on establishing search conditions and using each of the menu commands, see “Search” in Reference A.
**ATTRIBUTES**

Many of the most powerful features in the Reflex Report View can be found in the Attributes menu. There are two kinds of attributes; display attributes and arithmetic attributes.

**Display attributes** allow you to change the way an item is displayed in the report. The display attributes are Justification, Format, Precision, On Change/All, Variable Width, Export.

**Arithmetic attributes** allow you to include powerful summarization features in your report. The arithmetic attributes are Summary, Cumulative, % Of Total.

Attributes can be used singly, or in combination with other attributes.

**USING ATTRIBUTES**

*To set an Attribute for an item:*

1. Select the item.
2. Choose the type of Attribute desired from the Attributes menu.
3. Press [F10] for Choices and a list of attributes available for the attribute-type chosen and the particular item selected will be displayed.
4. Select the attribute desired and press \[\text\]

Two important notes:

1. Attributes must always be entered using the Choices key.
2. Choices will always display the available attributes for the last attribute-type chosen when an item in the Design Area is selected and [F10] is pressed.

Note the evolution in the use of Choices. When a blank spot is chosen in the Design Area, Choices shows the Fields and Special Fields which may be entered there. Once an item is in the Design Area, selecting it and using Choices shows the Attributes which may be applied to it.

Once you have chosen a type of attribute from the Attributes menu, it remains the current attribute-type until you choose another. Moving to successive items on your report and...
pressing [F10] will display the options available for the current type of attribute and the new item selected.

The current attribute is indicated in the highlighted box on the bottom right hand corner of the screen.

**DISPLAY ATTRIBUTES**

Display attributes affect the appearance of entries in the report, and their location on the page.

**JUSTIFICATION**

The Justification attributes are used to position data within columns. There are three options available for justifying data in a report:

- **Left justification**: Positions the left-most character in the data against the left edge of the column.  
  $1,200.00$

- **Center justification**: Centers the data in the column.  
  $1,200.00$

- **Right justification**: Positions the right-most character in the data against the right edge of the column.  
  $1,200.00$

To set an item's justification:

1. Select the item.
2. Choose Justification from the Attributes menu (/AJ).
3. Press [F10] to display the three choices discussed above.
4. Select the desired justification and press [←].

Unless the justification of an item is changed in report, date and numeric fields are right justified and text fields are left justified.

**FORMAT**

The Format attributes are used to set display formats for items entered in the report design.
Fields entered in a Report will display with the formats set in the Reflex database unless their format is changed with this attribute.

With one exception (Show Formula), the formats available with the Format attributes are the same as those available in the Field & Sort Settings tool.

Show Formula Displays the formulas used to calculate values displayed in the Reflex database.

To set an item's display format:
1. Select the item.
2. Choose Format from the Attributes menu (/AF).
3. Press [F10] to display the formats available for the item selected.
4. Select the desired format and press [→].

PRECISION
The Precision attributes are used to specify the number of digits following the decimal point displayed in numeric fields. The precision for any field will be the same as that established in the Reflex database unless precision is changed in the Report View.

NOTE Regardless of the precision chosen, any calculations performed using numeric fields are done using 15 digits of significance.

To set an item's precision:
1. Select the item.
2. Choose Precision from the Attributes menu (/AP).
3. Press [F10] to display a list of options.
4. Select the desired precision (0–15) and press [→].

ON CHANGE/ALL
The On Change/All attributes are used to specify when a value is to be printed. To set a field to On Change/All, the field must be a part of the current sort order.
There are two options available when On Change/All is chosen are:

**All**

The field value is printed for each record.

**Only On Change**

The field value is printed only when it changes.

For example, the following report design

```
| Rep  | Body | Sales $
```

would print this report:

David 100
David 150
David 125
Adam 115
Adam 150
Adam 130

If the Only On Change attribute were applied to the Rep field, the report would be printed as follows:

David 100
150
125
Adam 115
150
130

*To apply an On Change/All attribute:*

1. If necessary, sort the database by choosing Change Sort Settings from the Report menu (/RC). A field must be a part of the current sort order to have an On Change/All attribute.
2. Select the item in the Design Area.
3. Choose On Change/All from the Attributes menu (/AO).
4. Press [F10] to display the attribute choices.
5. Select the option desired and press [→] or [←].

**VARIABLE WIDTH**

The Variable Width attributes are used to make the width of a field as wide as needed to display the data in it. Variable
width is often used in mailing lists, and in printing out reports with fields containing data longer than 70 characters.

There are three attributes available with Variable Width:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width Shown</td>
<td>Allows you to set the width of a column by using the Set Column Width command.</td>
</tr>
<tr>
<td>Wide as Needed</td>
<td>Prints the column as wide as needed to display the data in it.</td>
</tr>
<tr>
<td>Position as Shown</td>
<td>Starts printing the field in the column shown. This option is used to anchor items to the right of fields with the Wide as Needed attribute set.</td>
</tr>
</tbody>
</table>

For example, the following report design

```
<table>
<thead>
<tr>
<th>Report</th>
<th>Edit</th>
<th>Print/File</th>
<th>Search</th>
<th>Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Design</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Body</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Body Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Body Address</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Body City, State</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Body Zip Code</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

would print this report:

Ann Adams  
123 A Street  
San Franc, CA  
98765

Bob Barnes  
456 B Street  
NY, NY  
12345
If City and Zip Code were set to be Wide as Needed, the following report would be printed:

Ann Adams  
123 A Street  
San Francisco, CA  
98765

Bob Barnes  
456 B Street  
NY, NY  
12345

The State field and the comma following City slide to the left or right, allowing the City field to be as wide as needed.

**EXPORT**

The Export attributes are used to format items in the report so that when the report is printed to a disk file, the data may be easily read by other programs, including mail-merge programs. The export options delimit (separate) the items in the report database by separating them with commas, enclosing them in quotes, or both.

There are four Export attributes available:

- **None**  
  This is the default type. Use this option to remove delimiters from an item.

- **Quotes**  
  This is used to surround an item with double quotes.
  
  "This item is quote delimited"

- **Commas**  
  This is used to place a comma following an item.
  
  This item is comma delimited,

- **Quotes & Commas**  
  This is used to surround an item with quotes, followed by a comma.
  
  "This item is quote and comma delimited"
All items entered on a report, including titles and other text, can be "exported," although typically you will only want to export the actual data, generally in Body lines. It would not be unusual to create a report consisting of nothing but one body line for export. This would create a file which contains just columns of data, properly delimited.

To write a file to disk using the Export Attribute, use the following procedure for each item to be exported:

1. Select the item.
2. Enter any attributes desired, (including Variable Width).
3. Choose Export from the Attributes menu (/AE).
4. Press [F10] and a list of the Export attributes will be displayed.
5. Select the option desired and press [→]
6. Print the file to disk by choosing Change Printer Settings from the Print/File menu (/PC) and selecting To Disk File checkbox.
7. Name the file, set the right margin to the width desired and print the report without page breaks.

For information on how to delimit files for use with several popular programs, see Appendix F. For more information on printing to disk, see "Print/File" in Reference A.

ARITHMETIC ATTRIBUTES

The arithmetic attributes enable you to perform calculations within the report.

SUMMARY

The Summary attributes are a special group of arithmetic functions that can be used in building your Report. They allow
you to draw values from a group of records rather than one record only. For example: the expression

@SUM(Sales)

uses the summary @SUM to add up the values in the sales field for a group of records. Summaries are used together with the Cumulative attribute to enter cumulative values, and are used on key breaks to provide subtotals.

To enter a summary:
1. Select the item to be summarized.
2. Choose Summary from the Attributes menu (/AS).
3. Press [F10]. A list of summaries available for the type of field selected will be displayed
4. Select the desired summary and press [←].

**Summaries Used in Report**

<table>
<thead>
<tr>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Removes any summary set previously.</td>
</tr>
<tr>
<td>@SUM</td>
<td>Adds up the values in the field specified. @SUM can only be used with numeric expressions.</td>
</tr>
<tr>
<td>@COUNT</td>
<td>Counts the number of entries in the field specified. @COUNT can be used with any numeric, date, or text fields.</td>
</tr>
<tr>
<td>@AVG</td>
<td>Finds the arithmetic average. @AVG can only be used with numeric expressions.</td>
</tr>
<tr>
<td>@MAX</td>
<td>Finds the maximum value. @MAX can be used with numeric or date expressions.</td>
</tr>
<tr>
<td>@MIN</td>
<td>Finds the minimum value. @MIN can be used with numeric or date expressions.</td>
</tr>
<tr>
<td>@STD</td>
<td>Finds the standard deviation. @STD can only be used with numeric expressions. Returns error if @COUNT = 0.</td>
</tr>
<tr>
<td>@VAR</td>
<td>Finds the variance. @VAR can only be used with numeric expressions. Returns error if @COUNT = 0.</td>
</tr>
</tbody>
</table>
Totals and Subtotals

Summary attributes are used to add totals and subtotals to your report. What is totaled depends on what is entered in the When Printed column.

To print subtotals in your report:

2. Enter the field to be totaled in the appropriate location on your report.
3. Choose Summary from the Attributes menu.
4. Press Choices [F10]. Select the desired summary.
5. Select the When Printed column and enter a sort-field row flag for the Report View to summarize over, or enter Footer to display a subtotal for each page.

The number displayed in the summarized field will draw its value from just those records in the database since the last summary. So, if the summary is on a row with a sort-field row flag, each summary will only include those records for the particular value of the sort field. This is how subtotals, sub-counts, sub-averages, etc., are printed.

Row for “Sub-Average” by Date.

Report Design:  
1-Date @AVG(Sales $)

This row will print once for each unique date in the database. Each time it prints, it will include the average sales for that date.

If this same formula were entered on a different key break as below:

Row for “Sub-Average” by Rep by Date.

Report Design:  
2-Rep @AVG(Sales $)

The row would be printed once for each rep for each date (since Date is the primary sort field and records will be printed for each rep within each date). Each time it prints, it will include the average sales for that rep for that date. To see the maximum sale each rep made on each date, change @AVG to @MAX.
Note that for a report to summarize over a field, that field must be a part of the current sort order.

Reports can be created that show subtotals following the detail from which that total is derived, preceding the detail, and without any of the underlying detail (subtotals only). For an example of each of these, see the examples at the end of this chapter.

To add totals to your report:

1. Enter the field to be totaled in the appropriate location on your report.
2. Choose Summary from the Attributes menu and select the desired summary.
3. Select the When Printed column for this row and enter Conclusion.

This row will be printed once at the end of the report. The number displayed will be calculated from all the records.

Effect of Filters

Summarized expressions draw their values from records in the working database only. Applying a filter will affect both the records shown and the summaries computed. The summary results shown will always correspond to the records printed.

CUMULATIVE

The Cumulative attributes are used to print running totals and other "running summaries" such as averages, counts, etc. The Cumulative attribute is always used together with a summary, and can be used to show the cumulative value of detail (Body) records, as well as subtotals.
A typical choice list for the Cumulative attribute.

The cumulative attribute choices allow a running total over the whole report or within each value of a key field. For example:

**Not Cumulative**  Used to remove the cumulative attribute.

**For Entire Report**  Used to provide a running accumulation from the beginning to the end of the report. If this attribute is applied to \@SUM (Sales $), the report will print a running total.

**For Each Date**  Used to reset the accumulated value each time the date changes. If this attribute is applied to \@SUM(Sales $), the report will print a running total of sales for each date, and will start over when the date changes.

**For Each Rep**  Used to reset the accumulated value each time the rep changes. If this attribute is applied to \@SUM(Sales $), the report will print a running total of sales for each rep, and will start over when the rep changes.

Note that one “For Each” choice is provided for each field in the sort order.

Two things are specified in setting a field to be cumulative:

1. The summary to be used
2. When to reset the cumulative value.

If you want a running total starting at the beginning and continuing to the end, you choose “For Entire Report” as the reset. If you want the cumulative results to build up for part of
the report, then start over, you choose the reset on one of the sort fields (e.g., each time Date changes, each time Rep changes, etc.). Any field or formula can be set to be cumulatively summarized over the entire report, or over any of the fields specified in the current sort order.

In the following Report design, the expressions $\text{@SUM(Sales)}$ and $\text{@AVG(Sales)}$ are set to be cumulative, resetting each time the Name changes.

This report design would generate the following report:

<table>
<thead>
<tr>
<th>NAME</th>
<th>SALES</th>
<th>TOTAL SALES</th>
<th>AVERAGE SALES</th>
</tr>
</thead>
<tbody>
<tr>
<td>David</td>
<td>10</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>David</td>
<td>20</td>
<td>30</td>
<td>15</td>
</tr>
<tr>
<td>David</td>
<td>30</td>
<td>60</td>
<td>20</td>
</tr>
<tr>
<td>Adam</td>
<td>15</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>Adam</td>
<td>25</td>
<td>40</td>
<td>20</td>
</tr>
<tr>
<td>Adam</td>
<td>35</td>
<td>75</td>
<td>25</td>
</tr>
</tbody>
</table>

The total sales and average sales figures accumulate for each sales rep, and then start over. If the reset were For Entire Report, the total sales and average sales figures would continue to accumulate, ignoring the change in the Name field.

To set an item to be Cumulative:

1. Sort the database.
2. Select the field to be displayed as cumulative.
3. Enter the summary desired using the Summary attribute.
4. Choose Cumulative from the Attributes menu (\AC).
5. Press $[\text{F10}]$ and a list of fields in the current report sort order will be displayed.
6. Select the field for the cumulative value to be reset on. If you want a running total over the whole report, choose for Entire Report.
7. Press $\leftarrow$.

NOTE If no summary is specified, the summary $\text{@SUM}$ is assigned automatically.
The Cumulative attribute can be applied to fields of any field type. For example, you could cumulatively count a text field. Summaries appropriate for the field selected will be displayed by choosing Summary from the Attributes menu and pressing [F10].

**Cumulative Used in Subtotals**

The Cumulative attribute can be used for subtotals in exactly the same way as it is used with individual records. The value displayed will be the cumulative value of each of the subtotals, reset on changes in the value of the field chosen.

In this example, the cumulative attribute is applied to @SUM(Sales $), and is reset on Rep (the primary sort field). Thus the report will print a running daily total for each Rep:
A Summary Report with Running totals.

<table>
<thead>
<tr>
<th>DATE</th>
<th>SALES REP</th>
<th>SALES</th>
<th>TOTAL SALES</th>
</tr>
</thead>
<tbody>
<tr>
<td>2/20/85</td>
<td>Alan</td>
<td>$5,528</td>
<td>$5,528</td>
</tr>
<tr>
<td>2/21/85</td>
<td>Alan</td>
<td>$16,987</td>
<td>$22,515</td>
</tr>
<tr>
<td>2/22/85</td>
<td>Alan</td>
<td>$7,358</td>
<td>$29,873</td>
</tr>
<tr>
<td>2/25/85</td>
<td>Alan</td>
<td>$18,578</td>
<td>$48,451</td>
</tr>
<tr>
<td>2/26/85</td>
<td>Alan</td>
<td>$4,859</td>
<td>$53,310</td>
</tr>
<tr>
<td>2/27/85</td>
<td>Alan</td>
<td>$40,976</td>
<td>$94,286</td>
</tr>
<tr>
<td>2/28/85</td>
<td>Alan</td>
<td>$5,593</td>
<td>$99,879</td>
</tr>
<tr>
<td>2/20/85</td>
<td>Cathy</td>
<td>$4,278</td>
<td>$4,278</td>
</tr>
<tr>
<td>2/21/85</td>
<td>Cathy</td>
<td>$8,891</td>
<td>$13,169</td>
</tr>
<tr>
<td>2/22/85</td>
<td>Cathy</td>
<td>$4,562</td>
<td>$17,731</td>
</tr>
<tr>
<td>2/25/85</td>
<td>Cathy</td>
<td>$8,632</td>
<td>$26,363</td>
</tr>
<tr>
<td>2/26/85</td>
<td>Cathy</td>
<td>$8,454</td>
<td>$34,817</td>
</tr>
<tr>
<td>2/27/85</td>
<td>Cathy</td>
<td>$23,813</td>
<td>$58,630</td>
</tr>
<tr>
<td>2/28/85</td>
<td>Cathy</td>
<td>$10,986</td>
<td>$69,616</td>
</tr>
</tbody>
</table>

% OF TOTAL

The % of Total attribute is used to print percentages rather than the value of a field. You have the option of printing a value as a percentage of all records, or as a percentage of the total for the records within the current value of a sort field. The % of Total attribute can be used to calculate the % of totals, counts, averages, or any of the other summaries. In fact, a summary attribute is always applied to a field before the % of Total attribute is. Commonly, this will be @SUM, which for a field in a body row will simply be that field’s value.
A typical choice list for % Of Total.

The % of Total attribute choices allow the percentage to be calculated over all records or within each value of a key field. For example:

**Not a Percent**   Removes the attribute from the field.

**Entire Report**  Causes the report to print a percentage figure which reflects the relationship between the value in the field and the value of that field for all the records in the working database. If this attribute is applied to @SUM(Sales $), the result is calculated with this formula:

\[
\text{result} = \frac{\text{@SUM(Sales $) for this row}}{\text{@SUM(Sales $) for all the records}}
\]

**By Date**      Prints the value as a percentage of all the records within the respective value of the Date field.

\[
\text{result} = \frac{\text{@SUM(Sales $) for this row}}{\text{@SUM(Sales $) for this date}}
\]

Note that a "By" choice is provided for each field in the sort order.

The % of Total attribute can be used with any summary attribute. The result will be calculated similarly to the examples above. For example, if % Total for Entire Report is applied to @COUNT(Sales $), the result shows what % of the number of sales was in each row or subtotal:
@COUNT(Sales $)—for this row
@COUNT(Sales $)—for all the records

Note that a @COUNT(Sales $) for a Body row is just one (1). For a row with a subtotal (a sort-field row flag), though, it counts all the records that went into the subtotal.

To apply the % of Total attribute:

1. Sort your report.
2. Select the item and apply a summary attribute.
3. Choose % of Total from the Attributes menu.
4. Press [F10] and the list of fields which may be used to total over will be displayed (these are the sort fields).
5. Select the field to be totaled over and press [→]. Or, to total over all records, select Entire Report.

% Total—Examples and Further Discussion

In the following report design the @SUM(Sales $) entry on the Body line has the % of Total For Entire Report attribute applied. (The attribute has been set, although it is not displayed on the screen).

<table>
<thead>
<tr>
<th>Report Design</th>
<th>NAME</th>
<th>SALES</th>
<th>% SALES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Body</td>
<td>Name</td>
<td>Sales $</td>
<td>@SUM(Sales $)</td>
</tr>
</tbody>
</table>

This report design would produce the following report:

<table>
<thead>
<tr>
<th>NAME</th>
<th>SALES</th>
<th>% SALES</th>
</tr>
</thead>
<tbody>
<tr>
<td>David</td>
<td>10</td>
<td>5</td>
</tr>
<tr>
<td>David</td>
<td>20</td>
<td>9</td>
</tr>
<tr>
<td>David</td>
<td>30</td>
<td>14</td>
</tr>
<tr>
<td>Tom</td>
<td>40</td>
<td>19</td>
</tr>
<tr>
<td>Tom</td>
<td>50</td>
<td>24</td>
</tr>
<tr>
<td>Tom</td>
<td>60</td>
<td>29</td>
</tr>
</tbody>
</table>

The figure in the % Sales column shows the percentage of the total contributed by the individual sale.

When the % of Total attribute is applied, you have the option of having the percentage calculated over just the current value of a sort field, rather than all records. In the example above, if the @SUM(Sales $) field had the % of Total attribute applied By Rep, the percentages would be calculated within each group of sales reps:
<table>
<thead>
<tr>
<th>NAME</th>
<th>SALES</th>
<th>% SALES</th>
</tr>
</thead>
<tbody>
<tr>
<td>David</td>
<td>10</td>
<td>17</td>
</tr>
<tr>
<td>David</td>
<td>20</td>
<td>33</td>
</tr>
<tr>
<td>David</td>
<td>30</td>
<td>50</td>
</tr>
<tr>
<td>Tom</td>
<td>40</td>
<td>27</td>
</tr>
<tr>
<td>Tom</td>
<td>50</td>
<td>33</td>
</tr>
<tr>
<td>Tom</td>
<td>60</td>
<td>40</td>
</tr>
</tbody>
</table>

The figures in the % Sales column show the percentage each individual sale contributes to that salesrep's total.

**% of Total Used in Subtotals**

The % of Total attribute can be used to print the percent of the total for subtotals. In the example above, if a subtotal line were added to the design and the % of Total For Entire Report were applied:

The following report would be printed:

<table>
<thead>
<tr>
<th>NAME</th>
<th>SALES</th>
<th>% SALES</th>
</tr>
</thead>
<tbody>
<tr>
<td>David</td>
<td>10</td>
<td>17</td>
</tr>
<tr>
<td>David</td>
<td>20</td>
<td>33</td>
</tr>
<tr>
<td>David</td>
<td>30</td>
<td>50</td>
</tr>
<tr>
<td>David</td>
<td></td>
<td>29</td>
</tr>
<tr>
<td>Tom</td>
<td>40</td>
<td>27</td>
</tr>
<tr>
<td>Tom</td>
<td>50</td>
<td>33</td>
</tr>
<tr>
<td>Tom</td>
<td>60</td>
<td>40</td>
</tr>
<tr>
<td>Tom</td>
<td></td>
<td>71</td>
</tr>
</tbody>
</table>

The figures printed each time the Rep changes show the percentage contributed by the total sales of each rep to the total for the entire report.

By removing the Body row, leaving only the Header and 1-Name row, you can print only the percentage each person contributes to the total:

<table>
<thead>
<tr>
<th>NAME</th>
<th>SALES</th>
<th>% SALES</th>
</tr>
</thead>
<tbody>
<tr>
<td>David</td>
<td></td>
<td>29</td>
</tr>
<tr>
<td>Tom</td>
<td></td>
<td>71</td>
</tr>
</tbody>
</table>
Interesting results can be obtained by applying the % of Total attribute to items which have other Summary attributes. The result is calculated as follows: the summary is calculated for the row printed (which may be a subtotal row) and then divided by the summary for all records (or just the set of records indicated by a sort-field row flag.) In the example above, if the Sales $ field had the @COUNT Summary attribute:

```
<table>
<thead>
<tr>
<th>NAME</th>
<th>SALES</th>
<th>% SALES</th>
</tr>
</thead>
<tbody>
<tr>
<td>David</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>Tom</td>
<td>50</td>
<td></td>
</tr>
</tbody>
</table>
```

The resulting report would show what percentage of the number of sales, rather than % of the total sales $, came from each salesman:

If it were set to @Avg, you would see the average sale for each salesrep as a percentage of the average for all salesreps:

```
<table>
<thead>
<tr>
<th>NAME</th>
<th>SALES</th>
<th>% SALES</th>
</tr>
</thead>
<tbody>
<tr>
<td>David</td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>Tom</td>
<td>143</td>
<td></td>
</tr>
</tbody>
</table>
```

While not immediately obvious, this is a valuable index of the amount each tends to sell at. An index over 100 is above average, while an index below 100 is below average. In addition to showing a concise comparison, this is a quick way to compare without first looking through all the entries to get an idea of the general level for comparison.
EXAMPLE REPORTS

BASIC COLUMNAR REPORT

```plaintext
<table>
<thead>
<tr>
<th>DATE</th>
<th>SALES REP</th>
<th>PRODUCT</th>
<th>NET SALES</th>
<th>PROFIT</th>
<th>COMMISSION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan-85</td>
<td>Alan</td>
<td>Paddles</td>
<td>$6,550</td>
<td>$313</td>
<td>$655</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Alan</td>
<td>Silent</td>
<td>$10,635</td>
<td>$7,715</td>
<td>$2,925</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Alan</td>
<td>Sport</td>
<td>$4,976</td>
<td>$1,076</td>
<td>$498</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Alan</td>
<td>Swiftwater</td>
<td>$6,672</td>
<td>$2,739</td>
<td>$1,010</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Bob</td>
<td>Paddles</td>
<td>$5,235</td>
<td>$1,308</td>
<td>$524</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Bob</td>
<td>Silent</td>
<td>$6,450</td>
<td>$3,030</td>
<td>$908</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Bob</td>
<td>Sport</td>
<td>$3,794</td>
<td>$1,064</td>
<td>$379</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Bob</td>
<td>Swiftwater</td>
<td>$7,433</td>
<td>$3,500</td>
<td>$1,115</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Cathy</td>
<td>Paddles</td>
<td>$4,613</td>
<td>$1,148</td>
<td>$461</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Cathy</td>
<td>Silent</td>
<td>$6,709</td>
<td>$2,719</td>
<td>$1,066</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Cathy</td>
<td>Sport</td>
<td>$4,737</td>
<td>$1,927</td>
<td>$474</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Cathy</td>
<td>Swiftwater</td>
<td>$6,904</td>
<td>$2,971</td>
<td>$1,036</td>
</tr>
<tr>
<td>Mar-85</td>
<td>Dave</td>
<td>Paddles</td>
<td>$8,632</td>
<td>$1,548</td>
<td>$863</td>
</tr>
<tr>
<td>Mar-85</td>
<td>Dave</td>
<td>Silent</td>
<td>$4,678</td>
<td>$1,828</td>
<td>$702</td>
</tr>
<tr>
<td>Mar-85</td>
<td>Dave</td>
<td>Sport</td>
<td>$6,455</td>
<td>$1,385</td>
<td>$563</td>
</tr>
<tr>
<td>Mar-85</td>
<td>Dave</td>
<td>Swiftwater</td>
<td>$7,886</td>
<td>$2,398</td>
<td>$2,683</td>
</tr>
<tr>
<td>Apr-85</td>
<td>Alan</td>
<td>Paddles</td>
<td>$5,528</td>
<td>($940)</td>
<td>$553</td>
</tr>
<tr>
<td>Apr-85</td>
<td>Alan</td>
<td>Silent</td>
<td>$16,987</td>
<td>$8,437</td>
<td>$2,548</td>
</tr>
<tr>
<td>Apr-85</td>
<td>Alan</td>
<td>Sport</td>
<td>$7,256</td>
<td>$1,598</td>
<td>$1,000</td>
</tr>
</tbody>
</table>
```

1. Prints these rows once at the beginning of the report.
2. Prints these rows at the top of each page.
3. Prints this row for each record in the working database.
4. Prints this row (in this case, a blank row) whenever "Rep" changes.
# COLUMNAR REPORT WITH SUBTOTALS

**Sales and Commission Summary**

**January - June, 1985**

<table>
<thead>
<tr>
<th>DATE</th>
<th>SALES REP</th>
<th>PRODUCT</th>
<th>NET SALES</th>
<th>PROFIT</th>
<th>COMMISSION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan-85</td>
<td>Alan</td>
<td>Paddles</td>
<td>$6,550</td>
<td>$313</td>
<td>$655</td>
</tr>
<tr>
<td>13</td>
<td>13</td>
<td>Silent</td>
<td>$16,835</td>
<td>$576</td>
<td>$2,825</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sport</td>
<td>$8,976</td>
<td>$1,076</td>
<td>$498</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Swiftwater</td>
<td>$6,072</td>
<td>$2,739</td>
<td>$1,001</td>
</tr>
<tr>
<td>Bob</td>
<td>Paddles</td>
<td>$5,235</td>
<td>$1,308</td>
<td>$524</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Silent</td>
<td>$6,450</td>
<td>$3,030</td>
<td>$968</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sport</td>
<td>$3,794</td>
<td>$1,064</td>
<td>$379</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Swiftwater</td>
<td>$7,433</td>
<td>$3,500</td>
<td>$1,115</td>
<td></td>
</tr>
<tr>
<td>Cathy</td>
<td>Paddles</td>
<td>$4,613</td>
<td>$1,148</td>
<td>$611</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Silent</td>
<td>$5,500</td>
<td>$2,719</td>
<td>$1,000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sport</td>
<td>$2,667</td>
<td>$777</td>
<td>$267</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Swiftwater</td>
<td>$5,728</td>
<td>$2,669</td>
<td>$859</td>
<td></td>
</tr>
<tr>
<td>Dave</td>
<td>Paddles</td>
<td>$6,350</td>
<td>$1,089</td>
<td>$633</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Silent</td>
<td>$11,760</td>
<td>$4,920</td>
<td>$1,764</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sport</td>
<td>$5,521</td>
<td>$2,321</td>
<td>$875</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Swiftwater</td>
<td>$11,836</td>
<td>$4,844</td>
<td>$1,715</td>
<td></td>
</tr>
</tbody>
</table>

**Total for Jan-85**: $113,414

**Feb-85**

| | | | | | |
| | | | | | |
| | | | | | |
| | | | | | |
| | | | | | |

**Total for Feb-85**: $84,478

**Mar-85**

| | | | | | |
| | | | | | |
| | | | | | |
| | | | | | |
| | | | | | |

**Total for Mar-85**: $72,961

**Apr-85**

| | | | | | |
| | | | | | |
| | | | | | |
| | | | | | |
| | | | | | |

**Total for Apr-85**: $63,025

**May-85**

| | | | | | |
| | | | | | |
| | | | | | |
| | | | | | |
| | | | | | |

**Total for May-85**: $54,433

**Jun-85**

| | | | | | |
| | | | | | |
| | | | | | |
| | | | | | |
| | | | | | |

**Total for Jun-85**: $123,682

**Year-To-Date Total**: $931,463
1. Prints these rows once at the beginning of the report.
2. Prints these rows at the top of each page.
3. Prints this row for each record in the working database.
4. Prints this row (in this case a blank row) whenever "Rep" changes.
5. Prints these rows whenever "Date" changes.
6. Sums sales for each date.
7. Sums dollar margin for each date.
8. Sums commission for each date.
9. Prints this row once at the end of the report.
10. Sums sales for each record in the working database.
11. Sums dollar margin for each record in the working database.
12. Sums commission for each record in the working database.
13. Uses On Change/All to print these values only when they change.
**SUMMARY REPORT USING SUBTOTALS**

### Product Sales Summary By Product For Each Month

<table>
<thead>
<tr>
<th>PRODUCT</th>
<th>SALES</th>
<th>NET MARGIN</th>
<th>PERCENT MARGIN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paddles</td>
<td>$22,723</td>
<td>$3,858</td>
<td>17.97%</td>
</tr>
<tr>
<td>Silent</td>
<td>$11,754</td>
<td>$3,384</td>
<td>28.96%</td>
</tr>
<tr>
<td>Sport</td>
<td>$17,268</td>
<td>$5,718</td>
<td>29.09%</td>
</tr>
<tr>
<td>Swiftwater</td>
<td>$31,669</td>
<td>$13,752</td>
<td>43.92%</td>
</tr>
</tbody>
</table>

Jan-85 Total: $113,414

<table>
<thead>
<tr>
<th>PRODUCT</th>
<th>SALES</th>
<th>NET MARGIN</th>
<th>PERCENT MARGIN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paddles</td>
<td>$21,375</td>
<td>$3,665</td>
<td>18.93%</td>
</tr>
<tr>
<td>Silent</td>
<td>$35,917</td>
<td>$14,257</td>
<td>39.60%</td>
</tr>
<tr>
<td>Sport</td>
<td>$15,416</td>
<td>$4,104</td>
<td>26.19%</td>
</tr>
<tr>
<td>Swiftwater</td>
<td>$40,877</td>
<td>$22,786</td>
<td>55.60%</td>
</tr>
</tbody>
</table>

Feb-85 Total: $113,612

<table>
<thead>
<tr>
<th>PRODUCT</th>
<th>SALES</th>
<th>NET MARGIN</th>
<th>PERCENT MARGIN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paddles</td>
<td>$21,029</td>
<td>$3,121</td>
<td>15.28%</td>
</tr>
<tr>
<td>Silent</td>
<td>$35,703</td>
<td>$14,073</td>
<td>39.60%</td>
</tr>
<tr>
<td>Sport</td>
<td>$15,496</td>
<td>$4,531</td>
<td>29.03%</td>
</tr>
<tr>
<td>Swiftwater</td>
<td>$40,121</td>
<td>$22,612</td>
<td>56.39%</td>
</tr>
</tbody>
</table>

Jun-85 Total: $241,029

<table>
<thead>
<tr>
<th>PRODUCT</th>
<th>REPORT</th>
<th>NET MARGIN</th>
<th>PERCENT MARGIN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paddles</td>
<td>$21,029</td>
<td>$3,121</td>
<td>15.28%</td>
</tr>
<tr>
<td>Silent</td>
<td>$35,703</td>
<td>$14,073</td>
<td>39.60%</td>
</tr>
<tr>
<td>Sport</td>
<td>$15,496</td>
<td>$4,531</td>
<td>29.03%</td>
</tr>
<tr>
<td>Swiftwater</td>
<td>$40,121</td>
<td>$22,612</td>
<td>56.39%</td>
</tr>
</tbody>
</table>

Total: $931,463

<table>
<thead>
<tr>
<th>PRODUCT</th>
<th>REPORT</th>
<th>NET MARGIN</th>
<th>PERCENT MARGIN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paddles</td>
<td>$1,167</td>
<td>$1,167</td>
<td>100.00%</td>
</tr>
<tr>
<td>Silent</td>
<td>$1,812</td>
<td>$1,812</td>
<td>100.00%</td>
</tr>
<tr>
<td>Sport</td>
<td>$2,496</td>
<td>$2,496</td>
<td>100.00%</td>
</tr>
<tr>
<td>Swiftwater</td>
<td>$22,786</td>
<td>$22,786</td>
<td>100.00%</td>
</tr>
</tbody>
</table>

Maximum: $93,876

---

YEAR-TO-DATE

Total: $931,463

Average: $335,574

Minimum: $1,167

Maximum: $93,876
1. Prints these rows at the top of each page.
2. Prints this row whenever “Product” changes.
3. Calculates total sales for each product, each month.
4. Calculates total dollar margin for each product, each month.
5. Calculates the average percent margin for each product, each month.
6. Prints these rows whenever “Date” changes.
7. Calculates total sales for each month.
8. Calculates total dollar margin for each month.
9. Calculates the average percent margin for each month.
10. Prints these rows once at the conclusion of the report.
11. Calculates total sales for every record in the working database.
12. Calculates total dollar margin for every record in the working database.
13. Calculates average sales for every record in the working database.
14. Calculates average dollar margin for every record in the working database.
15. Calculates average percent margin for every record in the working database.
16. Calculates the minimum sales for every record in the working database.
17. Calculates the minimum dollar margin for every record in the working database.
18. Calculates the minimum percent margin for every record in the working database.
19. Calculates the maximum sales for every record in the working database.
20. Calculates the maximum dollar margin for every record in the working database.
21. Calculates the maximum percent margin for every record in the working database.
## COLUMNAR REPORT USING SPECIAL REPORT FUNCTIONS AND CUMULATIVE

<table>
<thead>
<tr>
<th>Report Design</th>
<th>Sales Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Intro</td>
<td>2 Modeled</td>
</tr>
<tr>
<td>4 Header</td>
<td>REP PRODUCT</td>
</tr>
<tr>
<td>5 Body</td>
<td>REP Product</td>
</tr>
<tr>
<td>9 2-Rep</td>
<td>Total For Rep</td>
</tr>
<tr>
<td>13 1-Date</td>
<td>Total For Date</td>
</tr>
<tr>
<td>17 Concl</td>
<td>Year-To-Date</td>
</tr>
<tr>
<td>20 Footer</td>
<td></td>
</tr>
</tbody>
</table>

Row: 18 From Col: 1 through Col: 1
## Sales Summary

<table>
<thead>
<tr>
<th>REP</th>
<th>PRODUCT</th>
<th>SALES</th>
<th>PERCENT</th>
<th>CUMULATIVE SALES</th>
<th>NET MARGIN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alan</td>
<td>Paddles</td>
<td>$6,550</td>
<td>0.70 %</td>
<td>$6,550</td>
<td>($142.00)</td>
</tr>
<tr>
<td>Alan</td>
<td>Silent</td>
<td>$16,835</td>
<td>1.81 %</td>
<td>$23,385</td>
<td>$5,189.75</td>
</tr>
<tr>
<td>Alan</td>
<td>Sport</td>
<td>$4,976</td>
<td>0.53 %</td>
<td>$28,361</td>
<td>$578.40</td>
</tr>
<tr>
<td>Alan</td>
<td>Swiftwater</td>
<td>$6,672</td>
<td>0.72 %</td>
<td>$35,033</td>
<td>$1,738.20</td>
</tr>
<tr>
<td><strong>Total For Alan</strong></td>
<td><strong>$35,033</strong></td>
<td><strong>13.76 %</strong></td>
<td><strong>$71,164.35</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bob</td>
<td>Paddles</td>
<td>$5,235</td>
<td>0.56 %</td>
<td>$40,268</td>
<td>$784.50</td>
</tr>
<tr>
<td>Bob</td>
<td>Silent</td>
<td>$8,450</td>
<td>0.69 %</td>
<td>$46,718</td>
<td>$2,062.50</td>
</tr>
<tr>
<td>Bob</td>
<td>Sport</td>
<td>$3,794</td>
<td>0.41 %</td>
<td>$50,512</td>
<td>$884.60</td>
</tr>
<tr>
<td>Bob</td>
<td>Swiftwater</td>
<td>$7,433</td>
<td>0.80 %</td>
<td>$57,945</td>
<td>$2,385.05</td>
</tr>
<tr>
<td><strong>Total For Bob</strong></td>
<td><strong>$22,912</strong></td>
<td><strong>2.46 %</strong></td>
<td><strong>$51,659.45</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cathy</td>
<td>Paddles</td>
<td>$4,613</td>
<td>0.50 %</td>
<td>$62,558</td>
<td>$685.70</td>
</tr>
<tr>
<td>Cathy</td>
<td>Silent</td>
<td>$6,709</td>
<td>0.72 %</td>
<td>$69,267</td>
<td>$1,712.65</td>
</tr>
<tr>
<td>Cathy</td>
<td>Sport</td>
<td>$2,667</td>
<td>0.29 %</td>
<td>$71,934</td>
<td>$180.80</td>
</tr>
<tr>
<td>Cathy</td>
<td>Swiftwater</td>
<td>$5,728</td>
<td>0.61 %</td>
<td>$77,662</td>
<td>$1,809.80</td>
</tr>
<tr>
<td><strong>Total For Cathy</strong></td>
<td><strong>$19,717</strong></td>
<td><strong>2.12 %</strong></td>
<td><strong>$81,271.45</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dave</td>
<td>Paddles</td>
<td>$6,325</td>
<td>0.68 %</td>
<td>$83,897</td>
<td>$456.50</td>
</tr>
<tr>
<td>Dave</td>
<td>Silent</td>
<td>$11,760</td>
<td>1.26 %</td>
<td>$95,657</td>
<td>$3,156.00</td>
</tr>
<tr>
<td>Dave</td>
<td>Sport</td>
<td>$5,831</td>
<td>0.63 %</td>
<td>$101,488</td>
<td>$1,411.60</td>
</tr>
<tr>
<td>Dave</td>
<td>Swiftwater</td>
<td>$11,836</td>
<td>1.27 %</td>
<td>$113,324</td>
<td>$3,068.60</td>
</tr>
<tr>
<td><strong>Total For Dave</strong></td>
<td><strong>$35,752</strong></td>
<td><strong>3.84 %</strong></td>
<td><strong>$155,080.85</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Total For Jan-085</strong></td>
<td><strong>$111,414</strong></td>
<td><strong>12.18 %</strong></td>
<td><strong>$354,167.90</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alan</td>
<td>Paddles</td>
<td>$6,635</td>
<td>0.71 %</td>
<td>$6,635</td>
<td>($573.50)</td>
</tr>
<tr>
<td>Alan</td>
<td>Silent</td>
<td>$16,317</td>
<td>1.74 %</td>
<td>$22,952</td>
<td>$4,179.45</td>
</tr>
<tr>
<td>Alan</td>
<td>Sport</td>
<td>$5,977</td>
<td>0.67 %</td>
<td>$30,929</td>
<td>$639.30</td>
</tr>
<tr>
<td>Alan</td>
<td>Swiftwater</td>
<td>$6,259</td>
<td>0.69 %</td>
<td>$37,188</td>
<td>$1,836.90</td>
</tr>
<tr>
<td><strong>Total For Jan-085</strong></td>
<td><strong>$35,033</strong></td>
<td><strong>13.76 %</strong></td>
<td><strong>$71,164.35</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Total For Jun-085</strong></td>
<td><strong>$241,029</strong></td>
<td><strong>25.88 %</strong></td>
<td><strong>$579,537.75</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Year-To-Date</strong></td>
<td><strong>$931,463</strong></td>
<td><strong>100.00 %</strong></td>
<td><strong>$2,118,891.85</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. Prints these rows once at the beginning of the report.
2. Uses the special field @TODAY to return the date logged into your computer.
3. Uses the special field @NOW to return the time logged into your computer.
4. Prints these rows at the top of each page.
5. Prints this row for every record in the working database.
6. Uses the % of Total attribute to return the percent each sale is of the total sales.
7. Uses Cumulative Attribute to increment the value in this field by the value of the current record in the Sales $ field. This value will be reset to zero each time the date changes.

8. Uses the formula = Margin - Commission to return Net Margin.

9. Prints these rows whenever the Rep changes.

10. Returns the total sales for each Rep, each month.

11. Uses the % of Total attribute to return the percent of total sales each Rep's sales of each product are for each month.

12. Returns the total Net Margin for each Rep, each month, with the formula = Margin - Commission.

13. Prints these rows whenever the Date changes.

14. Returns the total sales for each date.

15. Uses the % of Total attribute to return each month's percent of total sales.

16. Returns the total Net Margin for each month using the formula = Margin - Commission.

17. Prints this row once at the end of the report.

18. Returns the total sales for all records in the working database.

19. Returns the total Net Margin for all records in the working database, applying the @SUM attribute to the formula = Margin - Commission.

20. Prints these rows once at the bottom of each page.

21. Uses the special field @Page-No to automatically return a page number.
**MAILING LABELS**

<table>
<thead>
<tr>
<th>Report</th>
<th>Edit</th>
<th>Print/File</th>
<th>Search</th>
<th>Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Design</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. Prints these rows for every record in the working database.
2. Uses Variable Width to set these columns to be as Wide as Needed to print the data in each record. All items to the right of these fields will slide right or left to preserve the spacing.
3. Uses Variable Width to set the Zip Code to Position as Shown.
4. Printer settings: Top Margin (1); Bottom Margin (2); Page length (6); Print with page breaks? (yes).
PART 2

TRANSLATE

A  TRANSLATE  63
   Overview of translating  63

B  TRANSLATING PFS AND DBASE FILES  67

C  TRANSLATING 1–2–3, SYMPHONY, AND DIF FILES  69

D  TRANSLATING ASCII TEXT FILES  76
The Translate program allows you to take files created with other programs and convert them into Reflex files. You can translate an entire file or part of one. The new files can then be retrieved for use with Reflex, just as if they had been created in Reflex.

**TRANSLATE**

Reflex can translate Lotus 1-2-3, Symphony, dBase II, dBase III, PFS, or DIF files. In addition, Text files (ASCII) formatted according to certain constraints can be translated.

Reflex displays the appropriate translate table for the type of file you are translating. The translate table provides information about the file you are translating (the “source” file) and enables you to establish the equivalent Reflex file information.

**OVERVIEW OF TRANSLATING**

Select Translate from the Report & Utilities title screen.

1. Enter Type of file: PFS, dBase, DIF, 1-2-3, Symphony, Text. Press Choices F10 for a choice list of file types.
2. Enter Name of file: Press Choices \[F10\] for a list of file names in the current directory (change the directory if necessary in the Global Settings tool).

3. Fill out the translate table.

4. Press \[\text{Esc}\] to select Translate. You now have three choices:
   - **Translate** To translate your file according to the instructions in the translate table.
   - **Partial Translate** To translate a subset of the records (the Search Conditions tool appears)
   - **Cancel** To cancel the translation and clear the translate tool. This allows you to start over.

**NOTE** If you wish to Save the translate specifications for later use, do so *before* selecting Translate, Partial Translate, or Cancel.

**THE TRANSLATE MENU**
The Translate menu has eight commands:

- **Retrieve Translate Spec** Retrieves a previously-defined translate specification.
- **Save Translate Spec** Saves the current translate specification for later use.
- **Erase Translate Spec** Erases a previously saved translate specification.
- **Fields and Types** Used for translating spreadsheets. See Translating DIF and Lotus Files, below.
- **Column Width** Used to change the width of a translate table column.
- **Global Settings** Enables you to change the system directory.
- **Quit** Returns to the Report & Utilities title screen.

**SOURCE AND DESTINATION FILES**
Reflex assumes your source file, the “From File,” is located in the system directory. To change the system directory instructions, choose Global Settings from the Translate menu. Or you may enter a disk, directory, and file name from a different directory in the “From File” cell. The Choices key \[F10\] displays files from the system directory.

The “To File” cell displays the destination for the translated file and the file name. You may change this and also enter the
disk and directory with the file name to put the translated file in a different directory.

**SOURCE FILE EXTENSIONS**

To translate files created by other programs they must have the following extensions:

- **PFS files**: .PFS
- **dBASE II, dBASE III files**: .DBF
- **DIF files**: .DIF
- **1-2-3 files**: .WKS
- **Symphony files**: .WRK
- **Text (ASCII) files**: .PRN

**TRANSLATING CALCULATED FIELDS**

Reflex translates only the values in the file. It will not translate any formulas you have written. There are two ways to handle the translation of calculated fields:

1. Include the fields in the translation. Then use the Field and Sort Settings tool's Remove Local Values command to delete the values translated; then enter the formulas for the fields.

2. Do not include the fields in your translation. Then add the fields to the database and then enter the formulas for the fields.

**TRANSLATING DATES**

Dates entered as text entries in the source file can be translated directly into a date-typed field in Reflex. The date entries in the source file must have one of the five Reflex date display formats:

<table>
<thead>
<tr>
<th>CHOICE</th>
<th>EXAMPLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>mm/dd/yy</td>
<td>1/16/85</td>
</tr>
<tr>
<td>mm/yy</td>
<td>1/85</td>
</tr>
<tr>
<td>dd-mmm-yy</td>
<td>16-Jan-85</td>
</tr>
<tr>
<td>mmm-yy</td>
<td>Jan-85</td>
</tr>
<tr>
<td>mmm dd, yyyy</td>
<td>January 16, 1985</td>
</tr>
</tbody>
</table>

**TRANSLATING A SUBSET**

When you select Partial Translate, the Search Conditions tool appears. Here you enter the conditions a record must pass
before it is translated. Only those records passing the conditions will be included in the translate file.

This tool works like the Search Conditions tool in the main part of Reflex. For further information, see “Search” in Reference A.

Here are the steps for translating a subset:

1. Select Partial Translate.
2. Enter the conditions in the table or type-in line.
3. Proceed. Reflex will translate your file. (If you select Cancel, Reflex redisplay the translate table.)

NAMED TRANSLATE SPECIFICATIONS

If you will be periodically translating the same file, say with new data each month, you may want to save the translate specification so you don’t have to recreate it each time.

SAVING A NAMED TRANSLATE SPEC

After you have filled out the translate table, and before translating, choose Save Translate Spec from the Translate menu (/TS). Reflex will display the Save Translate Spec tool.

Enter a name for the Translate Spec and Proceed. Reflex will save the current translate specifications, including the file names.

USING A NAMED TRANSLATE SPEC

The source file must be in the same directory location as it was when you created the Translate Spec.

Choose Retrieve Translate Spec from the Translate menu (/TR). Reflex will display the Retrieve Translate Spec tool. Enter the name for the Translate Spec you wish to retrieve.

Reflex will retrieve the Translate Spec and fill in the From File and To File cells and the rest of the translate table. This is just as if you had re-entered all the information. You may make any necessary modifications to the specifications.

Adjustment for Named Ranges

Reflex automatically adjusts for most changes in the size of a Lotus 1-2-3 or Symphony file that uses a Named Range. For example, if the number of rows in the named range
increases, Reflex will automatically adjust to the new named range when the Translate Spec is retrieved.

**ERROR MESSAGES**

Error messages you might encounter when retrieving a Translate Spec:

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name doesn’t exist</td>
<td>The source file is not in the same location (disk/directory) that it was when the spec was created.</td>
</tr>
<tr>
<td>Invalid translate spec</td>
<td>The structure of the source file has changed significantly, thus invalidating the translate spec.</td>
</tr>
</tbody>
</table>

**ERASING A NAMED TRANSLATE SPEC**

To erase a Translate Spec you have previously saved, choose Erase Translate Spec from the Translate menu (/TE). Reflex will display the Erase Translate Spec tool.

Enter the disk, directory, and file name information and Proceed. Reflex will erase the Translate Spec from the disk.

**TRANSLATING PFS AND dBASE FILES**

When you translate a PFS, dBase II or dBase III file, Reflex displays a table with five columns, and as many rows as there are field names.
The Translate grid for PFS and dBase files.

Source Field This column lists the field names in the source file.

Source Type Identifies the data type of each field in the source file.

Reflex Field Repeats the field names of the source file. Select any cell in this column to change the field name.

Reflex Type Repeats the data types from the source file. Select any cell in this column to change the field type. Press Choices [F10] to display a choices list of available Reflex field types.

Include? In this column you instruct Reflex to include or exclude fields in the source file when it translates. To exclude a field, select the corresponding cell in this column and change the Yes to a No.

NOTES ON TRANSLATING PFS FILES
Occasionally a PFS file will have a very long field name. Reflex will take the leftmost 70 characters for the Reflex field name.

PFS fields can contain very long entries. For the Reflex translate program, the upper limit is 254 characters. Reflex will automatically split every 70th character into a new (subscripted) field. This is done automatically so that you can view your translated PFS file in the same Form layout as it had in PFS. For example, if the field name is Comments, characters 71–140 will go into a Reflex field Comments2; characters
141–210 will go into a Reflex field Comments3, etc. The translation grid will show these added fields. You can then include or exclude them as desired.

Reflex can only translate 128 fields. If your file contains more than 128 fields, some will be excluded.

**NOTES ON TRANSLATING DBASE II AND DBASE III FILES**

Logical fields will become text fields, with .F for False and .T for True in Reflex.

Trailing spaces on the right of entries will be stripped.

Reflex will take the first 254 characters from a dBase III memo field. Memo files must be located in the same directory as the source dBase III file.

**TRANSLATING 1-2-3, SYMPHONY, AND DIF FILES**

1-2-3, Symphony, and DIF files are spreadsheet files with a row and column format. Translating them into Reflex files adjusts the information into a records-and-fields format.

Reflex reads a spreadsheet row-by-row, treating it as if it were organized like the List View: each row is a different record; each column is a series of field values, headed by a field name.
Reflex reads the data in each row as a set of field entries in a record.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATE</td>
<td>REP</td>
<td>WINE TYPE</td>
<td>CASES</td>
<td>SALES</td>
<td>AVG PRICE</td>
</tr>
<tr>
<td>01-Jan-84 Ann</td>
<td>Burgundy</td>
<td>567</td>
<td>7.50</td>
<td>13.23</td>
<td></td>
</tr>
<tr>
<td>01-Jan-84 Ann</td>
<td>Cabernet</td>
<td>152</td>
<td>12.00</td>
<td>84.21</td>
<td></td>
</tr>
<tr>
<td>01-Jan-84 Ann</td>
<td>Chablis</td>
<td>170</td>
<td>3.50</td>
<td>20.59</td>
<td></td>
</tr>
<tr>
<td>01-Jan-84 Ann</td>
<td>Riesling</td>
<td>170</td>
<td>14.40</td>
<td>84.71</td>
<td></td>
</tr>
<tr>
<td>01-Jan-84 Bob</td>
<td>Burgundy</td>
<td>254</td>
<td>3.40</td>
<td>13.39</td>
<td></td>
</tr>
<tr>
<td>01-Jan-84 Bob</td>
<td>Cabernet</td>
<td>133</td>
<td>11.60</td>
<td>87.22</td>
<td></td>
</tr>
<tr>
<td>01-Jan-84 Bob</td>
<td>Chablis</td>
<td>162</td>
<td>3.70</td>
<td>22.04</td>
<td></td>
</tr>
<tr>
<td>01-Jan-84 Bob</td>
<td>Riesling</td>
<td>187</td>
<td>11.70</td>
<td>62.57</td>
<td></td>
</tr>
<tr>
<td>01-Jan-84 Chuck</td>
<td>Burgundy</td>
<td>324</td>
<td>3.00</td>
<td>11.73</td>
<td></td>
</tr>
<tr>
<td>01-Jan-84 Chuck</td>
<td>Cabernet</td>
<td>114</td>
<td>5.50</td>
<td>48.23</td>
<td></td>
</tr>
<tr>
<td>01-Jan-84 Chuck</td>
<td>Chablis</td>
<td>144</td>
<td>1.60</td>
<td>11.11</td>
<td></td>
</tr>
<tr>
<td>01-Jan-84 Chuck</td>
<td>Riesling</td>
<td>187</td>
<td>11.70</td>
<td>62.57</td>
<td></td>
</tr>
<tr>
<td>01-Jan-84 Dave</td>
<td>Burgundy</td>
<td>702</td>
<td>7.10</td>
<td>10.11</td>
<td></td>
</tr>
<tr>
<td>01-Jan-84 Dave</td>
<td>Cabernet</td>
<td>152</td>
<td>9.60</td>
<td>63.16</td>
<td></td>
</tr>
<tr>
<td>01-Jan-84 Dave</td>
<td>Chablis</td>
<td>270</td>
<td>5.50</td>
<td>20.37</td>
<td></td>
</tr>
<tr>
<td>01-Jan-84 Dave</td>
<td>Riesling</td>
<td>340</td>
<td>20.90</td>
<td>61.47</td>
<td></td>
</tr>
<tr>
<td>01-Feb-84 Ann</td>
<td>Burgundy</td>
<td>507</td>
<td>4.10</td>
<td>6.98</td>
<td></td>
</tr>
<tr>
<td>01-Feb-84 Ann</td>
<td>Cabernet</td>
<td>209</td>
<td>16.80</td>
<td>80.38</td>
<td></td>
</tr>
</tbody>
</table>

Your files must have this format. Reflex can, however, read different portions of the spreadsheet for translating.

Here is the translate screen for Lotus files:
"From...To" line  Specifies the coordinates of the upper left corner and the lower right corner of a rectangle that contains the data on the spreadsheet. Change the coordinates to instruct Reflex to translate a particular portion of the spreadsheet.

Named Range  Enter the name to instruct Reflex to translate the named range of a Lotus 1-2-3 file or the named range or window of a Symphony file. (DIF files do not allow named ranges.) The choices key [F10] will display a list of the named ranges in the source file.

Show Data from Row  Identifies the row which is currently displayed in the Position and Has Value of columns. Reflex displays the first row of data in the spreadsheet or named range. Change the number to display a different row.

Position  Names the coordinates of the spreadsheet cells specified in the “Show Data from Row” cell.

Has Value of  Displays the values from the spreadsheet cells specified in the “Show Data from Row” cell. These are the actual values stored in the spreadsheet.

Type  Shows the data type of the entries in the “Show Data from Row” cell.

Reflex Field Name  Repeats the entries in the Has Value of column. You can select any cell in this column to change the field name. Or use the Fields menu command, discussed below.
Type  Repeats the data types from the third (type) column. You can select any cell in this column to change the field type. Or use the Types menu command, discussed below.

Include? In this column you instruct Reflex to include or exclude this row when it translates. To exclude a field, select the corresponding cell in this column and change the Yes to a No.

CHANGING THE "FROM . . . TO" COORDINATES

When the translate table is first displayed, Reflex shows the coordinates of the upper left corner and the lower right corner of the data on the spreadsheet. These coordinates are determined by rows and columns which contain entries. Note that some parts of the area may not contain any data.

If the spreadsheet is a perfect rectangle of data, you will not necessarily change the coordinates. If there is extra information on the spreadsheet, change the coordinates to isolate the information you want to translate.
Isolating the information to translate. Note that the field names are not part of the data.

To change the coordinates, select the cells in the “From . . . To” line and enter the appropriate column letters and row numbers. Or enter a named range for a 1-2-3 or Symphony file.

**USING NAMED RANGES**

Reflex can translate named ranges from 1-2-3 files, and named ranges, sheet windows, and data windows from Symphony files. The range, sheet or data window name is entered in the Named Range cell.

When you select the Named Range cell, the Choices key [F10] will display a list of named ranges, sheet windows, and data windows. In the choice list, sheet windows are indicated by a *S*; data windows are indicated by *D*; named ranges have no indicator following them.

When you enter a named range, sheet window, or data window, the translate table makes the following adjustments:

1. The “From Col” cells change to the boundaries defined by the range.
2. The “Show Data From Row” cell reflects the first row number of the range.
3. The Position column lists the coordinates of the first row of the range.
4. The “Has Value of” column shows values from the first row of the range.

5. The “Type” column shows the data type of the cells in the “Has Value of” column.

**USING THE “SHOW DATA FROM ROW” CELL**

Enter successive row numbers in the “Show Data from Row” cell to scan different rows on the spreadsheet. This enables you to determine the location of the data you want to translate.

This cell also enables you to enter field names and types automatically with the Fields and Types menu options. See Fields and Types Menu Options, below.

**NOTE**

The “Show Data From Row” function is not limited by the “From . . . To” coordinates. You can display data from any row on the spreadsheet which contains data.

**THE FIELDS MENU COMMAND**

The Fields menu command enables you to enter Reflex field names from one row of entries on the spreadsheet.

Typically, your desired field names will be entered in the spreadsheet across one row, i.e., in a row of column headings. Use “Show Data from Row” to display that row. The “Has Value of” column will change to reflect those names. Select Fields from the Translate menu (/TF). This command instructs Reflex to use those values as field names: the “Has Value of” entries will be copied in the “Reflex Field Name” column.

The Reflex field names entered can be changed individually.
DUPlicate AND Empty FIELD NAMES

Reflex prevents the translation of duplicate field names or unnamed fields (which can occur in spreadsheets) by automatically changing them.

If you do not change a duplicate field name before translating, Reflex will add a subscript number to the duplicate instances. For example, if “Date” occurs as a field name three times, the first instance will translate as Date, the second instance will translate as Date[2], and the third instance will translate as Date[3].

If you include blank field names, Reflex will name the fields Field1, Field2, etc.

THE TYPES MENU COMMAND

The Types menu command enables you to enter field types from a selected spreadsheet row.

Use “Show Data from Row” to display a row containing values of the type you want. Then choose Types from the Translate menu (/TT). This instructs Reflex to use the source file data types as the Reflex data types.

The Reflex types entered can be changed individually.

Note that you will typically want to take the Types from a different row than the field names come from, since the field names themselves are text (words).
NOTES ON TRANSLATING LOTUS FILES

Field names translated will include only the leftmost 70 characters.

Field entries translated will include only the leftmost 254 characters.

Lotus also uses a cell format command to display dates. For example, the numeric value of @DATE(84,9,1) can be displayed as a date in Lotus. It will be translated as a number unless you specify Date in the Type column.

If your Lotus file contains dates in a text-formatted column, they can be translated into Reflex date fields if they match one of Reflex's five date display formats. You must specify Date in the Type column.

NOTES ON TRANSLATING DIF FILES

DIF files use only numbers or text. There are no date fields. Again, dates entered in one of Reflex's five date display formats can be translated into a Reflex date field.

TRANSLATING ASCII TEXT FILES

You can translate ASCII Text files that have been formatted according to certain standard conventions.

In order to translate a text file:

☐ Each record must have a consistent structure.

☐ The file cannot contain extraneous elements:
  no page headers or footers.
  no titles.
  no summaries or previews.

You use the Translate table to represent the structure of one record in the source file. Essentially this says to Reflex, “here is what a record looks like.” Reflex then uses this “template” to translate the file one record at a time, establishing field names and types as well.

NOTE The Text (ASCII) file must have a DOS extension of .PRN.
TEXT FILE FORMATS

In order to tell Reflex what a record looks like, it is important to understand how records are set up in text files. Each record consists of a series of field entries. (Because they are text values, we call them words in this discussion.) Each word is set apart—delimited—in some way.

In fact, the delimiting format defines what Reflex sees as words.

Words can be delimited by spaces:

word1  word2  word3  word4  word5  <<

Words can be delimited by commas:

word1, word2, word3, word4, word5, <<

Words can be delimited by quotes:

"word1"  "word 2"  "word3"  "word4"  "word5"  <<

Words can be delimited by quotes and commas:

"word1", "word2", "word3", "word4", "word5"  <<

Words can be delimited by an end-of-row signal:

word1  <<
word2  <<
word3  <<
word4  <<
word5  <<

Words can be delimited by both commas and end-of-row:

word1,  <<
word2,  <<
word3,  <<
word4,  <<
word5,  <<

Or words can be delimited by column numbers:

1-10  11-18  19-35  36-40  41-42
word1  word2  word3  word4  word5  <<

NOTE When anything other than spaces are used to delimit words, the words may include spaces.
These examples cover the types of delimiters that Reflex can handle. With the exception of column number delimiters, they can also be mixed—a record may contain different words with different delimiters (although a word in a given position must use the same delimiter in each record.)

**HOW TO SEE YOUR FILE FORMAT**

You need to know how your file is delimited in order to tell Reflex how to translate it. To see your file you use the DOS Type command, already copied to your Reflex Disks by the Install procedure.

For this example, assume the file name of your source file is Biglist.PRN.

1. Quit Reflex to return to DOS.     Your computer displays the A> prompt.

2. Place the diskette containing your source file in Drive A.

3. Type in: Type Biglist and press [Enter].     Your source file will be displayed on the screen.

**NOTE** To halt scrolling of the display, hold down [Ctrl] and press [Break].

You can now see the delimiting format of this particular file.
WHAT REFLEX NEEDS TO KNOW

Reflex needs to know where one word begins and ends, and where the next word begins and ends, and so on, for one entire record. Each word becomes a field. It needs to know what field name to assign to each word, and what field type to use.

This defines the record structure for Reflex.

You use the Translate table to define the record structure. Because this structure is used to translate each record, every record must match the structure exactly.

To define a record structure, you build up the definition, word by word, in the Go From and Stop On columns in the Translate table.

For example, if the record is

"Johnson" "Bill" "3155 Kearney St" "Fremont" "CA" "94538" <<

The following delimiters might be used:

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>GO FROM</th>
<th>STOP ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name</td>
<td>Any Character (J), the first one it comes to</td>
<td>End of Word (n), the last character in the word</td>
</tr>
<tr>
<td>First Name</td>
<td>Any Character (B), the next one it comes to</td>
<td>End of Word (l), the last character in the word</td>
</tr>
<tr>
<td>Address</td>
<td>Any Character (3)</td>
<td>End of Word (t), the &quot;word&quot; in this case is defined by the delimiter &quot; to include three groups of characters: the entire address</td>
</tr>
<tr>
<td>City</td>
<td>Any Character (F)</td>
<td>End of Word (t)</td>
</tr>
<tr>
<td>State</td>
<td>Any Character (C)</td>
<td>End of Word (A)</td>
</tr>
<tr>
<td>Zip Code</td>
<td>Any Character (9)</td>
<td>End of Word (8)</td>
</tr>
</tbody>
</table>
If the same record were delimited by column number, Reflex would have to be told how to do the same things, and you would use the column numbers to do so:

**FIELD NAME** | **GO FROM** | **STOP ON**
---|---|---
Last Name | 1 | 10
First Name | 11 | 18
Address | 19 | 35
City | 36 | 45
State | 46 | 47
Zip Code | 49 | 53

**USING THE TEXT FILE TRANSLATE TABLE**

When it first appears, the text file translate table represents how Reflex understands the file. Reflex reads the first row of your data file and assumes that each word will be a field in the file you wish to create. You may need to change the entries in the table to reflect your actual file. Changing the entries is discussed below.
**Reflex Field** When Reflex looks at the file it makes an educated guess that each word in the first row is a field name. Any group of characters or words in double quotes is assumed to be one word.

**Reflex Type** When it first appears, all the entries are “text.” You may change this to instruct Reflex to define the correct field types.

**Go From and Stop On** Reflex assumes that it will be able to start at the beginning of a word and read until the end of the word for each field. Any group of characters surrounded with double quotes is assumed to be a word. You may need to change these instructions to fit the format of your file.

**Include?** In this column you instruct Reflex to include or exclude fields in the source file when it translates. To exclude a field, select the corresponding cell in this column and change the Yes to a No.

**NOTE** All fields must be defined in the translate table, even though some may be excluded at the time of translation.

**THE GO FROM AND STOP ON CHOICES**

The Go From and Stop On instructions tell Reflex to start reading the file at a particular point and stop at a particular point, and to put everything it reads between starting and stopping into one Reflex field as the field value for that record.

Here are the Go From and Stop On choices available:

<table>
<thead>
<tr>
<th>GO FROM</th>
<th>STOP ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any Character</td>
<td>End of Word</td>
</tr>
<tr>
<td>Start of Next Row</td>
<td>End of Row</td>
</tr>
<tr>
<td>Quote</td>
<td>Quote</td>
</tr>
<tr>
<td>Comma</td>
<td>Comma</td>
</tr>
<tr>
<td>Column number</td>
<td>Column number</td>
</tr>
</tbody>
</table>

Use Choices [F10] to enter the words in the appropriate cells, or type them in. Column numbers must be typed in.
NOTE

If you use column numbers, you must use only column numbers for all Go From and Stop On instructions. Column numbers may not be mixed with the other delimiters.

Words are defined by the delimiting format, not merely the groups of characters. Unless you specify comma delimiters, Reflex considers everything between two quotes to be one word. If you do specify comma delimiters, then everything between commas will be considered as one word (including quotes, if any). Reflex starts reading at the next character following the point at which it has stopped. Until it stops reading again, it considers the characters to all belong together in one field as the value for that field.

**GO FROM**
The Go From instruction tells Reflex where to begin reading for a particular field value. Anything encountered prior to the Go From point, and after the last Stop On point, is ignored.

<table>
<thead>
<tr>
<th>GO FROM</th>
<th>MEANING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any Character</td>
<td>Start reading when you come to the next letter, number, or anything else that is not a quote, comma, space, or end-of-row symbol.</td>
</tr>
<tr>
<td>Start of Next Row</td>
<td>Start reading on the far left of the next row containing a character. (Blank rows are skipped over.)</td>
</tr>
<tr>
<td>Quote</td>
<td>Start reading the first character following the next quote you come upon.</td>
</tr>
<tr>
<td>Comma</td>
<td>Start reading the first character following the next comma you come upon.</td>
</tr>
</tbody>
</table>
STOP ON

<table>
<thead>
<tr>
<th>STOP ON</th>
<th>MEANING</th>
</tr>
</thead>
<tbody>
<tr>
<td>End of Word</td>
<td>Reflex reads until it reaches the last character of the word—a space, quote, or comma—and enters what it has read as a Reflex field value.</td>
</tr>
<tr>
<td>End of Row</td>
<td>Reflex reads until it reaches the end of the row, and enters what it has read as a Reflex field value.</td>
</tr>
<tr>
<td>Quote</td>
<td>Reflex reads until it reaches a quote, and enters what it has read as a Reflex field value.</td>
</tr>
<tr>
<td>Comma</td>
<td>Reflex reads until it reaches a comma, and enters what it has read as a Reflex field value.</td>
</tr>
</tbody>
</table>

Sometimes these instructions are equivalent. You might be able to enter End of Word or Quote or Comma and get the same result. Reflex will not translate the delimiter as part of the field value.

Reflex will not translate the delimiters. If a field value contains commas or quotes, use the other as a delimiter.

DELETING ROWS

Press [F3] to select a row in the translate table. [Del] deletes the selected row. [Ins] has no effect. Enter new fields in the Reflex Field cell in the blank row at the bottom of the table.

TEXT TRANSLATION EXAMPLES

Reflex assumes that your file is double quote delimited or double quote and comma delimited. If that is the case, all you will need to do is replace the entries in the Reflex field column with the field names you want, change the Reflex type if appropriate, and proceed.
Double Quote Delimited, or Double Quote and Comma Delimited

Sample record from text file:

"Bill Johnson" "234 Kearney St" "Fremont" "CA" "93245"

or

"Bill Johnson","234 Kearney St","Fremont","CA","93245",

Here is what the Translate table looks like when it first appears:

Reflex Field | Reflex Type | Go From | Stop On | Include? |
-------------|-------------|---------|---------|----------|
Bill Johnson | Text        | Any Character | End of Word | Yes |
234 Kearney St | Text | Any Character | End of Word | Yes |
Fremont | Text | Any Character | End of Word | Yes |
CA | Text | Any Character | End of Word | Yes |
93245 | Text | Any Character | End of Word | Yes |

Reflex treats entries thus delimited as individual words. When the translation table appears, each cell in the Reflex Field Name column will contain one complete entry.

Notice that Reflex will read from any character to the end of a word. Reflex will treat any character or group of characters as a word if it is surrounded by quotes.

☐ Change the entries to appropriate field names.
☐ Change the data types if necessary.
☐ Proceed.
Here is what the translate table should look like after you have changed the field names:

<table>
<thead>
<tr>
<th>Reflex Field</th>
<th>Reflex Type</th>
<th>Go From</th>
<th>Stop On</th>
<th>Include?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Text</td>
<td>Any Character</td>
<td>End of Word</td>
<td>Yes</td>
</tr>
<tr>
<td>Address</td>
<td>Text</td>
<td>Any Character</td>
<td>End of Word</td>
<td>Yes</td>
</tr>
<tr>
<td>City</td>
<td>Text</td>
<td>Any Character</td>
<td>End of Word</td>
<td>Yes</td>
</tr>
<tr>
<td>State</td>
<td>Text</td>
<td>Any Character</td>
<td>End of Word</td>
<td>Yes</td>
</tr>
<tr>
<td>Zip Code</td>
<td>Text</td>
<td>Any Character</td>
<td>End of Word</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Multiple row record formats**

Sample record from file:

Johnson, Bill  
3155 Kearney St  
Fremont, CA, 93245

In this case, when the translate table first appears, only two field entries are showing in the Reflex Field Name column. You will need to add appropriate field names.
Here is what the translate table looks like after the field names and other entries have been entered:

NOTE With multiple row record structures, each record must conform to the same structure.
Multiple row single field record formats

Sample records from File:

Bill,
Smith,
J.,
424 East 57 St.,
New York,
NY,
10111,
Joe,
Brown,

, 123 West 34 St.,
New York,
NY,
10114,
Jane,
Billings,

, 23 Felton St.,
San Francisco,
CA,
94334,

This file format has one field value on each row. Notice that the second and third records don't have a value for the middle initial. They do, however, have an empty value where the Middle Initial would normally appear in the record. When translating this type of file format it is important that each record have the same number of fields, so even if many of the fields are blank they must be represented with a blank row with an appropriate delimiter.
When you first specify the file for the above example the translate tool looks like this:

<table>
<thead>
<tr>
<th>Reflex Field</th>
<th>Reflex Type</th>
<th>Go From</th>
<th>Stop On</th>
<th>Include?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bill</td>
<td>Text</td>
<td>Any Character</td>
<td>End of Word</td>
<td>Yes</td>
</tr>
</tbody>
</table>

After adding a row for each field in the database and setting your Go From and Stop On settings your translate tool looks like this:

<table>
<thead>
<tr>
<th>Reflex Field</th>
<th>Reflex Type</th>
<th>Go From</th>
<th>Stop On</th>
<th>Include?</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>Text</td>
<td>Any Character</td>
<td>Comma</td>
<td>Yes</td>
</tr>
<tr>
<td>Last Name</td>
<td>Text</td>
<td>Start of Next Row</td>
<td>Comma</td>
<td>Yes</td>
</tr>
<tr>
<td>Middle Initial</td>
<td>Text</td>
<td>Start of Next Row</td>
<td>Comma</td>
<td>Yes</td>
</tr>
<tr>
<td>Address</td>
<td>Text</td>
<td>Start of Next Row</td>
<td>Comma</td>
<td>Yes</td>
</tr>
<tr>
<td>City</td>
<td>Text</td>
<td>Start of Next Row</td>
<td>Comma</td>
<td>Yes</td>
</tr>
<tr>
<td>State</td>
<td>Text</td>
<td>Start of Next Row</td>
<td>Comma</td>
<td>Yes</td>
</tr>
<tr>
<td>Zip Code</td>
<td>Text</td>
<td>Start of Next Row</td>
<td>Comma</td>
<td>Yes</td>
</tr>
</tbody>
</table>
**Columnar (cardfile) delimited**

Sample records from file:

<table>
<thead>
<tr>
<th>Name</th>
<th>Address</th>
<th>City</th>
<th>State</th>
<th>Zip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bill Johnson</td>
<td>3155 Kearney St</td>
<td>Fremont</td>
<td>CA</td>
<td>94538</td>
</tr>
<tr>
<td>Joe Smith</td>
<td>425 1st St</td>
<td>Newark</td>
<td>CA</td>
<td>92345</td>
</tr>
</tbody>
</table>

In this case, the program which has created the file uses column numbers to delimit the entries. But Reflex does not know this. When the translate table appears, each individual word has a Reflex Field Name cell allotted to it. You will need to enter the appropriate field names, and define the column numbers for Reflex.

Here is what the translate table looks like when it first appears:

<table>
<thead>
<tr>
<th>Text</th>
<th>Translate</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Notice that Reflex considers each word as a separate field entry. Here is what the translate table looks like when the field names have been changed and the column numbers entered:
Occasionally, the first entry in such a text file does not begin in column one, but is set to the right a few spaces to include a left margin. In such cases, the entry in the translate table will be displayed with spaces in front of it. Be sure that the column numbers are accurate to prevent the translation from truncating later field entries.

**IF YOU HAVE A PROBLEM**

The most common error message you will likely see while translating Text files is “Hit Premature End of File.” This message means that Reflex reached the last character in the file while in the middle of adding a record. (It should reach the last character at the end of adding the last record.)

This means one of two things:

- □ The Text file is not uniform. (Uniform means that all records have exactly the same structure, and there are no extraneous elements like titles, headers, extra fields, etc.)

- □ The Translate table is incorrect.

Here is what you should do:

1. Check the Translate table. Correct any mistakes, and proceed.
2. Print out a hard copy of your source file.
3. Compare the record structure of the source to the Translate table. Correct any mistakes, and proceed.
4. Read the entire source file hard copy to be sure the file itself is **uniform**:

- Are all the records there?
- Are they all the same? (e.g., sequence of fields always the same from record to record.)
- Are there any extraneous elements? (e.g., headers, footers, titles, explanatory text, summary calculation, an extra field in *any* record.)
- Are there any missing or extra delimiters? (perhaps some records are missing fields?)

5. It is sometimes possible to translate a reluctant Text file by using a different method of defining the Go From and Stop On instructions. (If the file appears to be uniform and whole, try defining it in the Translate table with different (equivalent) Go From and Stop On instructions.)
PART 3

MERGE

MERGING DATABASES  93
The Merge program enables you to combine (merge) two or more Reflex databases into one new Reflex database.

**MERGING DATABASES**

Each database to be merged must have the same fields (field names and types), *entered in the same order* (this is the order of fields shown in the Field and Sort Settings tool, regardless of the order shown in Form or List Views).

To merge databases, select Merge from the Report & Utilities title screen.

**Input files** Enter file names of Reflex files you wish to merge in this column. Use Choices \([\text{F10}]\) for files in the system directory. Type in disk, directory, and file name instructions for files in other locations.

The first file name entered in the Input files column is the **master database** for the merge. All field names, types, precision, format, sort order, and formula specifications are taken from this database.

**Output file** Enter a file name for the combined database.

The Output file must have a file name different from any of the Input file names.
NOTES AND LIMITATIONS

The Sort Order from the master database is carried over to the merged database. However, the records are not automatically resorted. All the records from file 1 are followed by all the records from file 2, etc. When you retrieve the merged database, you may wish to choose Perform Sort from the Records menu to resort the entire new database.

The Search Conditions from the master database are carried over to the merged database. All records are included in the merge, whether or not they meet the conditions.

Formulas are taken from the master database. If a field has a formula in the master database (is a calculated field), it must have one in all the databases. However, it need not be the same formula in the subsequent files. The merged database will use the formula from the master database to recalculate that field in the new database.

If a field doesn't have a formula in the master database, it cannot have one in any of the subsequent databases.

Local values will be carried over to the new database.

Size The merged database cannot be larger than 65,535 records.

CHANGING THE FIELD NAME ENTRY ORDER

If you need to merge databases with field names which have been entered in a different order, you must first change their order to match the order in the master database. To do so, use the Field and Sort Settings tool in the database you wish to change.

☐ Enter a series of new field names and field types which match the order in the master database. Enter any formulas that occur in the master database.

☐ Enter the appropriate old field name, preceded by an exclamation point, in the formula cells for each new field name. (This creates a converted formula, bringing the values from the old fields into the new fields and then erasing the formula.)

☐ Delete the old field names.

☐ Rename the new field names, if necessary, to match those in the master database.
PART 4

GRAPH PRINT

PRINTING GRAPHS  96

COLOR SETTINGS  98

THE GRAPH PRINT MENUS  100
The Reflex Graph Print program enables you to print graphs saved in the Graph View. You can preview the graph on the screen prior to printing. You have control over the graph size, orientation, and (if you are using a plotter) colors for each range of values.

PRINTING GRAPHS

Graphs are saved on your data disk in the Graph View. To save a graph, you choose Print from the Graph menu and enter a file name. Reflex stores the specifications for the graph in a file with the name you enter. The Graph Print program uses these specifications to instruct the printer or plotter.

The Graph Print program works like the Reflex Print Settings tool. You fill out a series of cells and checkboxes, and then Print.

To bring up the Graph Print program, select Graph Print on the Report & Utilities title screen, and press ←.

Graph Name  Enter the file name of the graph saved in the Graph View. Do not specify a file extension. Choices [F10] provides a list of graph file names in the system directory when this cell is selected.
If your graph files are in a different location, use the Global Settings tool to change the directory.

**Printer**  Enter the name of the printer or plotter attached to your computer. Choices \([F10]\) provides a list of printers and plotters when this cell is selected.

You need to establish the connection for the printer or plotter in the Global Settings tool: Serial 1, Serial 2, Parallel 1, or Parallel 2.

**Graph Size**  These checkboxes control the remaining instruction cells:

- **Full**  enters the default settings for a full-sized graph. This graph will take the entire page.
- **Half**  enters the default settings for a half-sized graph. It will take half of a page.
- **Manual**  enables you to change the default settings to adjust the height, width, margins, and rotation for a particular graph.

**NOTE**  You can change any setting by selecting the cell and changing it. The Graph Size checkbox will automatically change to Manual.

**Height**  The height of the graph, in inches.

**Width**  The width of the graph, in inches.

**Left Margin**  The space between the left side of the graph and the edge of the paper, in inches.

**Top Margin**  The space between the top of the graph and the edge of the paper, in inches.

**NOTE**  When entering a fraction of an inch, use the decimal format, e.g., 7.5 or 13.6.

**Rotate**  The orientation of the graph on the paper. Typically, a half-sized graph will not be rotated and will print out normally on the paper (Y-axis parallel to the left side of the paper, X-axis parallel to the bottom). A full-sized graph will be rotated and therefore print out sideways (Y-axis on top, X-axis parallel to the left side).
Rotated and Not Rotated graphs.

Print  Prints the graph according to the settings.

Put Away  Puts away Graph Print (returns to Report & Utilities title screen), and retains the settings until you quit from the Report & Utilities disk.

Cancel  Puts away Graph Print (returns to Report & Utilities title screen), and returns the settings to what they were when Graph Print was opened.

COLOR SETTINGS

If you are using a plotter to reproduce your graph, you will need to set color choices for different elements of the graph. Choose Color Settings from the Graph menu (/GC). The Color Settings tool will be displayed.

The Color Settings tool presents 1) a table with two columns: Range and Color; and 2) checkboxes for Fill Style and Transparency. Here you define which color to use for each data range, whether to fill bars and pie slices solidly or with hatch marks, and whether you are plotting on paper or a transparency for an overhead projector.
The Color Settings tool.

Range Displays the data ranges for the graph. The X range covers the X-axis values, the grid and scale numbers, and any graph title. The Y ranges are the fields graphed on the Y-axis. Any color entered in the Color column will print the Legend and the graphic line, bar, or slice of pie in that color.

Y-1 through Y-8 correspond to the entries in the Y-axis legend cells at the bottom of the graph.

Color Enter the pen color you will use for each range.

The Choices key [F10] provides a list of colors to be entered in these cells.

If you are using more pens than your plotter can accomodate at one time, Reflex will prompt you to place successive pens in their holders at the right time.

Fill Style Determines how your plotter will treat solid areas of the graph, i.e., bars and pieces of pie.

Solid Instructs the plotter to fill the area solidly with the color indicated in the Color table.

Hatch Instructs the plotter to fill the area with hatch lines of the color indicated in the Color table.

Transparency Typically, a plotter draws a graph on paper. If, however, you are using a plastic transparency, select the Yes checkbox. The plotter will then work properly for drawing on a transparency (i.e., more slowly).
Proceed Returns to the Graph Print screen and establishes the color settings you have entered.

Cancel Returns to the Graph Print screen and returns the color settings to what they were when the tool was opened.

THE GRAPH PRINT MENUS

There are two menu titles in the main menu line: Edit and Graph.

The Edit Menu
Delete deletes the entry in the selected cell and restores the default setting.

Window Clear deletes all the entries and restores the default setting for each cell.

The Graph Menu
Preview displays the graph on the screen. The Preview display ignores any size and orientation settings. Once the Preview screen is displayed, pressing any key returns to the Graph Print screen.

Save Settings saves the Graph Print settings, including the Color settings, permanently on the Report & Utilities disk. This command makes the current settings the new default settings.

Color Settings displays the Color Settings tool to establish instructions for use with a plotter.

Global Settings displays the Global Settings tool to make any necessary changes to the directory and printer attachment settings.

PRINTERS AND PLOTTERS

Pressing Choices [F10] when the Printer cell is selected displays a list of printers and plotters supported by Reflex.
The Printer choices include:
- Epson FX-80
- Epson FX-100
- Epson RX-80
- Epson RX-100
- Epson MX-80
- Epson MX-100
- IBM Graphics
- Okidata 84ML
- Okidata 92ML
- Okidata 93ML
- C.Itoh 8510

The Plotter choices include:
- HP 7470A
- HP 7475A
- HP 7475A (11X17)
- Six Shooter
- Six Shooter (11X17)

If you are using 11 × 17 inch paper use the plotters with (11 x 17) following the name.

**DRIVER FILE**
These graphics printers and plotters are controlled by a file on the Report and Utilities Disk, named Driver.RX. Future product upgrades may include additional printer and plotter support. When you receive your upgrade disk, simply copy the Driver.RX file from the upgrade disk to the Report and Utilities Disk. Choices [F10] will continue to display the available printers and plotters.

**NOTES AND LIMITATIONS**

A printer or plotter accepts instructions from your computer in one of two ways: either serial or parallel. Use the Global Settings tool to indicate which type you are using, and which port it is connected to.

**NOTE** Serial printers require a “baud rate” setting in DOS. See “If You Have a Serial Printer,” Appendix D, Hardware Notes.
SEVEN

APPENDICES
<table>
<thead>
<tr>
<th>Appendix</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Reflex System Parameters</td>
<td>7-2</td>
</tr>
<tr>
<td>B</td>
<td>Functions and Operators</td>
<td>7-2</td>
</tr>
<tr>
<td>C</td>
<td>Printer Setup Strings</td>
<td>7-19</td>
</tr>
<tr>
<td>D</td>
<td>Hardware Notes</td>
<td>7-20</td>
</tr>
<tr>
<td>E</td>
<td>Error Messages</td>
<td>7-22</td>
</tr>
<tr>
<td>F</td>
<td>Handy Hints</td>
<td>7-30</td>
</tr>
</tbody>
</table>
APPENDIX A

REFLEX SYSTEM PARAMETERS

RECORDS AND FIELDS
Maximum number of records in file: 65,534 (working database is limited by available memory)
Maximum number of fields in record: 128
Maximum number of characters in record: 32,512
Maximum number of characters in field: 254

CALCULATIONS
Significance: 15 digits
Smallest number: 1.7E-308 (approx.)
Largest number: 1.79E+308 (approx.)
Earliest date: 1/01/00 (January 1, 1900)
Latest date: 6/04/2079 (June 4, 2079)

INTEGER FIELD TYPE
Minimum number: -32766
Maximum number: +32767

REFLEX DOS FILE EXTENSIONS
Reflex adds the following extensions to files when they are saved
Configuration file: .RX
Database file: .RXD
Crosstab specification file: .RXC
Graph Picture (Pic) file: .RXP
Report specification file: .RXR
Translate specification file: .RXT
Print to disk file: .PRN

APPENDIX B

FUNCTIONS AND OPERATORS

ARITHMETIC OPERATORS
LOGICAL OPERATORS
ARITHMETIC OPERATORS

- Negation (makes negative)
^ Exponent (to the power of)
* Multiply
/ Divide
+ Add
- Subtract

LOGICAL OPERATORS

= Equals.
> Greater than.
>= Greater than or equal to.
< Less than.
<= Less than or equal to.
<> Not equal to
AND Combines search conditions. All of the conditions must be met.
OR Combines search conditions. Any of the conditions must be met.
NOT Creates the inverse of a condition.

RANGE OPERATORS

BTWN Entry format: X BTWN (Value1, Value2)
The BTWN operator creates a range search condition which does not include either the Low value or the High value. BTWN is shorthand for

X > Low value AND X < High value

BTWN may be used in search conditions for numeric or date fields. The Low value and High value arguments may be in any order. X, the Low value, and the High value may be numeric or date constants, fields, functions or formulas. X, the Low value, and the High value must all have the same data type.

Note that BTWN does not have an @ sign.
Examples:

Price BETWEEN (10, 20)
Meaning: Price > 10 AND Price < 20

Date BETWEEN (2/3/84, 5/3/85)
Meaning: Date > 2/3/84 AND Date < 5/3/85

Price BETWEEN (Cost - 25, Cost + 25)
Meaning: Price > Cost - 25 AND Price < Cost + 25

Date BETWEEN (7/7/84, @TODAY())
Meaning: Date > 7/7/84 AND Date < @TODAY()

(Price - Cost) BETWEEN (200, 100)
Meaning: (Price - Cost) > 100 AND (Price - Cost) < 200

125 BETWEEN (Cost, Cost + 25)
Meaning: 125 > Cost AND 125 < (Cost + 25)

DNTO Entry format: X DNTO (Value1, Value2)

The DNTO operator creates a range search condition which includes the High value but does not include the Low value. DNTO is shorthand for

X <= High value AND X > Low value

DNTO may be used in search conditions for numeric or date fields. The High value and Low value arguments may be in any order. X, the High value may be numeric or date constants, fields, functions, or formulas. X, the High value, and the Low value must all have the same data type.

Note that DNTO does not have an @ sign.

Examples:

Price DNTO (20, 10)
Meaning: Price <= 20 AND Price > 10

Date DNTO (5/3/85, 2/3/84)
Meaning: Date <= 5/3/85 AND Date > 2/3/84

Price DNTO (Cost + 25, Cost - 25)
Meaning: Price <= Cost + 25 AND Price > Cost - 25

Date DNTO (@TODAY()), 7/7/84)
Meaning: Date <= @TODAY() AND Date > 7/7/84

(Price - Cost) DNTO (100, 200)
Meaning: Price - Cost <= 200 AND (Price - Cost) > 100

125 DNTO (Cost, Cost - 25)
Meaning: 125 <= Cost AND 125 > (Cost - 25)

THRU Entry format: X THRU (Value1, Value2)

The THRU operator creates a range search condition which includes both the Low and High values. THRU is shorthand for

X >= Low value AND X <= High value

THRU may be used in search conditions for numeric or date fields. The Low value and High value arguments may be in any order. X, the Low value, and the High value may be numeric or date constants, fields, functions, or formulas. X, the Low value, and the High value, must all have the same data type.

Note that THRU does not have an @ sign.

Examples:
Price THRU (10, 20)
Meaning: Price >= 10 AND Price <= 20

Date THRU (2/3/84, 5/3/85)
Meaning: Date >= 2/3/84 AND Date <= 5/3/85

Price THRU (Cost - 25, Cost + 25)
Meaning: Price >= Cost - 25 AND Price <= Cost + 25

Date THRU (7/7/84, @TODAY())
Meaning: Date >= 7/7/84 AND Date <= @TODAY()

(Price - Cost) THRU (200, 100)
Meaning: (Price - Cost) >= 100 AND (Price - Cost) <= 200

125 THRU (Cost, Cost + 25)
Meaning: 125 >= Cost AND 125 <= (Cost + 25)

**UPTO**
Entry format: X UPTO (Value1, Value2)

The UPTO operator creates a range search condition which includes the Low value, but does not include the High value. UPTO is shorthand for

\[ X > = \text{Low value AND X < High value} \]

UPTO may be used in search conditions for numeric or date fields. The Low value and High value arguments may be in any order. X, the Low value, and the High value may be numeric or date constants, fields, functions or formulas. X, the Low value, and the High value must all have the same data type.

Note that UPTO does not have an @ sign.

**Examples:**

Price UPTO (10, 20)
Meaning: Price >= 10 AND Price < 20

Date UPTO (2/3/84, 5/3/85)
Meaning: Date >= 2/3/84 AND Date < 5/3/85

Price UPTO (Cost - 25, Cost + 25)
Meaning: Price >= Cost - 25 AND Price < Cost + 25

Date UPTO (7/7/84, @TODAY())
Meaning: Date >= 7/7/84 AND Date < @TODAY()

(Price - Cost) UPTO (200, 100)
Meaning: (Price - Cost) >= 100 AND (Price - Cost) < 200

125 UPTO (Cost, Cost + 25)
Meaning: 125 >= Cost AND 125 < (Cost + 25)

**FINANCIAL FUNCTIONS:**

@CGR
Entry format: @CGR(Present Value, Future Value, Life)

The @CGR function returns the average periodic growth rate of “Present Value” growing to “Future Value”, over “Life” number of periods. The resulting value is expressed as a decimal. To convert the value to equal the percentage increase per period multiply it times 100. Present Value, Future Value, and life may be numeric constants, numeric fields, or formulas that result in a number. Present Value may be either >, <, or = Future Value. The compound growth rate is calculated using the following formula.

\[ \text{CGR} = ((\text{Future Value} / \text{Present Value})^{(1 / \text{Life})} - 1 \]

Note: Life may not equal zero. Present value and Future value must have the same sign.
Examples:
Given  Sales: 200  
Future Sales: 234  
Periods: 2
@CGR(200, 234, 2) = .0817 or 8.17 percent per period
@CGR(Sales, Future Sales, Periods) = .0817 or 8.17 percent per period
@CGR(234, 200, 2) = -.07550 or minus 7.5 percent per period

@FV Entry format: @FV(Payment, Interest, Life)
The @FV function returns the future value of the annuity where “Payment” is invested for “Life” periods at the rate of “Interest” per period. Where Payment, Interest, and Life may be numeric constants, numeric fields, or a formula that results in a number. The payment is calculated using the following formula.

\[
FV = \frac{Payment \cdot (1 + Interest)^{(Life)} - 1}{Interest}
\]

Note: Interest must be greater than or equal to -1. For Interest equal to zero, \(FV = Payment \cdot Life\).

Example:
Given  Payment: 200  
Int: 0.12  
Periods: 5
@FV(200, .12, 5) = 1270.5695
@FV(Payment, Int, Periods) = 1270.5695

@PMT Entry format: @PMT(Principal, Interest, Life)
The @PMT function returns the fully amortized mortgage payment of borrowing “Principal” dollars at “Interest” percent per period, over “Life” number of periods. Where Principal, Interest, and Life may be numeric constants, numeric fields, or a formula that results in a number. The payment is calculated using the following formula.

\[
PMT = \frac{Principal \cdot Interest}{1 - (1 + Interest)^{(-Life)}}
\]

Note: Interest must be greater than -1. Life may not equal zero.

Example:
Given  Princ: 1000  
Int: 0.12  
Periods: 5
@PMT(Princ, Int, Periods) = 277.4097

@PV Entry format: @PV(Payment, Interest, Life)
The @PV function returns the present value of the annuity where “Payment” is received for “Life” periods and is discounted the rate of “Interest” per period. Where Payment, Interest, and Life may be numeric constants, numeric fields, or a formula that results in a number. The payment is calculated using the following formula.

\[
PV = \frac{Payment \cdot 1 - (1 + Interest)^{(-Life)}}{Interest}
\]

Note: Interest must be greater than or equal to -1. For Interest equal to zero, \(PV = Payment \cdot Life\).
Examples:
Given Payment: 277.4097
Int: 0.12
Periods: 5

@PV(277.4097, .12, 5) = 1000
@PV(Payment, Int, Periods) = 1000

MATHEMATICAL FUNCTIONS

@ABS Entry format: @ABS(X)
Returns the absolute value of X. X can be a numeric constant, numeric field, or a formula that results in a number.

Examples:
@ABS(-23) = 23
@ABS(1.23) = 1.23
@ABS(Price / 3) = absolute value of Price divided by 3

@COS Entry format: @COS(X)
Returns the trigonometric cosine of X. X is interpreted as an angle in radians. X can be a numeric constant, numeric field, or a formula that results in a number.

Examples:
@COS(4) = -.65364
@COS(Price) = cosine of the value in the Price field
@COS(@INT(Price)) = cosine of the integer value of the Price field

@EXP Entry format: @EXP(X)
Returns the value of e raised to the X power. X can be a numeric constant, numeric field, or an formula that results in a number. The function returns ERROR if X is greater than 709.85

Examples:
@EXP(2) = 7.38905
@EXP(Price) = e raised to the value in the Price field
@EXP(Price / 4) = e raised to the Price field divided by 4
@EXP(800) = ERROR

@INT Entry format: @INT(X)
Returns the integer portion of X. X can be a numeric constant, numeric field, or a formula that results in a number.

Examples:
@INT(13.6) = 13
@INT(-13.6) = -13
@INT(Price + 2) = integer portion of the product of the Price field and 2

@LN Entry format: @LN(X)
Returns the Log base e of X. X can be a numeric constant, numeric field, or a formula that results in a number. If the value of X is less than or equal to zero the function returns ERROR.

Examples:
@LN(100) = 4.60517
@LN(Price) = log base e of the value in Price field
@LN(@INT(Price)) = log base e of the integer portion of the Price field
@LN(-1) = ERROR

@LOG Entry format: @LOG(X)
Returns the Log base 10 of X. X can be a numeric constant, numeric field, or a formula that results in a number. If the value of X is less than or equal to zero the function returns ERROR.

Examples:
@LOG(100) = 2
@LOG(Price) = log base 10 of the value in Price field
@LOG(@INT(Price)) = log base 10 of the integer portion of the Price field
@LOG(-1) = ERROR

@MOD Entry format: @MOD(X, Y)
This function returns the modulus (remainder) of X divided by Y. X and Y may be numeric constants, numeric fields, or formulas that result in numbers. @MOD(X,Y) is calculated as: X - (Y * @INT(X/Y)). If Y is zero the function returns ERROR.

Examples:
@MOD(3, 2) = 1
@MOD(-6.30, 2.05) = -0.15
@MOD(Sales, 10) = the value of the Sales field modulo of the number 10
@MOD(Sales, Units) = the value of the Sales field modulo of the value of the Units field.
@MOD(3, 0) = ERROR

@PI Entry format: @PI
Returns a value equal to 3.14159265358979. Note that @PI does not take an argument.

@RAND Entry format: @RAND()
Returns a normally distributed random number greater than or equal to 0.0 and less than 1.0. The @RAND function takes an empty argument.

@ROUND Entry format: @ROUND(X, N)
Rounds off the value of X using N as the number of digits to round to. X and N may be numeric constants, numeric fields, or formulas that result in numbers. The value of N is rounded to an integer and must be within the range of -15 to +15.

Examples:
@ROUND(345.6789, -2) = 300.0000
@ROUND(345.6789, -1) = 350.0000
@ROUND(345.6789, 0) = 346.0000
@ROUND(345.6789, 1) = 345.7000
@ROUND(345.6789, 2) = 345.6800
@ROUND(345.6789, 3) = 345.6790
@ROUND(500.0000, -3) = 1000.0000
@ROUND(499.9999, -3) = 0.0000
@ROUND(Price, 2) = Rounds off the value in the Price field to two digits.
@ROUND((Price – Cost), 2) = Subtracts the value in the Cost field from the value in the Price field then rounds off the result to two digits.

@sIN
 Entry format: @sIN(X)
Returns the trigonometric sine of X. X is interpreted as an angle in radians. X can be a numeric constant, numeric field, or a formula that results in a number.

Examples:
@sIN(4) = –.756802
@sIN(Price) = sine of the value in the Price field
@sIN(@INT(Price)) = sine of the integer value of the Price field

@sQRT
 Entry format: @sQRT(X)
Returns the square root of X. X can be a numeric constant, numeric field, or a formula that results in a number. If x is negative the function returns ERROR.

Examples:
@sQRT(16) = 4
@sQRT(Price / 3) = square root of the value in the Price field divided by 3
@sQRT(–4) = ERROR

@TAN
 Entry format: @TAN(X)
Returns the trigonometric tangent of X. X is interpreted as an angle in radians. X can be a numeric constant, numeric field, or a formula that results in a number. If X = @PI/2 + @PI * n (where n is any integer), the function returns an ERROR.

Examples:
@TAN(4) = 1.157821
@TAN(Price) = tangent of the value in the Price field
@TAN(@INT(Price)) = tangent of the integer value of the Price field
@TAN(@PI / 2) = ERROR

DATE FUNCTIONS

@ADDAYS
 Entry format: @ADDAYS(Date, X)
Adds X days to the value of Date. The Date argument must be a date constant, date field, or formula that results in a date. The X argument must be a numeric constant, numeric field, or formula that results in a number. The value of X may be a positive or negative number. Using a negative number will subtract days from the Date argument. The value of X is rounded off to an integer before it is used. @ADDAYS will roll days over into proper months and years.

Examples:
@ADDAYS(2/6/85, 5) = 2/11/85
@ADDAYS(2/6/85, –5) = 2/01/84
@ADDAYS(Date, Work) = Equals the value of the Date field plus the rounded value of the Work field.
@ADDAYS(2/6/85, 25) = 3/03/85
@ADMNTHS Entry format:  @ADMNTHS(Date, X)

Adds X months to the value in Date. The Date argument must be a date constant, date field, or formula that results in a date. The X argument must be a numeric constant, numeric field, or formula that results in a number. The value of X may be a positive or negative number. Using a negative number will subtract months from the Date argument. The value of X is rounded off to an integer before it is used. Months roll over into years; but the day of the month will remain the same. The last day of a month will roll over to the last day of the resulting month (see example 2, below).

Examples:

@ADMNTHS(2/6/85, 5) = 7/6/85
@ADMNTHS(1/31/85, 1) = 2/28/85
@ADMNTHS(2/28/85, -1) = 1/28/85
@ADMNTHS(Date, Work) = Equals the value of the Date field plus the number of months in the Work field.

@ADYRS Entry format:  @ADYRS(Date, X)

Adds X years to the value in Date. The Date argument must be a date constant, date field, or formula that results in a date. The X argument must be a numeric constant, numeric field, or formula that results in a number. The value of X may be a positive or negative number. Using a negative number will subtract years from the Date argument. The value of X is rounded off to an integer before it is used. The month and day of the month will remain the same, except for a date beginning on a leap day (see example 3, below).

Examples:

@ADYRS(2/6/85, 5) = 2/6/90
@ADYRS(2/6/85, -5) = 2/6/80
@ADYRS(2/28/84, 1) = 2/28/85
@ADYRS(2/28/85, -1) = 2/28/84
@ADYRS(Date, Work) = Equals the value of the Date field plus the number of years in the Work field.

@CDATE Entry format:  @CDATE(Month, Day, Year)

The @CDATE function uses three numeric values (Month, Day, Year) to calculate a Reflex date. Reflex then evaluates that date and calculates a date value which equals the first day of that month. (The resulting value is a date.) Any or all of the arguments may be a numeric constant, numeric field, or a formula that results in a number. The result must fall within the range of 1/1/1900 and 6/4/2079. The @CDATE function is equivalent to @CMONTH(@DATE(Month,Day,Year))

Example:

@CDATE(7, 4, 84) = 7/01/84
@CDATE(Month, Day, Year) = 7/01/84 When the value in the Month field equals 7, the value in the Day field equals 1 through 30, and the value in the Year field is 1984

@CMONTH Entry format:  @CMONTH(Date)

The @CMONTH function returns a date value which equals the first day of the month for the Date. The date argument must be a date constant, date field, or formula that results in a date. The @CMONTH function can be used to summarize monthly information in situations where year-to-year monthly results need to be separated.
Example:
@CMONTH(7/4/84) = 7/01/84
@CMONTH(Date) = 7/01/84 When the value in the Date field falls anywhere in July-84
@CMONTH(@TODAY()) = 7/01/84 When the value of @TODAY() falls anywhere in July-84

@CQTR Entry format: @CQTR(Date)

The @CQTR function returns a date value which equals the first day of the first month of a given quarter. The date argument must be a date constant, date field, or formula that results in a date. The @CQTR function can be used when comparing quarters while at the same time maintaining a difference between years.

Examples:
@CQTR(1/1/85) = 1/01/85
@CQTR(3/31/85) = 1/01/85
@CQTR(4/1/85) = 4/01/85
@CQTR(8/15/85) = 7/01/85
@CQTR(@TODAY()) = The first day of the first month in the quarter in which @TODAY() falls.
@CQTR(@DATE(Month, Day, Year)) = 10/01/85 if @DATE(Month, Day, Year) equals any day in the months of October, November, or December of 1985.

@DATE Entry format: @DATE(Month, Day, Year)

The @DATE function uses three numeric values (Month, Day, Year) to calculate a Reflex date. (The resulting value is a date.) Any or all of the arguments may be a numeric constant, numeric field, or a formula that results in a number. The result must fall within the range of 1/1/1900 and 6/4/2079.

Examples:
@DATE(3, 1, 85) = 3/1/85
@DATE(Month, 1, 85) = 3/1/85 if the value in the Month field is a 3

Date Wrapping The Day and Month arguments automatically “wrap.” That is, day 32 is the first day of the next month (for 31-day months), and month 13 is the first month of the next year. This feature may be used to create a range of dates very easily.

Examples:
@DATE(12, 32, 85) = @DATE(1, 1, 86) = 1/1/86
@DATE(36, 1, 84) = @DATE(12, 1, 86) = 12/1/86

@DAY Entry format: @DAY(Date)

@DAY returns a number which represents the day of the month in which Date occurred. The numbers range from 1 through 31. The Date argument may be a date constant, date field, or a formula that results in a date.

Examples:
@DAY(2/3/85) = 3
@DAY(Date of Hire) = 11 if the Date of Hire occurred on the 11th of any month
@DAY(@TODAY()) = 5 if @TODAY() is the fifth of any month
@DAYSBTWN
Entry format: @DAYSBTWN(Date1, Date2)
Calculates the number of days between Date1 and Date2. Each Date argument must be a date constant, date field, or formula that results in a date. If the value of Date1 is greater than the value of Date2, the function will return a negative number.

Examples:
@DAYSBTWN(12/16/84, 12/19/84) = 3
@DAYSBTWN(12/19/84, 12/16/84) = -3

@MNTHSBTWN
Entry format: @MNTHSBTWN(Date1, Date2)
Calculates the number of months between Date1 and Date2. Each Date argument must be a date constant, date field, or formula that results in a date. If the value of Date1 is greater than the value of Date2, the function will return a negative number. Partial months are not counted. If, however, Date2 is the last day of the month and Date1 is greater than or equal to Date2, Reflex considers that a full month has expired. This is noted below as a "special condition."

Examples:
@MNTHSBTWN(12/16/84, 1/15/85) = 0
@MNTHSBTWN(12/16/84, 1/16/85) = 1
@MNTHSBTWN(12/18/84, 2/18/85) = 2
@MNTHSBTWN(12/19/84, 11/19/84) = -1
@MNTHSBTWN(Hire Date, @TODAY()) = The number of complete months between the value in the Hire Date field and the current date.

@MNTHSBTWN(1/29/85, 2/28/85) = 1 (special condition)

@MONTH
Entry format: @MONTH(Date)
@MONTH returns the month number in which Date occurred. The result is a number between 1 and 12. The Date argument may be a date constant, date field, or a formula that results in a date. The @CMONTH function is used to group the same months from different years.

Examples:
@MONTH(3/2/85) = 3
@MONTH(Date of Hire) = 3 if the value in the Date of Hire field is any day in March.
@MONTH(@TODAY()) = 7 if @TODAY() is any day during the month of July

Use @MONTH in conjunction with @CHOOSE to spell out the different months:

@QTR
Entry format: @QTR(Date)
@QTR returns the quarter in which Date occurs. The result is a number between 1 and 4. The Date argument may be a date constant, date field, or a formula that results in a date. The first quarter is assumed to start on January 1 and run through March 31. The @CQTR function is used to group the same quarters from different years.

Examples:
@QTR(3/2/85) = 1
@QTR(Date of Hire) = 1 if the value in the Date of Hire field occurred during the months of Jan, Feb, or March
@QTR(@TODAY()) = 3 if @TODAY() is a day during the months of July, August, or September

To represent the Quarter using a text value instead of a quarter number, enter the following formula in a text field.
@CHOOSE(@QTR(Date), “Qtr 1”, “Qtr 2”, “Qtr 3”, “Qtr 4”)

To add quarters use @QTR with @ADMNTHS as follows:
@QTR(@ADMNTHS(Date, X * 3))
where X is the number of quarters you want added.

To count complete quarters between two dates, use @MNTHSbetween as in the following:
@INT(@MNTHSbetween(Date1, Date2)/3)

If you don't want your first quarter to start on January 1, you can use the following formula to calculate the adjusted quarter.
1 + @INT(@MOD(@MONTH(Date) + 12 - Start Month, 12)/3)

Where Date is the input value from which the adjusted quarter is calculated and Start Month is a number 1 through 12 which represents the month number of the start of the first quarter.

@TODAY Entry format: @TODAY()

@TODAY() returns today's date. @TODAY() uses the date from your computer's operating system. Note that the @TODAY() function takes an empty argument.

Example:
@TODAY() = 7/4/85 (if today is July 4, 1985)

@WKDAY Entry format: @WKDAY(Date)

@WKDAY returns number which represents the day of week. The numbers range from 1 (Sunday) through 7 (Saturday). The Date argument may be a date constant, date field, or a formula that results in a date.

Examples:
@WKDAY(12/31/84) = 2 (Monday)
@WKDAY(Date of Hire) = 3 if the Date of Hire occurred on any Tuesday
@WKDAY(@TODAY()) = 5 if @TODAY() is any Thursday

Use @WKDAY in conjunction with @CHOOSE to spell out the different days of the week:
@CHOOSE(@WKDAY(Date), “Sun”, “Mon”, “Tues”, “Wed”, “Thur”, “Fri”, “Sat”)

@YEAR Entry format: @YEAR(Date)

@YEAR returns the year in which Date occurs. The result is a number between 1900 and 2079. The Date argument may be a date constant, date field, or a formula that results in a date.

Examples:
@YEAR(3/2/85) = 1985
@YEAR(Date of Hire) = 1985 if the value in the “Date of Hire” field is any date during 1985
@YEAR(@TODAY()) = 1985 if @TODAY() is any day during the 1985 calendar year

@YRSbetween Entry format: @YRSbetween(Date1, Date2)
Calculates the number of years between Date1 and Date2. Each Date argument must be a date constant, date field, or formula that results in a date. If the value of Date1 is greater than the value of Date2 the function will return a negative number. Partial years are not counted.

**Examples:**

@YRSBTWN(12/16/84, 12/15/85) = 0
@YRSBTWN(12/16/84, 12/16/85) = 1
@YRSBTWN(12/19/85, 12/19/84) = -1
@YRSBTWN(Hire Date, @TODAY()) = The number of complete years between the current date and the value in the Hire Date field.

**LOGICAL FUNCTIONS**

@IF  
Entry format: @IF(Search Condition, True Result, False Result)

If the search condition is true then the true result is returned, otherwise the false result is returned. True and false results may be constants, fields, or other formulas. The true result and false result may be any data type, but both must have the same data type.

**Example:** (Results have numeric data types)

@IF(Rep = "Bill", 20, Price * 3)  
Meaning: If the value of the Rep field equals Bill then use the number 20 otherwise use the product of the Price field and 3.

**Example:** (Results have Text data types)

@IF(Price > 20, "Buy", "Hold")  
Meaning: If the value of the Price is greater than 20 use Buy, otherwise use Hold.

**Example:** (Results have Date data types)

@IF(Price > 20, @TODAY(), 2/5/85)  
Meaning: If the value of the Price is greater than 20 use the value of the @TODAY() function, otherwise use the date constant 2/5/85.

**Example:** (Invalid because the results have different data types)

@IF(Price > 20, "Bill", 20)

@CASE  
Entry format: @CASE(Search Condition 1, Result 1, Search Condition 2, Result 2, ..., Search Condition n, Result n,)

The @CASE function is similar to the @IF function. It tests a series of search conditions. If a search condition is true then the result linked to that search condition is returned, otherwise the next search condition is tested. Reflex reads the @CASE function from left to right. You may have as many search conditions and results as will fit in a 254 character formula. All result values must have the same data types. If all search conditions fail then ERROR will display.

**Example:**

@CASE(Rep = "Ed", 20, Rep = "Ann", 25, Rep = "Joe", 40)  
Meaning: If the value of the Rep field is Ed, use 20. If the value of the Rep field is Ann, use 25. If the value of the Rep field is Joe, use 40. Else, use ERROR.

When using @CASE you will often want to define a search condition that all of your records will meet. For this “catch all” search condition use @TRUE as the last search condition.
Example:  
@CASE(Rep="Ed", 30, Rep="Ann", 25, @TRUE, 35)  
Meaning: If the value of the Rep field is Ed, use 30. If the value of the Rep field is Ann, use 25. For all other values in the "Rep" field use 35.

Example: (Invalid because the data types of the results differ.)  
@CASE(Rep="Ed", 20, Rep="Joe", "Sally")

@CHOOSE  
Entry format: @CHOOSE(X, Result1, Result2, Result3, Resultn)  
@CHOOSE is used for short table lookups. X is a number linked to a Result. If X equals 1, Result1 is used. If X equals 2, Result2 is used. The value of X must be a number between 1 and n. Values of X outside that range will cause an ERROR. If X includes a decimal, Reflex rounds off the value. X may be a numeric constant, field, or formula. The Results may be constants, fields, or formulas of any data type. However, all Results must have the same data type.

Examples:  
@CHOOSE(2, 20, 30, 40)  = 30  
@CHOOSE(1.6, 20, 30, 40)  = 30  
@CHOOSE(1, "Good", "Average", "Poor")  = Good  
@CHOOSE(Years Employed, 1, 2, 4)  = 2 if "Years Employed" = 2  
@CHOOSE(@QTR(Date), "First", "Second", "Third", "Fourth")  = "Second" (If the value of "Date" is between 4/1 of any year and 6/30 of any year)  
@CHOOSE(2, 10, "Bill", 30)  Invalid because results have differing data types.  = ERROR  
@CHOOSE(4, 10, 20, 30)

SPECIAL FUNCTIONS

@DERERROR  
Entry format: @DERERROR  
Returns the date ERROR value. @DERERROR is most often used in @IF and @CASE formulas.

Example: (As used in an @IF formula)  
@IF(Commission > 25, 7/5/84, @DERERROR)  
Meaning: If the Commission field is greater than 25 then use 7/5/84, otherwise use ERROR.

@DNULL  
Entry format: @DNULL  
Returns a blank value (a null value). @DNULL must be used when a date value is expected. @DNULL is most often used in @IF and @CASE formulas.

Example: (As used in an @IF formula)  
@IF(Date of Hire < 1/1/84, 7/5/84, @DNULL)  
Meaning: If the Date of Hire field is less than 1/1/84 use 7/5/84 otherwise, use a blank.

@ERROR  
Entry format: @ERROR
Returns the numeric ERROR value. @ERROR is most often used in @IF and @CASE formulas.

**Example:** (As used in an @IF formula)
@IF(Commission > 25, Price/10, @ERROR)
Meaning: If the Commission field is greater than 25 then use the value of Price divided by 10, otherwise use ERROR.

**@FALSE** Entry format: @FALSE

The @FALSE function is a special search condition that always evaluates as false. It will be used most often as a search condition with @IF, @CASE, and @CHOOSE formulas. @FALSE has a boolean data type. It does not result in the number 0 and may not be entered into a field as a value.

**Example:** (As used in the Condition cell in the Search Conditions tool)
@CHOOSE(Quarter, @TRUE, @TRUE, @FALSE, @FALSE)
Meaning: If the value in the Quarter field is 1 or 2, the result is the boolean TRUE condition and the record meets the condition. If the value in the Quarter field is 3 or 4, the result is the boolean FALSE condition and the record does not meet the condition.

**@ISERR** Entry format: @ISERR(field)

A Function used as a search condition to locate all records where ERROR is the field value. The @ISERR function works with numeric and date fields. (For text field errors, see below.) @ISERR may be used as a search condition in the Condition cell in the Search Conditions tool or in an @IF or @CASE formula. Cannot be used as the first condition in a conditions table cell.

**Example:** (As used in the Condition cell in the Search Conditions tool)
@ISERR(Commission)
Meaning: locate all records in which ERROR displays in the Commission field.

**Example:** (As used in an @IF formula)
@IF(@ISERR(Commission), 25, 0)
Meaning: If the Commission field contains ERROR then use 25, otherwise use 0.

**Text Fields** To locate all records with ERROR in a text field, use the search condition: **fieldname** = "ERROR"

**Examples:**
- Division = "ERROR"
- Last Name = "ERROR"

**@ISNULL** Entry format: @ISNULL(field)

A Function used as a search condition to locate all records with an empty or blank field value (a null value). The @ISNULL function works for numeric and date fields. (For null values in text fields, see below.) @ISNULL may be used as a search condition in the Condition cell in the Search Conditions tool or in an @IF or @CASE formula. Cannot be used as the first condition in a conditions table cell.

**Example:** (As used in the Condition cell in the Search Conditions tool)
@ISNULL(Commission)
Meaning: locate all records in which the Commission field is blank.
Example: (As used in an @IF formula)
@IF(@ISNULL(Commission), 25, 0)
Meaning: If the Commission field is empty then use the number 25, otherwise use the number 0.

Text Fields  To locate all records with empty or blank text field values use the search condition fieldname = ""

NOTE  This is two double quotes with no space between.

Examples:  Division = ""
Last Name = ""

@LOCALVAL  Entry format:  @LOCALVAL(Field)
Use as a search condition to locate records with a local value in “field.”

@NULL  Entry format:  @NULL
Returns a blank value (a null value). @NULL must be used in a numeric or integer field. @NULL is most often used in @IF and @CASE formulas.

Example: (As used in an @IF formula)
@IF(Commission > 25, Price/10, @NULL)
Meaning: If the Commission field is greater than 25 then use the value of Price divided by 10, otherwise use a blank.

@TRUE  Entry format:  @TRUE
The @TRUE function is a special search condition that always evaluates as true. It will be used most often as a search condition with @IF, @CASE, and @CHOOSE formulas. @TRUE has a boolean data type. It does not result in the number 1 and may not be entered into a field as a value.

Example:
@CASE(Rep="Joe", 20, Rep="Bill", 30, @TRUE, 40)
Meaning: If the value in the Rep field equals “Joe,” the result is 20; otherwise if the value in the Rep field equals “Bill,” the result is 30, otherwise use 40.

SUMMARY FUNCTIONS

The following functions are used in the Crosstab, Graph, and Report Views. They are special functions because unlike the other functions which use information from a single record, these Summary Functions refer to many records to calculate a result.

In the Crosstab View, they are entered in the Summary cell. In the Graph View, they are entered in the Summary cell in the Options tool. In the Report view, they are entered as Summary Attributes with Choices [F10].

@AVG  Averages the values in a numeric field from all records in the working database. @AVG(field) is equivalent to: @SUM(field)/@COUNT(field). If @COUNT(field)=0 then @AVG(field) will result in a null value. An ERROR in one field value will cause the overall average to be in ERROR.

Crosstab Example: Summary: @AVG  Field: Price
Reporting Example: @AVG(Price)
@COUNT Counts the number of non-blank values in a field from all records in the working database. The field may be any field type. ERROR values are counted. If no values are counted, 0 is returned.

Crosstab Examples:
- Summary: @COUNT Field: Employee#
- Summary: @COUNT Field: Last Name
- Summary: @COUNT Field: Date of Hire

Reporting Examples:
- @COUNT(Employee#)
- @COUNT(Last Name)
- @COUNT(Date of Hire)

@MAX Finds the maximum value in a numeric or date field from all records in the working database. ERROR values in the field will result in @MAX being in ERROR. If @COUNT(field) = 0 then @MAX will result in a null value.

Crosstab Example: Summary: @MAX Field: Price
Reporting Example: @MAX(Price)

@MIN Finds the minimum value in a numeric or date field from all records in the working database. ERROR values in the field will result in @MIN being in ERROR. If @COUNT(field) = 0 then @MIN will result in a null value.

Crosstab Example: Summary: @MIN Field: Price
Reporting Example: @MIN(Price)

@STD Calculates the standard deviation of all non-blank values in a numeric field from all records. Standard Deviation is the square root of the Variance. If @COUNT(field) = 0 then standard deviation will result in a blank value. ERROR values in the field will result in the Standard Deviation of ERROR.

Examples:
- Given: Three records with values in the “Price” field of 1, 25, and 60:
  - Crosstab Example: Summary: @STD Field: Price
  - Result for ALL: = 24.2258
  - Reporting Example: @STD(Price)
  - Entered in Conclusion row = 24.2258

@SUM Sums the values in a numeric field from all records in the working database. An ERROR in one field value will cause the overall sum to be in ERROR. If @COUNT(field) = 0, @SUM(field) will result in a null value.

Crosstab Example: Summary: @SUM Field: Cost
Reporting Example: @SUM(Cost)

@VAR Calculates the Variance of all non-blank values in a numeric field from all records. If @COUNT(field) = 0 then Variance will result in a null value. ERROR values in the field will result in a variance of ERROR. Variance is calculated using the “N” method: $\frac{n\Sigma x^2 - (\Sigma x)^2}{n^2}$

n is @COUNT(field)
Each x is an instance of a non-null field value in a different record.
Examples:
Given: Three records with values in the Price field of 1, 25, and 60.
Crosstab Example: Summary: @VAR Field: Price
Result for ALL: = 586.889
Report View Example: @VAR(Price)
Entered in Conclusion row: = 586.889

APPENDIX C

PRINTER SETUP STRINGS

Your printer may require special characters, called “ASCII control codes” to be entered in the Setup String cell in the Print Settings tool. Setup strings are not usually required for regular printing, but if you want to use compressed printing or italics, etc., you will need to use a setup string.

Each printer recognizes its own set of control codes. Be sure to consult your printer’s user manual for a list of control codes. Several examples of setup strings for IBM and Epson (FX) dot matrix printers are shown below.

In Reflex, the first thirty-two ASCII characters, the “control characters” (holding down the [Ctrl] key and typing the letter), must be entered as a three-digit decimal number, preceded by a backslash: (\nnn). The rest of the characters may be entered either as a typed character (see examples below) or as a three-digit decimal number preceded by a backslash.

IBM AND EPSON SETUP STRINGS

Printing type:
\015 Turns on compressed print.
\018 Turns off compressed print.
\027E Turns on emphasized print.
\027F Turns off emphasized print.
\0274 Turns on italic print.
\0275 Turns off italic print.
\027G Turns on double strike print.
\027H Turns off double strike print.
\027W1 Turns on continuous expanded printing.
\027W0 Turns off continuous expanded printing.
Type faces:
\027M  Turns on Elite characters.
\027P  Turns off Elite characters.

Horizontal line spacing:
\027p1  Turns on proportional spacing (note lower case “p”).
\027p0  Turns off proportional spacing (note lower case “p”).

Vertical line spacing
\0270  \1/8 inch line spacing.
\0271  \1/2 inch line spacing.
\0272  \1# inch line spacing.

Combined setup strings:
\0274\027E  Italic and emphasized printing.
\027M\027E  Elite and emphasized printing.
\027E\027G  Elite and double strike printing.

APPENDIX D

HARDWARE NOTES

This is a short guide to the equipment you need to work with Reflex. Consult your dealer for other compatible and equivalent systems.

PERSONAL COMPUTERS

IBM PC, XT, AT, and 100% IBM-PC compatible computers.

GRAPHICS CARDS

IBM Color/Graphics Adapter.
Hercules Graphics Card (monochrome version)

TEXT PRINTERS

Reflex uses any standard ASCII printer for all printing except Graph printing. Some popular printers are:
IBM dot matrix
Epson (FX and MX series)
C. Itoh 8510
Okitada Microline series (ML 92, ML 93, and other Epson-compatible models), and the Serial Microline series (ML 92S, and ML 93S).
Consult your dealer for other suitable dot matrix and letter-quality printers.
GRAPHICS PRINTING

Reflex requires a graphics plotter or printer device to print from the Graph View. Printers and plotters supported include:

- HP7470A
- HP7475A
- 6-Shooter
- IBM Graphics Printer
- Epson (FX and MX series)
- C. Itoh 8510
- Okidata Microline series (ML 92, ML 93, and other Epson-compatible models), and the Serial Microline series (ML 92S, and ML 93S).

MICE

Microsoft Mouse

*Use their mouse driver program dated 12/31/83 or later. Earlier versions will not work with Reflex.*

Mouse Systems Mouse

*Use their mouse driver program which emulates the Microsoft Mouse. For the IBM PC (or compatible), we recommend the MSMOUSE.COM version 3.00 B dated 9/1/84. For the IBM AT, we recommend the MSMOUSE.COM version 3.10 dated 9/25/84.*

IF YOU HAVE A SERIAL PRINTER

If you use a serial printer, you must use the Mode program (included on your DOS diskette,) to establish a set of instructions so your computer and printer can communicate. The command you enter depends entirely upon what baud rate you set in your printer and which port it is connected to.

Be certain that the baud rate you set in the computer is the same as the one you set in the printer.

Prior to running Reflex, enter the appropriate command from the chart below:

<table>
<thead>
<tr>
<th>BAUD RATE</th>
<th>DOS COMMAND (PORT #1)</th>
<th>DOS COMMAND (PORT #2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>110</td>
<td>Mode Com1:110,N,8,2</td>
<td>Mode Com2:110,N,8,2</td>
</tr>
<tr>
<td>150</td>
<td>Mode Com1:150,N,8,1</td>
<td>Mode Com2:150,N,8,1</td>
</tr>
<tr>
<td>300</td>
<td>Mode Com1:300,N,8,1</td>
<td>Mode Com2:300,N,8,1</td>
</tr>
<tr>
<td>600</td>
<td>Mode Com1:600,N,8,1</td>
<td>Mode Com2:600,N,8,1</td>
</tr>
<tr>
<td>1200</td>
<td>Mode Com1:1200,N,8,1</td>
<td>Mode Com2:1200,N,8,1</td>
</tr>
<tr>
<td>2400</td>
<td>Mode Com1:2400,N,8,1</td>
<td>Mode Com2:2400,N,8,1</td>
</tr>
<tr>
<td>4800</td>
<td>Mode Com1:4800,N,8,1</td>
<td>Mode Com2:4800,N,8,1</td>
</tr>
<tr>
<td>9600</td>
<td>Mode Com1:9600,N,8,1</td>
<td>Mode Com2:9600,N,8,1</td>
</tr>
</tbody>
</table>

(The final three parts of the command—N,8,1 or N,8,2—give the computer important instructions about how the data is to be transmitted.)

Although the commands are printed here in upper-case letters, note that lower-case letters work as well.
After starting Reflex, use the Global Settings tool to set the appropriate Connection (Parallel port #1, Parallel port #2, Serial port #1 or Serial port #2).

Consult the printer manual for instructions about setting the baud rate in the printer. Use as high a baud rate as will successfully transmit data. If you lose data while printing, set a lower baud rate. Typically, a baud rate of 1200 will work well.

The Mode command may be made part of an Autoexec.Bat file so it will be automatically given when you start your system. Consult your DOS manual for instructions.

APPENDIX E

ERROR MESSAGES

Bad field was—<expected field name>
The Report spec that you retrieved contains one or more fields that aren't in the current database. Reflex has placed "Bad Field Was" followed by the expected field name at the location where each bad field was positioned in the Named Report Spec.
Resolution: Delete the entry and enter the correct field name.

The blank row cannot be deleted
The blank row at the bottom of the List View cannot be deleted. It always exists so you may enter additional records.

Cannot have overlapping fields, move ignored
You have moved a field or title that would have overlapped another field or title. Reflex has ignored the move.
Resolution: Move the field or title again, placing it where it won't overlap other fields or titles. In Form Design, three spaces must be left to the right of any field name.

Cannot insert an item, only a space or a row
You cannot insert unless a blank space on the report is selected.
Resolution: Move or resize one of the items on the Row to leave a space between the items, then select the empty space between the two items and press the Ins Key.

Can't find device entry in driver file
The graph printing device you selected isn't supported by Reflex.
Resolution: Use choices to enter a valid printing device.

Can't open device driver file
Reflex couldn't locate the device driver file that it needs to do graph printing. The file is named Driver.RX.
Resolution: Place a copy of Driver.RX in your System Directory.

A cell or column must be selected
Because the entire Row is selected Reflex doesn't know which of the columns to resize.
Resolution: Select an individual cell then choose Set column Width again.

Circular reference in formula
You have created a formula that refers to itself. For example, if you enter
Price * 2 in the Price field, this is a circular reference.
Resolution: Modify the formula. (Formulas with a leading exclamation point can use circular reference. See “Global Replace,” Appendix F, Handy Hints.)

Column too wide for margins
One or more of the columns in the View are wider than the margins you have specified in the Print Settings.
Resolution: Either reduce the width of the columns or change the margins to allow room.

Corrupted driver file
Your driver file (Driver.RX) is corrupted.
Resolution: Place a new copy of the Driver.RX file in your working disk.

Couldn’t open Helpfile
Reflex couldn’t locate the help file (file name: HELP.RXH).
Resolution: Place a copy of the file in your system directory.

Data error (CRC)
The data on your disk is not readable. Something happened to your disk which makes it impossible to read your data.
Resolution: Use your backup version of your data files.

Delete only empty lines
You may not delete a line in Form Design that contains a field name or title.
Resolution: Move or delete the fields or titles prior to deleting the line.

Disk is full
The disk that you tried to use is full.
Resolution: Use another disk.

Drive not ready
Your disk drive isn’t ready. The drive door may be open or the drive may not contain a disk.
Resolution: Check your disk drive.

Duplicate field name
You have entered or renamed a field with the same name as another field already in the database.
Resolution: Rename the field to a unique name.

Duplicate Y-axis field defined
You attempted to enter the same field into two separate Y-Axis legend cells.
Resolution: Enter another field.

Expression has data type conflict
Reflex expressions (formulas or search conditions) may not make comparisons between two different data types nor can a formula calculate to return a value different from the field type. For example the formula:
@IF(Rep = “Ed”, 230.4, “Vacation”)
says IF the Rep field equals “Ed”, THEN place the number 230.4 in the current field, ELSE enter the word “Vacation” in the current field. This is invalid because one field cannot be both numeric and text.
Search conditions may have data type conflicts as well. For example:
20 < “Bill”
This is invalid because the number 20 may not be compared to the text value “Bill.”
Resolution: Modify the formula or search condition to remove the data type conflict.
Expression has missing or invalid component
The expression (formula or search condition) that you entered has a missing or invalid component. The cursor will be positioned at or near the error location.
Resolution: Check the spelling of field names and the spelling and proper use of Reflex functions.

Expression is too complex. Partition into smaller formulas
The formula you entered is too complex to interpret.
Resolution: Here is a simplified example of partitioning a formula into smaller formulas. Suppose the following formula is entered into a field titled "Commission":
@IF(Rep="Ed", @IF(Price > 500, 120, 230), 500)
This could be partitioned by taking the "inside" portion of the formula and placing it in another field. Do the following:
1. Add a field named "Commission2" and enter the following formula:
   @IF(Price > 500, 120, 230)
2. Change the formula in the "Commission" field to equal:
   @IF(Rep="Ed", Commission2, 500)

Expression uses undefined field
The expression (formula or search condition) references a field that is undefined.
Resolution: Define the field types of the fields used in the formula. Either enter the appropriate data in the undefined fields (Reflex will automatically set the field type), or set the field type in the Field & Sort Settings Tool.

Field definitions do not match first file's
The spelling of the field names in the files being merged don't exactly match, or the order of the fields is different (when viewed in the Field & Sort Settings tool).
Resolution: Rename or re-order fields so all names exactly match and the fields are in the same order when viewed in the Field & Sort Settings Tool. See “Merge” in Reference B.

Field has undefined data type
The field that you used in the graph is undefined.
Resolution: Use the Field & Sort Settings tool to set the field type or use another field in the graph.

Field must have numeric or integer type
The Make Ranges option in Crosstab only accepts Numeric or Integer fields.
Resolution: Use a Numeric or Integer field.

A field must be selected
You have tried to remove Local Values in the Field & Sort Settings Tool without first highlighting a field name.
Resolution: Select a field name in the Field column then choose Remove Local Values from the Fields menu.

Field name has reserved word or invalid character
Your field name contains one or more of Reflex's reserved words or characters this includes a leading or trailing blank space.
Resolution: Rename the field to remove the special characters. See “Field Specifications” in Reference A for a list of reserved words and characters.

Invalid field type
You have entered a field that doesn't work with the current summary function. Text fields can only use @COUNT. Date fields can only use @MIN, @MAX, and @COUNT.
Resolution: Use another field in the Field cell or change the function in the Summary cell.

<File Name> doesn't exist
The file that you requested doesn't exist. This error could have occurred for two reasons: 1) the file name was invalid; 2) the directory that was specified was the wrong directory or doesn't exist.
Resolution: Verify the Directory and File Name and try again. If you get this message when retrieving a named translate spec, make sure the source file is located in the same directory as when the translate spec was created.

<File Name> has an invalid format
You have attempted to retrieve a non-Reflex file that had a .RXD file name extension.
Resolution: Retrieve a valid Reflex file.

Formula too long to save
One or more formulas in your database became longer than 254 characters because a field was renamed. Reflex cannot save a database with invalid formulas.
Resolution: Shorten the field names so all formulas are less than 254 characters. Then save the database again.

Formula uses all available memory
Reflex must allocate memory to evaluate formulas. This message is notification that not enough memory is left for Reflex to evaluate the formula that you just entered.
Resolution: Remove fields, records, or formulas that are not needed. This will free up memory. Enter the formula again.

Formulas do not match first file's
This is a warning that a file you entered in the Merge tool has one or more fields that contain formulas which don't match prior fields. This occurs 1) when a file has a formula in a field where all prior files had only local values in that field; or 2) when the file has only local values in a field where all prior files contained a formula in that field.
Resolution: The file you entered cannot be merged. Exit Merge, modify the file to match the other files, and then use Merge again. Or use another file which matches the other files.

Hit premature end of file in <File Name>
The structure of the data file that you attempted to translate doesn't match the structure as defined in the Translate Table. This causes Translate to reach the end of your file while in the middle of adding a record to your database. Or part of the file that you attempted to translate is missing.
Resolution: You should do the following:
1) If performing a Text Translate check the “Go From” and “Stop On” instructions to make sure they have been specified correctly. See “Translate” in Reference B for some examples that may prove helpful.
2) Check to make sure that part of your file isn't missing. Return to DOS; at the A> prompt, enter Type <filename>. Press Ctrl S to stop the listing.

Inconsistent data in record [ ]. Continue YES NO
Occurs when Translate encounters some data that it cannot accept into a field, based on that field’s type. For example, Reflex cannot accept a text or date value into a numeric field. The record number indicates which record
in the “From File” has the inconsistent data. *This message occurs only once,*
when the first piece of inconsistent data is encountered.

**Resolution:** If you answer “YES” to the prompt Reflex will throw out the
inconsistent data value and will continue to translate. If you enter “NO”
Reflex will halt translation of the file and will return you to the Translate
Tool.

**Insufficient memory to print report**
The Reflex Report View uses a certain amount of memory to print a report.
If there isn’t enough memory to do so, this message is displayed.

**Resolution:** Simplify the Report Spec or delete some records.

**Invalid disk or directory**
The disk or directory that you specified doesn’t exist.

**Resolution:** Change the directory designation.

**Invalid field name**
You entered the name of a field that doesn’t exist into one of the cells in your
graph.

**Resolution:** Type in the name of a valid field or use Choices to pick a field
name.

**Invalid Filter for partial retrieve**
Displays when the @LOCALVAL search condition is used for a partial
retrieve.

**Resolution:** Modify the search condition to exclude the @LOCALVAL
function.

**Invalid manual scaling ranges**
The manual scaling ranges you requested resulted in all values being
removed from the graph.

**Resolution:** Change the scaling options.

**Invalid Named Translate Spec**
The Named Translate Spec that you requested is invalid. The structure of
the source file no longer matches the translate specification. This will
occur if your Translate Spec references fields that have been removed from
the source file. Or it contains one of Reflex’s invalid characters or a
leading or trailing blank space.

**Resolution:** Recreate the Translate Spec.

**Invalid or duplicate field name**
A field name that you entered in the Translate table is duplicated somewhere
in the source file. Or it contains one of Reflex’s invalid characters or a
leading or trailing blank space.

**Resolution:** Use different field name in the Translate table.

**Memory is running low. It’s a good idea to save your work**
Reflex has just allocated your memory reserve.

**Resolution:** Save your database then attempt to free-up some memory. See
“Memory Saving” in Appendix F.

**Must not be anything else on row**
When using @Newpage nothing else may be on the row in Report View.

**Resolution:** Move or delete the items that are on the same row as the
@Newpage.

**No fields included, cannot translate**
You have set the “Include?” parameter for every field in the database to NO.

**Resolution:** Set the “Include?” parameter for one or more of the fields to
equal YES.
No file name
You have selected “Print To Disk” but haven’t specified a file name.
Resolution: Enter a file name and then select Print.

No data points
No data points are displayed in the graph you have defined. One or more fields you are using has only blank values.
Resolution: Create another graph using other fields.

No For Each values
The field that you entered in the For Each cell contains only blanks. There are no For Each values to graph.
Resolution: Enter data into the field, or use another.

No room to insert, already have 500 rows
Your Form Design already uses 500 rows. You may not insert another row.
Resolution: Move some fields toward the top of the Form Design to make room for more rows.

Not a valid summary
The summary function you have entered in the Summary cell is not valid.
Resolution: Use Choices [F10] to display a list of valid summary functions.

Not all data displayed; Filter for others
You have created a Graph that contains more values than it can successfully plot. Reflex has graphed the first group of values. This can happen in one of two ways: 1) you performed a For Each and there were more than eight unique values in the For Each field; 2) you selected a Pie Chart and the data would have created too many slices in the pie.
Resolution: Set search conditions, and apply a Filter to see the other values.

Not enough memory for choices listing
There is not enough memory to display a choice list of files. Choices [F10] will display an empty choice list.
Resolution: Type the name of the file instead of using Choices, or delete some records, fields, or formulas from the database to free-up some memory.

Not enough memory:
The last action that you requested will use all available memory.
Resolution: Delete some unneeded fields, records, or formulas to free up some memory.

Not a valid file type
Occurs when you specify a file type in Translate that cannot be translated by Reflex.
Resolution: Use the Choices F10 Key to display a list of valid alternatives then choose from the list.

Nothing selected to move
You have chosen Move from the Edit menu, but the cursor is on an empty space.
Resolution: Select the object that you want to move then choose Move again.

Only Sort # fields can be “On Change”
The “On Change” attribute may be applied only to a field in the current sort order.
Resolution: Choose Change Sort Settings from the Report menu and assign a Sort # to the field.
Out of paper
Your printer is out of paper.
Resolution: Check your printer to make sure the paper is properly installed.

Past column 500
You may not move an item to a position where the right edge is past column 500.
Resolution: Move the item again but not as far to the right. Use the Position numbers at the bottom of Form Design to determine the location.

Printer error
There is a problem with the printer or the connection between the printer and the computer.
Resolution: Check your printer and the connecting cables.

Printer not ready
Your printer is turned off, off-line, unplugged, paper jammed, etc.
Resolution: Check your printer.

Reflex has run out of memory calculating the formulas in your database. The database is intact but the values may be inconsistent. Automatic recalculation has been turned off. You should delete some records, fields, or formulas before performing another recalculation.
Resolution: Delete some records, fields, or formulas to free up some memory which can be used to calculate the formulas.

Reflex is out of memory and cannot continue. If you Proceed, the File Save tool will display so you can save your database. After you save it, memory will be cleared and you will return to DOS. If you Cancel, memory will be cleared without displaying the File Save tool and you will return to DOS.
Resolution: Proceed and Save your database. Then do a Partial Retrieve to continue working with a subset of your records.

Sector not found
Your disk drive is searching for a portion of your disk that can't be found.
Resolution: Remove the diskette and insert it again. This is only a temporary expedient: have the disk drive adjusted.

Seek error
Your disk drive is attempting to read or write to an invalid area of the disk.
Resolution: Have the disk drive adjusted.

The printer port selected isn't on this computer
The port that you selected isn't on your computer. Reflex doesn't recognize the device as existing in your current hardware configuration.
Resolution: Check your hardware configuration or use another port setting.

To make an entry, first enter the field name
Occurs when you attempt to define a Reflex Type, Start On, Stop On or Include? parameter for an empty row in the Translate table.
Resolution: Enter a field name in the Reflex Field cell first.

Too close to field name or title
In Form Design, you have placed a field or title that is too close to another field or title. You must leave a minimum of three spaces between the right edge of a field name and the left edge of another field or title.
Resolution: Move the field to allow for the minimum of three characters between fields and other objects in the Form Design.

Too many fields
Reflex allows a maximum of 128 fields. You have attempted to add a 129th field.
Resolution: Delete one of the other fields.

Too many fields. Can only have 128
Your Translate specification included more than 128 fields. Reflex will translate a maximum of 128 fields.
Resolution: Set the “Include?” cell equal to “NO” for one or more fields in your Translate table.

Too many files in directory
There are too many files in the directory on the disk you tried to use.
Resolution: Use another disk or directory.

Too many sort fields
Reflex allows a maximum of 5 sort fields at one time. You have attempted to create more than five Sort # fields.
Resolution: Remove the Sort # from some other field.

The Vary could not be completed because there is not enough memory. No records were added. Proceed will display the Vary tool so that you can change the specifications to create fewer records
Reflex attempted to create the records you requested in your Vary but there wasn’t enough memory for all of the records that you requested. When Reflex realized that there wasn’t enough memory it deleted all records that it had created.
Resolution: Change the instructions in the Vary tool to create fewer records or Filter the database first.

Window too small to split that direction
You have attempted to split a window that will be too small to contain any of Reflex’s Views.
Resolution: Resize one of the other Views then split the View again.

Write protected disk
You attempted to write to a disk that is write protected. Files cannot be saved to or erased from a write-protected disk.
Resolution: Exchange the disk with a non-write protected disk or remove the write protection tab from your current disk.

Wrong number of arguments
The function used in your formula or search condition needs a different number of arguments than you have supplied. The cursor will sit at or near the location of the error.
Resolution: Check the proper use of the Reflex function. See Appendix B, Functions and Operators.

Y-Axis fields must be Numeric
You have attempted to graph a non-numeric value on the Y-axis of your graph. You may enter only Numeric or Integer fields in a Y-axis legend box.
Resolution: Use a Numeric or Integer field.
DESIGNING A FORM

There are two elements to consider when designing a Reflex form: how many fields to use, and where to place them. Placing fields is both cosmetic and practical, dealing with appearance of the form and ease of use.

The number of fields you use, however, will determine how your database is structured. It is possible design a form two different ways, each with a different number of fields, and be able to gather and store the same information.

There are essentially two ways to structure a database. We have given them the names "Normalized" and "Non-normalized."

It is important to understand the difference between these two basic form designs, because one design will lead to more flexibility in your ability to analyze and present information with the different Reflex Views while the other is less flexible.

A normalized database provides the most flexibility in analyzing the data. Each individual record (filled out form) is the smallest unit of information required to establish a unique identity for all the information on that record.

The non-normalized database tends to provide as much information as possible on each individual record. It is more difficult to break down information into different sets of relationships and summaries.

For example, if you are tracking the monthly sales of belts, shoes, and hats for the clothing accessories section in a department store, here are two ways you might design your form:

<table>
<thead>
<tr>
<th>FORM FOR NORMALIZED DATABASE</th>
<th>FORM FOR NON-NORMALIZED DATABASE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Month: Jan-84</td>
<td>Month: Jan-84</td>
</tr>
<tr>
<td>Product: Belts</td>
<td>Belts: $3,000</td>
</tr>
<tr>
<td>Sales: $3,000</td>
<td>Hats: $2,000</td>
</tr>
<tr>
<td></td>
<td>Shoes: $5,000</td>
</tr>
<tr>
<td></td>
<td>Total: $10,000</td>
</tr>
</tbody>
</table>

With the normalized database, you would enter one of the product types (belt, shoes, hat) in the Product field, and the sales amount in the Sales field. And every month you would create three records.

With the non-normalized database you would enter the sales amounts in each of the product’s fields, and have a formula calculate the total sales for the month. There would be only one record created every month.

We suggest that you use the normalized database design when possible. In so doing, you will get the most out of the analysis and reporting capabilities Reflex has to offer.

Two general rules apply when creating a normalized database:
1. The number of fields is as few as possible, and the data is spread across many records.
2. The field names tend to be more generic, with the data providing the differentiation.

Here are printouts from the List View showing the first three months data from each of the form designs shown above. Consider how you would be able to re-sort the database in more ways with the normalized database.

LIST VIEW OF NORMALIZED DATABASE

<table>
<thead>
<tr>
<th>MONTH</th>
<th>PRODUCT</th>
<th>SALES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan-85</td>
<td>Belts</td>
<td>$3,000</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Hats</td>
<td>$2,000</td>
</tr>
<tr>
<td>Jan-85</td>
<td>Shoes</td>
<td>$5,000</td>
</tr>
<tr>
<td>Feb-85</td>
<td>Belts</td>
<td>$4,000</td>
</tr>
<tr>
<td>Feb-85</td>
<td>Hats</td>
<td>$1,000</td>
</tr>
<tr>
<td>Feb-85</td>
<td>Shoes</td>
<td>$4,000</td>
</tr>
<tr>
<td>Mar-85</td>
<td>Belts</td>
<td>$2,000</td>
</tr>
<tr>
<td>Mar-85</td>
<td>Hats</td>
<td>$1,000</td>
</tr>
<tr>
<td>Mar-85</td>
<td>Shoes</td>
<td>$3,000</td>
</tr>
</tbody>
</table>

LIST VIEW OF NON-NORMALIZED DATABASE

<table>
<thead>
<tr>
<th>MONTH</th>
<th>BELTS</th>
<th>HATS</th>
<th>SHOES</th>
<th>TOTAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan-85</td>
<td>$3,000</td>
<td>$2,000</td>
<td>$5,000</td>
<td>$10,000</td>
</tr>
<tr>
<td>Feb-85</td>
<td>$4,000</td>
<td>$1,000</td>
<td>$4,000</td>
<td>$9,000</td>
</tr>
<tr>
<td>Mar-85</td>
<td>$2,000</td>
<td>$1,000</td>
<td>$3,000</td>
<td>$6,000</td>
</tr>
</tbody>
</table>

Here is a crosstab from each of the databases. With the normalized database, Reflex is able to do both the column and row headings automatically, using the Crosstab For Each command (CF). With the non-normalized database, the column headings are entered individually as "additional formulas."

The Crosstab View of the normalized database

Summary: @SUM  Field: Sales

<table>
<thead>
<tr>
<th></th>
<th>&quot;BELTS&quot;</th>
<th>&quot;HATS&quot;</th>
<th>&quot;SHOES&quot;</th>
<th>ALL</th>
</tr>
</thead>
<tbody>
<tr>
<td>M 1/01/85</td>
<td>$3,000</td>
<td>$2,000</td>
<td>$5,000</td>
<td>$10,000</td>
</tr>
<tr>
<td>o 2/01/85</td>
<td>$4,000</td>
<td>$1,000</td>
<td>$4,000</td>
<td>$9,000</td>
</tr>
<tr>
<td>n 3/01/84</td>
<td>$2,000</td>
<td>$1,000</td>
<td>$3,000</td>
<td>$6,000</td>
</tr>
<tr>
<td>t h ALL</td>
<td>$9,000</td>
<td>$4,000</td>
<td>$12,000</td>
<td>$25,000</td>
</tr>
</tbody>
</table>
The Reflex system occupies approximately 273 KB of memory. The DOS operating system occupies approximately 21 KB. Reflex uses a small amount of memory for keeping track of fields, etc., but the amount does not depend on the number of records. This will rarely exceed 1 KB, even for a complex database.

The remaining memory is available for data. The exact amount of memory (RAM) depends upon your computer. Current memory available is shown in the Global Settings tool.

To approximate the amount of memory a particular database will use, consider these factors:

- **Overhead:** 22 bytes per record
- **Numeric fields:** 8 bytes per field per record
- **Integer fields:** 2 bytes per field per record
- **Date fields:** 2 bytes per field per record
- **Text fields:** \((3 + \text{average number of characters in field})\) bytes per field per record
- **Repeating text fields:** 2 bytes per field per record + \([\text{number of unique entries} \ast (\text{average number of characters in field} + 5)]\) bytes
Calculated fields: 1 byte per record per 8 calculated fields
For example:
Number of calculated fields: Memory required:
1-8 1 byte per record
9-16 2 bytes per record
17-24 3 bytes per record
... and so on (1 byte for each additional 8 calculated fields)

Graphs: 4 bytes per record
Crosstabs: 8 bytes per result cell plus approximately 60 bytes per heading cell.

The RAMCALC file, included on the Reflex System Disk, provides a calculating form to estimate memory usage for particular applications.

3 MEMORY SAVING FEATURES

We have designed features into Reflex that can reduce the amount of memory needed for a database. This will allow you to work with more information using the same amount of your computer's memory space.

If a numeric field or a text field meets certain criteria, you can change the field type to reduce the memory usage.

CHANGE NUMERIC TO INTEGER

Use only if the numeric field contains whole numbers in the range of \(-32766\) through \(32767\).

Fields that contain only values which are whole numbers (no decimals) and in which all values fall in the range of \(-32766\) through \(+32767\) are candidates for space saving measures. You can save space by changing the field's data type from Numeric to Integer.

The following example shows two fields, one is a candidate for this field type conversion, the other is not a candidate.

<table>
<thead>
<tr>
<th>CANDIDATE</th>
<th>NOT A CANDIDATE</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>(-1050)</td>
<td>(-33000)</td>
<td>This value is below the valid range</td>
</tr>
<tr>
<td>(13)</td>
<td>(1.5)</td>
<td>This value has a decimal</td>
</tr>
<tr>
<td>(35000)</td>
<td>(38000)</td>
<td>This value is above the valid range</td>
</tr>
</tbody>
</table>

If you are working with large numbers, for example, you can enter them as multiples of 1000 in an Integer field to save memory:

<table>
<thead>
<tr>
<th>SALES [1000s]</th>
<th>SALES</th>
</tr>
</thead>
<tbody>
<tr>
<td>1550 (integer)</td>
<td>1550000 (numeric)</td>
</tr>
</tbody>
</table>

To change the field type choose Field & Sort Settings from the Records menu ([RF]), select the cell in the type column for the field and use Choices [F10] to change the entry from Numeric to Integer. Reflex will ask you to confirm the change.
Notes:
If you have any field values that use decimals, changing the field type to Integer will automatically round off the value to zero decimal places.
Any field values outside the range of $-32766$ through $+32767$ will display ERROR.

CHANGE TEXT TO REPEATING TEXT

Use only if a field has text values with many duplicated values.

If you have a text field that contains field values which repeat, you can save space by changing the field type from Text to Repeating Text. This can greatly reduce the memory required by a field. The more duplicate entries that you have, and the greater the length of the duplicate entries, the more significant the savings.

The following example shows two fields; one is a good candidate for changing Text to Repeating Text field type, the other is not.

<table>
<thead>
<tr>
<th>CANDIDATE</th>
<th>NOT A GOOD CANDIDATE</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bill Smith</td>
<td>Ed Smith</td>
<td>Only one repeating value makes this field a poor candidate</td>
</tr>
<tr>
<td>Bill Smith</td>
<td>John Jones</td>
<td></td>
</tr>
<tr>
<td>Bill Smith</td>
<td>Mary Jones</td>
<td></td>
</tr>
<tr>
<td>Mark Hill</td>
<td>Adam Johnson</td>
<td></td>
</tr>
<tr>
<td>Mark Hill</td>
<td>Bill Smythe</td>
<td></td>
</tr>
<tr>
<td>Mark Hill</td>
<td>Mark Hill</td>
<td></td>
</tr>
<tr>
<td>Mark Hill</td>
<td>Mark Hill</td>
<td></td>
</tr>
<tr>
<td>Mark Hill</td>
<td>George Brown</td>
<td></td>
</tr>
</tbody>
</table>

To change the field type, choose Field & Sort Settings from the Records menu (RF), select the cell in the type column for the field and use Choices [F10] to change the entry from Text to Repeating Text. Reflex will ask you to confirm the change.

4 SAVE A COPY OF THE DATABASE STRUCTURE WITHOUT ANY RECORDS

You may design a database with fields and useful formulas that others will want to share. Or you may wish to make an exact copy of the database structure to use for databases you will merge later on. In these situations you will want to save a copy of your database without any records.

1. First save your database to disk.
2. Choose Set Conditions from the Search menu.
3. Select the “Cell” check box and enter the following Search Condition:
   @false.
   then Proceed.
4. Choose Apply Filter from the Search Menu. All records will be filtered out.
5. Choose Keep Records from the Search menu. This deletes all the records, since they were filtered out.
6. Save this database in a Reflex file with a new file name. This new file contains an exact copy of your original database without any records.
7. You may now retrieve your previously saved database to work with all of the records again.

5 PERFORMING A GLOBAL REPLACE

Suppose you have an inventory database that has 1000 records. The Product Name field contains the names of each of your products. You have just decided to rename your DELUXE product to SUPER DELUXE. You would like a way to change all DELUXE entries in the Product Name field to SUPER DELUXE.

Enter the following formula in the Product Name field:

! = @IF(Product Name = "Deluxe", "Super Deluxe", Product Name)

This formula tells Reflex to look for the value DELUXE in the Product Name field. If DELUXE is found, SUPER DELUXE will be entered. If DELUXE is not found in the Product Name field, then the value from the Product Name field is reentered.

The exclamation point at the beginning of the formula tells Reflex to store only the value calculated by the formula, and then delete the formula.
(You cannot store a formula in a field if it refers to that field.)

6 UPDATING THE VALUE OF A FIELD

Suppose you want to increase the price of each of your products by 10 percent. You have a field named Price which contains your price information. Enter the following formula in the Price field.

! = Price * 1.10

The exclamation point at the beginning tells Reflex to calculate and store only the value, after the value has been calculated. (You cannot store a formula in a field if it refers to that field.)

7 USING THE FORM AS A CALCULATOR

You may choose to design a Form to be used as a calculator for “What If?” analyses. You enter assumptions in one or two fields and calculate results in other fields. By changing your assumptions you can see the effect on other field values.

Suppose you want to perform a production cost forecast. You want to test various values for Quantity to see the effect on resulting costs.

1. Create a Form that looks like this:
   Quantity:
   Fixed Cost:
   Unit Cost:
   Total Production Cost:
   Average Unit Cost:

2. Enter your initial “What If?” estimate for Quantity.
3. Enter formulas in the fields:
FIELD | FORMULA
---|---
Fixed Cost | = 1000000
Unit Cost | = 10 − Quantity / 20
Total Production Cost | = Fixed Cost + (Quantity * Unit Cost)
Average Unit Cost | = Total Production Cost / Quantity

4. Change the Quantity to perform different “What If?” analyses.

RETRIEVING OR TRANSLATING A RANDOM SAMPLING OF RECORDS

In working with a large amount of data you may wish to take a random sampling of that information for analysis.

This can be done by using the Condition cell in any Search Conditions tool. You can Filter for a random sample of a current Reflex database; you can Translate a random sample of records from another file (using Partial Translate); or you can Retrieve a random sample from an existing Reflex file (using Partial Retrieve).

For this example assume you want a 20 percent sampling of your entire database.

1. From the main program, choose Set Conditions from the Search menu. From Translate, select the Partial Translate button. From Retrieve File, choose Partial Retrieve from the File menu. Reflex will display the Search Conditions tool.

2. Select the “Cell” check box and enter the following Search condition:

   @RAND() < .20

   Because @RAND returns a random number between zero and one, this search condition will capture 20% of the records (20% of the random numbers will be less than .20). If you wanted a 50 percent sample you would enter @RAND() < .50 as the search condition.

3. Proceed.

   Reflex will automatically translate or retrieve 20% of the records if you have chosen Partial Translate or Partial Retrieve. From the main program, Apply a Filter.

CREATING A RANGE OF DATES WITH VARY AND @DATE

You want to create a five year sales forecast database. You will enter sales figures for each month over the next five years. You want to use Reflex to create the 60 records that you need (5 years times 12 months) automatically. Your forecast starts on January 1985 and runs through December 1989. Your Form looks like this:

Date:
Month:
Budgeted Sales:   Actual Sales:
Variance:
Comments:
1. Enter the value 1 (one) into the Month field on a single record. (Your database should contain only a single record.)
2. Enter the following formula in the Date field:
   \[ \text{@DATE(Month, 1, 85)} \]
   This formula tells Reflex to use the value in the Month field to determine the Date.
3. Choose Vary from the Records menu. Fill out the Vary tool like this:
   Field To Vary: Month
   From: 2   To: 60   By: 1
   then Proceed.
   Reflex will create one record for each month with the desired dates in the Date field.

### SHORT NOTES

#### CALCULATING THE JULIAN NUMBER OF A DATE

Reflex keeps track of dates by means of their “Julian numbers.” The Julian number of a date is simply the number of days since December 31, 1899. To turn a Reflex date into a Julian number, use the following formula:

\[ \text{@DAYSBTWN(@DNULL, Date)} \]

Where Date can be a date entry, a date field, or a formula which results in a date.

To turn a Julian number into a Reflex date, use the following formula:

\[ \text{@ADDAYS(@DNULL, Number)} \]

Where Number can be a constant, a numeric field, or a formula which results in a number.

#### CREATING A RANDOM NUMBER WITHIN A RANGE OF NUMBERS

Suppose you want to create a random number between two values. In this example you want a random number between 50 and 150.

1. Add a field named Random.
2. Enter the following formula in the Random field:
   \[ (150 - 50) \cdot \text{@RANDO} + 50 \]

#### HANDLING APPROXIMATE NUMBERS

Because of the differences between binary and decimal number systems, when computers subtract a non-whole number (such as .1) several times, the result can become an approximate number (46.59999999999 instead of 46.6). In performing a Vary with non-whole numbers, such effects are possible.

Aside from an unattractive display, a symptom of this will be when searching for a fractional number produced by Vary or a formula. The numbers created may not be exactly the ones expected. If a fixed format display is used, the numbers shown in the Form or List may even look like the ones expected, while they’re not, since the fixed format display rounds the value displayed without changing the underlying number. The edit line will, of course, display the full number when a cell is selected.

If this happens, enter the following formula in the Formula cell in the Field & Sort Settings tool:
USE THE REPORT VIEW FOR MAIL-MERGE

Although Reflex is not a word processor, many of our users have found that the Report View is particularly convenient for producing short letters to be used with a mailing list.

To do this, create a database of names, addresses, titles, etc. Then create the letter in the Report View with text labels. Use the name and address field names to place those values appropriately in the letter.

With this Report design, all the rows in the letter would be Body fields, so the whole letter would print once per record, i.e. once for each person in the mailing list. Put @Newpage at the end to start each letter on a separate page.

SOME PERFORMANCE HINTS

1. Some crosstabs will recalculate faster if the ALLs are deleted from the heading cells. If you don't need them, delete them.
2. It is faster to change field types for fields being translated when translating the file, than to change them afterwards.
3. If you have changed settings in Reflex tools, and wish to restore the default setting, select the cell and press Del. The default setting will be restored. Some settings have no value in the cell as the default.

FILE NAMES

1. Be careful to give a partial file a new file name when you save it. After a partial retrieve, the partial file has the same file name as your original file. If you don't give it a distinct file name, it will erase the original file when it is saved.
2. Valid characters Here are the valid characters that can be used in file names:

   - The letters: A—Z (upper case or lower case)
   - The numbers: 0—9
   - ( ) $ @ { } % ~ ! #
   - ' (single quote) -(hyphen) _ (underline)

   No other characters can be used.

   Reserved names The following character combinations cannot be used alone as file names. They are reserved for specific DOS functions.

   AUX CON COM1 COM2 LPT LPT2 LPT3 PRN

USING REFLEX DATABASES WITH OTHER SOFTWARE PRODUCTS

To export a Reflex database, use the Report View. Enter the fields you wish to export. Choose Export from the Attributes menu. Select the fields
and press F10 for a list of delimiters. Enter the proper delimiters from the Choices list. Print this report to disk without page breaks.

Following are examples of Reflex reports properly formatted to be printed to disk and read into several other popular software programs.

For more information on how to import files into each of these programs, consult the users guide for the program.

**WORD PROCESSING SOFTWARE**

The following procedure is used to delimit Reflex databases in the widely used “Wordstar” format.

1. Enter each item across a single Body row starting in column 1.
2. Use the Export Attribute to delimit items with a comma following. You may include an optional space following the comma if desired. The last item on a row does not have to be followed by a comma.
3. If an item contains a comma (for example, a number), use the Export Attribute to surround it with double quotes and a comma following the second quote.
4. Use the Variable Width attribute to make fields as Wide As Needed. This will make sure all of the information in a field is exported. (If a field is not set to be Wide As Needed, only the information that fits into the width of the column shown will be exported.)

![Report Design](image)

**LOTUS 1-2-3 AND SYMPHONY**

To export data in a format to be read in using the 1-2-3 Numbers or Symphony Structured option:

1. Enter each item across a single Body row starting in column 1.
2. Use the Export Attribute to surround text and date fields double quotes. You may include an optional space following the second quote if desired.
3. Separate numeric fields with a space. Use the Format Attribute to set the General display format on numeric fields. (Numeric fields surrounded by double quotes will be read in as text.)
4. Use the Variable Width attribute to make fields as Wide As Needed. This will make sure all of the information in a field is exported. (If a field is not set to be Wide As Needed, only the information that fits into the width of the column shown will be exported.)

![Report Design](image)

**dBASE II AND dBASE III**

1. Enter each item across a single Body row starting in column 1.
2. Use the Export Attribute to delimit items with a comma following. You may include an optional space following the comma if desired. The last item on a row does not have to be followed by a comma.
3. Use the Format Attribute to set General format on numeric fields.
4. Use the Variable Width attribute to make fields as Wide As Needed to make sure all of the information in a field is exported. If a field is not set
to be Wide As Needed, only the information that fits into the width of the column shown will be exported.

If a field contains a comma, the SDF option explained below should be used to export Reflex databases to dBase.

### SDF option:

dBase II and dBase III can also read ASCII files using the SDF option (Standard Data Format). SDF includes in a field all of the characters between predetermined column settings. To export data to be read in using the SDF option:

1. Enter each item across a single Body row.
2. Record the exact column positions taken by each item. Structure your dBase file to correspond to these column widths.

Items to be exported do not have to be delimited if the SDF option is used. All keyboard characters within the column widths set in dBase, including commas and quotes will be included in the field.

Items cannot be set to Wide As Needed when exporting to a file to be read in using the dBase SDF option. The SDF option reads from column position to column position.
EIGHT

INDEX
INDEX

Active View 5—6, 18
  Change 3—12-13, 35; 5—18
  Close 3—9; 5—17
  Expand 3—13; 5—18
  Resize 3—13-14; 5—18
  Shrink 3—13-14; 5—18
Add Record 5—43, 48, 112
  Added menu titles. 3—8, 12; 5—13
AND 3—47, 50; 5—118, 128-129
Apply Filter 3—48; 5—131
Approximate numbers 7—37
Arguments 5—144
Arithmetic attributes 6—41-52
Arithmetic operators 5—138-139; 7—3
Arrow keys 5—9
Ascending sort 3—37; 5—104
ASCII control codes 7—19
Attributes 6—35-52
Auto-line feed 5—86
Auto-recalc 5—85, 154-155
Auto-line feed 5—32, 46; 6—27
Automatic Column titles 5—68
Automatic Row titles 5—68
Automatic data entry see Vary

Backspace key 5—12
Backup copies 2—6-7
Bar graph 5—58
Blank column 3—53; 5—47-48, 72, 74
Blank record 3—24; 5—23, 43, 48-49
Blank row 3—62; 5—72, 74
BTWN 5—119; 7—3

Calculated fields 4—2-13; 5—134-156
  @functions 5—143-147
  Arithmetic operators 5—138-139
  Built-in functions 5—143-147
  Field & Sort Settings tool 5—97-107
  Formulas 4—3-5; 5—135-143
  Global constants 4—13; 5—143
  Local values 5—141-142, 156
  Logical operators 5—118
  Models 4—3-4, 45-50; 7—35
  Printing formulas 6—37
  Range operators 5—119
  Translating 6—65
  see Formulas

Cancel 5—19-20
Caps Lock key 5—12
Change Printer Settings 6—31-33
Change Sort Settings 6—21-22
Changing Field Names see Field names
Check boxes 5—20
Choice list 3—7-8; 4—8; 5—28-29; 6—35
Choices key [F10] 5—11, 28
Choose 3—5-6; 5—7, 13-14
Clear Database 3—14-15; 5—113
Clear Settings see Window Clear
Clear View see Window Clear
Close 5—17
Closings a View 5—17
Color settings 6—93-100
Column headings 3—32, 53-54; 5—11, 46-48
Column Select 3—52-53; 5—11, 33
Column width 3—32-33; 5—32; 6—27
Columnar Report 6—53-55
Columns
  Deleting 3—52-53; 5—32; 6—26
  Inserting 3—53; 5—32; 6—26
  Moving 3—53-54; 5—47
  Recalling 3—54, 5—48
  Show all columns 3—54, 5—48
Comparison operators see Logical operators
Condition cell 5—127, 129-130
Conditions table 3—46; 5—127-129
Connection (printer) 5—86
Constants 5—24, 135-136
  see Values, Local values
Control key 1—14; 5—12
Converting Formulas 5—155-156; 6—94; 7—35
Copy 6—29
Crosstab View 4—27-43; 5—66-80
  Additional formulas 5—77-80
  Automatic Column titles 5—68
  Automatic Row titles 5—68
  Categories 4—29, 32-34; 5—71
  Changing column width 4—41; 5—69-70
  Clearing the crosstab 5—70
  Closing 5—67

8—1
Column headings 4—31, 33-34; 5—68, 71
Creating a crosstab 4—29-35; 5—70-77
Deleting columns 5—69
Deleting rows 5—69
Display options 4—37-39; 5—76-77
Erasing on disk 5—80
Field headings 4—31, 33-34; 5—68, 71
For Each 4—32-35; 5—72-73
Index 5—77
Inserting columns 5—69
Inserting rows 4—41-42; 5—69
Make Ranges 4—39-41; 5—73-75
Numeric display formats 4—38; 5—77
Numeric ranges in headings 4—39-41; 5—73-75
Percent column 4—37-39; 5—76
Percent row 5—76
Percent total 5—76
Printing 5—91-95
Results area 5—68
Results cells 5—68
Retrieving from disk 5—80
Row headings 4—31, 33-34; 5—68, 71
Saving on disk 5—80
Scrolling 5—69
Search conditions 5—71, 75
Summary cell 4—31; 5—68, 70-71
Summary functions 4—28-29; 5—70
Cumulative attribute 6—44-48
Cumulative Bar graph 5—58-59
Currency format 5—106
Current record 5—24-25
Changing 5—25
Form View 5—43
Graph View 5—54
List View 5—45
Report View 6—23
Cursor movement keys 1—13; 3—9; 5—8, 37, 42; 6—8

Damaged diskette 2—3-4,
Data disk 3—28-29
Data entry see Entering data
Data type see Field type
Database
Fields 5—22-28
Filtered 3—48-50; 5—115, 131-132
Records 5—22-25
Retrieving 5—86-89
Saving 5—89-90
Translate 6—62-91
Working 3—48-49; 5—115
Database design 7—30
Database structure 7—30, 34

Date arithmetic 5—153
Date display formats 5—106
Date entry format 5—27
Date fields 5—27
Date functions 5—146; 7—9
Date ranges 5—111, 124
Dates (translating) 6—65
DBASE II files 6—67-69; 7—39
DBASE III files 6—67-69; 7—39
Decimal places see Precision
Default settings 7—38
see Global Settings
Delete 3—52-53, 61-63; 5—81-82; 6-26
Delete key [Del] 1—14; 5—12; 7—38
Delete Local Values 5—102, 141-142
Delete Record 3—61-63; 5—49, 112-113
Descending sort 3—37; 5—104
Design area 6—9-16
Design elements 6—9-14
Design Form 3—63; 5—36
Destination file 6—64-65
DIF files 6—69-76
Directory see Field & Sort Settings
Diskettes 2—2-5
Display attributes 6—36-41
Display formats 4—9-10; 5—105-106
Display Values ON/OFF 6—23
Ditto see Data entry
DNTO 5—119; 7—3
DOS Directories 5—82-83
DOS File extensions 5—83-84; 7—2
Edit line 3—5; 5—5
Edit mode 3—60-61; 5—30-31
Editing 3—59-67; 5—30-33
End key [End] 5—9
Enter key [Enter] 1—14; 5—12
Entering data 3—23-25, 31-35; 5—23-24
Calculated fields 5—142-143
Ditto 4—30; 5—24
Form View 3—23-25; 5—43
List View 3—31-35; 5—48
Using Vary 5—107-112
Entry format 5—27
Epson printers 5—94; 6—101; 7—19, 20
Erase File 5—90-91
Erase Named Crosstab 5—80
Erase Report Design 6—25
Erase Translate Specs 6—67
Error messages 7—22-29
Escape key [Esc] 1—14; 3—14; 5—12, 19
Exit Design 3—21-22; 5—37
Exit Reflex  see Quit
Expand  3—13; 5—18
Export attribute  6—40-41
Exporting data  6—40-41; 7—38-40

Field & Sort Settings  5—97-107
  Ascending/Descending  3—40-41; 5—104
  Changing field types  5—100-101
  Display formats  4—9-10; 5—105-106
  Field names  5—99
  Field types  5—99-101
  Formulas  5—102
  Precision  5—106-107
  Remove Local Values  5—102
  Sort order  3—36-42; 5—102-105
Field cell (Crosstab)  5—71
Field length  3—25-26; 7—2
Field names  3—18-22; 5—25,99
  Editing  3—65-67; 5—38-40
  Entering  3—19-22; 5—38
  Field types  3—26; 5—26-28, 99-101
  Form Design  3—18-22; 5—35-40
  In column headings  3—32, 53-54; 5—46-48
  In formulas  5—135-136
  In Report View  4—58-61; 6—9-10
  Reserved words and characters  5—25-26
Field specifications  5—25-28; 7—2
Field type recognition  5—27-28
Field types  3—26; 5—26-28, 99-101
  Changing  3—26-27; 5—100-101; 7—34
  Date fields  3—26; 5—27
  Errors  3—26-27; 4—8; 5—28
  First-entry recognition  5—27-28
  In formulas  5—135-136
  Integer fields  5—135-136
  Numeric fields  3—26; 5—27; 7—33
  Repeating text fields  5—100; 7—34
  Setting  5—26, 100
  Text fields  3—26; 5—27; 7—34
Fields (Translate)  6—74-75
File extensions  5—83-84; 7—2
File names  3—28-29; 7—38
Filter  3—43-49; 5—131
  Set conditions  3—43-51; 5—126-131
  Status  5—85
Filter key  [O][F5]  5—11, 131, 132
Financial format  5—106
Financial functions  5—145; 7—5
Find key  [F5]  5—11, 132
Find Record  3—43, 48; 5—132
First letter shorthand  3—6, 7; 4—64; 5—14, 29
First Record key  [O][F7]  5—11, 25
Fixed format  5—106
For Each  5—61-63, 72-73
Form Design  3—18-22; 5—35-40
  Adding field names  3—66; 4—6; 5—38
  Deleting field names  5—39
  Editing field names  3—65; 5—40
  Entering field names  3—19-21; 5—38
  Exit Design  3—21-22; 5—37
  Labels  3—65; 5—40
  Moving field names  3—63-64; 5—38
  Position numbers  3—19; 5—36
  Titles  3—65; 5—40
Form View  3—16-27; 5—40-44
  Creating a record  3—23; 5—43
  Editing data  3—59-62; 5—43
  Entering data  3—23-26; 5—43
  Fields: order of selection  5—42
  Scanning  3—25; 5—42
Format attribute  6—36-37
Formatting diskettes  2—4-5
Formulas  4—2-13; 5—134-156
  @functions  5—143-147
Arguments  5—144
  Arithmetic operators  5—138-139
  Calculating field values  5—135-138; 7—2, 35
  Constants  5—143
  Converting to local values  5—155-156; 7—35
  Date functions  5—146
  Dates in  5—142, 147-154
  Editing  5—155
  Entering  4—7-9; 5—140-141
  Field names in  5—135-136
  Financial functions  5—145
  Format of  4—2-5; 5—138
  In Report View  6—12-13
  Local values  5—141-142; 5—155-156
  Logical operators  5—118
  Mathematical functions  5—146
  Numbers in  5—142
  Operators  5—138-139
  Overriding  5—141
  Partitioning  7—24
  Precedence of operators  5—139
  Printing  6—37
  Special functions  5—147
  Text in  5—142-143
    see Calculated fields
Function keys  1—13; 5—10-11
Functions (built-in)  4—5, 11; 5—143-147
Global replace 7–35
Global Settings 5–84–86
Graph file 5–65–66; 6–96–97
Graph name 5–65–66; 6–96
Graph print 6–95–101
  Color settings 6–98–100
  Driver file 6–101
  Graph Name 6–96
  Graph Size 6–97
  Orientation 6–97
  Plotters 6–100–101
  Printer cell 6–97
  Printers 6–100–101
  Rotate 6–97
  Save Settings 6–100
Graph types 4–21–22; 5–56–59
Graph View 4–14–26; 5–49–66
  Current record 4–19–21; 5–54
  Detail records 4–19; 5–55
  For Each 4–16, 24–26; 5–61–63
  Graph area 5–50
  Graph type 4–21–22; 5–56–59
  Graphic record selection 4–19–21; 5–55
  Graphing summaries 4–15, 22–24; 5–60–61
  Grid lines 5–63, 65
  Individual records 4–18–20
  Origin 5–64
  Printing 5–65–66; 6–96–101
  Scaling 5–63–64
  Scrolling 4–19; 5–54–55
  Setting up a graph 4–16–19; 5–51–53
  Summary functions 5–60–61
  Summary graphs 4–22–24; 5–60–61
  Title 5–50, 65
  X-axis field name 4–18; 5–50, 53
  X-axis scale 5–53
  Y-axis legend cells 4–18; 5–50, 53
  Y-axis scale 5–50
Graphics card 2–2, 12; 7–20
Graphics printers 6–100–101; 7–21

Halt printing 5–95; 6–33
Hard disk 2–5, 8–9, 10–11
Hardware 2–2, 12–15; 7–20
Help disk 2–3;
Help key [F2] 5–11
Hercules graphics card 2–2, 12; 7–20
Home [Home] 5–9, 37; 6–8
Horizontal 5–16–17

IBM color/graphics adaptor 2–2, 7–20
IBM printers 5–94; 6–101; 7–19, 20

Insert 3–53, 61–63; 5–32; 6–26–27
Insert key [Ins] 5–12
Install procedure 2–7–9

Julian numbers 7–37
Justification attribute 6–36

Keep Records 5–133
Keyboard 1–12

Labels 3–65; 5–40
Last Record key [Q] 5–11, 25
Line graph 5–56–57

List View 3–30–36; 5–44–49
  Adding a record 3–62, 5–48
  Changing column width 3–32–33; 5–46
  Clearing the View 3–54; 5–48
  Current record 3–32; 5–45
  Deleting a column 3–54; 5–47
  Deleting a record 3–61–62; 5–49
  Editing data 3–59–63; 5–48
  Entering data 3–33–35; 5–48
  Inserting a column 3–53; 5–47
  Inserting a row 3–62–63; 5–48–49
  Moving a column 3–53–54; 5–47
  Selecting a column 3–53; 5–46
  Show all fields 3–54; 5–48
Local values 5–124, 141
  Convert formula to 5–155–156
  Delete local values 5–102, 141–142
Logical functions 5–147; 7–14
Logical operators 3–51; 5–118; 7–3
Lotus 1-2-3 files 6–69–76; 7–39

Mail merge 7–38
Mailing labels 6–61
Main menu line 3–5; 5–5
Main menu titles
  Added menu titles 3–8, 12; 5–13
Make Ranges 4–39–41; 5–71, 73–75
Mathematical functions 5–146; 7–7
Memory usage 5–85; 7–32
Merge 6–92–94
Message line 3–5; 5–5
Method of entry 5–127
Models 4–3–4, 45–50; 7–35
Mouse 1–15; 5–9–10
  Choose 3–6; 5–10
  Moving objects with 3–33, 64; 5–38
  Pointer 1–15; 5–9
  Press-and-hold 5–10
  Select 3–7; 5–10
Types 7–21
Move 6—28
Move field 3—63-64; 5—38

Naming fields see Field names
Next Record key \[F7\] 5—11, 25
Non-normalized database 7—30
Normal Retrieve 5—89
Normalized database 7—30
NOT 5—118
Null 5—124-125
Num Lock key 5—12
Numeric fields 5—27; 7—33

On Change/All attribute 4—67-68; 6—37-38
Opening a View 5—16
Opening multiple Views 3—10-12, 34-35; 4—20; 5—16-17
Split screen 3—11-12, 34-35
Operating system (DOS) 2—2
Operators 5—116-119, 138-139
Options (Crosstab) 5—76-77
Options (Graph) 5—60-61, 65
Options (Print) 5—95
OR 3—49-50; 5—118
OR column 5—128-129

Page down 5—9, 37; 6—8
Page left 5—9, 37; 6—8
Page right 5—9, 37; 6—8
Page up 5—9, 37; 6—8
Partial Retrieve 5—87-89; 7—36
Partial Translate 6—65-66; 7—36
Percent of Total attribute 6—48-52
Perform Sort 5—113
PFS files 6—67-69
Pie chart 5—59
Planning 4—44-50; 7—35
Plotters 6—100-101
Pop-down menus 3—5-6; 5—13
Position numbers 5—37; 6—5
Precision 5—106-107
Precision attribute 6—37
Preview Graph 6—100
Preview on Screen 6—20-21
Preview Report 6—20-21
Previous Record key \[F8\] 5—11, 25
Print 5—91-95
Print (Graph) 5—65-66; 6—96-101
Print settings 5—91-95; 6—31-33
Print-screen key 2—12-14
Printer connection 5—86-7—21
Printer setup strings 5—94-95; 7—19
Printers 6—100-101; 7—20

Printing 3—55-58; 5—91-95
Effect of Filters 5—95
Formulas 6—37
Graph View 5—65-66; 6—96-101
Halt printing 5—95; 6—33
Margins 3—57; 5—92-93
Page length 3—57; 5—92-93
Report View 6—31-33
Save Settings 5—95
Proceed 3—8; 5—19-20
Put Away 5—19-20; 5—95

Quick Proceed 3—58; 4—39; 5—19
Quit 3—15; 6—25

Random numbers 5—126; 7—37
Random sample 5—125-126; 7—36
Range operators 5—119; 7—3
Recalc key \[F9\] 5—11
Recalculation 5—85, 154-155
Records 3—23-25; 5—22-25; 7—2
Adding 3—23-25
Blank 3—24
Creating 5—23
Editing 5—30-33
Entering 5—23-24
First 5—25
Last 5—25
Next 5—25
Previous 5—25
Record keys 3—24-25; 5—11, 25
Scanning 3—25
Sorting 5—103-105
Status 5—85
Reflex menus 5—12
Reflex screen 3—5; 5—4-5
Remove Filter 5—132
Renaming fields 5—99
Replace 3—10-11; 5—16-17
Report & Utilities disk 2—2, 11; 4—53
Report View 4—50-74; 6—2-61
Attributes 6—7, 9, 13-14, 35-52
Change Printer Settings 4—73; 6—8, 31-33
Change Sort Settings 6—21-22
Design area 4—55; 6-5
Design elements 6—9-16
Display values 6—23
Edit menu in 6—26-29
Erase Report Design 6—25
Erase Field names 4—59-61; 6—9-10
Formulas 6—12-13, 60
Global Settings 6—34
Position numbers 6-5
Preliminary steps 4-57-59; 6-6
Preview on Screen 6-5-6, 20-21
Print report 6-8, 31
Quit 6-25
Retrieve database 4-57-58; 6-30
Preview on Screen 6-5-6, 20-21
Print report 6-8, 31
Quit 6-25
Retrieve database 4-57-58; 6-30
Retrieve Report Design 6-24-25
Row flags 4-59-63; 6-17-19
Save report design 4-74; 6-21-22
Search menu in 6-34
Sort fields 6-16, 6-21-22
Sort Settings 4-58-59; 6-21-22
Special fields 6-11-12
Subtotals 4-61-64; 6-14-16, 18-19, 43-44, 47-48, 51-52
Summaries 6-14-16
Text 4-64-68; 6-10-11
Titles 4-64-66; 6-10-11
Totals 6-43-44
When Printed Column 4-55; 6-5, 7, 17-19
Reserved words and characters 5-25-26
Resize 3-13-14; 5-18
Retrieve Crosstab 5-80
Retrieve File 3-4-8; 5-86-89
Retrieve Report Design 6-24-25
Retrieve Translate Spec 6-66-67
Row 5-32-33
Row flags 4-57, 62-63; 6-7, 17-19
Body 6-17
Conclusion 6-17
Entering 6-19
Footer 6-17
Header 6-17
Intro 6-17
Sort field row flags 6-17-19
Row Select 5-33, 6-27-28
Save Crosstab 5-80
Save file 3-27-29; 5-89-90
Save Report Design 6-23-24
Save settings (global) 5-86
Save settings (print) 5-95; 6-100
Save Translate Spec 6-66-67
Scaling (Graph) 5-63-64
Scatter graph 5-57
Scientific format 5-106
Scrolling 3-11; 5-7-8
Search Conditions 3-43-51; 5-115-126
Operators 5-117-119
AND 3-47; 5-128-129
Condition cell 5-129-130
Conditions as written 5-130-131
Conditions table 3-46-47; 5-127-129
Date 5-124
Numeric 5-123
Opposite of conditions 5-130-131
OR 3-49-50; 5-128-129
Setting 3-45-48; 5-126-131
Special conditions 5-124-125
Text 5-120-123
Search criteria see Search Conditions
Select 3-9; 5-7
Serial printers 7-21
Set Column Width 3-32-33; 5-32; 6-27
Set Conditions 5-126
Shift key 5-12
Shrink 3-13; 5-18
Significance (in calculating) 5-107; 7-2
Slash key 5-12
Sort Fields 5-103-104
Sort order 3-36-42; 5-102-105; 6-21-22
Ascending 3-37; 5-104
Descending 3-37; 5-104
Primary sort field 3-37, 40-41; 5-103
Secondary sort field 3-37, 41-42; 5-103-104
Sort Settings 6-21-22
Source file 6-64-65
Special fields 6-11-12
Special functions 5-124, 147; 7-15
Split Screen see Opening Multiple Views
Stacked Bar graph see Cumulative Bar graph
Starting Reflex 2-9-11
Status 5-85
Summary attribute 4-61-62; 6-41-44
Summary cell 5-60, 68, 70
Summary functions 5-60-61, 70; 6-42; 7-17
Summary Report 6-56-57
Symphony files 6-69-76; 7-39
System directory 5-83, 85-86
System disk 2-2,
System parameters 7-2
Tab key [S] 5-9
Text (ASCII) files 6-76-91
Text fields 5-27, 100-101
THRU 5-119; 7-4
Titles (in Graph) 5-65
Titles (in Printing) 3-55-56; 5-92
Titles (in Report) 4-65; 6-10-11
Tools 5-6, 19-20
Translate 6-62-91
1-2-3 files 6-69-76
DBASE II files 6-67-69
EIGHT

DBASE III files 6-67-69
DIF files 6-69-76
Partial 6-65-66
PFS files 6-67-69
Symphony files 6-69-76
Text (ASCII) files 6-76-91
Translate specifications 6-66
Type menu (Graph View) 5-56
Types (Translate) 6-75

Updating a field 7-35
Updating a field 5-90
UPTO 5-119; 7-5
Use as entered 5-130-131
Use opposite 5-130-131

Values 5-116-119, 135-136, 138-139, 143-147; 6-9, 12, 42-49, 65
see Local values

Variable Width attribute 4-70-71; 6-38-40
Vary 4-44-50; 5-107-112
Date fields 4-50, 5-111
Effect on original records 5-110-111
Enter range of numbers 4-48; 5-111
Field to Vary 4-48; 5-109
Numeric fields 4-48; 5-111
Text fields 4-50; 5-111-112
Vary current record/all records 5-110

Vertical 3-12; 5-16-17
View label 5-18
Views 5-5, 16

When Printed column 6-17-19
Wildcard text matching 5-120-123
Window 5-5, 16
Window Clear 5-33; 6-29
Windows area 5-5, 16
Working database 3-48-49; 5-131

@Functions

@ABS 5-146; 7-7
@ADDAYS 5-146, 154; 7-9
@ADMNTHS 5-146, 154; 7-10
@ADYRS 5-146, 154; 7-10
@AVG 5-60, 70; 6-42; 7-17
@CASE 5-147; 7-14
@CDATE 5-146, 148; 7-10
@CGR 5-145; 7-5
@CHOOSE 5-147; 7-15
@CMONTH 5-146, 148-155; 7-10

INDEX

@COS 5-146; 7-7
@COUNT 5-60, 70; 6-42; 7-13
@CQTR 5-146, 148; 7-11
@DATE 5-146; 7-11
@DAY 5-146, 148; 7-11
@DAYSBTWN 5-146, 153; 7-12
@ERROR 5-147; 7-15
@ERROR 5-147; 7-15
@EXP 5-146; 7-7
@FALSE 5-125; 7-16
@FV 5-145; 7-6
@IF 4-10-12; 5-147; 7-14
@INT 5-146; 7-7
@ISERR 5-124, 130, 147; 7-16
@ISNULL 5-124, 130, 147; 7-16
@LN 5-146; 7-7
@LOCALVAL 5-124, 130; 7-17
@LOG 5-146; 7-8
@MAX 5-60, 70; 6-42; 7-18
@MIN 5-60, 70; 6-42; 7-18
@MTNSBTWN 5-146, 153; 7-12
@MOD 5-146; 7-8
@MONTH 5-146, 148-153; 7-12
@Newpage 6-11
@Now 6-11
@NULL 5-147; 7-17
@PageNo 6-11
@PI 5-146; 7-8
@PMT 5-145; 7-6
@PV 5-145; 7-6
@QTR 5-146, 148; 7-12
@RAND 5-125-126, 146; 7-8, 36, 37
@ROUND 5-146; 7-8
@SIN 5-146; 7-9
@SQRT 5-146; 7-9
@STD 5-61, 70; 6-42; 7-18
@SUM 5-60, 70; 6-42; 7-18
@TAN 5-146; 7-9
@TODAY 5-146; 6-11; 7-13
@TRUE 7-17
@VAR 5-61, 70; 6-42; 7-18
@WKDAY 5-146, 148; 7-13
@YEAR 5-146, 148; 7-13
@YRSBTWN 5-146, 153; 7-13
CATALOG OF BORLAND PRODUCTS

As of August 1, 1985

Available at better dealers nationwide. Call (800) 556-2283 for the dealer nearest you. To order by Credit Card call (800) 255-8008, CA (800) 742-1133
Whether you're running WordStar™, Lotus™, dBase™, or any other program, SIDEKICK puts all these desktop accessories at your fingertips. Instantly.

A full-screen WordStar-like Editor You may jot down notes and edit files up to 25 pages long.

A Phone Directory for your names, addresses and telephone numbers. Finding a name or a number becomes a snap.

An Autodialer for all your phone calls. It will look up and dial telephone numbers for you. (A modem is required to use this function.)

A Monthly Calendar functional from year 1901 through year 2099.

A Datebook to remind you of important meetings and appointments.

A full-featured Calculator ideal for business use. It also performs decimal to hexadecimal to binary conversions.

An ASCII Table for easy reference.

All the SIDEKICK windows stacked up over Lotus 1-2-3. From bottom to top: SIDEKICK'S "Menu Window," ASCII Table, Notepad, Calculator, Datebook, Monthly Calendar and Phone Dialer.

Here's SIDEKICK running over Lotus 1-2-3. In the SIDEKICK Notepad you'll notice data that's been imported directly from the Lotus screen. In the upper right you can see the Calculator.

The Critics' Choice

"In a simple, beautiful implementation of WordStar's™ block copy commands, SIDEKICK can transport all or any part of the display screen (even an area overlaid by the notepad)" to the notepad."

—Charles Petzold, PC MAGAZINE

"SIDEKICK is by far the best we've seen. It is also the least expensive." —Ron Mansfield, ENTREPRENEUR

"If you use a PC, get SIDEKICK. You'll soon become dependent on it." —Jerry Pournelle, BYTE

"SIDEKICK deserves a place in every PC."

—Garry Ray, PC WEEK

SIDEKICK IS AN UNPARALLELED BARGAIN AT ONLY $54.95 (copy-protected) OR $84.95 (not copy-protected)

Minimum System Configuration: SIDEKICK is available now for your IBM PC, XT, AT, PCjr., and 100% compatible microcomputers. The IBM PC jr. will only accept the SIDEKICK not copy-protected version. Your computer must have at least 128K RAM, one disk drive and PC-DOS 2.0 or greater. A Hayes™ compatible modem, IBM PCjr.™ internal modem, or AT&T® Modem 4000 is required for the autodialer function.

SIDEKICK and SuperKey are registered trademarks of Borland International Inc. dBase is a trademark of Ashton-Tate. IBM is a registered trademark and PCjr. is a trademark of International Business Machines Corp. AT&T is a registered trademark of American Telephone & Telegraph Company. Infoworld is a trademark of Popular Computing, Inc., a subsidiary of CW Communications Inc. Lotus 1-2-3 is a trademark of Lotus Development Corp. WordStar is a trademark of Micropro International Corp. Hayes is a trademark of Hayes Microcomputer Products, Inc.
SuperKey turns 1,000 keystrokes into 1!

Yes, SuperKey can record lengthy keystroke sequences and play them back at the touch of a single key. Instantly. Like Magic.

Say, for example, you want to add a column of figures in 1-2-3. Without SuperKey you’d have to type seven keystrokes just to get started. ["shift-@-s-u-m-shift-{"] With SuperKey you can turn those 7 keystrokes into 1.

SuperKey keeps your ‘confidential’ files...CONFIDENTIAL!

Time after time you’ve experienced it: anyone can walk up to your PC, and read your confidential files (tax returns, business plans, customer lists, personal letters...). With SuperKey you can encrypt any file, even while running another program. As long as you keep the password secret, only YOU can decode your file. SuperKey implements the U.S. government Data Encryption Standard (DES).

SuperKey helps protect your capital investment.

SuperKey, at your convenience, will make your screen go blank after a predetermined time of screen/keyboard inactivity. You’ve paid hard-earned money for your PC. SuperKey will protect your monitor’s precious phosphor...and your investment.

SuperKey protects your work from intruders while you take a break.

Now you can lock your keyboard at any time. Prevent anyone from changing hours of work. Type in your secret password and everything comes back to life...just as you left it.

SUPERKEY is now available for an unbelievable $69.95 (not copy-protected).

Minimum System Configuration: SUPERKEY is compatible with your IBM PC, XT, AT, PCjr. and 100% compatible microcomputers. Your computer must have at least 128K RAM, one disk drive and PC-DOS 2.0 or greater.
If you use an IBM PC, you need Turbo Lightning™

Turbo Lightning™ teams up with the Random House Spelling Dictionary® to check your spelling as you type!

Turbo Lightning, using the 83,000-word Random House Dictionary, checks your spelling as you type. If you misspell a word, it alerts you with a 'beep'. At the touch of a key, Turbo Lightning opens a window on top of your application program and suggests the correct spelling. Just press ENTER and the misspelled word is instantly replaced with the correct word. It's that easy!

Turbo Lightning works hand-in-hand with the Random House Thesaurus® to give you instant access to synonyms.

Turbo Lightning lets you choose just the right word from a list of alternates, so you don't say the same thing the same way every time. Once Turbo Lightning opens the Thesaurus window, you see a list of alternate words, organized by parts of speech. You just select the word you want, press ENTER and your new word will instantly replace the original word. Pure magic!

If you ever write a word, think a word, or say a word, you need Turbo Lightning.

Turbo Lightning's intelligence lets you teach it new words. The more you use Turbo Lightning, the smarter it gets!

You can also teach your new Turbo Lightning your name, business associates' names, street names, addresses, correct capitalizations, and any specialized words you use frequently. Teach Turbo Lightning once, and it knows forever.

Turbo Lightning™ is the engine that powers Borland's Turbo Lightning Library™. Turbo Lightning brings electronic power to the Random House Dictionary® and Random House Thesaurus®. They're at your fingertips — even while you're running other programs. Turbo Lightning will also 'drive' soon-to-be-released encyclopedias, extended thesauruses, specialized dictionaries, and many other popular reference works. You get a head start with this first volume in the Turbo Lightning Library.

And because Turbo Lightning is a Borland product, you know you can rely on our quality, our 60-day money-back guarantee, and our eminently fair prices.

Suggested Retail Price: $99.95 Not copy-protected

BORLAND INTERNATIONAL

IBM, PC, XT, AT, and PCjr. are registered trademarks of International Business Machines Corp. Lotus 1-2-3 is a registered trademark of Lotus Development Corporation. WordStar is a registered trademark of MicroPro International Corp. dBase is a registered trademark of Ashton-Tate. Microsoft is a registered trademark of Microsoft Corporation. SideKick is a registered trademark and Turbo Lightning and Turbo Lightning Library are trademarks of Borland International. Random House Dictionary and Random House Thesaurus are registered trademarks of Random House Inc. Reflex is a trademark of BORLAND/Analytica Inc. MultiMate is a trademark of MultiMate International Inc.

Minimum System Requirements: 128K IBM PC® or 100% compatible computer, with 2 floppy disk drives and PC-DOS (MS-DOS) 2.0 or greater.
SideKick, the Macintosh Office Manager, brings information management, desktop organization and telecommunications to your Macintosh. Instantly, while running any other program.

A full-screen editor/mini-word processor lets you jot down notes and create or edit files. Your files can also be used by your favorite word processing program like MacWrite™ or MicroSoft® Word™.

A complete telecommunication program sends or receives information from any on-line network or electronic bulletin board while using any of your favorite application programs. A modem is required to use this feature.

A full-featured financial and scientific calculator sends a paper-tape output to your screen or printer and comes complete with function keys for financial modeling purposes.

A convenient “Things-to-Do” file reminds you of important tasks.

A convenient alarm system alerts you to daily engagements.

A phone log keeps a complete record of all your telephone activities. It even computes the cost of every call. Area code hook-up provides instant access to the state, region and time zone for all area codes.

An expense account file records your business and travel expenses.

A credit card file keeps track of your credit card balances and credit limits.

A report generator prints-out your mailing list labels, phone directory and weekly calendar in convenient sizes.

A convenient analog clock with a sweeping second-hand can be displayed anywhere on your screen.

On-line help is available for all of the powerful SIDEKICK features.

Best of all, everything runs concurrently.

SIDEKICK, the software Macintosh owners have been waiting for.

SideKick, Macintosh’s Office Manager is available now for $84.95 (not copy-protected).

Minimum System Configuration: SIDEKICK is available now for your Macintosh microcomputer in a format that is not copy-protected. Your computer must have at least 128K RAM and one disk drive. Two disk drives are recommended if you wish to use other application programs. A Hayes-compatible modem is required for the telecommunications function. To use SIDEKICK’S autodialing capability you need the Borland phone-link interface. See inside for details.
THE CRITICS’ CHOICE:

"Language deal of the century . . . Turbo Pascal: it introduces a new programming environment and runs like magic."
—Jeff Duntemann, PC Magazine

"Most Pascal compilers barely fit on a disk, but Turbo Pascal packs an editor, compiler, linker, and run-time library into just 39K bytes of random-access memory."
—Dave Garland, Popular Computing

“What I think the computer industry is headed for: well - documented, standard, plenty of good features, and a reasonable price.”
—Jerry Pournelle, BYTE

THE FEATURES:

One-Step Compile: No hunting & fishing expeditions! Turbo finds the errors, takes you to them, lets you correct, then instantly recompiles. You’re off and running in record time.

Built-in Interactive Editor: WordStar-like easy editing lets you debug quickly.

Automatic Overlays: Fits big programs into small amounts of memory.

Microcalc: A sample spreadsheet on your disk with ready-to-compile source code.


LOOK AT TURBO NOW!

☐ More than 400,000 users worldwide.

☐ TURBO PASCAL is proclaimed as the de facto industry standard.

☐ TURBO PASCAL PC MAGAZINE’S award for technical excellence.

OPTIONS FOR 16-BIT SYSTEMS:

8087 math co-processor support for intensive calculations.

Binary Coded Decimals (BCD): Eliminates round-off error! A must for any serious business application. (No additional hardware required.)

Turbo Pascal 3.0 is available now for $69.95.

Options: Turbo Pascal with 8087 or BCD at a low $109.90. Turbo Pascal with both options (8087 and BCD) priced at $124.95.

MINIMUM SYSTEM CONFIGURATION: To use Turbo Pascal 3.0 requires 64K RAM, one disk drive, Z-80, 8088/86, 80186 or 80286 microprocessor running either CP/M-80 2.2 or greater, CP/M-86 1.1 or greater, MS-DOS 2.0 or greater or PC-DOS 2.0 greater, MS-DOS 2.0 or greater or PC-DOS 2.0 or greater. A XENIX version of Turbo Pascal will soon be announced, and before the end of the year, Turbo Pascal will be running on most 68000-based microcomputers.
LEARN PASCAL FROM THE FOLKS WHO INVENTED TURBO PASCAL® AND TURBO DATABASE TOOLBOX®.

Borland International proudly introduces Turbo Tutor®. The perfect complement to your Turbo Pascal compiler. Turbo Tutor is really for everyone—even if you've never programmed before.

And if you're already proficient, Turbo Tutor can sharpen up the fine points. The 300 page manual and program disk divides your study of Pascal into three learning modules:

FOR THE NOVICE: Gives you a concise history of Pascal, tells you how to write a simple program, and defines the basic programming terms you need to know.

ADVANCED CONCEPTS: If you're an expert, you'll love the sections detailing subjects such as "how to use assembly language routines with your Turbo Pascal programs."

PROGRAMMER'S GUIDE: The heart of Turbo Pascal. This section covers the fine points of every aspect of Turbo Pascal programming: program structure, data types, control structures, procedures and functions, scalar types, arrays, strings, pointers, sets, files and records.

A MUST. You'll find the source code for all the examples in the book on the accompanying disk ready to compile.

Turbo Tutor may be the only reference on Pascal and programming you'll ever need!

TURBO TUTOR—A REAL EDUCATION FOR ONLY $34.95.

(not copy-protected)

*Minimum System Configuration: TURBO TUTOR is available today for your computer running TURBO PASCAL for PC-DOS, MS-DOS, CP/M-80, and CP/M-86. Your computer must have at least 128K RAM, one disk drive and PC-DOS 1.0 or greater, MS-DOS 1.0 or greater, CP/M-80 2.2 or greater, or CP/M-86 1.1 or greater.
Dazzling graphics and painless windows.
The Turbo Graphix Toolbox™ will give even a beginning programmer the expert's edge. It's a complete library of Pascal procedures that include:

- Full graphics window management.
- Tools that allow you to draw and hatch pie charts, bar charts, circles, rectangles and a full range of geometric shapes.
- Procedures that save and restore graphic images to and from disk.
- Functions that allow you to precisely plot curves.
- Tools that allow you to create animation or solve those difficult curve fitting problems.

No sweat and no royalties.
You can incorporate part, or all of these tools in your programs, and yet, we won't charge you any royalties. Best of all, these functions and procedures come complete with source code on disk ready to compile!

John Markoff & Paul Freiberger, syndicated columnists:
"While most people only talk about low-cost personal computer software, Borland has been doing something about it. And Borland provides good technical support as part of the price."

**Turbo Graphix Toolbox—only $54.95 (not copy protected).**

Minimum System Configuration: Turbo Graphix Toolbox is available today for your computer running Turbo Pascal 2.0 or greater for PC-DOS, or truly compatible MS-DOS. Your computer must have at least 128K RAM, one disk drive and PC-DOS 2.0 or greater, and MS-DOS 2.0 or greater with IBM Graphics Adapter or Enhanced Graphics Adapter, IBM-compatible Graphics Adapter, or Hercules Graphics Card.
Build your own lightning-fast editor and incorporate it into your Turbo Pascal programs. Turbo Editor Toolbox gives you easy-to-install modules. Now you can integrate a fast and powerful editor into your own programs. You get the source code, the manual and the know how.

To demonstrate the tremendous power of Turbo Editor Toolbox, we give you the source code for two sample editors:

**Simple Editor**
A complete editor ready to include in your programs. With windows, block commands, and memory-mapped screen routines.

**MicroStar™**
A full-blown text editor with a complete pull-down menu user interface, plus a lot more. Modify MicroStar's pull-down menu system and include it in your Turbo Pascal programs.

The Turbo Editor Toolbox gives you all the standard features you would expect to find in any word processor:

- Word wrap
- UNDO last change
- Auto indent
- Find and Find/Replace with options
- Set left and right margin
- Block mark, move and copy.
- Tab, insert and overstrike modes, centering, etc.

And Turbo Editor Toolbox has features that word processors selling for several hundred dollars can't begin to match. Just to name a few:

- **RAM-based editor.** You can edit very large files and yet editing is lightning fast,
- **Memory-mapped screen routines.** Instant paging, scrolling and text display.
- **Keyboard installation.** Change control keys from WordStar-like commands to any that you prefer.

Best of all, source code is included for everything in the Editor Toolbox. Use any of the Turbo Editor Toolbox's features in your programs. And pay no royalties.

Minimum system configuration: The Turbo Editor Toolbox requires an IBM PC, XT, AT, 3270, PCjr or true compatible with a minimum 192K RAM, running PC-DOS (MS-DOS) 2.0 or greater. You must be using Turbo Pascal 3.0 for IBM and compatibles.

**Suggested Retail Price $69.95**
(not copy-protected)
Secrets And Strategies Of The Masters Are Revealed For The First Time

Explore the world of state-of-the-art computer games with Turbo GameWorks™. Using easy-to-understand examples, Turbo GameWorks teaches you techniques to quickly create your own computer games using Turbo Pascal®. Or, for instant excitement, play the three great computer games we’ve included on disk—compiled and ready-to-run.

TURBO CHESS

Test your chess-playing skills against your computer challenger. With Turbo GameWorks, you’re on your way to becoming a master chess player. Explore the complete Turbo Pascal source code and discover the secrets of Turbo Chess.

“What impressed me the most was the fact that with this program you can become a computer chess analyst. You can add new variations to the program at any time and make the program play stronger and stronger chess. There’s no limit to the fun and enjoyment of playing Turbo GameWorks’ Chess, and most important of all, with this chess program there’s no limit to how it can help you improve your game.”

—George Koltanowski, Dean of American Chess, former President of the United Chess Federation and syndicated chess columnist.

TURBO BRIDGE

Now play the world’s most popular card game—Bridge. Play one-on-one with your computer or against up to three other opponents. With Turbo Pascal source code, you can even program your own bidding or scoring conventions.

“There has never been a bridge program written which plays at the expert level, and the ambitious user will enjoy tackling that challenge, with the format already structured in the program. And for the inexperienced player, the bridge program provides an easy-to-follow format that allows the user to start right out playing. The user can “play bridge” against real competition without having to gather three other people.”

—Kit Woolsey, writer and author of several articles and books and twice champion of the Blue Ribbon Pairs.

TURBO GO-MOKU

Prepare for battle when you challenge your computer to a game of Go-Moku—the exciting strategy game also known as “Pente”™. In this battle of wits, you and the computer take turns placing X’s and O’s on a grid of 19X19 squares until five pieces are lined up in a row. Vary the game if you like using the source code available on your disk.

Minimum system configuration: IBM PC, XT, AT, Portable, 3270, PCjr, and true compatibles with 192K system memory, running PC-DOS (MS-DOS) 2.0 or later. To edit and compile the Turbo Pascal source code, you must be using Turbo Pascal 3.0 for IBM PC and compatibles.

Suggested Retail Price: $69.95 (not copy-protected)
TURBO Database Toolbox™
Is The Perfect Complement To Turbo Pascal.

It contains a complete library of Pascal procedures that allows you to sort and search your data and build powerful applications. It's another set of tools from Borland that will give even the beginning programmer the expert's edge.

THE TOOLS YOU NEED!

TURBOACCESS Files Using B+Trees - The best way to organize and search your data. Makes it possible to access records in a file using key words instead of numbers. Now available with complete source code on disk ready to be included in your programs.

TURBOSORT - The fastest way to sort data—and TURBOSORT is the method preferred by knowledgeable professionals. Includes source code.

GINST (General Installation Program) - Gets your programs up and running on other terminals. This feature alone will save hours of work and research. Adds tremendous value to all your programs.

GET STARTED RIGHT AWAY: FREE DATABASE!
Included on every Toolbox disk is the source code to a working database which demonstrates the power and simplicity of our Turbo Access search system. Modify it to suit your individual needs or just compile it and run. Remember, no royalties!

THE CRITICS' CHOICE!
"The tools include a B+tree search and a sorting system. I’ve seen stuff like this, but not as well thought out, sell for hundreds of dollars."
—Jerry Pournelle, BYTE MAGAZINE

"The Turbo Database Toolbox is solid enough and useful enough to come recommended."
—Jeff Duntemann, PC TECH JOURNAL

TURBO DATABASE TOOLBOX—ONLY $54.95 (not copy-protected).

Minimum system configurations: 64K RAM and one disk drive. 16-bit systems: TURBO PASCAL 2.0 or greater for MS-DOS or PC-DOS 2.0 or greater. TURBO PASCAL 2.1 or greater for CP/M-86 1.1 or greater. Eight-bit systems: TURBO PASCAL 2.0 or greater for CP/M-80 2.2 or greater.
HOW TO BUY
BORLAND
SOFTWARE

For The Dealer
Nearest You,
Call (800) 556-2283

To Order By Credit Card,
Call (800) 255-8008
In California (800) 742-113~

Borland International

60 Day Money-Back Guarantee

NOT COPY-PROTECTED
Reflex™ is the most amazing and easy to use database management system. And if you already use Lotus 1-2-3, dBASE or PFS file, you need Reflex—because it's a totally new way to look at your data. It shows you patterns and interrelationships you didn't know were there, because they were hidden in data and numbers. It's also the greatest report generator for 1-2-3.

Reflex opens multiple windows with new views and graphic insights into your data.


THE CRITICS' CHOICE:

"The next generation of software has officially arrived."
Peter Norton, PC WEEK

"Reflex is one of the most powerful database programs on the market, its multiple views, interactive windows and graphics, great report writer, pull-down menus and cross tabulation make this one of the best programs we have seen in a long time..."

Marc Stern, INFOWORLD